13.6.1
To hide dimensions in tables ................................................................. 185
13.6
Printing reports..................................................................................... 172
13.5
To redisplay all hidden content in a report ........................................... 172
13.4.1
To fold and unfold report data.............................................................. 171
13.4
Folding and unfolding report data........................................................ 170
13.3.2
To switch between viewing modes....................................................... 170
13.3.1
Viewing modes defined......................................................................... 168
13.2
To remove a table................................................................................. 178
13.1
To add table rows or columns.............................................................. 177
14.3.6
To move a row or column..................................................................... 177
14.3.5
To remove table rows or columns........................................................ 177
14.3.4
To apply a different template to a table with Turn Into....................... 177
14.3.3
To clear cell contents from a table..................................................... 178
14.3.2
To swap a row or column.................................................................... 178
14.3.1
To create a table by dragging objects onto a report............................ 176
14.3
To create a table by selecting a template............................................ 176
14.2.3
To set the position of a table or chart on the report page.................. 173
14.2.2
To insert an image or skin in a table.................................................. 178
14.2.1
To remove table rows or columns........................................................ 177
14.2
To add table rows or columns.............................................................. 177
14.1.10
To copy a table.................................................................................... 178
14.1
To create a table by selecting a template............................................ 175
14.1
Creating and editing tables................................................................... 175
14.2
Formatting tables and table cells........................................................ 179
14.1
Overview of tables.............................................................................. 173
14.3.
Displaying data in tables..................................................................... 173
14.
Chapter 14
Cross tables............................................................................................. 174
Horizontal table .................................................................................... 174
Vertical table.......................................................................................... 173
Forms....................................................................................................... 175
Creating and editing tables..................................................................... 175
To select a background color for the table or cells............................... 179
14.4.2
To define alternate row and column colors for a table....................... 179
14.4.1
To format cell borders........................................................................ 180
14.4.4
To format text in table cells............................................................... 180
14.4.6
To set cell height and width............................................................... 181
14.4.7
To copy formatting using the Format Painter..................................... 182
14.4.8
To set the position of a table or chart on the report page.................. 183
14.4.9
To layer tables and cells..................................................................... 183
14.4.10
To merge table cells........................................................................... 183
14.5
Controlling the display of tables .......................................................... 184
14.5.1
To show or hide tables, rows or columns.......................................... 184
14.5.2
To redisplay hidden tables, cells or sections....................................... 184
14.5.3
To hide dimensions in tables............................................................. 185
Contents

Chapter 17

Displaying data in charts........................................................................................................207

17.1 Creating charts.................................................................................................................207
17.1.1 Opening charts created with Web Intelligence 3.x ....................................................207
17.2 Chart types.......................................................................................................................207
17.2.1 Bar charts....................................................................................................................208
17.2.2 Box plot charts............................................................................................................208
17.2.3 Column charts............................................................................................................208
17.2.4 Line charts..................................................................................................................209
17.2.5 Area charts..................................................................................................................209
17.2.6 Tree map charts.........................................................................................................209
17.2.7 Pie charts...................................................................................................................210
17.2.8 Heat map charts.........................................................................................................210
17.2.9 Point charts................................................................................................................210
17.2.10 Radar charts.............................................................................................................211
17.2.11 Tag cloud charts.......................................................................................................211
17.2.12 Waterfall charts.......................................................................................................211
17.3 Adding, copying and removing charts...........................................................................212
17.3.1 To add a chart to a report.........................................................................................212
17.3.2 Chart feeding: Binding objects to a chart.................................................................213
17.3.3 To apply a chart style..............................................................................................214
17.3.4 To copy a chart..........................................................................................................214
17.3.5 To remove a chart.....................................................................................................215
17.4 Changing the chart type.................................................................................................215
17.4.1 To change the chart type by using Turn Into...........................................................215
17.4.2 Turning Hierarchical queries into charts.................................................................216
17.4.3 To switch between bars, lines and surfaces.............................................................216
17.5 Positioning and sizing charts.......................................................................................217
17.5.1 To set the position of a table or chart on the report page........................................217
17.5.2 To position a chart in relation to another chart or table..........................................217
17.5.3 To resize a chart.......................................................................................................218
17.6 Formatting charts..........................................................................................................218
17.6.1 Formatting chart areas.............................................................................................218
17.6.2 To format a chart.......................................................................................................218
17.6.3 Formulas in chart elements.......................................................................................219
17.6.4 Warning icons in charts..........................................................................................219
17.6.5 To insert and format a chart title.............................................................................220
17.6.6 To display a chart with a 3D look............................................................................221
Chapter 24

Drilling on report data..............................................................................................................269
24.1 Drill defined..........................................................................................................................269
24.1.1 Scope of analysis..............................................................................................................269
24.1.2 To set the scope of analysis...........................................................................................270
24.1.3 Drill paths and hierarchies.............................................................................................271
24.2 Setting drill options.............................................................................................................272
24.2.1 To set drill options in the BI launch pad........................................................................272
24.2.2 To set drill options in Web Intelligence Rich Client......................................................272
24.3 Drill options explained......................................................................................................272
24.3.1 Prompt when drill requires additional data option.......................................................272
24.3.2 Synchronize drill on report blocks option.................................................................273
24.3.3 Hide drill toolbar option..............................................................................................273
24.3.4 Start drill session on existing report option.................................................................273
24.3.5 Start drill session on a duplicate report option............................................................274
24.4 To switch to drill mode....................................................................................................274
24.5 Retrieving more levels of data to the report....................................................................274
24.5.1 To drill out of the scope of analysis............................................................................275
24.6 To choose a drill path when more than one is available................................................275
24.7 To take a drill snapshot....................................................................................................276
24.8 Drilling on dimensions in tables and sections.................................................................276
24.8.1 Drilling down.................................................................................................................276
24.8.2 Drilling up.....................................................................................................................278
24.8.3 Drilling by.....................................................................................................................278
24.9 Drilling on measures in tables and sections.....................................................................280
24.9.1 To drill down on a measure value..............................................................................281
24.9.2 To drill up on a measure value....................................................................................281
24.10 Synchronizing drill across multiple tables and charts..................................................281
24.11 Drilling on charts............................................................................................................282
24.11.1 Drilling on dimensions via chart axes.........................................................................282
24.11.2 Drilling on measures in charts..................................................................................283
24.11.3 Drilling on axis legends............................................................................................284
24.12 Using filters when you drill.............................................................................................285
24.12.1 To change a filter value on the Drill toolbar.............................................................286
24.12.2 To add or remove a drill filter.....................................................................................286
24.13 Saving reports with drill filters.....................................................................................286
24.14 Refreshing data in a drilled report with prompts............................................................287
24.15 Drilling with query drill.................................................................................................287
24.15.1 Query drill defined......................................................................................................287
Chapter 25
Merging data from dimensions and hierarchies
25.1 Merging defined
25.1.1 Merging data providers based on keys
25.2 Choosing which data to merge
25.3 Merged dimension example
25.4 Merging hierarchies
25.5 Merging different types of object
25.6 Forcing merged calculations with the ForceMerge function
25.7 Creating, editing and deleting merged objects
25.7.1 To merge details, dimensions, or hierarchies
25.7.2 To merge dimensions automatically
25.7.3 To edit merged objects
25.7.4 To delete merged objects
25.8 Understanding the effects of merged data
25.8.1 Synchronizing data providers with different aggregation levels
25.8.2 Attributes and merged dimensions
25.8.3 Incompatible objects and merged dimensions
25.8.4 Filtering merged dimensions
25.8.5 Drilling on merged dimensions
25.8.6 Extending the values returned by merged dimensions

Chapter 26
Ranking report data
26.1 Ranking data
26.2 Rankings and sorts
26.3 Tied rankings
26.4 Ranking parameters
26.4.1 Example of a ranking
26.5 Ranking and data order
26.6 Ranking workflows
26.6.1 To create a ranking
26.7 Ranking examples

Chapter 27
Tracking changes in data
27.1 Tracking changes in your data
27.2 Types of data change
27.3 Data tracking modes
27.3.1 Automatic data tracking mode
27.3.2 Manual data tracking mode
27.4 To activate data tracking
Displaying changed data.......................................................................................................319
27.5.1 To display changed data..........................................................................................319
27.5.2 Configuring the appearance of changed data...........................................................319
27.5.3 How changed data is displayed in blocks..................................................................320
27.5.4 How changed data is displayed in reports with merged dimensions.......................321
27.5.5 How changed data is displayed in sections..............................................................323
27.5.6 How changed data is displayed in blocks with breaks.............................................324
27.5.7 How changed data is displayed in charts.................................................................325
27.6 Data tracking restrictions............................................................................................325
27.6.1 Data tracking and drill............................................................................................325
27.6.2 Data tracking and Refresh on Open..........................................................................326
27.7 Using the formula language to track changed data.....................................................326
27.7.1 The RefValue function............................................................................................326
27.7.2 The RefValueDate function.....................................................................................327
27.7.3 The RefValueUserResponse function.......................................................................327
27.7.4 Building formulas using the RefValue function.......................................................327
27.8 Changed data and the calculation context.....................................................................328
28.1 Publishing content as web services............................................................................331
28.1.1 To publish a report block as a web service...............................................................331
28.1.2 To identify duplicate content..................................................................................332
28.1.3 To publish prompts..................................................................................................332
28.1.4 To define the web service........................................................................................333
28.1.5 To save and publish a web service...........................................................................334
28.2 Viewing and managing published content.....................................................................335
28.2.1 To view and manage published content....................................................................335
28.2.2 To test published content........................................................................................336
28.3 Importing and converting QaaWS (Query as a Web Service) queries.........................337
28.3.1 To publish a QaaWS query.......................................................................................337
28.4 BI service structure......................................................................................................338
28.4.1 GetReportBlock_blockname....................................................................................338
28.4.2 Drill_blockname........................................................................................................341
28.4.3 BI Services output parameters................................................................................342
28.4.4 Sample BI service return data................................................................................344
28.4.5 BI service WSDL definition....................................................................................347
29.1 Linking to other documents.......................................................................................355
29.1.1 Cell text defined as a hyperlink...............................................................................355
29.1.2 A hyperlink associated with a cell.................................................................356
29.1.3 A link to another document in the CMS......................................................358
29.2 Working with hyperlinks..................................................................................362
29.2.1 To link to another document from a hyperlink.............................................362
29.2.2 To edit a hyperlink........................................................................................363
29.2.3 To delete a hyperlink......................................................................................363
29.2.4 Formatting hyperlink colors.........................................................................363
29.3 Linking report elements in a document............................................................364

Chapter 30 Formatting your reports using Cascading Style Sheets..........................365
30.1 Style sheets explained ......................................................................................365
30.2 Using the style in documents..........................................................................365
30.3 Modifying the document default style............................................................366
30.4 Modifying and using the standard default style...............................................366
30.5 Web Intelligence CSS syntax ........................................................................367
30.5.1 Elements........................................................................................................367
30.5.2 Properties.......................................................................................................368
30.5.3 Units................................................................................................................375
30.6 Style and 3.x documents..................................................................................376
30.7 Web Intelligence CSS restrictions....................................................................376

Chapter 31 Creating a corporate palette for charts................................................379
31.1 About corporate palettes..................................................................................379
31.2 Corporate palette configuration file syntax.......................................................379
31.3 To define a corporate palette for charts............................................................380

Chapter 32 Error Messages.....................................................................................381
32.1 Web Intelligence Error Messages......................................................................381
32.1.1 Web Intelligence (WJ) Error Messages..........................................................381
32.1.2 Web Intelligence Desktop (WIO) Error Messages........................................389
32.1.3 Web Intelligence Server (WIS) Error Messages..........................................390
32.1.4 Web Intelligence Desktop HTML Interface (WIH) Error Messages............400
32.1.5 ReportEngine Web Intelligence (RWI) Error Messages.............................402
32.1.6 Custom Data Source (CDS) Framework Error Messages............................417
32.2 Information Engine Services (IES) Error Messages.........................................428
32.2.1 Information Engine Services (IES) Error Messages......................................429
About this users guide

This user guide describes the Web Intelligence Java and HTML applications.

The Web Intelligence Rich Client application is described in the SAP BusinessObjects Web Intelligence Rich Client Users Guide.

1.1 Document History: Web Intelligence

The following table provides an overview of the most important document changes.
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP BusinessObjects Interactive Analysis Desktop 4.0</td>
<td>30, November 2010</td>
<td>Initially rebranded Interactive Analysis. First release of this document.</td>
</tr>
<tr>
<td>SAP BusinessObjects Interactive Analysis Desktop 4.0 SP01</td>
<td>25, February 2011</td>
<td>Support Package 1</td>
</tr>
<tr>
<td>BusinessObjects Web Intelligence Rich Client 4.0 SP02</td>
<td>15, June 2011</td>
<td>Support Package 2. Rebranded back to Web Intelligence</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Additional administrator-defined security right called “Download connection locally” for connection objects</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Query Panel enhancements:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• BEx Query Scaling factor information is displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Query Panel indicates which hierarchy is activated in a BEx Query.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Techname is displayed in reports.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Default hierarchies managed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Prompt on member selection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Can select all hierarchy members to a specified depth.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Member selection based on level.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Charts:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Waterfall charts can be used to display vertical bars.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hierarchical navigation is available</td>
</tr>
<tr>
<td>BusinessObjects Web Intelligence Rich Client 4.0 SP03</td>
<td>20, February 2012</td>
<td>Feature Pack 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>zero line feature</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Custom sort feature</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Query Panel functionality</td>
</tr>
</tbody>
</table>
You perform data analysis with SAP BusinessObjects Web Intelligence by creating reports based on data you want to analyze, or by opening pre-existing documents. Depending on your license and security rights, you can then analyze the data in your reports by, for example, filtering, drilling down to reveal more details, merging data from different data sources, displaying data in charts, or adding formulas.

Data comes from universes, which organize data from relational or OLAP databases into objects or hierarchies, from personal data providers such as Microsoft Excel or CSV files, from BEx queries based on SAP Info Cubes, from web services, or from Advanced Analysis workspaces. You build data providers to retrieve data from these data sources and you create reports from the data in data providers.

You can also connect to the HANA (SAP High-Performance Analytical Appliance) data source to take advantage of the benefits of in-memory computing.

You can use the Java or HTML interface of SAP BusinessObjects Web Intelligence to perform data analysis from the BI launch pad. Which interface is launched depends on your Preferences settings in the BI launch pad.

You can also use Web Intelligence Rich Client to perform data analysis. Web Intelligence Rich Client allows you to work locally without a connection to a repository. Additional information is available in the SAP BusinessObjects Web Intelligence Rich Client User’s Guide.

**Note:**
When you have launched the desktop tool once and closed it, the quick start icon is available in the toolbar. This quick start icon allows you to launch the desktop tool rapidly.

**About the three Web Intelligence interfaces**
There are three different interfaces available for creating and editing queries, and creating and editing documents, and creating, editing, and refreshing reports:
Table 2-1: The three Web Intelligence interfaces

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
</table>
| Web                              | Also referred to as the DHTML interface. You launch this via the BI launch pad. Depending in your rights, you can do the following:  
• Create and edit queries based on 'no data source', .unx, and .unv universes (but not on BEx queries).  
• Create, edit and refresh all types of reports.  
**Note:**  
In 4.0 SP02, it was not possible to create queries. It was only possible to work with documents and reports. |
| Rich Internet Application        | Also referred to as the Java applet. You launch this via the BI launch pad. Depending on your permissions, you can do the following:  
• Create and edit queries based on 'no data source', .unx and .unv universes, BEx queries, Analysis views (Advanced Analysis workspaces), and Text sources.  
• Create, edit and refresh all types of reports.                                                                                                                                                                          |
| Web Intelligence Rich Client    | You download and install this via the BI launch pad. Depending on your permissions, you can do the following:  
• Create queries based on 'no data source', .unx and .unv universes, BEx queries, Analysis Views (Advanced Analysis workspaces), and Text sources.  
• Create, edit and refresh all types of reports.                                                                                                                                                                          |
The application has the following components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The main toolbar</td>
<td>You use the main toolbar to open, save and print documents, track data changes and display the report outline. The main toolbar appears in the <strong>File</strong> tab when the application is in Design mode.</td>
</tr>
<tr>
<td>Toolboxes</td>
<td>You work with data providers and perform report design and analysis tasks using the toolboxes. Toolboxes appear at the top of the application in Data and Design mode only. In Data mode, only those toolboxes related to working with data providers are active.</td>
</tr>
</tbody>
</table>
### Component

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Left Panel | The Left Panel groups several panes that provide different views of the current document. Refer to the table below to see which panes are available in the different modes.  
- The **Document Summary** provides an overview of the document properties.  
- The **Available Objects** pane lists the data providers and objects available for inclusion in reports.  

**Note:**  
The Web interface (DHTML mode) does not display formulas in this panel.  
- The **Input Controls** pane allows you to add and edit input controls applied to the document.  
- **User Prompt Input**  
- The **Document Structure and Filters** pane displays the structure of the document in a tree view, and displays filters applied to different report elements.  

**Note:**  
The Web interface (DHTML mode) does not display filters in this pane. If you want to use filters, use the Rich Internet Application (Java applet).  
- (Rich Internet Application mode only) The **Navigation Map** pane lists all the reports in a document. This pane is the same as the Report Map in HTML mode.  
- (Web mode only) The **Report Map** pane lists all the reports in a document. This pane is the same as the **Navigation Map** in Rich Internet Application mode.  
- The **Web Services Publisher** pane lists the BI Services published from the document.  
- The **Data** pane appears in Data mode only and allows you to navigate the data providers in a document. |
| File and Properties tabs | The **File** and **Properties** tabs are available in Design and Data mode only. The **File** tab contains the main file menu tools. The **Properties** tab allows you to set **View**, **Document**, and **Application** properties. |
| Report Panel | The "Report Panel" displays the report. |
| Status Bar | The "Status Bar" appears beneath the report and allows you to perform actions such as activating data tracking or changing the display mode. It can be activated and deactivated in the **View** menu of the **Properties** tab. |
The tabs available in the left panel depend on your choice of interface: Rich Internet Application (the Java applet mode), Web (HTML mode), or Desktop (Web Intelligence Rich Client):

<table>
<thead>
<tr>
<th>Pane</th>
<th>RIA Data</th>
<th>RIA Design</th>
<th>RIA Reading</th>
<th>Web Design</th>
<th>Web Reading</th>
<th>Rich Client Data</th>
<th>Rich Client Design</th>
<th>Rich Client Reading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Summary</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigation Map</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report Map</td>
<td></td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Input Controls</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User Prompt Input</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Available Objects</td>
<td>Yes</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Document Structure and Filters</td>
<td>Yes</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Web Service Publisher</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Data pane</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
Using the BI launch pad

4.1 About the BI launch pad

The BI launch pad has the following main tabs: Home, Documents, and any open document.

Table 4-1: BI launch pad panes

<table>
<thead>
<tr>
<th>Tab pane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Shows recent documents, messages, alerts, and applications that you can run.</td>
</tr>
<tr>
<td>Documents</td>
<td>Allows you to navigate through the available folders and documents. You can view, organize, and manage documents in this pane.</td>
</tr>
<tr>
<td>Web Intelligence Documents</td>
<td>One tab for each open document.</td>
</tr>
</tbody>
</table>

Use the Applications tab of the BI launch pad to start an application including Web Intelligence.

Use the Preferences menu to set the preferences shown in the table below.

Table 4-2: Preferences menu items

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Set the user default settings. (These are Administrator defined.)</td>
</tr>
<tr>
<td>Change Password</td>
<td>Change your password. Enter your old password, then enter the new password twice.</td>
</tr>
<tr>
<td>Locales and Time Zone</td>
<td>Set the Product Locale, Preferred Viewing Locale, and Current Time Zone.</td>
</tr>
<tr>
<td>Analysis edition for OLAP</td>
<td>Set the Accessibility mode. (Not described here).</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Web Intelligence | Choose the interfaces you want to use for View and Modify modes.
 | Select a default universe.
 | Set the drill options.
 | Set the saving priorities when saving as Excel.
BI workspaces | Set a default style. (Not described here).
Crystal Reports | Set Crystal Reports options. (Not described here).

### 4.2 To log in to the BI launch pad

Before you can perform interactive analysis from the BI launch pad, you need the following information:

- a URL to the BI launch pad (for example `http://arcachon:8080/BOE/BI`).
- your login and password
- your authentication, which controls the resources available to you

Contact your administrator for these details if you do not already know them.

**Note:**

By default the server name and authentication method are not displayed on the BI launch pad logon page. You need to supply this information only if your administrator has made these options visible.

You launch SAP BusinessObjects Web Intelligence by using your web browser to log into the BI launch pad.

1. Launch your web browser.
2. Point your browser to the BI launch pad bookmark or URL.

   The login page appears.
3. If the **System** box is blank, type the name of the server followed by a colon (:), and then type the port number.
4. In the **Username** box, type your user name.
5. In the **Password** box, type your password.
6. In the **Authentication** box, select the authentication provided to you by your administrator.
7. Click **Log On**.

   The BI launch pad home page appears.
4.3 To log out of the BI launch pad

You need to log out when you have finished working in the BI launch pad instead of simply closing your web browser.

Logging out ensures that any preferences you modified during your session are saved. It also lets your administrator track how many users are logged into the system at any given time. Your administrator can use this information to optimize system performance.

- Click Log Off.

4.4 About setting Web Intelligence preferences

Use the Preferences tab of the BI launchpad to do the following:

- View the General preferences (These are usually administrator defined).
- Change your password.
- Set the Locales and Time Zone preferences.
- Set the Web Intelligence preferences, select an interface for the read mode and modify mode.

4.4.1 Choosing the viewing and design interfaces

You can set options to determine how you view and explore existing documents (using the Read interface) and how you create new documents or edit and analyze existing documents (using the Modify interface). You set these options in the Preferences panel in the BI launch pad.

Depending on your permissions, you have a choice of Reading mode, Design mode, and Data mode.

Note:
Your choice of interface can be further restricted by your security profile.

The Reading interface is launched when you select an existing document from the list of corporate documents, right-click and select View from the menu. The Design interface is launched when you create a new document, or select an existing document, and select Design from the interface.

In the BI launch pad, you have the following choice of Read interfaces:
### Interface Description

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web</td>
<td>You view documents using the Web interface within the BI launch pad.</td>
</tr>
<tr>
<td>Rich Internet Application</td>
<td>You view documents using the Rich Internet Application interface within the BI launch pad.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This interface requires the download of a Java applet.</td>
</tr>
<tr>
<td>Desktop</td>
<td>You view documents using Web Intelligence Rich Client, a standalone interface that works outside the BI launch pad and allows you to work with documents without being connected to a corporate repository.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Web Intelligence Rich Client requires an install on your local machine.</td>
</tr>
<tr>
<td>PDF</td>
<td>You view documents statically in PDF format.</td>
</tr>
</tbody>
</table>

In the BI launch pad, you have the following choice of **Modify** interfaces:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web</td>
<td>You create, edit and analyze documents using the Web interface within the BI launch pad.</td>
</tr>
<tr>
<td>Rich Internet Application</td>
<td>You create, edit and analyze documents using the Rich Internet Application interface within the BI launch pad. You can select <strong>Design</strong> or <strong>Data</strong> mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This interface requires the download of a Java applet.</td>
</tr>
<tr>
<td>Desktop</td>
<td>You create and edit documents using Web Intelligence Desktop, a standalone interface that works outside the BI launch pad and allows you to work with documents without being connected to a corporate repository. You can select <strong>Design</strong> or <strong>Data</strong> mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Web Intelligence Rich Client requires an install on your local machine.</td>
</tr>
</tbody>
</table>

Once you begin working in a specific interface, you remain in that interface for the rest of your session. For example, if you select **Web** as your Read interface and **Rich Internet Application** as your Modify interface, you remain in the **Web** interface even if you switch to **Design** mode (which uses the Modify interface) within the application.

### 4.4.1.1 To select the document viewing and design interfaces
1. Click **Preferences** in the BI launch pad to open the "Preferences" dialog box.
2. Click **Preferences** in the left pane of the "Preferences" dialog box to display the list of preferences, then select **Web Intelligence** from the list.
3. Select the viewing interface from the **Read** options.
4. Select the design interface from the **Modify** options.
   This allows you to access the Data and Design editing modes with your chosen interface. The Data editing mode is not available in Web interface.
5. Click **Save and Close**.
6. To make the changes permanent, log out of the BI launch pad and Log on again.

### 4.4.2 Setting the interface and document locales

Locales determine the appearance of the application interface (for example, menu items and button text) and data (for example, date and number formatting).

There are three locales:

<table>
<thead>
<tr>
<th>Locale</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Locale</td>
<td>The locale of the Web Intelligence interface</td>
</tr>
<tr>
<td>Document Locale</td>
<td>The locale of the data currently contained in the document</td>
</tr>
<tr>
<td>Preferred Viewing Locale</td>
<td>The preferred locale for displaying document data</td>
</tr>
</tbody>
</table>

The locale settings determine how the locales interact to display document data.

#### 4.4.2.1 The Product locale

The product locale is used to display the user interface (for example, menu items and button text).

**Note:**
The `getLocale` function returns the Product Locale.

#### 4.4.2.1.1 To set the Product locale in the BI launch pad

1. Click **Preferences** on the BI launch pad toolbar.
2. Click **Locales and Time Zone** to display the available options.
3. Select the product locale from the Product Locale list.
4. Click Save and Close.

### 4.4.2.2 The Document locale

The Document locale formats the data in documents. For example, the Document locale determines the display of dates and numbers.

By default, the browser locale is used. A user can permanently associate the current Document locale with a document by saving the document with the Permanent Regional Formatting option selected. Once a document has been saved with the option selected, the settings are ignored and the document data is always formatted using the saved Document Locale. This applies to all users, not just the user who selected the Permanent Regional Formatting option.

**Note:**
The GetContentLocale function returns the Document locale.

**Related Topics**
- To associate a locale with a document permanently

#### 4.4.2.2.1 To set the Document locale in the BI launch pad

1. Click Preferences on the BI launch pad toolbar to display the Preferences panel.
2. Click Web Intelligence.
3. In the section "When viewing a document", select Use the document locale to format the data or select Use my preferred viewing locale to format the data.
4. Click Save and close.

**Related Topics**
- The Preferred Viewing locale
- To set the Preferred Viewing locale in the BI launch pad

### 4.4.2.3 The Preferred Viewing locale

The Preferred Viewing locale is a user's preferred locale for displaying document data. The Document locale becomes the user's Preferred Viewing locale when the BI launch pad settings give the Preferred Viewing locale priority.
If the locale settings give the user's Preferred Viewing locale priority through the **Use the Preferred Viewing Locale to format the data** setting, the Document locale is set to the Preferred Viewing locale when the user opens a document. When the user saves the document, this Document locale is saved with the document.

If the settings do not give the user's Preferred Viewing locale priority, the data is formatted according to the Document locale saved with the document.

When a user creates a document, the user's Preferred Viewing locale is always assigned as the initial Document locale, whether or not the locale settings give the Preferred Viewing locale priority.

**Note:**
The `GetPreferredViewingLocale` function returns the Preferred Viewing locale. The `GetLocalized` function also uses the Preferred Viewing locale to display translated strings.

### 4.4.2.3.1 To set the Preferred Viewing locale in the BI launch pad

1. Click **Preferences** on the BI launch pad toolbar to display the "Preferences" dialog box.
2. Click **General** to display the general options.
3. Select the preferred viewing locale from the **Preferred Viewing Locale** list.
4. Click **Web Intelligence** to display the Web Intelligence options.
5. If you want data to be formatted using the preferred viewing locale, click **Use my Preferred Viewing Locale to format the data** beneath **When viewing a document**.
6. Click **Save and Close**.

### 4.4.2.4 To associate a locale with a document permanently

1. In Design mode, click **Document** on the **Properties** tab in the left panel to display the "Document Summary" dialog box.
2. Select **Permanent regional formatting**.
3. Click **OK**.
4. Save the document.

### 4.4.3 Setting application modes

You build queries, documents and reports and analyze the data in reports using three application modes: Data, Reading and Design.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>In Data mode you create, edit and manage queries that supply data to reports. You can, for example, create a new data provider, rename a data provider, or change the source from which a data provider draws its data.</td>
</tr>
<tr>
<td></td>
<td>All the data providers used by the current document appear in a list in Data mode, and all toolboxes not related to working with data providers are disabled.</td>
</tr>
<tr>
<td></td>
<td>Data view is not available in the Web interface.</td>
</tr>
<tr>
<td>Reading</td>
<td>Reading mode allows you to view existing reports, search for text in reports, track changes in report data or drill down on report data.</td>
</tr>
<tr>
<td></td>
<td>The main application toolbar and the Left Panel are available in Reading mode. Toolboxes are not available.</td>
</tr>
<tr>
<td>Design mode</td>
<td>Design mode allows you to perform a wide range of analysis tasks. You can, for example, add and delete report elements such as tables or charts, apply conditional formatting rules, and enhance reports with formulas and variables.</td>
</tr>
<tr>
<td></td>
<td>You can work with the report structure only in Design mode, or with the report populated with data.</td>
</tr>
<tr>
<td></td>
<td>Working with the report structure only allows you to make modifications without accessing the server. When you work with reports populated with data, each change you make is applied on the server.</td>
</tr>
<tr>
<td></td>
<td>If you are making numerous modifications, you are recommended to work with the report structure only, and to populate the report with data when you have finished your modifications.</td>
</tr>
</tbody>
</table>
4.4.3.1 To switch between application modes

1. To work in Data mode, click **Data**.
2. To work in Reading mode, click **Reading**.
3. To work in Design mode with the report structure only, click **Design > Structure Only**.
4. To work in Design mode with report data, click **Design > With Data**.

Depending on the mode you choose, the toolboxes and toolbars relevant to the mode are made available and other toolboxes and toolbars are either invisible or disabled.
Working with documents

5.1 To start the Web Intelligence interface

- Start Web Intelligence, in the "BI launch pad": click Applications > Web Intelligence Application or select Web Intelligence Application in the application shortcuts.
- Web Intelligence starts. The "Web Intelligence" tab is active in the main pane. To check which interface has started (Web, Rich Internet Application, or Rich Client), click Preferences and select Web Intelligence.

Related Topics
- Queries defined
- Choosing the viewing and design interfaces

5.2 Creating and editing documents

You can create or edit documents from the BI launch pad using SAP BusinessObjects Web Intelligence or Web Intelligence Rich Client, which allows you to work with documents offline without a connection to the corporate repository.

You can work with documents either by selecting an existing document, or by starting your selected interface which you then use to open existing documents or create new documents.

You can base documents on universes, which present data in relational or OLAP datasources as collections of objects, on local data sources such as Microsoft Excel or CSV files, on SAP BEx Queries, or on Advanced Analysis workspaces.

You create a new document, either a blank document, or a document based on a data source. The data sources you can use depend on the interface you are using.
Table 5-1: Available data sources

<table>
<thead>
<tr>
<th>Data source</th>
<th>Web interface</th>
<th>Rich Internet Application interface</th>
<th>Web Intelligence Rich Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>No data source</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Universe (unx or unv)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>BEx query</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis View</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Text source</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note:

- For information specific to Web Intelligence Rich Client, see the SAP BusinessObjects Web Intelligence Rich Client User's Guide or the online help for Web Intelligence Rich Client.
- In order to connect to an Essbase OLAP data source from SAP BusinessObjects OLAP products including universe design tool, Web Intelligence Rich Client and Web Intelligence, ensure that Essbase Client middleware is properly installed and configured on machines hosting those SAP BusinessObjects OLAP products. Specifically, ensure that Essbase Client environment variables ARBORPATH and ESSBASEPATH are created and set as Windows system environment variables (as opposed to Windows user environment variables).

5.2.1 To create an empty document

You have started the Web Intelligence interface in Design mode.
You want to create a blank document for working with later.
1. Click the New icon in the toolbar.
2. Select No data source, and click OK.
A blank document opens. The "Available Objects" pane contains no objects.

5.2.2 To create a new document based on a universe

You have the necessary permissions to access a universe data source and create a query and document. Certain universe objects may not be available depending on your permissions.
You want to create a document based on either a .unx universe created with the information design tool, or you want to create a document based on a .unv universe created with the universe design tool.

1. Click the **New** icon in the toolbar.
2. Select **Universe**, and click **OK**.
3. Select a .unx or .unv universe as required. A default universe is proposed, you can use this universe or select a different universe. .unx universes have the file extension .unx, the .unv universes have no file extension.
4. Click **Select**.

A blank document is created, and the "Query Panel" is open, showing "Universe outline" in the left pane, and the "Result Objects", "Query Filters", and "Data Preview" panels in the main pane. You can build and run queries on the selected universe.

### 5.2.3 To create a new document based on a BEx query

- You can only access BEx queries that have the flag "Allow External Access to the Query" is enabled.
- The object mapping is not all equivalent, refer to the equivalents and restrictions pages to ensure that the queries can be used correctly.

**Note:**
You cannot use the Web Intelligence Web interface to create documents based on BEx queries.

You want to run queries on a BEx query data source.

1. Click the **New** icon in the toolbar.
2. Select **BEx**, and click **OK**.
   - The "Select a BW BEx query" pane displays. You can only see BEx queries that allow external access, and for which you have permissions to use.
3. Choose the appropriate connection folder. When a connection folder contains several BEx queries, select the appropriate BEx query and click **OK**.

A blank document is created, and the "Query Panel" is open, showing "Universe outline" in the left pane where the available BEx query objects are displayed, and the "Result Objects", "Query Filters", and "Data Preview" panels in the main pane. You can build and run queries on the selected BEx query.

### 5.2.4 To create a new document based on an Analysis View

You have the appropriate permissions to access Analysis Views and use them for reporting.

**Note:**
You cannot use the Web Intelligence Web interface to create documents based on Analysis Views.
1. Click the **New** icon in the toolbar.
2. Select **Universe**, and click **OK**.
3. Navigate to the Analysis View that you want to use, select the Analysis View, and click **OK**.

A new blank document is created and the Query Panel is opened showing the available query objects. You can add objects to the query and filter panes, and run the query.

### 5.3 To open a document from the repository

You have logged in to BI launch pad.

1. In the BI launch pad, click the **Documents** tab to show the documents available in the repository.
2. Click the **Folders** tab on the left, and navigate to the folder containing your document.
3. Select the document, right-click and select **View** to open the document with the chosen View interface, or **Modify** to open the document with the chosen Modify interface.

   When a document is set to refresh its data on opening (when the “Refresh on open” document property is selected), the document displays the latest information.

   **Note:**

   The Refresh on open option is dependent on two CMS settings (document and user-related security settings): "Check automatic refresh on open" in the CMC/Application/Webi/Properties and the "Disable automatic refresh on open" in the CMC/Application/user security settings. If the property **Check automatic refresh on open** security setting is ENABLED/checked in CMC/Application/Webi/Properties and in the CMC/Application/user security settings, the security right Disable automatic refresh on open is DISABLED for this user, then even if the document is not set as being Refresh on open, it will still be refreshed on opening.

   The document opens in the interface you selected in the **Preferences** options.

**Related Topics**
- Choosing the viewing and design interfaces

### 5.4 To open a document in Web Intelligence

You have access to the documents and have the appropriate permissions to open the document.

1. Launch Web Intelligence: click **Applications > Web Intelligence Application**
2. Click the **Open** icon in the toolbar.
   
   The "Choose a document" dialog displays.
3. Navigate through the folders to the file you want to open. Select the file, click **Open**.
The document is opened in Design mode. Depending on your rights, you can work in reading and Design modes.

5.5 To delete a document from the repository

You have started the appropriate permissions to delete the file.
1. Log into the BI launch pad
2. Click the **Documents** tab to show the documents available in the repository. Navigate to the folder that contains the document you want to delete.
3. Navigate to the folder that contains the document you want to delete.
4. Right-click the document that you want to delete and click **Organize**.
5. Click **Delete**.

5.6 Sending documents

5.6.1 To send a document by mail

1. Select the document you want to send.
2. Click **Send** on the toolbar and select **Email**.
3. Fill in the email information and type a message if required.
4. Click **Send**.

5.6.2 To send a document to another user

1. Select the file you want to send.
2. Click **Send** on the toolbar and select **BI Inbox**.
3. Select the users or groups to which you want to send the document from the list of users and groups.
4. Click **Automatically generated** to send the document with an automatically-generated name.
5. Click **Specific name** and type the name in the box to send if you want to name the document.
6. Click **Shortcut** to send a shortcut to the document or **Copy** to send a copy of the document.
7. Click **Send**.

### 5.6.3 To send a document by FTP

You have a document open in Web Intelligence and you have the required permissions to send files via FTP. If you do not have the permissions, the "Send to FTP" dialog will not display.

You want to transfer the current document via FTP.

1. Save the document before sending.
2. Click the Mail icon in the toolbar and select **Send to Ftp**.
3. Type the host name in the **Host** box.
4. Type the port in the **Port** box.
5. Type the username and password in the **User Name** and **Password** boxes.
6. Type the account in the **Account** box.
7. Type the directory in the **Directory** box.
8. Click **Automatically generated** to send the document with an automatically-generated name.
9. Click **Specific name** and type the name in the box to send if you want to name the document.
10. Click **Send**.

### 5.7 Managing reports in documents

Each Web Intelligence document contains one or more reports. You can add, delete, duplicate, or change the order of reports.

#### 5.7.1 To rename a report

You have opened a document in Design mode.

1. Right-click the **Report** tab of the report you want to rename.
2. Select **Rename Report** on the menu and type the new report name.
3. Click outside the report name tab and save the document.
5.7.2 To duplicate a report

You have opened a document in Design mode.
1. Right-click the report tab of the report you want to duplicate.
2. Click Duplicate Report.
3. Rename the duplicated report, if required.
4. Save the document.

5.7.3 To delete a report

1. Right-click the report tab of the report you want to delete and select Remove Report.
2. Save the document.

5.7.4 To change the order of reports

1. Right-click the report tab of the report whose order you want to change in the document.
2. Click Move Report on the menu, then select one of the menu options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>The report becomes the first report in the document</td>
</tr>
<tr>
<td>Previous</td>
<td>The report is moved to the previous position in the document</td>
</tr>
<tr>
<td>Next</td>
<td>The report is moved to the next position in the document</td>
</tr>
<tr>
<td>Last</td>
<td>The report is moved to the last position in the document</td>
</tr>
</tbody>
</table>

5.7.5 To add a report

You have opened a document in Design mode.
* Right-click the report tab of any existing report and click Add Report.
A new blank report is added to the document with the default name Report n.

5.7.6 To save a report locally

1. Right-click the report tab and select Export Current Report As.
2. Click PDF to save in PDF format, Excel to save in Excel format, or Excel 2007 to save in Excel 2007 format, click Text to save the report in text format.
3. Click Save on the "File Download" dialog box and navigate to the location where you want to save the file.
4. Navigate to the folder where you want to save the document.
5. Click Save.

The document is saved in the folder of your choice.

5.8 About saving documents, reports and data in Web Intelligence

You can save Web Intelligence documents in the corporate repository, export them locally, or export the data as CSV format. You can also export reports locally. You can do the following:

- Save a Web Intelligence document in the corporate repository
- Export a document locally as a PDF file
- Export a document locally as an Excel file
- Export a document locally as an Excel 2007 file
- Export a document locally as a Text file
- Export a report locally as a PDF file
- Export a report locally as an Excel file
- Export a report locally as an Excel 2007 file
- Export a report locally as a Text file
- Export data locally in CSV format file

Refer to the appropriate topics for instructions on how to save the different formats in the interface you are using.

5.9 About saving documents to MS Excel

You can select a priority for saving to MS Excel.
5.10 To set preferences for saving documents as Excel

You are logged into the BI launch pad.

You can select a priority for saving to MS Excel. You can
1. In the "Header" panel, click Preferences.
2. Click Web Intelligence.
3. Under "Select a priority for saving to MS Excel", select the option that best fits your needs:
   a. Choose Prioritize the formatting of the documents to display the data in a format that is similar to working in Web Intelligence.
   b. Choose Prioritize easy data processing in Excel to display the data in a text format.
4. Click Save and Close.

5.11 Saving documents using Rich Client or the Java interface

5.11.1 To save a document in the corporate repository (with the Java interface or Rich Client)

You are using the Java interface to perform this action.

1. Click the arrow next to Save on the toolbar in the File tab and select Save As to display the "Save As" dialog box.
2. Select the corporate repository on the left of the dialog box.
3. If you are using the desktop interface, you can save to any available corporate repository by selecting My Enterprise on the left of the dialog box, then logging in to the repository.
4. Click Folders or Categories to display the repository by folders or by categories.
5. In the File Name box, type the name of the document.
6. Click Advanced to display additional document options.
   The additional options are always displayed in the desktop interface.
7. Type a description of the document in the **Description** box.
8. Type keywords that you or other users can use to search for the document in the future in the **Keywords** box.
9. Select **Refresh on open** to refresh the document each time it is opened.
10. Select **Permanent regional formatting** to preserve the document regional formatting with the document.
11. Select **Remove document security** to remove all document security and make the document accessible in Standalone mode (desktop interface only).
12. Select **Save for all users** to ensure the document is not locked by the current user (desktop interface only).
13. Click **OK**.

**Note:**
If the property **Check automatic refresh on open** security setting is ENABLED/checked in CMC/Application/Webi/Properties and in the CMC/Application/user security settings, the security right **Disable automatic refresh on open** is DISABLED for this user, then even if the document is not set as being **Refresh on open**, it will still be refreshed on opening.

The document is saved in the corporate repository.

5.11.2 To save a document as an Excel spreadsheet (with the Java interface or Rich Client)

You are using the Java interface to perform this action. You can set formatting preferences when saving as Excel. This is done separately, see the related links below.

**Note:**
The table cell formatting Read content as HTML is not supported when exporting a document or report as pdf. Any table cells with this setting will appear blank in the generated pdf. To obtain the content in pdf, unselect this property. Right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the "Read contents as" to some other value than HTML. The setting is applied to the entire column.

1. Click the arrow next to **Save** on the toolbar in the **File** tab and select **Save As** to display the "Save As" dialog box.
2. Select **My Computer**, **My Desktop**, or **My Documents** on the left of the dialog box and navigate to the folder where you want to save the document.
3. Select **Excel** or **Excel 2007** from the **Files of Type** list.
   Each Excel 2007 worksheet can contain up to 1 million rows of exported data. If you save to Excel rather than Excel 2007, each 65,000 rows of exported data start on a new worksheet.
4. Select the reports you want to save as Excel or select **Select All** to save all reports.
   Each report within the document is saved as separate worksheet within the Excel file if you chose to save the entire document to Excel.
5. Select **Prioritize the formatting of the documents** to match the layout and formatting of the document as closely as possible in the Excel file. (As a trade-off, this option does not exploit the data processing features of Excel to the same extent.)

6. Select **Prioritize easy data processing in Excel** to avoid merging multiple cells into Excel cells as much as possible to exploit the data processing features of Excel.

7. Click **Save**.
   In Web Intelligence, all charts are automatically converted to images in Excel. You can use the exported data to create your own chart using the functionality of Excel.

**Related Topics**
- About saving documents to MS Excel
- To set preferences for saving documents as Excel

---

### 5.11.3 To save a document as PDF (with the Java interface or Rich Client)

You are using Web Intelligence Rich Client or the Java interface to perform this action.

**Note:**
The table cell formatting Read content as HTML is not supported when exporting a document or report as pdf. Any table cells with this setting will appear blank in the generated pdf. To obtain the content in pdf, unselect this property. Right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the "Read contents as" to some other value than HTML. The setting is applied to the entire column.

1. Click the arrow next to **Save** on the toolbar in the **File** tab and select **Save As** to display the "Save As" dialog box.
2. Select **My Computer**, **My Desktop**, or **My Documents** on the left of the dialog box and navigate to the folder where you want to save the document.
3. In the **Files of Type** field, select **PDF**.
4. Select **Export current report as > PDF** to save the current report as PDF.
   When a report contains charts and images, you can optimize the size of the exported document by choosing the 96 dpi size. This can be useful for online publishing.
5. Select **Select reports** to select reports to save, then select the reports from the list, or select **Current report** to save the current report and select the pages you want to save.
6. Click **Save**.

---

### 5.11.4 To save a document as Text (with the Java interface or Rich Client)

---
You are using the Java interface to perform this action.

- Report elements are exported in the following order.
  1. Based on report element (upper left corner) position.
  2. Left to right, then top to bottom.
  3. In page mode, report elements are exported page by page.
  4. If the report element upper left corner is in page n, then all the report element data is exported with this page.
  5. The exported file in page mode can be different from the result in draft mode.
- The separator used is a tab space.
- Charts/images are not exported
- Size limit for text file is defined in the CMC (export limit) – default value is 5 Mb – error message displays if the size limit is exceeded.
- If several reports are selected, they are appended one after another in the same text file.

1. Click the arrow next to Save on the toolbar in the File tab and select Save As to display the "Save As" dialog box.
2. Select My Computer, My Desktop, or My Documents on the left of the dialog box and navigate to the folder where you want to save the document.
3. In the Files of Type field, select TXT File.
4. Select the reports to save from the list, or select Select All to export all reports.
5. Click Save.

5.11.5 To save document data as CSV (with the Java interface or Rich Client)

You are using the Java interface in Design or Data mode to perform this action. Saving to CSV only saves the raw data from the cube.

1. In Design or Data mode, select the query whose data you want to save as CSV and select Data Access > Tools > Export Data.
2. Click on the file name.
3. Choose the text qualifier, column delimiter and character set in the dialog box.
4. Select Set as default values if you want the options you chose in the previous step to be the default options when you save to CSV.
5. Click Save.

5.12 Saving documents using the HTML interface
5.12.1 To save a document in the corporate repository (with the HTML interface)

You are using the HTML interface to perform this action.

1. Click the arrow next to the Save icon and select Save As to display the "Save As" dialog box.
2. Select the folder where you want to save the document.
3. In the File Name box, type the name of the document.
4. Click the expand button to display additional document options.
   The additional options are always displayed in the desktop interface.
5. Type a description of the document in the Description box.
6. Type keywords that you or other users can use to search for the document in the future in the Keywords box.
7. Select the categories you want to associate with the document in the Assign Category box.
8. Select Refresh on open to refresh the document each time it is opened.
9. Select Permanent regional formatting to preserve the document regional formatting with the document.
10. Click OK.
    The document is saved in the corporate repository.

5.12.2 To save a document or report as an Excel spreadsheet (with the HTML interface)

You are using the HTML interface to perform this action. To save the document or report locally, use Export As. You can set formatting preferences when saving as Excel. This is done separately, see the related links below.

**Note:**
The table cell formatting Read content as HTML is not supported when exporting a document or report as pdf. Any table cells with this setting will appear blank in the generated pdf. To obtain the content in pdf, unselect this property. Right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the "Read contents as" to some other value than HTML. The setting is applied to the entire column.

   - Each Excel 2007 worksheet can contain up to 1 million rows of exported data. If you save to Excel rather than Excel 2007, each 65,000 rows of exported data start on a new worksheet.
   - Each report within the document is saved as separate worksheet within the Excel file if you chose to save the entire document to Excel.
2. Click **Save** on the "File Download" dialog box that appears and navigate to the folder where you want to save the file.

   All charts are automatically converted to images in Excel. You can use the exported data to create your own chart using the functionality of Excel.

3. Close the file download box.

**Related Topics**
- About saving documents to MS Excel
- To set preferences for saving documents as Excel

### 5.12.3 To save a document or report as PDF (with the HTML interface)

You are using the HTML interface to perform this action. You save the current document or the current active report.

**Note:**
The table cell formatting Read content as HTML is not supported when exporting a document or report as pdf. Any table cells with this setting will appear blank in the generated pdf. To obtain the content in pdf, unselect this property. Right-click in the table cell, select Format Cell, and in the Display section of the General tab, change the "Read contents as" to some other value than HTML. The setting is applied to the entire column.

1. Click the arrow next to **Export** on the toolbar in the **File** tab and select **Export Document As/Export Current Report As > PDF**.
2. Click **Save** on the "File Download" dialog box that appears and navigate to the folder where you want to save the file.

### 5.12.4 To save a document or report as Text (with the HTML interface)

You are using the HTML interface to perform this action. You can save the current document or the current active report.
Report elements are exported in the following order.

1. Based on report element (upper left corner) position.
2. Left to right, then top to bottom.
3. In page mode, report elements are exported page by page.
4. If the report element upper left corner is in page n, then all the report element data is exported with this page.
5. The exported file in page mode can be different from the result in draft mode.

- The separator used is a tab space.
- Charts/images are not exported
- Size limit for text file is defined in the CMC (export limit) – default value is 5 Mb – error message displays if the size limit is exceeded.
- If several reports are selected, they are appended one after another in the same text file.

1. Click the arrow next to **Export** on the toolbar in the **File** tab and select **Export Document As/Export Current Report As > Text**.
2. Click **Save** on the "File Download" dialog box that appears and navigate to the folder where you want to save the file.
3. Close the file download box.

### 5.12.5 To save document data as CSV (with the HTML interface)

You are using the HTML interface to perform this action. Saving to CSV only saves the raw data from the cube.

1. Click the arrow next to **Export** on the toolbar in the **File** tab and select **Export data to CSV**.
2. Choose the text qualifier, column delimiter and character set in the dialog box.
3. Select **Set as default values** if you want the options you chose in the previous step to be the default options when you save to CSV.
4. Click **OK**, then click **Save** on the "File Download" dialog box that appears and navigate to the folder where you want to save the file.

### 5.13 Automatic saving and recovery
5.13.1 Saving documents automatically

If autosave is active, and if you have the appropriate security rights, your documents are saved automatically in the My Favorites/ folder as you work. Autosaved document names consist of the document name prefixed by the document ID and followed by the autosaved document ID. If the document ID is -1, the document was not saved before being autosaved.

Note:
Web Intelligence Rich Client does not save documents automatically.

The interval at which documents are autosaved is defined in the CMC. This interval is reset each time you save a document manually, and each time a document is saved automatically. The autosaved document is also deleted when you save a document manually.

In addition to regular autosaving, documents are saved when your session times out.

Note:
If you lose a document before you can save it, check the folder immediately for the autosaved version. The My Favorites/ folder is not a permanent storage location for autosaved documents.

For more information on the settings and security rights that impact automatic saving, see the documentation for the Central Management Console.

Related Topics
  • Management of autosaved documents
  • Recovering autosaved documents

5.13.2 Recovering autosaved documents

If your session times out while you are working on a document, your document is saved in the My Favorites/ folder and displays a dialog box explaining that the session has ended.

You can select Restore on the dialog box, to launch a new session and re-open the autosaved document. The next time you save the document manually, it is saved in its original folder.

If you select Close, you are redirected to the home page of the BI launch pad. The autosaved document is available in the My Favorites/ folder.

It is not always possible to link to the autosaved document after a server timeout or connection loss. In this you do not have the option to restore the autosaved document. You must check the My Favorites/ folder immediately for your autosaved document. Documents are regularly deleted from this folder based on the autosave settings.
5.13.3 Management of autosaved documents

Documents are autosaved in the My Favorites/ folder.

As a general rule, autosaving is transparent and you do not access autosaved documents directly. You need to access them directly when your session times out and it was not possible to retrieve your autosaved document manually.

**Note:**
If you need to access an autosaved document directly, check the My Favorites/ folder immediately. This folder is not a permanent storage location for autosaved documents.

The My Favorites/ folder has a maximum size limit, which is set in the CMC. When the total size of the documents in the folder exceeds this limit, the application deletes as many of the oldest documents in the folder as necessary to make way for the latest document.

All documents are also deleted from the folder at a defined interval, which is set in the CMC.

If you navigate away from your document in your browser without saving the document, the document is lost and the contents of the My Favorites/ folder are cleared.

5.14 Setting document properties

The following table lists the document properties that you can view and/or set in the “Document Summary” pane:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The name of the document in the BI launch pad. This is displayed above the general properties and cannot be edited.</td>
</tr>
</tbody>
</table>

Related Topics

- Saving documents automatically
- Management of autosaved documents

Related Topics

- Saving documents automatically
- Recovering autosaved documents
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of document.</td>
</tr>
<tr>
<td>Author</td>
<td>The creator of the document.</td>
</tr>
<tr>
<td>Creation date</td>
<td>The date the document was created.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional information that describes the document.</td>
</tr>
<tr>
<td>Keywords</td>
<td>Optional keywords that can be used to search for the document in the BI launch pad.</td>
</tr>
<tr>
<td>Enhanced viewing</td>
<td>When this option is checked, the appearance of reports is optimized for onscreen viewing.</td>
</tr>
</tbody>
</table>
| Refresh on Open               | Automatically refreshes the results in reports with the latest data from the database each time the document is opened.  
Default setting =  
When Refresh on open is selected, data tracking does not display the difference between the data prior to the refresh and the data after the refresh.  
Data after the refresh is treated as new data because the refresh purges the document. |
| Permanent regional formatting | Formats the document according to the format locale with which it was saved.                                                                                                                                 |
| Use query drill               | Drills in query drill mode.                                                                                                                                 |
| Hide warning icons in chart   | Hides warning icons in order to enhance readability.                                                                                                                                 |
| Enable query stripping        | Generates queries that only use objects that contribute to the reports in which they are used.  
Each time a query is refreshed, non-contributing objects are ignored. Only relevant data is retrieved from the data provider.  
This feature enhances performance.                                                                                                                                 |
| Auto-merge dimensions         | Automatically merges dimensions with the same name and from the same universe.  
You see the merged dimension in the list of available objects with the dimensions merged within it below.  
Merged dimensions are the mechanism for synchronizing data from different data providers. |
### 5.14.1 To display and set document properties

You have a document opened with the interface in **Design** mode.

1. Click **Document** on the **Properties** tab to display the "Document Summary" dialog box.
2. View or edit the properties in the dialog box as described above.
3. Click **OK** when you have finished.
Returning data using queries

6.1 Queries defined

6.1.1 Queries defined

When you create a document or add new data to a document, you use queries to retrieve data from a data source to the document. You build queries using a "Query Panel", and the type of query panel depends on the data source of the query.

Depending on the interface, on the interface you are using, you can create queries based on universes, which represent data in relational or OLAP databases as objects, on local data sources such as text files or Microsoft Excel files, on SAP Info Cubes in a SAP BW Business Warehouse by using BEx queries, on Pioneer data sources or on web services. You run the query to return data in a report which you can then analyze further by, for example, filtering or ranking its data.

Measures are common to all queries. Measures return data, often numeric, that is calculated based on the other objects in the query (dimensions or hierarchies).

Queries based on universes can be hierarchical or non-hierarchical. Non-hierarchical queries organize data in dimensions which have no hierarchical relationship. For example, a query containing a customer dimension and a revenue measure calculates revenue per customer.

Hierarchies organize data into hierarchical relationships. For example, a geographical hierarchy can contain data about countries, states and cities (different levels of the hierarchy). A query containing a geographical hierarchy and a revenue measure calculates revenue at the different levels of the hierarchy (country, state, city).

Whether a universe query is hierarchical or non-hierarchical depends on the database from which the universe retrieves its data.

**Note:**
You cannot build queries using the Web interface (the DHTML interface): the "Query Panel" is not available.
6.1.2 About query and document user rights

Whether you can view, create, modify, or delete queries and their related objects depends on your user rights. Whether you can view, create, modify, or delete documents and reports also depends on your user rights. Also, you will not be able to view certain elements of reports if you do not have the appropriate rights. These rights are defined by administrators. Administrators can view and edit queries even when the access rights have been limited to a restricted sub-set of users.

6.1.3 Classes and subclasses

Objects are grouped into folders called classes. Each class can also contain one or more subclasses. Subclasses contain objects that are a further subcategory of the objects in the upper level of the class.

The role of classes is to organize the objects into logical groups. When you create queries on the universe, classes help you to find the objects that represent the information that you want to use in a query.

6.1.4 Analysis dimension

An analysis dimension contains a collection of related hierarchies. Analysis dimensions do not appear as result objects in queries. If you select an analysis dimension, its default hierarchy appears in the query.

Analysis dimensions appear as follows:

6.1.5 Dimension

A dimension represents non-hierarchical data that can provide the basis for analysis in a report. Dimensions typically retrieve character-type data, for example: customer names, resort names, or dates. A query containing the [Customer] dimension and the [Revenue] measure, for example, returns the revenue generated by each customer.

Dimensions produce non-hierarchical columns in the result set generated by the query.
In hierarchical data sources, hierarchies are based on dimensions. Hierarchies appear beneath the dimensions on which they are based in the list of available objects. You can include the dimension in the query to return non-hierarchical data, or one or more of its associated hierarchies to return hierarchical data.

6.1.6 Attribute

An attribute provides descriptive data about a dimension or hierarchy. For example, Age can be an attribute of the Customer dimension.

Attributes must have a one-to-one relationship with their associated dimension. Each value of a dimension object can have only one associated value of any attribute. In the above example, each Customer value can have only one associated value in the Age detail object.

If, due to incorrect universe design, a detail object tries to return multiple values for one dimension value, its cell displays the #MULTIVALUE error message.

Attributes appear as follows:

**Note:**
For .unv universes (created with the universe design tool), attributes are referred to as details, and apply to relational data sources.

6.1.7 Hierarchy

A hierarchy is a set of data members arranged in levels or parent-child relationships. For example, a [Geography] hierarchy might contain the [Country], [State] and [City] levels.

Hierarchies produce hierarchical columns in the result set produced by the query. You can expand the items in the hierarchy to explore its data. For example, you can expand the [California] level in a [Geography] hierarchy to explore data related to California.

You can select which members appear in the result set by using the Member Selector.

In hierarchical data sources, hierarchies are associated with a dimension and appear beneath the dimension with which they are associated in the list of available objects.

6.1.8 Level object
A level is a set of members in a hierarchy at the same distance from the root of the hierarchy. For example, [City] might be a level in a [Geography] hierarchy which contains members such as [Los Angeles] and [San Francisco].

Levels produce flat columns in the result set generated by the query. For example, a query containing the [Country] level and [Revenue] objects produces a result such as the following:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>Revenue</td>
</tr>
<tr>
<td>US</td>
<td>10,123,121</td>
</tr>
<tr>
<td>France</td>
<td>8,232,231</td>
</tr>
<tr>
<td>Germany</td>
<td>7,342,342</td>
</tr>
<tr>
<td>UK</td>
<td>9,343,092</td>
</tr>
</tbody>
</table>

Not all hierarchies contain levels. Levels are not available in hierarchies in BEx queries.

Levels appear as follows:

**Related Topics**
- BEx queries defined

### 6.1.9 Member

A member is an individual data item in a hierarchy. For example, the [Geography] hierarchy can contain members such as [France] at the [Country] level, or [Las Vegas] (at the [City] level).

You select individual members from a hierarchy for inclusion in the query result if you do not want to include all members in the hierarchy. You can also define a named set containing a set of members.

### 6.1.10 Named set

A named set is a named expression that returns a set of members. Named sets can be defined in OLAP databases, or in universes based on relational or OLAP databases.
6.1.11 Calculated member

Calculated members are members returned by an MDX expression. MDX is the language used to access hierarchical data in OLAP databases.

The administrator of an OLAP database can create calculated members that are available to MDX queries that access the database.

Calculated members appear as follows:

6.1.12 Measure

Measures retrieve data, usually numeric, that is the result of calculations on data in the database. For example, Revenue is the calculation of the number of items sold multiplied by item price. Measures are often located in a Measures class.

By default, measures are calculated by aggregating detailed values returned from the database. Smart measures are a special kind of measure that are calculated by the database itself and returned by the query already aggregated.

In certain situations, smart measures impact the way in which calculations are displayed. For more information on smart measures, see the Using functions, formulas and calculations in Web Intelligence guide.

Measures return results based on the objects with which they are associated in a query. For example, a query containing the [Customer] dimension and [Revenue] measure returns revenue by customer. A query containing the [Geography] hierarchy and [Revenue] measure returns revenue calculated for all the different aggregations possible in the hierarchy.

Measure objects appear as follows:

6.2 Building and working with queries
6.2.1 Hierarchical and non-hierarchical queries

6.2.1.1 Non-hierarchical queries defined

Non-hierarchical queries are universe-based queries that do not include objects that organize data hierarchically. You build a non-hierarchical query using dimensions, attributes and measures. Dimensions represent business objects such as customers or cities. Measures derive results, usually numerical, from the dimensions you include in the query. For example, a query containing the [Customer] dimension and the [Revenue] measure returns revenue by customer.

Non-hierarchical queries produce result sets in which dimensions are not related. Each object in the query produces one flat column in the result set.

Non-hierarchical queries do not include the following objects: hierarchies, levels, members or named sets.

Related Topics
- To build a query on a universe

6.2.1.2 Hierarchical queries defined

A hierarchical query contains at least one hierarchy object. You have the option to build hierarchical queries on universes that support hierarchical data, or on BEx queries which access SAP Info Queries directly. Hierarchical data can come from relational or OLAP databases, depending on how the universe structures the data.

Note:
For a relational Data Source, it is not a true hierarchy but a navigational path.

You can include hierarchies either as result or filter objects. When you build a hierarchical query, the query panel provides you with additional features for working with hierarchical data. For example, if you include a hierarchy as a result object, you have the ability to choose members from the hierarchy to appear in the result. These hierarchical features are not available when you build a query on non-hierarchical data. The exact features available in the hierarchical query panel also depend on the source of the hierarchical data you are accessing.
The result set generated by a hierarchical query allows you to perform hierarchical data analysis. Each hierarchy object in the query produces a hierarchical column in the report. You can expand members to reveal their child members; for example, you can expand the [US] member to reveal US states in a [Geography] hierarchy.

Measures in the block are aggregated depending on the member with which they are associated. For example, a hierarchical query containing the [Customers] hierarchy and the [Unit Sales] and [Store Cost] measures gives the following result set:

<table>
<thead>
<tr>
<th>Customers</th>
<th>Unit Sales</th>
<th>Store Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>364,707</td>
<td>371,579</td>
</tr>
<tr>
<td>US</td>
<td>276,773</td>
<td>234,555</td>
</tr>
<tr>
<td>CA</td>
<td>45,506</td>
<td>67,999</td>
</tr>
<tr>
<td>OR</td>
<td>32,104</td>
<td>56,700</td>
</tr>
<tr>
<td>Albany</td>
<td>10,324</td>
<td>12,325</td>
</tr>
</tbody>
</table>

Related Topics

- Hierarchical member selection in BEx queries
- Using contexts in BEx queries

6.2.1.2.1 Including multiple hierarchies in a query

When you combine multiple hierarchies in a query, the query returns results for all the combinations of members in the different hierarchies.

Example: **Including two hierarchies in a query**

You have two hierarchies, [Gender] (containing the members [All], [Male] and [Female]) and [Customer Geography]. Combined in a query with a measure, the two hierarchies give the following result:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>All Gender</td>
<td>$29,358,677</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>$10,000,000</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>$19,358,677</td>
</tr>
<tr>
<td>France</td>
<td>All Gender</td>
<td>$2,644,017</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>$1,058,677</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>$1,285,340</td>
</tr>
</tbody>
</table>
6.2.2 Building queries on universes

6.2.2.1 Universes defined

Universes present data from relational or OLAP data sources as collections of related objects. Universes contain two types of data:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relational</td>
<td>Relational data organizes data as a collection of related objects (dimensions, details and measures). You combine universe objects in a query which you run to generate a report. For example, a query containing the Customer dimension and the Revenue measure generates a report showing revenue generated by customer.</td>
</tr>
<tr>
<td>Hierarchical</td>
<td>Hierarchical data organizes data hierarchically as members in related hierarchies. For example, a Geography hierarchy can contain levels showing countries, states and cities. A query built on the Geography hierarchy and Revenue measure generates a report showing revenue generated at different levels of the hierarchy (revenue by country, by state and by city). The query automatically calculates the revenue values at different levels of the hierarchy.</td>
</tr>
</tbody>
</table>

The features available in the query panel you use to build a query on a universe are determined by the data in the universe. For example, the hierarchical query panel allows you to select data members from a hierarchy.
6.2.2.2 To select a default universe

You can select a default universe for universe-based queries. When the user creates a new document, the Select a universe dialog will show the default universe as selected.

1. In the BI launch pad, click Preferences.
2. Click Preferences in the left pane of the dialog box to display the list of preferences, then select Web Intelligence from the list.
3. Click Browse beneath Select a default universe and browse to the universe you want to select as the default.
4. Select a universe and click OK at the bottom of the pane.
5. Click Save and Close.
6. You must Log Off and then Log On for the change to take effect.

When you create a new document based on a universe, when you choose the data source, the new default data source is selected. You can select a different data source if required.

6.2.2.3 To build a query on a universe

1. Click Data.
   The Data Manager displays all the queries available in the document.
2. Select Data Providers > New > From Universe
3. Select the universe on which you want to create a document (then click Select if you are using the Web Intelligence Rich Client).
   The query panel opens.
4. Select the objects you want to include in the query and drag them to the Result Objects pane. To add all the objects in the class, drag the class to the Result Objects pane.
5. Repeat the previous step until the query contains all the objects you want to include.
6. Click Sort on the Result Objects toolbar and use the "Sort" dialog box to sort the query result.
7. Select the objects on which you want to define query filters and drag them to the Query Filters pane. To create a quick filter on an object, select the object in the Result Objects pane then click Add Quick Filter at the top right of the pane.
8. Set the scope of analysis and other query properties.
9. To remove an object from the Result Objects or Query Filters panes, click Remove at the top right corner of the pane.
10. To remove all objects from the Result Objects or Query Filters panes, click Remove All at the top right corner of the pane.
11. Click Run Query to run the query.

**Note:**

If a document is created with two data providers (Queries) based on same source (universe), when you change the source of one of the queries, the source of the other data provider is not changed.

**Related Topics**

- To preview query results
- Non-hierarchical queries defined
- To sort query results

---

**6.2.2.4 Selecting members of a hierarchy**

When you use a hierarchy in a query, you use the Member Selector to select members of the hierarchy to appear in the report generated from the query result set. After you have selected members, they appear below the hierarchy object in the query panel.

You can select members explicitly, or implicitly through functions. For example, you can explicitly select the [California] and [Los Angeles] members of the [Geography] hierarchy. You can select the child members of the [US] member (to give US states). You can also select the members included in a named set, for example Top Cities by Revenue, to include the cities that generate the most revenue.

**Related Topics**

- Overview of the Member Selector
- Member selection and hierarchical filtering compared

---

**6.2.2.4.1 Member selection and hierarchical filtering compared**

When you filter members in a query filter, you also impact measure aggregation. This is different from member selection in the Member Selector, which does not impact measures.

**Example: Member selection and hierarchical filtering**

In this example you have the following data:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
</tbody>
</table>
### Internet Sales Amount

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Brandenburg</td>
<td>$119,871.08</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

If you select only the France-related members in the Member Selector, the measure value for All Customers is not impacted:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>

If you filter the Germany and its child members using a query filter, the All Customers measure is affected because the German figures no longer appear in the aggregation:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$26,464,364.08</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>

### Related Topics
- Selecting members of a hierarchy

### 6.2.2.4.2 Overview of the Member Selector

You use the Member Selector to visualize and select members in a hierarchy. You can work with members explicitly, or with sets of members given, for example, by functions, named sets or hierarchy levels.
You can also use the Member Selector to define prompts, which allow users to select which members they wish to include in a hierarchy when they run the query.

You launch the Member Selector from hierarchy objects that you include in queries in the query panel.

The following table describes the tabs available in the Member Selector.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Members</td>
<td>The Members tab displays the members arranged hierarchically. Calculated members appear at the position in the hierarchy defined by the administrator.</td>
</tr>
<tr>
<td>Metadata</td>
<td>The Metadata tab shows the hierarchy levels (if the hierarchy supports levels), named sets and calculated members.</td>
</tr>
<tr>
<td>Prompts</td>
<td>The Prompts allows you to defer member selection until the query is run by displaying a prompt that allows the users to select members.</td>
</tr>
</tbody>
</table>

**Note:**
The "Query Panel" displays the technical name and the Business Name of objects or hierarchy objects. The Technical Name is the name that identifies the object in addition to its Business Name. Technical Names are not localized whereas Business Names are localized. For example, a Business name would be 'Customer', and the Technical Name could be Z_CUSTOMER.

**Related Topics**
- Selecting members of a hierarchy

6.2.2.4.3 To select hierarchy members

You have launched the query panel and there is at least one hierarchy object available for inclusion in the query.

1. Add the hierarchy object to the Result Objects pane in the query panel.
2. Click the arrow to the right of the hierarchy object to launch the Member Selector.
3. Use the Member Selector to select members for inclusion in the query.
4. Close the Member Selector.
   The selected members appear below the hierarchy object in the Result Objects pane. When you run the query, only those members are included in the query result.

**Note:**
If you do not select members, the default member for the hierarchy (defined in the database) is used in the query result. If no default member is defined, the top-level member is used.
6.2.2.4.4 Showing the selected hierarchy members

The Query Panel indicates which members are selected.

6.2.2.4.5 To select hierarchy members explicitly

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

1. Click Members to display the hierarchy members.
2. Select the members by clicking the check-box next to the member in the hierarchy display.
   The members appear in the list of selected members in the Member Selector.
3. To select all members in the hierarchy, click All Members at the top of the hierarchy.
   This option is useful when you want to include all members even if the hierarchy structure changes in the future.
4. Close the Member Selector
   The members you selected appear below the hierarchy object in the query panel.

Related Topics
• To select hierarchy members

Hierarchical member selection in BEx queries

Use the “Query Panel” “Member Selector” to select members of a hierarchy for your query. The following hierarchy illustrates member selection behavior in BEx queries.

<table>
<thead>
<tr>
<th>World</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EMEA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Europe</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Middle East</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Africa</td>
<td></td>
</tr>
<tr>
<td>North America</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asia PAC</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pacific</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Australia</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Philippines</td>
<td></td>
</tr>
<tr>
<td>Rule</td>
<td>Example</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>When you select a member of a hierarchy at a given level.</td>
<td>All of the parent members in the hierarchy are selected. The root is always selected. It is not possible to select one specific level.</td>
<td></td>
</tr>
</tbody>
</table>
| If you deselect a member when its parent member is already selected, all child members of the parent are also deselected. | If Pacific and all its child members are already selected and you deselect Australia, Philippines and New Zealand are also deselected. The following member selections appear:  
  - Europe  
  - Pacific |
| If you select a member when some of its child members are already selected, all child members are selected. | If Europe is selected and you select EMEA, Middle East and Africa are also selected. The following member selections appear:  
  - EMEA  
  - Children of EMEA |
| If you select a member when descendant members are already selected, all children of the member, and all siblings of the selected descendant members are also selected. | If you select Asia PAC when Australia was already selected, Asia, Pacific (children of Asia PAC) and Philippines and New Zealand (siblings of Australia) are also selected. The following member selections appear:  
  - Asia PAC  
  - Children of Asia PAC  
  - Pacific  
  - Children of Pacific |
<table>
<thead>
<tr>
<th>Rule</th>
<th>Example</th>
</tr>
</thead>
</table>
| If you select a member when descendant members are already selected, all children of the member, and all siblings of the selected descendant members are also selected. | If you select Asia PAC when Australia was already selected, Asia, Pacific (children of Asia PAC) and Philippines and New Zealand (siblings of Australia) are also selected. The following member selections appear:  
  - Asia PAC  
  - Children of Asia PAC  
  - Pacific  
  - Children of Pacific |

**Related Topics**

- Restrictions when using BEx queries
- About selecting hierarchy members to a specified depth
- Hierarchical member selection in BEx queries
- Using contexts in BEx queries

**About hierarchy node variables in BEx queries**

When a prompt is present on a characteristic of a hierarchy node in a BEx query, this is referred to as a hierarchy node variable. When this occurs, the member selection function is disabled for that hierarchy. The prompt related to the hierarchy node variable displays at run time.

**6.2.2.4.6 To select hierarchy members using functions**

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

1. Click **Members** to display the hierarchy members.
2. Right-click the member to which you want to apply a function.
   
   The menu displays the following options:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Children</strong></td>
<td>Adds all child members of the member to the list of selected members. All members immediately below the selected member are its children. The members appear as <strong>Children of [selected member]</strong> in the list. <strong>Note:</strong> You cannot include children and descendants of the same member. If you had already selected <strong>Descendants</strong> before selecting <strong>Children</strong>, the descendants are removed from the list and replaced by children.</td>
</tr>
<tr>
<td><strong>Descendants</strong></td>
<td>Adds all descendant members of the member to the list of selected members. All members below the selected member in the hierarchy are its descendants. The members appear as <strong>Descendants of [selected member]</strong> in the list. <strong>Note:</strong> You cannot include children and descendants of the same member. If you had already selected <strong>Children</strong> before selecting <strong>Descendants</strong>, the children are removed from the list and replaced by descendants</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent</td>
<td>Adds the parent member of the member to the list of selected members</td>
</tr>
<tr>
<td></td>
<td>The member immediately above the selected member is its parent.</td>
</tr>
<tr>
<td></td>
<td>The member appears as Parent of [selected member] in the list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot include the parent and ancestors of the same member.</td>
</tr>
<tr>
<td></td>
<td>If you had already selected Ancestors before selecting Parent, the ancestors</td>
</tr>
<tr>
<td></td>
<td>are removed from the list and replaced by the parent.</td>
</tr>
<tr>
<td></td>
<td>The Parent function is not available in BEx queries.</td>
</tr>
<tr>
<td>Ancestors</td>
<td>Adds the ancestor members of the member to the list of selected members</td>
</tr>
<tr>
<td></td>
<td>All members above the selected member in the hierarchy are its ancestors.</td>
</tr>
<tr>
<td></td>
<td>The members appear as Ancestors of [selected member] in the list.</td>
</tr>
<tr>
<td></td>
<td>You cannot include the ancestors and parent of the same member in the list.</td>
</tr>
<tr>
<td></td>
<td>If you had already selected Parent before selecting Ancestors, the parent</td>
</tr>
<tr>
<td></td>
<td>is removed from the list and replaced by the ancestors.</td>
</tr>
<tr>
<td></td>
<td>The Ancestors function is not available in BEx queries.</td>
</tr>
<tr>
<td>Siblings</td>
<td>Adds the selected member and its sibling members to the list of selected members</td>
</tr>
<tr>
<td></td>
<td>All members at the same level as the selected member and that share the same parent are its siblings. The members appear as Siblings of [selected member] in the list.</td>
</tr>
<tr>
<td></td>
<td>The Siblings function is not available in BEx queries.</td>
</tr>
</tbody>
</table>
3. Close the Member Selector.
   The selected members appear below the hierarchy object in the Result Objects pane. When you run the query, only those members are included in the query result.

Related Topics
• To select hierarchy members

6.2.2.4.7 About level-based member selection
   You can select members by level in the Metadata pane of the Query Panel. You can select members based on level and depth in the hierarchy.

6.2.2.4.8 About selecting hierarchy members to a specified depth
   In the "Query Panel", you can select all members of a hierarchy to a specified depth. All members of the selected hierarchy until the specified depth are displayed in the report.

6.2.2.4.9 When a hierarchy variable is defined on a characteristic
   When a hierarchy variable is defined on a characteristic, only one default hierarchy is displayed in the Query Panel's universe outline.

6.2.2.4.10 To select hierarchy members from a level
   You have launched the query panel, selected a hierarchy object that supports levels and launched the Member Selector.

   You can select all the members at a level in the hierarchy if the hierarchy is organized into levels.

   **Note:**
   Not all hierarchies are organized into levels.
   1. Click Metadata to display the hierarchy levels.
   2. Select the levels whose members you want to include.
      The members appear as All members of the [selected level] level in the list.
   3. Close the Member Selector.
      The selected members appear below the hierarchy object in the Result Objects pane. When you run the query, only those members are included in the query result.

Related Topics
• To select hierarchy members
6.2.2.4.11 To select calculated members

You have launched the query panel, selected a hierarchy object, launched the Member Selector, and the database on which your universe is based supports calculated members.

1. Click **Metadata** and select the calculated member, or click **Members** and select the calculated member from the hierarchy.
   - The position of the calculated member in the hierarchy is determined by the administrator.
   - You cannot apply functions (for example **Children** or **Parent**) to a calculated member.

2. Select the calculated member from the list of calculated members.

3. Close the Member Selector.

The selected members appear below the hierarchy object in the **Result Objects** pane. When you run the query, only those members are included in the query result.

**Related Topics**
- To select hierarchy members
- Calculated member

6.2.2.4.12 To select named sets

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

1. Click **Metadata**.

2. Select the named set from within the **Named Sets** folder.

3. Close the Member Selector.

The selected members appear below the hierarchy object in the **Result Objects** pane. When you run the query, only those members are included in the query result.

**Note:**
You can also include a named set by selecting it in from the list of available query objects. Named sets appear beneath the analysis dimension containing the hierarchy with which they are associated. When you select a named set, its parent hierarchy is included as a result object and the named set appears as a member selection beneath the hierarchy object.

6.2.2.4.13 To exclude hierarchy members

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

1. Select the members or member sets that you want to exclude.

2. Click **Exclude** next to the selected members.

3. Close the Member Selector.

The excluded members appear below the hierarchy object in the **Result Objects** pane. When you run the query, these members are excluded from the hierarchy.

**Note:**
You cannot exclude members in BEx queries.
6.2.2.4.14 To search for members

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

You can search a hierarchy for specific members using the Member Selector.

**Note:**
The search is always performed on the entire hierarchy stored in the database, rather than only on the members already retrieved by the Member Selector.

1. Click Members.
2. Click the search button at the bottom right of the member display to launch the "Search" dialog box.
3. Type your search text in the "Search pattern" box.
   You can use wildcards in the search.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Replaces any string of characters</td>
</tr>
<tr>
<td>?</td>
<td>Replaces any individual character</td>
</tr>
</tbody>
</table>

4. Click **Search in Text** to search the display text of the members, or **Search in Key** to search their database keys.

6.2.2.4.15 To build prompts for selecting members

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

You can defer member selection until the query is run. When you do so, the user is prompted to select members when they run the query.

**Note:**
- Selection in member prompts is restricted to explicit selection of members. The user cannot select members using functions such as Ancestors or Parent.
- The rules about selecting members using functions apply here. Refer to the link at the bottom of this topic.

1. Click **Prompts**.
2. Click **Enable Parameter** to enable member selection when the query is run.
   You cannot access the other tabs in the Member Selector when this option is selected.
3. Type the prompt text in the **Prompt Text** box.
4. Click **Keep last values selected** if you want the prompt to select the previously-chosen values by default when it is displayed.
5. Click **Set default values**, click **Edit** and select the default values if you want the prompt to select default values when it is displayed.
6. Close the **Member Selector**
   The prompt text appears beneath the hierarchy in the query panel.
6.2.2.5 Resolving ambiguous queries

6.2.2.5.1 Ambiguous queries defined

An ambiguous query is a query that contains one or more objects that can potentially return two different types of information.

In a universe, certain dimensions may have values that are used for two different purposes in the database. For example, the [Country] dimension in the query below can return two types of information:

- Customers and the country in which they spent their vacation.
- Customers and the country for which they have made their reservation.

The role that Country plays in this query is ambiguous. A country can be either the country where a vacation was sold, or a country where a vacation is reserved. One is existing information (sales), and the other is future information (reservations).

To avoid ambiguities in a query, the universe designer identifies the different ways that objects can be used in the universe, and implements restrictions on how these objects can be combined. These restrictions are called contexts.

6.2.2.5.2 Contexts defined

A context is a defined group of objects that share a common business purpose. This business purpose is usually the type of information that these related objects represent. For example, a sales context is a grouping of all the objects that can be used to create sales queries. A reservations context is a grouping of all the objects that can be used in reservation queries. Contexts are defined in the universe by the universe designer.

You can combine any objects within the same context to create a query. You can also combine objects in different contexts. If you use an object that is common multiple contexts in a query and it is not possible to determine the best context that fits all the other objects in the query, you are prompted to choose the context to apply.

6.2.2.5.3 To choose a context when you run a query

When you create a query or refresh a report, you may be asked to choose a context before the query can run. Contexts are set up in a universe to avoid ambiguous queries.

You need to choose a context each time you run the query if the Reset contexts on refresh query property is selected. You will also need to choose contexts if you select the Clear contexts option in the query properties.
1. Run the query containing multiple contexts.
   The "Select a Context" dialog box appears.
2. Select the context in the "Select a Context" dialog box.

6.2.2.5.4 To reset contexts when a query is refreshed

   The query panel is open.
   1. Click **Query properties** on the query panel toolbar to display the "Query Properties" dialog box.
   2. Select **Reset contexts on refresh**.

6.2.2.5.5 To clear contexts from a query

   The query panel is open.
   1. Click **Query properties** on the query panel toolbar to display the "Query Properties" dialog box.
   2. Click **Clear contexts**.

### 6.2.2.6 Scope of analysis

The scope of analysis for a query is extra data that you can retrieve from the database to give more details on the results returned by each of the objects in a query. This extra data does not appear in the initial result report, but it remains available in the data cube, so you can pull this data into the report to allow you to access more details at any time. This process of refining the data to lower levels of detail is called drilling down on an object.

**Note:**
This option in the Query Panel is only available for relational universe universes and not for OLAP.

In the universe, the scope of analysis corresponds to the hierarchical levels below the object selected for a query. For example, a scope of analysis of one level down for the object Year, would include the object Quarter, which appears immediately under Year.

You can set this level when you build a query. It allows objects lower down the hierarchy to be included in the query, without them appearing in the **Results Objects** pane. The hierarchies in a universe allow you to choose your scope of analysis, and correspondingly the level of drill available. You can also create a custom scope of analysis by selecting specific dimensions to be included in the scope.

**Note:**
You cannot set the scope of analysis when working in query drill mode because this drill mode modifies the scope dynamically in response to drill actions.
6.2.2.7 Levels of scope of analysis

You can set the following levels for scope of analysis:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Only the objects that appear in the Result Objects pane are included in the query.</td>
</tr>
<tr>
<td>One level down</td>
<td>For each object in the Result Objects pane, one, two, or three objects lower down the hierarchy tree are included in the query. The data from these objects is stored in the cube until you add them to the document.</td>
</tr>
<tr>
<td>Two levels down</td>
<td></td>
</tr>
<tr>
<td>Three levels down</td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>All objects added manually to the Scope of Analysis panel are included in the query.</td>
</tr>
</tbody>
</table>

Including a scope of analysis in a document increases the document size significantly. This is because the data necessary for the scope you specify is saved with the document, even though it is not visible in the reports unless you start drill mode and drill down to the data to display the corresponding values.

In order to minimize the size of documents and optimize performance, include a scope of analysis only in documents where you are certain that users will need to drill.

6.2.2.8 To set the scope of analysis

1. Click the Show/Hide Scope of Analysis Pane button so that it appears pressed in.
   The Scope of Analysis panel appears at the bottom of the Result Objects pane. The default scope of analysis is None. Each dimension in the Result Objects pane appears in the Scope of Analysis pane.
2. Click the down arrow in the Scope of Analysis drop-down list box.
3. Select a level for the scope of analysis.
   The level appears in the list box and the dimensions that are hierarchically below each dimension in the Result Objects pane appear in the Scope of Analysis pane.
4. If you want to add selected dimensions to the scope of analysis or create a custom scope of analysis, select dimensions in the Query Manager and drag them across to the Scope of Analysis panel.
### 6.2.2.9 Viewing the script generated by a query

When you build a query, the query generates SQL or MDX script behind the scenes to run against the database to return the query result. SQL is the query language understood by all relational databases. MDX is the query language understood by OLAP databases.

You can view and edit the SQL generated by the query. You can view MDX queries but you cannot edit them.

**Note:**
You cannot view the script of queries that call database stored procedures.

#### 6.2.2.9.1 To view and edit the generated script

**Note:**
You cannot edit the query SQL when the query contains optional prompts. Edit the query to remove the optional prompts before attempting to edit the SQL.

1. Click **SQL** on the query toolbar to display the “SQL Viewer” dialog box.
   - When SQL is not editable, values supplied in response to prompts appear directly in the query.
   - For example, if "UK" was supplied in response to a prompt on [Country], a line similar to
     \[
     \text{Resort\_country.country In ('UK')}\]
     appears in the query.
   - If no value has yet been supplied for the prompt, the Web Intelligence syntax for prompts (described below) appears in the query.

2. Click **Use custom SQL** to make the generated SQL editable.
   - When you make the SQL editable, the Web Intelligence syntax for prompts appears in the query.
   - For example, a line similar to
     \[
     \text{Resort\_Country.country = @prompt('Enter Country:','A','Resort\Country', Mono,Free,Persistent,,User:0)}\]
     appears in the query.

3. Click **Validate** after editing the script to check that your edits are valid.
4. Click **Copy** to copy the script to the clipboard. This option is not available in the Web interface.
5. Click **Print** to print the script. This option is not available in the Web interface.

### 6.2.2.10 Restricting the amount of data returned by queries
6.2.2.10.1 To restrict the amount of data returned by a query

The query panel is open.

You can restrict the amount of data returned by queries by setting the maximum number of rows a query can return, using a sampled result set, choosing whether to retrieve empty rows, and choosing whether to retrieve duplicate rows.

Table 6-13: How you can restrict the amount of data returned by a query

<table>
<thead>
<tr>
<th>Function</th>
<th>Available in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieving duplicate rows</td>
<td>Relational .unx, OLAP , but not available in BEx queries.</td>
</tr>
<tr>
<td>Returning sample result sets</td>
<td>Available in relational .unx, but not available in OLAP .unx or BEx queries.</td>
</tr>
<tr>
<td>Retrieving/excluding empty rows</td>
<td>Available in OLAP .unx only. Not available in BEx queries.</td>
</tr>
</tbody>
</table>

1. Click **Query properties** on the query panel toolbar to display the "Query Properties" dialog box.
2. To exclude duplicate rows, make sure that **Retrieve duplicate rows** is not selected (this option is not available in BEx queries).
3. To select a maximum numbers of rows for retrieval, select **Max rows retrieved** and set maximum number of rows to be retrieved.
4. To return a sample result set, click **Sample result set**. To use fixed sampling, click **Fixed**. Sampling is not available in BEx queries.
   - The **Fixed** option is visible, but not activated if this option is not supported by your data source.
5. To exclude empty rows from the result, make sure that **Retrieve empty rows** is not selected.

**Related Topics**
- Retrieve empty rows query property
- Retrieve duplicate rows query property
- Sample result set query property
- Max rows retrieved query property

6.2.2.10.2 Max rows retrieved query property

The Max rows retrieved query property determines the maximum number of rows of data that are displayed when a query is run. If you only need a certain amount of data, you can set this value to limit the number of rows of data in your document.

Max rows retrieved is applied at the database level if the database supports it. If not, rows are discarded after retrieval from the database.
Max rows retrieved does not distinguish between levels in hierarchical data. If Max rows retrieved is set to 3, the data in the first table below is truncated as in the second table.

<table>
<thead>
<tr>
<th>Customers</th>
<th>Unit Sales</th>
<th>Store Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>276,773</td>
<td>234,555</td>
</tr>
<tr>
<td>CA</td>
<td>45,506</td>
<td>67,999</td>
</tr>
<tr>
<td>OR</td>
<td>32,104</td>
<td>56,700</td>
</tr>
<tr>
<td>Albany</td>
<td>10,324</td>
<td>12,325</td>
</tr>
</tbody>
</table>

The Sample result set query property also applies a restriction on the number of rows in the query, but at the database level. If you set Max rows retrieved to 2000 and Sample result set to 1000, the query retrieves a maximum of 1000 rows only.

This setting can be overridden by the limits set by your administrator in your security profile. For example, if you set the Max rows retrieved setting to 400 rows, but your security profile limits you to 200 rows, only 200 rows of data will be retrieved when you run the query.

**Related Topics**
- Sample result set query property

### 6.2.2.10.3 Sample result set query property

The **Sample result set** property determines the maximum number of rows that a query returns. This restriction is applied at the database level, in the generated script that is used to return the data.

**Note:**
The sample Result set option in the Query Panel is only available for relational unx universes, and not for OLAP .unx universes or BEx queries.

The **Fixed** option uses fixed sampling. At each data refresh, the query returns the same rows. If you do not set the **Fixed** option, the sampling is random. At each data refresh, the query returns a different set of sampled rows.

**Sample result set** is more efficient than the **Max rows retrieved** property, which discards rows beyond the maximum limit only after retrieving all the rows in the query.
Not all databases support sampling. If it is not supported, the option is deactivated. Similarly, the Fixed option may not be supported by certain databases - in which case the Fixed option is deactivated. Sampling is not available in BEx queries or OLAP .unx universes.

Related Topics
• Max rows retrieved query property
• BEx queries defined

6.2.2.10.4 Retrieve duplicate rows query property
In a database, the same data may be repeated over many rows. You can choose to have these repeated rows returned in a query, or to have only unique rows returned.

This option is not available in BEx queries, or if it is not supported by the underlying database.

Related Topics
• BEx queries defined

6.2.2.10.5 Retrieve empty rows query property
The return non-empty rows only query property returns rows only when they contain data.

This property is available only in universes based on OLAP data sources.

6.2.2.11 To set the maximum amount of time a query can run
The query panel is open.

Note:
This feature is not available for BEx queries.

1. Click Query properties on the query panel toolbar to display the "Query Properties" dialog box.
2. Select Max retrieval time and enter the amount of time in seconds.

6.2.2.12 To allow other users to edit queries
The query panel is open.
By default, queries can be edited only by the user who created them. You can give other users with the necessary rights the ability to edit queries.

1. Click **Query properties** on the query panel toolbar to display the "Query Properties" dialog box.
2. Click **Allow all users to edit queries**.

### 6.2.3 Building queries based on BEx queries

#### 6.2.3.1 About BEx queries

BEx queries (Business Exchange queries) are queries created by SAP BEx Query Designer, based on SAP Info Cubes in a SAP NetWeaver Business Warehouse (SAP NetWeaver BW). BEx queries retrieve the metadata from the data source. You use Web Intelligence to connect to a BEx query by using a BICS (BI Consumer services) connection, and retrieve data via the BEx query for reporting purposes. Web Intelligence automatically maps data from the BEx query to hierarchies, attributes, dimensions and measures as in universe-based hierarchical queries. Direct access on a SAP BEx query (through a BICS connection) does not allow you to rename, modify or add metadata. You do not create a universe for BEx queries. Note the following points about using BEx queries:

- You can only access BEx queries that have the flag "Allow External Access to the Query" is enabled.
- The object mapping is not all equivalent, refer to the equivalents and restrictions pages to ensure that the queries can be used correctly.

**Note:**
You can create, edit and refresh documents and reports based on BEx queries using Web Intelligence"Rich Internet Application" interface (the Java applet), or Web Intelligence Rich Client, but you can only use the Web Intelligence"Web" interface (DHTML mode) to view and refresh documents, not edit them.

#### 6.2.3.1.1 BEx queries defined

BEx queries are queries created from a different tool, they are based on SAP Info Cubes in a SAP BW Business Warehouse. Web Intelligence automatically maps data from the BEx query to hierarchies, attributes, dimensions and measures as in universe-based hierarchical queries. You do not create a universe for BEx queries.

You use Web Intelligence to connect to a BEx query by using a 'BICS' (BI Consumer Services) connection. The resulting micro cube is represented in the Available Objects Pane as a tree of objects, but uses a subset of the features available in universe-based hierarchical queries. For example, the Siblings, Parent and Ancestor member functions are not available in the "Member Selector" in BEx queries. These restrictions are noted in the documentation relating to the features.
**Note:**

Web Intelligence can create a document on a BEx query only when the BEx query connection authentication is pre-defined. Prompted authentication mode is not supported on the BEx query at document creation.

**Related Topics**
- [To create a new query based on a BEx query](#)

### 6.2.3.1.2 Supported BEx query metadata

The following NetWeaver BW metadata features are supported:

<table>
<thead>
<tr>
<th>Metadata in BEx query</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics (including Time and Unit)</td>
<td>Yes</td>
</tr>
<tr>
<td>Hierarchies</td>
<td>Yes</td>
</tr>
<tr>
<td>Basic Key Figures</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigational Attributes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display Attributes</td>
<td>Yes</td>
</tr>
<tr>
<td>Calculated Key Figures/Formulas</td>
<td>Yes</td>
</tr>
<tr>
<td>Restricted Key Figures</td>
<td>Yes</td>
</tr>
<tr>
<td>Custom Structures</td>
<td>Yes</td>
</tr>
<tr>
<td>Variables</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The metadata types are mapped to Universe objects that can be used to build your queries and run reports. The datamapping is as follows:

**Table 6-16: How BEx query metadata is mapped**

<table>
<thead>
<tr>
<th>This BEx query metadata</th>
<th>is mapped to this Web Intelligence 4.x object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristic</td>
<td>Dimension</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Hierarchy</td>
</tr>
<tr>
<td>Hierarchy level</td>
<td>N/A (levels are displayed in the Member Selector)</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute</td>
</tr>
<tr>
<td>Characteristic properties (Key, Caption, Short description, Medium description, long description)</td>
<td>Attribute</td>
</tr>
</tbody>
</table>
### This BEx query metadata

<table>
<thead>
<tr>
<th>Key figure without unit/currency</th>
<th>is mapped to this Web Intelligence 4.x object</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Measure (numeric)</td>
</tr>
<tr>
<td></td>
<td>Property formatted value (string)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key figure with unit/currency</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Measure (numeric)</td>
</tr>
<tr>
<td></td>
<td>Property unit/currency (string)</td>
</tr>
<tr>
<td></td>
<td>Property formatted value (string)</td>
</tr>
</tbody>
</table>

### 6.2.3.1.3 Restrictions when using BEx queries

**Note:**

The administrator must ensure that the BEx query complies with reporting restrictions described in the table below.

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked nodes</td>
<td>Linked nodes are not displayed.</td>
</tr>
<tr>
<td>Lower level nodes</td>
<td>Lower level nodes are always shown after the main node.</td>
</tr>
<tr>
<td>Decimal number</td>
<td>The BEx query decimal number definition is not consumed in Web Intelligence. Use the formatted value instead if you need to keep the exact decimal setting in your report. You can also apply the decimal setting in the table and chart of your report.</td>
</tr>
<tr>
<td>Variable orders</td>
<td>Variables are displayed with respect to the variable dependency (less dependent first) rather than the order defined in the BEx query.</td>
</tr>
<tr>
<td>Number of objects allowed in a query</td>
<td>Do not use more than 50 objects in a BEx query, otherwise an error occurs.</td>
</tr>
<tr>
<td>Variables dependent on compound characteristics and the parent object</td>
<td>When there are dependencies between variables in compound characteristics and their parent, the dependencies are not guaranteed.</td>
</tr>
<tr>
<td>Row/Column display as hierarchy</td>
<td>It is not possible to show an overall hierarchy out of an axis hierarchy. The characteristics, hierarchies, and key figures that make up the hierarchy are retained.</td>
</tr>
<tr>
<td>Variables on default values</td>
<td>Do not define variables on default values in BEx queries. The variables will be prompted without an effect on the BEx query. Instead, define the default value in the filter.</td>
</tr>
<tr>
<td><strong>BEx query feature</strong></td>
<td><strong>Web Intelligence restriction</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filters as default values</td>
<td>Not supported, these are removed from the BEx query. The filter will be ignored, or, if a variable is used, the variable prompt will display, but the user response is ignored. Move any restriction based on a variable into the filter zone in order for it to be taken into account for reporting.</td>
</tr>
<tr>
<td>Expand to level</td>
<td>By default, hierarchies are not expanded to a given level. Level00 is always the default level. To reproduce this behavior, expand the table and chart in the report, then save the document.</td>
</tr>
<tr>
<td>Query exceptions</td>
<td>These are not taken into account in Web Intelligence. Apply conditional formatting in Web Intelligence instead.</td>
</tr>
<tr>
<td>Complex selection</td>
<td>When a variable is defined to support the complex selection, there is no equivalent. This is limited to range selection.</td>
</tr>
<tr>
<td>Zero suppression</td>
<td>Rows of zero values are not removed from the result table.</td>
</tr>
<tr>
<td>Query default layout</td>
<td>Default positions of characteristics in Rows / Columns are not reproduced.</td>
</tr>
<tr>
<td>Position of lower level nodes</td>
<td>These are always below the upper levels.</td>
</tr>
<tr>
<td>Local calculations (&quot;Rank&quot;, &quot;Minimum&quot;...)</td>
<td>The key figures on which the local calculation are defined are removed from the BEx query. Avoid the use of these, prefer the equivalent calculation function in the report.</td>
</tr>
<tr>
<td>Result rows</td>
<td>It is recommended to rely on Web Intelligence summaries instead.</td>
</tr>
<tr>
<td>Formula with calculation</td>
<td>It is recommended to avoid Formula with calculation depending on the layout (&quot;Percentage share of result&quot;) that are not supported. You can use equivalent calculation function in the Web Intelligence report.</td>
</tr>
<tr>
<td>Hierarchical measure structures</td>
<td>Hierarchical measure structures are displayed as a flat list of measures.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Do not use conditions. When the query is run, the conditions (‘if present in the query) are not applied.</td>
</tr>
</tbody>
</table>
### 6.2.3.2 About accessing BEx queries

In order to access BEx queries, the following conditions must be met:

- You can only access BEx queries that have the flag "Allow External Access to the Query" enabled.
- You must have the appropriate security rights to access and use the BEx queries for reporting.

To define the connection, you can use the CMC to define the connection, or you can use the information design tool to publish the connection to the CMC. The simplest method is to use the CMC.

#### 6.2.3.2.1 To enable access to BEx queries

BEx queries can only be accessed by other tools including Web Intelligence if the BEx Query property "Allow External Access to the Query" is enabled. You must do the following or ask your administrator to perform the task below.

1. In the BEx Query Designer, select the query that you want to access with Web Intelligence.
2. In the Properties pane, select Advanced, and ensure that "Allow External Access to the Query" is selected.
3. Save the query.
4. Repeat the above steps for all BEx queries that you want to make available to Web Intelligence.

Web Intelligence can access these BEx queries.

#### 6.2.3.2.2 To define a BICS connection with the CMC

You can connect to BEx queries via BICS connections that have been created and saved in the CMC. You have the appropriate rights to use the CMC. To connect to a BEx query, you can define a BICS connection in the information design tool. You can define a connection to a single BEx query or to an InfoProvider containing several BEx queries.

1. In the CMC console, Login to the CMC.
2. Choose "OLAP connection".
3. Define a new connection. In the New Connection window, in the Provider dialog, select "SAP NetWeaver Business Warehouse".

<table>
<thead>
<tr>
<th>BEx query feature</th>
<th>Web Intelligence restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measures</td>
<td>Cannot be used in filters.</td>
</tr>
<tr>
<td>A hierarchy</td>
<td>Cannot be used in the result set and in filters at the same time.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Cannot be used in the result set and in filters at the same time.</td>
</tr>
</tbody>
</table>
4. Enter the connection information and your system details.
5. Save the connection

6.2.3.2.3 To define a BICS connection to a BEx query in the information design tool

To connect to a BEx query, you can define a BICS connection in the information design tool. You can define a connection to a single BEx query or to an InfoProvider containing several BEx queries.

1. In the information design tool, use the New OLAP Connection wizard to define an OLAP connection and choose the SAP NetWeaver BW SAP BICS Client middleware driver.
2. Publish the connection to a repository where it can be accessed by Web Intelligence.

Use the New OLAP Connection wizard to define an OLAP connection.

You can now use Web Intelligence to select the connection and connect to the BEx query.

6.2.3.3 Building a Web Intelligence query on a BEx query

The following section describes how to build a Web Intelligence query based on a BEx query data source.

6.2.3.3.1 Hierarchical queries defined

A hierarchical query contains at least one hierarchy object. You have the option to build hierarchical queries on universes that support hierarchical data, or on BEx queries which access SAP Info Queries directly. Hierarchical data can come from relational or OLAP databases, depending on how the universe structures the data.

**Note:**
For a relational Data Source, it is not a true hierarchy but a navigational path.

You can include hierarchies either as result or filter objects. When you build a hierarchical query, the query panel provides you with additional features for working with hierarchical data. For example, if you include a hierarchy as a result object, you have the ability to choose members from the hierarchy to appear in the result. These hierarchical features are not available when you build a query on non-hierarchical data. The exact features available in the hierarchical query panel also depend on the source of the hierarchical data you are accessing.

The result set generated by a hierarchical query allows you to perform hierarchical data analysis. Each hierarchy object in the query produces a hierarchical column in the report. You can expand members to reveal their child members; for example, you can expand the [US] member to reveal US states in a [Geography] hierarchy.

Measures in the block are aggregated depending on the member with which they are associated. For example, a hierarchical query containing the [Customers] hierarchy and the [Unit Sales] and [Store Cost] measures gives the following result set:
<table>
<thead>
<tr>
<th>Customers</th>
<th>Unit Sales</th>
<th>Store Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>364,707</td>
<td>371,579</td>
</tr>
<tr>
<td>US</td>
<td>276,773</td>
<td>234,555</td>
</tr>
<tr>
<td>CA</td>
<td>45,506</td>
<td>67,999</td>
</tr>
<tr>
<td>OR</td>
<td>32,104</td>
<td>56,700</td>
</tr>
<tr>
<td>Albany</td>
<td>10,324</td>
<td>12,325</td>
</tr>
</tbody>
</table>

**Related Topics**
- Hierarchical member selection in BEx queries
- Using contexts in BEx queries

### 6.2.3.3.2 About building a query based on a BEx query

When you have connected to your BEx query, Web Intelligence maps the BEx query metadata to the Web Intelligence query objects. You use the "Query Panel" to select the appropriate objects to build your query. You can add filters and prompts in the same way as you create queries on universes, but there are restrictions in certain situations, refer to the section *Restrictions when using BEx queries*.

**Related Topics**
- Restrictions when using BEx queries
- About selecting hierarchy members to a specified depth
- Hierarchical member selection in BEx queries
- Using contexts in BEx queries

### 6.2.3.3.3 To create a new query based on a BEx query

To access the BEx query, the BEx query must have the flag "Allow External Access to the Query" enabled.

1. In Design mode, click **New > Bex** to display the "Select a BW BEx Query" dialog box.
2. Select the appropriate BICS connection from the pane on the left of the dialog box.
3. Select the BEx query in the right pane and click **OK**. When a BICS connection is based on an InfoCube, there may be several BEx queries available.
   The Query Panel appears, displaying the objects in the query as hierarchies, dimensions and attributes. If you cannot see the BEx query that you want to use, use the BEx Query Designer to ensure that the "Allow External Access to the Query" property is tagged in the query.
4. Build the query and query filters using the available objects.
**Note:**
You cannot filter on result objects in BEx queries.

**Note:**
If the BEx query you connected to is designed to include an SAP server-side variable, you can change the value of the variable in the "Query Panel" - click the **Set Variable** button and in the **Custom Hierarchy Variable** dialog, select a new variable from the available List of Values.

6.2.3.3.4 About the scaling factor in BEx queries

When a BEx query contains measures that are mapped from scaled key figures, the factor of scaling on the measure is displayed in the resulting report. When the scaling factor is changed for the key figure, this change is reflected in the report when the report is refreshed. The scaling factor is displayed for the measure name in the report, and for the measure attribute in the "Query Panel".

6.2.3.3.5 About hierarchy node variables in BEx queries

When a prompt is present on a characteristic of a hierarchy node in a BEx query, this is referred to as a hierarchy node variable. When this occurs, the member selection function is disabled for that hierarchy. The prompt related to the hierarchy node variable displays at run time.

6.2.3.3.6 Hierarchical member selection in BEx queries

Use the "Query Panel”“Member Selector” to select members of a hierarchy for your query. The following hierarchy illustrates member selection behavior in BEx queries.

<table>
<thead>
<tr>
<th>World</th>
<th>EMEA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Europe</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Middle East</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Africa</td>
<td></td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asia PAC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pacific</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Australia</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Philippines</td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Zealand</td>
<td></td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td></td>
</tr>
<tr>
<td>Rule</td>
<td>Example</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>When you select a member of a hierarchy at a given level.</td>
<td>All of the parent members in the hierarchy are selected. The root is always selected. It is not possible to select one specific level.</td>
<td></td>
</tr>
</tbody>
</table>
| If you deselect a member when its parent member is already selected, all child members of the parent are also deselected. | If Pacific and all its child members are already selected and you deselect Australia, Philippines and New Zealand are also deselected. The following member selections appear:  
  • Europe  
  • Pacific |
| If you select a member when some of its child members are already selected, all child members are selected. | If Europe is selected and you select EMEA, Middle East and Africa are also selected. The following member selections appear:  
  • EMEA  
  • Children of EMEA |
| If you select a member when descendant members are already selected, all children of the member, and all siblings of the selected descendant members are also selected. | If you select Asia PAC when Australia was already selected, Asia, Pacific (children of Asia PAC) and Philippines and New Zealand (siblings of Australia) are also selected. The following member selections appear:  
  • Asia PAC  
  • Children of Asia PAC  
  • Pacific  
  • Children of Pacific |

**Related Topics**

- [Restrictions when using BEx queries](#)
To select hierarchy members using functions

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

1. Click Members to display the hierarchy members.
2. Right-click the member to which you want to apply a function.

The menu displays the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Children</td>
<td>Adds all child members of the member to the list of selected members. The members immediately below the selected member are its children.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot include children and descendants of the same member. If you had already selected <strong>Descendants</strong> before selecting <strong>Children</strong>, the descendants are removed from the list and replaced by children.</td>
</tr>
<tr>
<td>Descendants</td>
<td>Adds all descendant members of the member to the list of selected members. All members below the selected member in the hierarchy are its descendants.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot include children and descendants of the same member. If you had already selected <strong>Children</strong> before selecting <strong>Descendants</strong>, the children are removed from the list and replaced by descendants</td>
</tr>
</tbody>
</table>
The Parent function is not available in BEx queries.

The Ancestors function is not available in BEx queries.

The Siblings function is not available in BEx queries.

Use the list of level names to choose the level.

Choose the number of levels that you want to include in the selection.

3. Close the Member Selector.
   The selected members appear below the hierarchy object in the Result Objects pane. When you run the query, only those members are included in the query result.

   **Note:**
   You cannot exclude hierarchy members in BEx queries.

**Related Topics**
- To select hierarchy members

**Notes about using calculated members in BEx queries**
For specific restrictions concerning calculated members, refer to the topic Restrictions when using BEx queries.

**Related Topics**
- Restrictions when using BEx queries
- About selecting hierarchy members to a specified depth
- Hierarchical member selection in BEx queries
- Using contexts in BEx queries

**To search for members**
You have launched the query panel, selected a hierarchy object and launched the Member Selector.
You can search a hierarchy for specific members using the Member Selector.

**Note:**
The search is always performed on the entire hierarchy stored in the database, rather than only on the members already retrieved by the Member Selector.

1. Click **Members**.
2. Click the search button at the bottom right of the member display to launch the "Search" dialog box.
3. Type your search text in the "Search pattern" box.
   You can use wildcards in the search.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Replaces any string of characters</td>
</tr>
<tr>
<td>?</td>
<td>Replaces any individual character</td>
</tr>
</tbody>
</table>

4. Click **Search in Text** to search the display text of the members, or **Search in Key** to search their database keys.

**To build prompts for selecting members**

You have launched the query panel, selected a hierarchy object and launched the Member Selector.

You can defer member selection until the query is run. When you do so, the user is prompted to select members when they run the query.

**Note:**
- Selection in member prompts is restricted to explicit selection of members. The user cannot select members using functions such as **Ancestors** or **Parent**.
- The rules about selecting members using functions apply here. Refer to the link at the bottom of this topic.
1. Click **Prompts**.
2. Click **Enable Parameter** to enable member selection when the query is run.
   You cannot access the other tabs in the Member Selector when this option is selected.
3. Type the prompt text in the **Prompt Text** box.
4. Click **Keep last values selected** if you want the prompt to select the previously-chosen values by default when it is displayed.
5. Click **Set default values**, click **Edit** and select the default values if you want the prompt to select default values when it is displayed.
6. Close the **Member Selector**
   The prompt text appears beneath the hierarchy in the query panel.

**Related Topics**
- **To select hierarchy members using functions**
6.2.3.3.7 Using contexts in BEx queries

A context is a defined group of objects that share a common business purpose. This business purpose is usually the type of information that these related objects represent. For example, a sales context is a grouping of all the objects that can be used to create sales queries. A reservations context is a grouping of all the objects that can be used in reservation queries. Contexts are defined in the universe by the universe designer.

You can combine any objects within the same context to create a query. You can also combine objects in different contexts. If you use an object that is common multiple contexts in a query and it is not possible to determine the best context that fits all the other objects in the query, you are prompted to choose the context to apply.

Related Topics

- Restrictions when using BEx queries
- About selecting hierarchy members to a specified depth
- Hierarchical member selection in BEx queries

6.2.3.3.8 Changing the data source for BEx queries

You can change the data source for a document based on a BEx query in the following way:

Table 6-22: Changing the data source

<table>
<thead>
<tr>
<th>Original data source</th>
<th>Change to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A BEx query</td>
<td>A .unv universe on an OLAP source</td>
</tr>
<tr>
<td>A BEx query</td>
<td>Another BEx query</td>
</tr>
</tbody>
</table>

When you change the source, the Query Panel automatically starts. You must edit the query accordingly.

6.2.4 Building queries on Advanced Analysis views

6.2.4.1 SAP BusinessObjects Analysis defined
SAP BusinessObjects Analysis is an OLAP analysis tool that allows users to interactively define analyses to explore data in OLAP data sources. Users can export data in their analyses as Analysis Views, for use in other applications including SAP BusinessObjects Web Intelligence.

You can build queries on Analysis Views to analyse their data in Web Intelligence documents. The data in the Analysis View appears in the query panel as report objects such as hierarchies, dimensions and attributes.

**Note:**
Analysis Views with custom objects are not supported. Only analysis views coming directly from NetWeaver BW are supported.

### 6.2.4.2 To build a query on an Analysis View

**Note:**
You cannot build a query on an analysis view with the Web interface (DHTML client).

1. In Design or Data mode, select **Data Access > New > From Analysis View** to display the "Select an Analysis View" dialog box.
2. Select the folder containing the Analysis View in the **Folders** pane.
3. Select the Analysis View in the right pane.
   The Query Panel appears, displaying the data in the Analysis View as report objects.
4. Click **Run** to run the query.

### 6.2.5 Working with multiple queries

#### 6.2.5.1 Using multiple queries

You can include one or multiple queries in a document. These queries can be based on any supported data source.

For example, you can include product sales data and customer data in the same document. In this case, your corporate data for product line sales is available on one universe and data on customers is available on another universe. You want to present product line sales results and information on customer age groups in the same report. To do this, you create a single document that includes two queries; one query on each universe. You can then include and format results from both queries on the same report.
Defining multiple queries in a single document is necessary when the data you want to include in a document is available in multiple data sources, or when you want to create several differently-focused queries on the same data source. You can define multiple queries when you build a new document or add more queries to an existing document. You can present the information from all of the queries on a single report or on multiple reports in the same document.

### 6.2.5.2 Multiple queries, combined queries and synchronized queries compared

Multiple queries can be related in a document in different ways.

- Basic multiple queries draw unrelated data from different sources.
- “Synchronized queries” relate the data from different queries around a dimension that contains data common to both queries. These dimensions are called merged dimensions. You merge dimensions after you have created and run your multiple queries.
- “Combined queries” are a special kind of query. Combined queries generate SQL containing the UNION, INTERSECT and MINUS operators (if the database supports them) or simulate the effect of these operators.

Combined queries allow you to answer complex business questions that are difficult to formulate using standard queries.

**Note:**
This option is not accessible for OLAP databases or for .unx relational databases. It is available for .unv relational universes only.

### 6.2.6 Managing queries

#### 6.2.6.1 To switch to Data mode

**Note:**
Data mode is not available in the Web interface (DHTML client).

- Click **Data** on the top right menu.

  The **Data** pane appears with the document selected. All the data providers appear in a list to the right of the **Data** pane. The list displays information about the data provider such as the number or rows in contains and its last refresh date.
6.2.6.2 Managing queries with the Data Manager

You can use the Data Manager to view, explore and manage all the queries in a document. It consists of a Data pane that you use to explore the queries, and a list display that changes depending on the selection in the Data pane.

You use the Data Manager by switching to Data view. In Data view, the toolboxes in the Data Access group only are available.

6.2.6.2.1 To view and filter the data in a data provider

1. Switch to Data mode to display the Data Manager.
2. Select the data provider in the Data pane.
   The data in the objects in the data provider appears in a list to the right of the data pane, with one column for each object.

   **Note:**
   If the data provider contains multiple contexts or grouping sets, they appear in a drop-down list at the top right of the list pane. Each context or grouping set appears as Result n. Select a context or grouping set from the list to display its data.

3. To filter the data, click the arrow on a column header and select a value from the drop-down list, or select Custom and define a custom filter.
   A custom filter contains a filter operators and values that you select from the list of values or type directly. The number of values you can specify depends on the operator).
   The custom filters are as follows:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>is anything</td>
<td>The data is not filtered</td>
</tr>
<tr>
<td>is</td>
<td>The data is equal to a single value (equivalent to selecting a single value from the drop-down list)</td>
</tr>
<tr>
<td>does not equal</td>
<td>The data is not equal to a single value (all values apart from that value are displayed)</td>
</tr>
<tr>
<td>is in</td>
<td>The data is in a list of values (the selected values only are displayed)</td>
</tr>
<tr>
<td>is not in</td>
<td>The data is not in a list of values (all values apart from the selected values are displayed)</td>
</tr>
<tr>
<td>is empty</td>
<td>Only rows with empty values are displayed</td>
</tr>
<tr>
<td>is not empty</td>
<td>Only rows with non-empty values are displayed</td>
</tr>
<tr>
<td>begins with</td>
<td>Only rows that begin with the text you type are displayed</td>
</tr>
</tbody>
</table>
The data is filtered based on the values you specified. The filter also restricts the display in the other column. For example, if you filter the column showing the Customer dimension to show three values only, the Order Amount column displays only the values that correspond to the remaining Customer values.

### 6.2.6.3 To manage queries using the Data Manager

You can view, explore and manage all the queries in a document using the Data Manager. The Data Manager lists all the queries and allows you to perform actions such as renaming a query or changing the source of the data on which a query is based.

1. **To display the Data Manager**, click **Data** on the main toolbar.
   All the queries providing data to the document appear in a list, the Left Pane contains a **Data** tab only that lists all the objects in the selected query, and only the toolbox items relevant to managing queries are enabled.

2. **To edit a query**, right-click the query and in the contextual menu, select **Edit**.
   The query panel for the query you selected appears.

3. **To purge a query of data**, right-click the query and in the contextual menu, select **Purge** from the menu.

4. **To rename a query**, right-click the query and in the contextual menu, select **Rename**, then type the new name.

5. **To change the data source of a query**, right-click the query and in the contextual menu, select **Change Source**.
   For detailed information on changing the data source of a query, see the link at the bottom of this topic.

* When using an Excel data source in Web Intelligence Rich Client, the **Tools** -> **Change Source** options are not available: Open the "Query Panel", and in the "**Query Properties**" tab, use the **Source Path** menu to select a different source file.

**Related Topics**
- [Changing the data source of a query](#)
6.2.6.4 To set the key dates of queries

If one or more of the queries in the document contains a key date, you can set the key dates.

1. Select Data Access > Data Providers > Keydates.
2. Select Use the default date for all queries to set each query to its default key date.
3. Select Set date for all queries and choose the date to specify a key date for all queries.
4. Select Prompt users when refreshing data to display a prompt for the key date whenever a query containing a key date is refreshed.

6.2.7 To sort query results

The query panel is open.

You can sort the results returned by a query. The sorts are added directly to the script generated by the query and the database returns the query results already sorted.

For example, sorts added to queries that generate SQL appear in the ORDER BY clause of the generated SQL.

Note:
Sorting is not available in queries based on OLAP data sources.

1. Click Sort on the Result Objects toolbar to display the "Sort" dialog box.
2. Click Insert sort object and select the object in the "Select an Object" dialog box that displays to add a sort on an object.
3. Select the sort direction from the Sort type list.
4. Repeat the previous steps to add additional sorts to the query.
5. Select an object and click Delete selection to remove a sort from the query, or click Delete All to remove all sorts from the query.
6. Click OK to close the "Sorts" dialog box.
   The sorts are added to the script generated by the query.

6.2.8 To preview query results

You have defined the result objects and filter objects in the query panel.
You can preview the results of a query in the Data Preview pane in the query panel.

- Click Show/Hide Data Preview Pane on the query panel toolbar to display the Data Preview pane.

6.2.9 Displaying data from an added query

When a query is not the first query in the document, you need to specify in the "New Query" box how its data will be displayed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a table in a new report</td>
<td>Display the data on a new report in the document</td>
</tr>
<tr>
<td>Insert a table in the current report</td>
<td>Display the data on the currently selected report in a new table</td>
</tr>
<tr>
<td>Include the result objects in the document</td>
<td>Include the data in the document without displaying the data on a report.</td>
</tr>
<tr>
<td>without generating a table</td>
<td>(You can add the objects returned by the query to the report later.)</td>
</tr>
</tbody>
</table>

6.2.10 To interrupt a query

You can interrupt a query before all the data is returned to the document.

When you interrupt a query, only partial data is returned to the document. The values displayed in the document do not accurately reflect the definition in the query.

When you interrupt data retrieval, you have a choice of which data to display.

**Note:**
In the Web interface, when you cancel a query that is running, the Web interface returns to the precedent state of the document, and does not propose the option to interrupt data retrieval.

1. On the "Waiting - Refresh Data" dialog box, click Cancel.
   The "Interrupt Data Retrieval" dialog box appears.
2. Select one of the options on the "Interrupt Data Retrieval" dialog box.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore the results from the previous data retrieval</td>
<td>Restores the values to the document that were retrieved the last time the query was run. The values displayed will not be the most up to date information available on the database. You can run the query later to return the up to date values from the database</td>
</tr>
<tr>
<td>Purge all data from the document</td>
<td>Displays the document empty of values. The structure and formatting of the document is retained. You can run the query later to return the up to date values from the database</td>
</tr>
<tr>
<td>Return the partial results</td>
<td>Displays the new values retrieved so far in the appropriate parts of the document. The rest of the document will display the values retrieved the last time the query was run</td>
</tr>
</tbody>
</table>

### 6.2.11 To remove a query

1. Select the query you want to remove by right-clicking the appropriate Query tab.
2. Click Remove.

### 6.2.12 To duplicate a query

You must run the query first before you are allowed to duplicate the query.

If you want to build a different query on a universe already included in the document, you can duplicate the existing query on that universe and then modify it, instead of starting from scratch.

1. Select the query you want to duplicate by right-clicking the appropriate Query tab at the bottom of the report panel.
2. Select Duplicate

### 6.2.13 Changing the data source of a query

You can change the data source of a query. This is useful, for example, when you want to develop a document on a universe in a test environment, then change to a universe in a production environment.
You can change the source of the data by mapping objects to different objects in the same query or in a different query.

It is not possible to change between all data sources. The following table lists the possible changes (from a source to a target):

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
<th>UNV universe</th>
<th>UNX universe on relational data source</th>
<th>UNX universe on OLAP data source</th>
<th>Personal data provider (CSV, Excel)</th>
<th>BEx query</th>
<th>Advanced Analysis view</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNV universe</td>
<td>Change possible</td>
<td>Change possible</td>
<td>Change possible</td>
<td></td>
<td>Change possible</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNX universe on relational data source</td>
<td></td>
<td></td>
<td>Change possible</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UNX universe on OLAP data source</td>
<td></td>
<td></td>
<td>Change possible</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal data provider (CSV, Excel)</td>
<td></td>
<td></td>
<td>Change possible*</td>
<td></td>
<td></td>
<td></td>
<td>Change possible*</td>
</tr>
<tr>
<td>BEx query</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Change possible</td>
</tr>
<tr>
<td>Advanced Analysis view</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* See the first note below concerning changing the data source for Excel files with Web Intelligence Rich Client.

When you choose the query whose data source you want to change, you are presented only with those data sources to which a change is possible.

You can change the data source in the Java applet or Web Intelligence Rich Client only. In Web Intelligence Rich Client, you also have the option to change the data source of queries based on personal data files such as Excel files (see the first note below).
Note: When using an Excel data source in Web Intelligence Rich Client, the Tools -> Change Source options are not available: Open the "Query Panel", and in the "Query Properties" tab, use the Source Path menu to select a different source file.

Note:

• When a report contains two queries based on the same universe, you can change the data provider for one of the queries from a universe to a BEx query.

• When the source for a query is a universe (.unv file), you can change the source to a BEx query. You must remap objects to their corresponding object type in the new source.

6.2.13.1 To change the data source of a query

You change the data source on which a query is based by identifying the objects in the new data source that are the equivalents of the objects in the current data source. Where possible, source and target objects are mapped by default based on their name, object type, data type and location in the data source.

Note: You cannot map query filter objects.

You can change mappings manually, or create mappings manually for objects that could not be mapped by default.

1. Click Data to display the Data Manager and list the data providers in the document.
2. Right-click the query whose source you want to change and select Change Source.

   When using an Excel data source in Web Intelligence Rich Client, the Tools -> Change Source options are not available: Open the "Query Panel", and in the "Query Properties" tab, use the Source Path menu to select a different source file.

3. Select Choose an existing data source from the document to select a target data source that is already used in the document, or Specify a new data source, then specify the data source from the list, to choose a different data source.

   It is not possible to change between all types of data sources. The lists display only those data sources to which a change from the current data source is possible.

4. Click Next.

   The source and target objects appear in default mappings.

   If the data sources contain hierarchical data, all objects in the hierarchy appear beneath their parent hierarchy.

5. For each object pair that you want to map manually, click ... to display the "Map Object" dialog box.

6. Use the "Map Object" dialog box to choose which object in the new universe replaces the object in the current universe.

   Objects are mapped by default based on the object type, data type, name and path in the source and target data sources. You can accept the default mapping or choose your own mapping.
If no default mapping is possible, the object appears as **Remove result object** in the target data source. If you do not select an object from the new data source, the unmapped object is removed from the query when you change the data source.

If the removed object is the filtered object or rank-based object in a database ranking, the application displays a warning message. If you decide to remove the objects, the objects are removed from the ranking or sub-query.

If the removed object is the filtering object in a query on query filter, the application displays a warning message. If you remove the object, the query on query filter is removed.

7. Click **Finish** to change the data source.
You can refresh Web Intelligence documents created from Personal data sources such as text, excel files and from Custom data sources such as Web Services from the BI launch pad.

To manage the refresh option of a Web Intelligence document created using text or excel file, you must edit the RefreshOnServer parameter in the registry with one of the following values:

- NO or DISABLE - to disable refresh option
- YES or ENABLE - to enable refresh on server option and use the data source files from the Server_Path. If the data source path is not specified in the Server_Path, then the data source is taken from the original source location (location of data source from where the Web Intelligence document is created). By default, the RefreshOnServer parameter is set to ENABLE.
- ALLOW_USE_WINDOWS_SHARE - to enable refresh option from Windows shared location/UNC Path. As a fallback mechanism, if the source could not be reached then the source is looked up in the Server_Path.

**Note:**

- Server_Path is a registry parameter which specifies the path of the personal data sources on the server. By default, the Server_Path folder is not created during installation. You must manually create the Server_Path folder. You can also change the Server_Path value in the registry by editing the Server_Path parameter.
- The RefreshOnServer registry parameter is not applicable for custom data sources. For File based custom data sources, plug-in is free to implement the data source look-up / fallback mechanism.

On Windows platforms, you must edit the RefreshOnServer parameter found at the following location in the registry:

- **Text:** [HKEY_LOCAL_MACHINE]\SOFTWARE\SAP BusinessObjects\Suite XI 4.0\default\Web Intelligence\Calculator\PDP\TXT
- **Excel:** [HKEY_LOCAL_MACHINE]\SOFTWARE\SAP BusinessObjects\Suite XI 4.0\default\Web Intelligence\Calculator\PDP\XLS

To modify the value of Server_Path parameter, you must edit the Server_Path entry located at:

[HKEY_LOCAL_MACHINE\SOFTWARE\SAP BusinessObjects\Suite XI 4.0\default\Web Intelligence\Calculator\PDP]

By default, the value of Server_Path parameter is <SAP_BOBJ_INST_DIR>\PersonalDPFiles>.

On UNIX platforms, to manage the refresh option of a document created using Text and Excel personal data sources, you must edit the RefreshOnServer parameter with the YES/ENABLE or NO/DISABLE value in the .registry file. The default value of RefreshOnServer parameter is ENABLE. You can find the .registry file in the following locations:
Text: `<SAP_BOBJ_INST_DIR>/sap_bobj/data/.bobj/registry/64/software/sap
businessobjects/suite xi 4.0/default/webintelligence/calculator/pdp/txt`

Excel: `<SAP_BOBJ_INST_DIR>/sap_bobj/data/.bobj/registry/64/software/sap
businessobjects/suite xi 4.0/default/webintelligence/calculator/pdp/xls`

To modify the value of Server_Path parameter, you must edit the .registry file located at: `<SAP_BOBJ_INST_DIR>/sap_bobj/data/.bobj/registry/64/software/sap
businessobjects/suite xi 4.0/default/webintelligence/calculator/pdp/`

By default, the value of Server_Path parameter is `home/<username>/<SAP_BOBJ_INST_DIR>/PersonalDPFiles`.

Example: Refreshing Web Intelligence documents based on Excel datasource

Scenario A: User A creates a Web Intelligence document using Web Intelligence Rich Client from an excel datasource located at `C:\xyz.xls`. The user exports this document to the repository. Now, the user wants to view and refresh the document using BI Launchpad where Web Intelligence Server is installed on a different machine.

To refresh the document, perform the steps:
1. Place `xyz.xls` in the `C:\` directory on the server machine.
2. Place `xyz.xls` under a pre-defined path on server - the default server path is `<INST_DIR>\Business Objects\PersonalDPFiles`. You can change this path by changing the value of Server_Path in the registry `[HKEY_LOCAL_MACHINE\SOFTWARE\Business
Objects\Suite 12.0\default\WebIntelligence\Calculator\PDF]`

Scenario B: User B creates a Web Intelligence document using Web Intelligence Rich Client from an excel datasource located in the UNC Path: `\MySharedLocation\MYXLSFILES\xyz.xls`

To refresh the document, the user must either place the data source under Server_Path as mentioned in the Scenario A above or set the value of RefreshOnServer parameter to ALLOW_USE_WINDOWS_SHARE. This value indicates to enable refresh on Windows shared locations. However, there is a fallback mechanism to the Server_Path location if the UNC Path is not accessible from the Server.

Note:
- The above example applies for Text data source also.
- The Server Intelligence Agent (SIA) must be managed by a valid user authentication in the network domain. SIA is managed using local system account. Hence, if you are in the Scenario B mentioned above and the service is not able to access the shared location of your excel file, even if you are able to access the file through `start > Run > \MySharedLocation\MYXLSFILES`; in such cases, you can either start the SIA through the credentials which has access to the shared location or put the file in the Server_Path.
7.1 Points to consider before refreshing a document from BI launch pad

Before refreshing a document from BI launch pad, ensure that the following points are taken care:

• If the requirement is not to use UNC (Universal Naming Convention) path even if it is the original location of the data source, then the data source file must be located on the SAP BusinessObjects Enterprise server at the Server_Path. If the SAP BusinessObjects Enterprise server is clustered, then each and every cluster must be updated with the same copy of the data source file.

• If the requirement is to enable the use of UNC paths, then the Server Intelligence Agent (SIA) should be managed with a user account which has an access to the network domain. In usual installations, the SIA uses the local system account; this is not recommended because the UNC paths may not be accessible with such accounts.

To manage the SIA with a particular account (username/password), perform the following steps:

1. Launch the Central Configuration Manager (CCM).
2. Stop SIA.
3. Right-click SIA, and click on Properties.
4. In the Properties tab, under Log On As, if the SystemAccount option is selected, unselect it, and enter the user and password credentials.
5. Click Apply, and OK.
6. Start SIA.

**Note:**
This is applicable only for Windows.

• For refreshing a document based on generic WS, update the net.properties file located at:
  \SAP_BOBJ_INST_DIR\SAP BusinessObjects Enterprise XI 4.0\win64_x64\sapjvm\jre\lib (For UNIX, \BOBJ_INST_DIR\sap_bobj\enterprise_xi40\<platform>_x64\sapjvm\jre\lib) with the following lines:

```
http.proxyHost=<http proxy hostname>
http.proxyPort=<http proxy port number>
http.nonProxyHosts=localhost|127.0.0.1
```

where,
• proxyHost is the name of the proxy server. For example, proxy.mydomain.com.
• proxyPort is the port number to use. By default value is 80.
• nonProxyHosts is a '|' separated list of hostnames which should be accessed directly, ignoring the proxy server. By default the value is localhost & 127.0.0.1.

• Provide the following values for HTTPS parameters:

```
https.proxyHost=<https proxy hostname>
https.proxyPort=<https proxy port number>
```

where,
• proxyHost is the name of the proxy server. For example, proxy.mydomain.com
• proxyPort is the port number to use. By default value is 443. The HTTPS protocol handlers uses the http nonProxyHosts list.
Filtering data using query filters

8.1 Query filters defined

You limit the data returned to the document by applying filters when you define the query. Using query filters enables you to secure the data that you don’t want specific user groups to see and limits the size of the documents that are stored on your network. When you run the query on the document data, the query returns only the values that meet the query filter definitions.

Query filters limit the data returned to a document. They retrieve a sub-set of the data from the database and return the corresponding values to the document. You define filters to match business questions. For example, you can filter the Year dimension to view only sales revenue for Year 2003; or filter the Annual Income dimension to view only customers whose annual income is equal to or greater than $1.5M.

Query filters allow you to:

- retrieve only the data you need to answer a specific business question
- hide the data you don’t want specific users to see when they access the document
- minimize the quantity of data returned to the document to optimize performance

Example: In Q4 2002, which stores in my sales region gained margins above $130K?

As Regional Marketing Manager for Texas, you are only interested in analyzing margins for Texas, but the sales universe includes data US-wide. In addition, you only want to view information for stores where margins reached over your 4Q 2002 quarterly target figure: $130K. To create a document with only the information you need, you apply a filter on the State, Year, and Quarter dimensions and a filter on the Margin measure:

<table>
<thead>
<tr>
<th>AND</th>
<th>Year Equal to 2002</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Quarter Equal to Q4</td>
</tr>
<tr>
<td></td>
<td>State Equal to Texas</td>
</tr>
<tr>
<td></td>
<td>Margin Greater than or equal to 130000</td>
</tr>
</tbody>
</table>

To avoid displaying the filtered values Texas, 2002, and Q4 in the table columns Year, Quarter, and State, you exclude the Year, Quarter, and State objects from the Result Objects pane. When you generate the report, the report values correspond to Texas stores with 4Q 2002 margins greater than or equal to $130K:
<table>
<thead>
<tr>
<th>Store name</th>
<th>Sales Revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-Fashion Houston</td>
<td>307,914</td>
<td>133,802</td>
</tr>
<tr>
<td>e-Fashion Houston Leighton</td>
<td>316,232</td>
<td>136,055</td>
</tr>
</tbody>
</table>

### 8.2 Query filters and report filters compared

You can apply filters at two levels within a document:

- query filters – these filters are defined on the query; they limit the data retrieved from the data source and returned to the document.
- report filters – these filters limit the values displayed on reports, tables, charts, sections within the document, but they don’t modify the data that is retrieved from the data source; they simply hide values at the report level.

### 8.3 Structure of query filters

Query filters have the following structure: filtered object, operator, operand.

In the filter `[Country] InList (US;France)`, the `[Country]` dimension is the filtered object, `InList` is the operator, and the list of values `(US;France)` is the operand. The filter removes all values of `[Country]` other than US and France from the query result.
Table 8-3: Query filter components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filtered object</td>
<td>The filtered object is the objects whose values are filtered. Dimensions, attributes, measures, hierarchies and levels can be used as filtered objects. With the exception of BEx queries, the filtered object is not required to appear as a result object in the query. For example, a query that contains the [Customer] and [Revenue] objects can filter on the [Region] object. If the filter is [Region] Equal To &quot;South West&quot;, the query returns only those customers in the South West region.</td>
</tr>
<tr>
<td>Operator</td>
<td>The operator is used to compare the filtered object with the operand. For example, the Equal To operator retains only those values of the filtered object that correspond exactly to the value of the operand.</td>
</tr>
<tr>
<td>Operand</td>
<td>The operand supplies the value or values used to filter the filtered object. The next table describes the operand types.</td>
</tr>
</tbody>
</table>

Table 8-4: Operand types

<table>
<thead>
<tr>
<th>Operand type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>The constant operand is used to type values directly. For example, you can use a constant to type &quot;France&quot; into the filter [Country] Equal To France. The operand cannot be a constant if the filtered object is a hierarchy, unless the hierarchy is used in conjunction with the Matches pattern or Different from pattern operator.</td>
</tr>
<tr>
<td>List of Values</td>
<td>The List of Values operand is used to select values from the list associated with the filtered object. For example, if the filtered object is [City], you can use List of Values to select one or more of the cities associated with the object.</td>
</tr>
</tbody>
</table>
Filtering data using query filters

<table>
<thead>
<tr>
<th>Operand type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>A prompt is a dynamic filter that is answered when the query is refreshed.</td>
</tr>
<tr>
<td>Universe object</td>
<td>You can select an object from the universe to filter the filtered object against its values. <strong>Note:</strong> You cannot select a universe object as an operand on some OLAP data sources or the filtered object is a hierarchy.</td>
</tr>
<tr>
<td>Result from another query</td>
<td>You can compare the filtered object against the values returned by another query.</td>
</tr>
</tbody>
</table>

**Related Topics**
- BEx queries defined

### 8.3.1 Query filter and prompt operators

#### 8.3.1.1 List of operators

**8.3.1.1 Equal To operator**

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal To US".

**8.3.1.2 Not Equal To operator**

Use the Not Equal To operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter "County Not Equal To US".
8.3.1.1.3 Greater Than operator

Use the Greater Than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter "[Customer Age] Greater than 60".

Note: This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx queries.

8.3.1.1.4 Greater Than Or Equal To operator

Use the Greater Than Or Equal To operator to retrieve data greater than or equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the filter "[Revenue] Greater than or equal to 1500000".

Note: This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx hierarchies.

8.3.1.1.5 Less Than operator

Use the Less Than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter "[Exam Grade] Less Than 40".

Note: This operator cannot be used for OLAP unx universes, and hierarchies in filters, or for hierarchies in BEx queries.

8.3.1.1.6 Less Than Or Equal To operator

Use the Less Than Or Equal To operator to retrieve data less than or equal to a value.

For example, to retrieve data for customers whose age is 30 or less, create the filter "[Age] Less Than Or Equal To 30".

Note: This operator cannot be used for OLAP unx universes and hierarchies in filters, or for hierarchies in BEx queries.

8.3.1.1.7 Between operator

Use the Between operator to retrieve data between and including two values.
For example, to retrieve data for weeks starting at week 25 and finishing at 36 (including week 25 and week 36), create the filter "[Week] Between 25 and 36".

**Note:**
This operator cannot be used for OLAP unx universe and for BEx hierarchies in filters.

### 8.3.1.1.8 Not Between operator

Use the Not Between operator to retrieve data outside the range of two values.

For example; to retrieve data for all the weeks of the year, except for and not including weeks 25 through 36, create the filter "[Week] Not between 25 and 36".

**Note:**
This operator cannot be used for OLAP unx universe and for BEx hierarchies in filters.

### 8.3.1.1.9 In List operator

Use the In List operator to retrieve data corresponding to values in a list of values.

For example, to retrieve data for the US, UK and Japan only, create the filter [Country] In List ("US","UK","Japan").

When used in a query filter with a hierarchical list of values (either from a dimension associated with a hierarchical list of values or a hierarchy object), In List allows selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the In List operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

When used in a report filter, In List produces a flat list of values.

### 8.3.1.1.10 Not In List operator

Use the Not In List operator to retrieve data that does not correspond to multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan, create the filter [Country] Not In ("US","UK","Japan").

When used with a hierarchical list of values (either from a dimension associated with a hierarchical list of values, a hierarchy object or a level object), In List allows selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the Not In List operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

**Note:**
This operator can only be used in certain types of hierarchies - for example, it can be used in level-based hierarchies.

### 8.3.1.1.11 Matches Pattern operator

Use the Matches Pattern operator to retrieve data that includes a specific string or part of a string.
For example, to retrieve customers whose date of birth is 1972, create the filter [DOB] Matches Pattern "72".

**Note:**
This operator cannot be used for BEx hierarchies.

### 8.3.1.1.12 Different From Pattern operator

Use the Different From Pattern operator to return data that doesn't include a specific string.

For example, to retrieve customers whose date of birth is not 1972, create the filter [DOB] Different From Pattern '72'.

**Note:**
This operator cannot be used for BEx or OLAP unx universe parent-based hierarchies.

### 8.3.1.1.13 Both operator

Use the Both operator to retrieve data that corresponds to two values.

For example, to retrieve customers who have both a fixed and a mobile telephone, create the filter [Account Type] Both 'Fixed' And 'Mobile'.

**Note:**
This operator is not supported for filters based on hierarchy objects, or in universes based on OLAP data sources.

### 8.3.1.1.14 Except operator

Use the Except operator to retrieve data that corresponds to one value and excludes another.

For example, to retrieve customers who have a fixed telephone and do not have a mobile telephone, create the filter [Account Type] 'Fixed' Except 'Mobile'.

The Except operator is more restrictive than Different From or Not In List. For example, a report that returns customers and that includes the filter [Lines] Different From 'Accessories' excludes all sales records where the item sold is part of the 'Accessories' line. If the same customer has purchased Accessories and non-Accessories items, the customer still appears in the report, but their spending total includes only non-Accessories sales.

If the filter is [Lines] Except 'Accessories', only customers who have bought no accessories are included in the report.

**Note:**
This operator is not supported in universes based on OLAP data sources.

**Related Topics**
- [Not In List operator](#)
- [Different From operator](#)
8.3.1.2 Restrictions on filter operators

The following table lists the restrictions on prompt and filter operators based on the filtered object and query type.

<table>
<thead>
<tr>
<th>Object</th>
<th>Available filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level-based hierarchy</td>
<td>Equal To, Not Equal To, In List, Not In List, Matches Pattern, Different From Pattern</td>
</tr>
<tr>
<td>Parent-child hierarchy</td>
<td>Equal To, In List, Matches Pattern</td>
</tr>
<tr>
<td>Hierarchy in BEx query</td>
<td>Equal To, In List</td>
</tr>
</tbody>
</table>

8.4 Types of query filter

You can create the following types of query filter:

- predefined filters – created by your administrator
- custom filters – you define on the query
- quick filters - a simplified form of custom filter for simple filters
- prompts – you define these dynamic filters to display a question or a list of values so you or other users can select different filter value(s) at each run query

You can mix different types of filters on a single query.

8.4.1 Predefined query filters

Predefined filters make the specific data you most typically need for reports permanently available. They are created by an administrator and saved with the universe. Predefined filters often contain complex expressions that require a detailed knowledge of the database structure. Including predefined filters on the universe means you don’t need to create the same custom filters every time you create a new document based on the same universe.

You cannot view the component parts of predefined filters or edit predefined filters.
8.4.1.1 To select a predefined query filter

- Double-click the predefined filter or drag it to the **Query Filters** pane.

When you run the query, the data corresponding to the query filters you selected is returned to the report.

8.4.2 Quick filters

Quick filters allow you to quickly define the values you want to retrieve for a specific result object without launching the Filter Editor. By default, Quick filters use the Equal to operator if you select a single value or the In List operator if you select multiple values.

For example:

- If you select the [Payment Status] dimension and the value “unpaid?” you create the filter: [Payment Status] Equal to “unpaid?”
- If you select the [Country] dimension and the values US, Japan, Germany, you create the filter: [Country] In list “US;Japan;Germany?”

**Note:**
Quick filters are not available in Bex queries.

**Related Topics**
- BEx queries defined

8.4.2.1 To create or remove a quick filter

1. Select the object you want to filter.
2. Click **Add Quick Filter** at the top right corner of the **Result Objects** pane.
   The **List of Values** dialog box appears. The values for the selected object are listed.
3. Select the values you want to retrieve from the database.
   For example, to filter the query for values in Q1, select the [Quarter] dimension, then select Q1 from the list of values.
4. Click **OK**
   The new filter appears on the **Query Filters** pane.
5. To remove the filter, select it in the Query Filters pane and press the Delete key.

8.4.3 Custom query filters

You create custom query filters to limit document data to information corresponding to:

- a specific business question
- the business information needs of a specific group of users

For example, you can create custom filters to retrieve sales results data for specific dates, products, or services, or to view customer information only for customers who are high wage earners or who live in a particular region.

8.4.3.1 To add and remove custom query filters

1. Select the object you want to filter and drag it to the Query Filters pane.
   The query filter appears in outline in the Query Filters pane.
2. Click the arrow next to the default operator (In List) and select the query operator from the list of operators.
3. Click the arrow on the right of the query filter and select the type of filter you want to apply: **Constant**, **Value(s) from List**, **Prompt**, **Object from this query**, **Result from another query**, **Result from another query (Any)**, **Result from another query (All)**.
Filtering data using query filters

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>You compare the object against a constant value to filter the query result.</td>
</tr>
<tr>
<td>Value(s) from list</td>
<td>You compare the object against values from a list of values to filter the</td>
</tr>
<tr>
<td></td>
<td>query result.</td>
</tr>
<tr>
<td></td>
<td>• If the filtered object is a dimension, attribute or measure, you can</td>
</tr>
<tr>
<td></td>
<td>select any of the values of the object.</td>
</tr>
<tr>
<td></td>
<td>• If the filtered object is a hierarchy, you can select any members of the</td>
</tr>
<tr>
<td></td>
<td>hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• If the filtered object is a level, you can select any member from the</td>
</tr>
<tr>
<td></td>
<td>level.</td>
</tr>
<tr>
<td>Prompt</td>
<td>You create a filter which requires the user to supply filter values on data</td>
</tr>
<tr>
<td></td>
<td>refresh.</td>
</tr>
<tr>
<td>Object from this query</td>
<td>You compare the object against the values returned by an object from in</td>
</tr>
<tr>
<td></td>
<td>the same query.</td>
</tr>
<tr>
<td>Result from another</td>
<td>You compare the object against the values returned by an object from an-</td>
</tr>
<tr>
<td>query</td>
<td>other query (the filtering query) to filter the query result.</td>
</tr>
</tbody>
</table>

4. Type/select the constant, list of values or object you want to include in the filter.
5. To remove the filter, select it and click the Delete key, or click **Remove** at the top right corner of the **Query Filters** pane. To remove all filters, click **Remove All** at the top right corner of the **Query Filters** pane.

### 8.4.3.2 To select values from a list

In a query, values in a list of values can appear either as a single-column list, a multicolumn list, or a hierarchy, depending on the object. In a multicolumn list, additional columns provide related values to the main value. In a hierarchical list, values appear in a hierarchical relationship.

In a report, values appear in a flat list without multiple columns.
1. If the list of values does not display when the dialog box opens, refresh the list, or search the list to retrieve values. (See later in this topic for details of searching lists of values.)
   Some list of values require an initial search to display values because the list is too large to be loaded in full.
2. If the list of values is divided into ranges, use the control above the list to navigate through the ranges.
   Some large lists of values are divided into ranges to reduce the amount of data retrieved from the database.
   When you select a range, the list displays the values in that range.
3. If the list of values depends on other lists of values, specify the dependent values first in the prompt dialog box that displays.

A list of values can be dependent on other lists of values, for example when it is part of a hierarchical list of values. For example, if the list of values contains cities, and the City object is part of the hierarchy Country > Region > City, you need to specify values for country and region first to filter the list of cities.

**Note:**
Dependent lists of values appear in queries only. They do not appear when you are selecting from a list of values in a report.

When you first display the list of values, you see the Prompt dialog box that you use to specify the dependent values. Once you have specified the dependent values, you can select the values from the filtered list.

4. To display the value keys, click **Show/hide key values**.

Some lists of values contain key values, which are unique values that can be used to identify values with the same display value. If the list of values contains multiple columns, only the key of the filtering column is displayed.

5. To search for values in the list, type the search text in the box below the list and select the **Match case**, **Search in keys** or **Search on database** option.
## Option | Description
--- | ---
**Match case** | The search is case-sensitive. This option is not available when the **Search in keys** or **Search on database** options are selected.

**Search in keys** | The search uses unique value keys rather than display values. This option is available only on lists of values that support key values.

**Search on database** | The search includes all values stored in the database rather than being restricted to the values loaded into the list. It improves search accuracy but reduces search speed. This option is available only on lists of values that support database searches. Database searching improves search accuracy at the cost of performance. It is useful when not all values in the list of values were retrieved. This can happen when the total number of values in the list exceeds the **Max rows retrieved** query property. Database searching is particularly useful when the list of values is hierarchical because values are loaded from the database only in response to their parent value being expanded in the hierarchy. For example, in a geographical hierarchy, the child values of the California value (cities in California) are not loaded from the database until the value is expanded. If the option is selected, the search includes these items even when the California value has not been expanded.

The search includes all ranges if the list of values is divided into ranges.

In search patterns, the "*" wildcard represents any string of characters and the '?' wildcard represents any single character. For example, the value "March" can be returned by the search patterns "M*" or "Mar?h". To include the "*" and '?' characters literally rather than as wildcards, precede them with "\" in the search pattern.

6. Type values from the list directly (if the list supports direct data entry) or select values from the list.

**Related Topics**
- Max rows retrieved query property

### 8.4.3.3 Filtering a query on values returned from another query
You can filter a query on values returned from another query. For example, if you want to return results for all the countries in Query 1 that have a corresponding country in Query 2, you can filter the [Query 1].[Country] object on the values of the [Query 2].[Country] object.

The filtered query must be in a universe based on a relational (RDBMS) data source. The query that supplies the filtering values (filtering query) can be based on a relational, OLAP or local data source.

When you are building a query on a query, the filtering query does not appear in the list of queries that can be used as filtering queries until it has been run or saved.

The filtering query is not refreshed when you refresh the filtered query.

The query filter can filter against all or any of the values returned by the filtering query. The supported combinations of operator and filter mode appear in the table below. If you do not choose an operator from the table, the Result from another query menu item is not available.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Filter mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal To</td>
<td>Any</td>
<td>Keep values in the filtered query that are equal to any value returned by the filtering query.</td>
</tr>
<tr>
<td>Not Equal To</td>
<td>All</td>
<td>Keep values in the filtered query that are different from all the values returned by the filtering query.</td>
</tr>
<tr>
<td>Greater Than</td>
<td>Any</td>
<td>Keep values in the filtered query that are greater than/greater than or equal to any of the values in the filtering query. In other words, keep values in the filtered query that are greater than/greater than or equal to the minimum value returned by the filtering query.</td>
</tr>
<tr>
<td>Greater Than or Equal To</td>
<td>All</td>
<td>Keep values in the filtered query that are greater than all of the values in the filtering query. In other words, keep values in the filtered query that are greater than/greater than or equal to the maximum value returned by the filtering query.</td>
</tr>
<tr>
<td>Less Than</td>
<td>Any</td>
<td>Keep values in the filtered query that are less than/less than or equal to any of the values in the filtering query. In other words, keep values in the filtered query that are less than/less than or equal to the maximum value returned by the filtering query.</td>
</tr>
</tbody>
</table>
### 8.4.4 Combining query filters

#### 8.4.4.1 Combining query filters

Typical business questions require you to retrieve information that matches more than one criteria. For example, if you are analyzing customer services data, you will most likely want to focus on customers for a specific time period and also for a specific region, and probably also for a specific level of customer service contract. You can retrieve data that answers several criteria like this by combining filters in the same query.

Example: **Analyze sales revenue this year at stores where the floor size is over 4,000 square feet and sales revenue figures are equal to or less than $1.5M**

In this example, you are an operations manager for a retail chain. You want to analyze information about the large retail stores in your chain that are making less than the sales revenue figure your company has set as the target.

To do this you add a predefined filter on the [Year] dimension to specify that you only want to retrieve values for this year. Then you create a second filter on the [Sales Floor Size] dimension to specify that you only want to retrieve data for stores where the floor size is greater than 4,000 square feet. After this, you create a third filter on the [Sales Revenue] measure to specify that you only want to retrieve data for stores where the sales revenue figures are equal to or less than $1.5M. Finally, you combine these three filters with the And operator:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Filter mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less Than</td>
<td>All</td>
<td>Keep values in the filtered query that are less than/less than or equal to any of the values in the filtering query.</td>
</tr>
<tr>
<td>Less Than or Equal To</td>
<td></td>
<td>In other words, keep values in the filtered query that are less than/less than or equal to the minimum value returned by the filtering query.</td>
</tr>
<tr>
<td>InList</td>
<td>Any</td>
<td>Keep values in the filtered query that are equal to any value in the list of values returned by the filtering query.</td>
</tr>
<tr>
<td>Not InList</td>
<td>Any</td>
<td>Keep values in the filtered query that are not equal to any of the values in the list of values returned by the filtering query.</td>
</tr>
</tbody>
</table>
When you run the query, only data for stores that satisfy all three criteria will be returned to the report.

**8.4.4.2 To combine query filters**

1. Create the filters and add them to the Query Filters pane.
   - Filters are combined by default with the And operator.
2. Click the operator or click the arrow next to the operator checkbox and select the other operator to toggle between AND and OR.

   **Note:**
   - Some OLAP data sources do not support the OR operator.

**Related Topics**
- [Combining query filters](#)

**8.4.4.3 Nesting query filters**

Nesting query filters allows you to create more complex filter conditions than is possible when you combine filters at the same level.

When you nest filters, you set the order in which they are evaluated. For example, you can return the data given by two query filters joined in an OR relationship (where either one filter condition or the other is true) and then further restrict this data by applying another filter to it. In this case, the two filters in an OR relationship are nested, then compared with the other filter in an AND relationship.

The following example illustrates this:
Example: List all sales made in Japan either in Q4 or where the revenue was greater than 1,000,000.

To answer this question you create the following nested query filter:

<table>
<thead>
<tr>
<th>AND</th>
<th>Country Equal To Japan</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>Quarter Equal To Q4</td>
</tr>
<tr>
<td></td>
<td>Revenue Greater Than 1000000</td>
</tr>
</tbody>
</table>

This combination of query filters first returns sales data where the sale was made in Q4 or the revenue was greater than 1,000,000, then restricts this data further by returning only those sales made in Japan.

Related Topics
- To nest query filters
- Combining query filters

8.4.4.4 To nest query filters

1. Drag and drop a report object onto an existing query filter.
   A query filter outline on the report object appears in a nested AND relationship with the existing query filter.
2. Define the new query filter.

Related Topics
- Nesting query filters
- Combining query filters

8.5 Filtering hierarchical queries
8.5.1 How levels filter hierarchical queries

A level used as a query filter removes the specified members from the level and all their child members from the hierarchy. The filter also impacts measure aggregation.

Example: Filtering on a level

You have the following data, on which the level filter [Country] Not Equal To Germany is applied. (You apply the filter by dragging the [Country] level to the Query Filters pane in the Query Panel, selecting the Not Equal To operator and selecting "Germany" from the list of values of the level).

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Brandenburg</td>
<td>$119,871.08</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

After filtering, the data appears as follows:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$26,464,364.88</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
</tbody>
</table>

When the filter is applied, Germany and all descendant members are filtered from the hierarchy. The value of [Internet Sales Amount] for All Customers is also reduced because the value for Germany is no longer part of the aggregation.
8.5.2 How measures filter hierarchical queries

A filter on a measure applies to all levels in a hierarchy and does not impact measure aggregation in the filtered result.

Example: Filtering on a measure

You have the following data, to which you apply the filter [Internet Sales Amount] Greater Than 500,000.

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Hauts de Seine</td>
<td>$263,416.19</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Brandenburg</td>
<td>$119,871.08</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

The filtered data appears as follows:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>$29,358,677.22</td>
</tr>
<tr>
<td>France</td>
<td>$2,644,017.71</td>
</tr>
<tr>
<td>Seine (Paris)</td>
<td>$539,725.80</td>
</tr>
<tr>
<td>Germany</td>
<td>$2,894,312.34</td>
</tr>
<tr>
<td>Hessen</td>
<td>$794,876.08</td>
</tr>
</tbody>
</table>

The filter is applied to all members, irrespective of their level in the hierarchy, and the aggregated measures are not impacted by the removal of the filtered members. (For example, the All Customers amount remains at $29,358,677.22).
Filtering data using prompts

9.1 Prompts defined

A prompt is a special type of query filter. It is a dynamic filter that displays a question every time you refresh the data in a document. You answer prompts by either typing or selecting the values you want to view before you refresh the data. The query then retrieves only the values you specified from the database and returns those values to the reports within the document.

Prompts allow multiple users viewing a single document to specify a different sub-set of the database information and display it in the same report tables and charts. Prompts also reduce the time it takes for the data to be retrieved from the database.

A prompt contains the following elements:

- a filtered object
- an operator
- a message

For example, to prompt users to select a specific year, you define a prompt on the [Year] dimension:

```
Year Equal To (“Which year?”)
```

In this prompt, the filtered object is [Year], the operator is Equal To, and the prompt message is "Which year?".

You can define prompts on dimensions, measures, attributes, hierarchies and levels. For example, you can filter the [Year] dimension to return values for a specific year, filter the [Sales Revenue] measure to return values for a range of revenue figures, or filter the [Geography] hierarchy to return members from the hierarchy.

**Note:**

- In Web Intelligence Rich Client, or the Rich Internet Application interface, for OLAP unx universes, when filtering on measures, you can only type a constant.
- In Web Intelligence Rich Client, or the Rich Internet Application interface, you cannot add measures or detail objects in the filter panel for BEx queries

You can create multiple prompts, related by the AND or OR operators, in the same query. You can also nest prompts. When the user runs a query, the prompts are displayed.

**Note:**

On BEx queries and OLAP unx universes, you can only use the AND operator.
Prompts appear in the script generated by the query as either the value supplied in response to the prompt or as special prompt syntax. For example, a prompt on [Country] can appear in generated SQL as

```sql
Resort.Country.country = @prompt('Enter Country:', 'A', 'Resort\Country', Mono, Free, Persistent, User:0)
```
or as

```sql
Resort_country.country In ('UK')
```

Prompts can be optional. You are not obliged to supply values for optional prompts. If you do not supply a value, the prompt is ignored.

You can create your own prompts or select from prompts already defined in the universe.

### 9.1.1 Merged prompts

When a document contains multiple data providers, any prompts that include objects with the same data type, operators of the same operator type, and that use the same prompt text are merged.

When all the data providers are refreshed, a single prompt message appears for such prompts.

The List of Values displayed by the merged prompt is the list associated with the object in the prompt that has the most display property constraints.

### 9.1.2 Hierarchical prompts

The following objects display their lists of values hierarchically in a prompt:

- Hierarchies
- Levels
- Dimensions associated with a hierarchical list of values

A hierarchical list of values appears in tree form. You can navigate up and down the tree to the items you want. Depending on the filter operator in the prompt, you can select items from different levels of the list of values, or at the lowest level only.

### 9.2 Query filter and prompt operators
9.2.1 List of operators

9.2.1.1 Equal To operator

Use the Equal to operator to obtain data equal to a value.

For example, to return data for the US only, create the filter "County Equal To US".

9.2.1.2 Not Equal To operator

Use the Not Equal To operator to obtain data not equal to a value.

For example, to return data for all countries except the US create the filter "County Not Equal To US".

**Note:**
This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx queries.

9.2.1.3 Greater Than operator

Use the Greater Than operator to retrieve data greater than a value.

For example, to retrieve data for customers aged over 60, create the filter "[Customer Age] Greater than 60".

**Note:**
This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx queries.

9.2.1.4 Greater Than Or Equal To operator

Use the Greater Than Or Equal To operator to retrieve data greater than or equal to a value.
For example, to retrieve data for revenue starting from $1.5M, create the filter "[Revenue] Greater than or equal to 1500000".

**Note:**
This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx hierarchies.

### 9.2.1.5 Less Than operator

Use the Less Than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter "[Exam Grade] Less Than 40".

**Note:**
This operator cannot be used for OLAP unx universes, and hierarchies in filters, or for hierarchies in BEx queries.

### 9.2.1.6 Less Than Or Equal To operator

Use the Less Than Or Equal To operator to retrieve data less than or equal to a value.

For example, to retrieve data for customers whose age is 30 or less, create the filter "[Age] Less Than Or Equal To 30".

**Note:**
This operator cannot be used for OLAP unx universes and hierarchies in filters, or for hierarchies in BEx queries.

### 9.2.1.7 Between operator

Use the Between operator to retrieve data between and including two values.

For example, to retrieve data for weeks starting at week 25 and finishing at 36 (including week 25 and week 36), create the filter "[Week] Between 25 and 36".

**Note:**
This operator cannot be used for OLAP unx universe and for BEx hierarchies in filters.
9.2.1.8 Not Between operator

Use the Not Between operator to retrieve data outside the range of two values.

For example, to retrieve data for all the weeks of the year, except for and not including weeks 25 through 36, create the filter "[Week] Not between 25 and 36".

Note:
This operator cannot be used for OLAP unx universe and for BEx hierarchies in filters.

9.2.1.9 In List operator

Use the In List operator to retrieve data corresponding to values in a list of values.

For example, to retrieve data for the US, UK and Japan only, create the filter [Country] In List ("US","UK","Japan").

When used in a query filter with a hierarchical list of values (either from a dimension associated with a hierarchical list of values or a hierarchy object), In List allows selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the In List operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

When used in a report filter, In List produces a flat list of values.

9.2.1.10 Not In List operator

Use the Not In List operator to retrieve data that does not correspond to multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan, create the filter [Country] Not In ("US","UK","Japan").

When used with a hierarchical list of values (either from a dimension associated with a hierarchical list of values, a hierarchy object or a level object), In List allows selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the Not In List operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

Note:
This operator can only be used in certain types of hierarchies - for example, it can be used in level-based hierarchies.
9.2.1.11 Matches Pattern operator

Use the Matches Pattern operator to retrieve data that includes a specific string or part of a string.

For example, to retrieve customers whose date of birth is 1972, create the filter [DOB] Matches Pattern "72".

**Note:**
This operator cannot be used for BEx hierarchies.

9.2.1.12 Different From Pattern operator

Use the Different From Pattern operator to return data that doesn't include a specific string.

For example, to retrieve customers whose date of birth is not 1972, create the filter [DOB] Different From Pattern '72'.

**Note:**
This operator cannot be used for BEx or OLAP unx universe parent-based hierarchies.

9.2.1.13 Both operator

Use the Both operator to retrieve data that corresponds to two values.

For example, to retrieve customers who have both a fixed and a mobile telephone, create the filter [Account Type] Both 'Fixed' And 'Mobile'.

**Note:**
This operator is not supported for filters based on hierarchy objects, or in universes based on OLAP data sources.

9.2.1.14 Except operator

Use the Except operator to retrieve data that corresponds to one value and excludes another.
For example, to retrieve customers who have a fixed telephone and do not have a mobile telephone, create the filter [Account Type] 'Fixed' Except 'Mobile'.

The Except operator is more restrictive than Different From or Not In List. For example, a report that returns customers and that includes the filter [Lines] Different From 'Accessories' excludes all sales records where the item sold is part of the 'Accessories' line. If the same customer has purchased Accessories and non-Accessories items, the customer still appears in the report, but their spending total includes only non-Accessories sales.

If the filter is [Lines] Except 'Accessories', only customers who have bought no accessories are included in the report.

Note:
This operator is not supported in universes based on OLAP data sources.

Related Topics
• Not In List operator
• Different From operator

9.2.2 Restrictions on filter operators

The following table lists the restrictions on prompt and filter operators based on the filtered object and query type.

<table>
<thead>
<tr>
<th>Object</th>
<th>Available filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level-based hierarchy</td>
<td>Equal To, Not Equal To, In List, Not In List, Matches Pattern, Different From Pattern</td>
</tr>
<tr>
<td>Parent-child hierarchy</td>
<td>Equal To, In List, Matches Pattern</td>
</tr>
<tr>
<td>Hierarchy in BEx query</td>
<td>Equal To, In List</td>
</tr>
</tbody>
</table>

9.3 To build a new prompt

1. Drag the object you want to filter with a prompt and drop it onto the Query Filters pane.
   The query filter appears in outline in the Query Filters pane. The outline shows the filtered object, the operator and the type of filter applied to the object. (By default the filter is a constant.)
2. Select the filter operator from the list.

   **Note:**
   The list of available operators depends on the type of filtered object.

3. Click the arrow at the right of the outline query filter and select **Prompt** from the menu to filter the object using a prompt.

   **Note:**
   If the document contains multiple data providers, and there is already a prompt that includes objects with the same data type, operators of the same operator type, and that uses the same prompt text as the new prompt, a warning displays telling you that the two prompts will be merged. This means that whenever all the data providers are refreshed, a single prompt message will appear for the two prompts.

   The **Prompt** dialog box appears.

4. If the **Prompt with list of Values** prompt properties is unchecked, type the prompt text (for example "Enter a City") in the **Prompt text** box.

5. Click **Prompt with list of values** to allow the user to select from a list of values when answering the prompt.
   - The option is selected by default if the filtered object has an associated list of values in the universe.
   - The option is selected by default and cannot be deselected if the filtered object is a hierarchy.
   - Do not select this option if the filtered object is a date and you want users to see a popup calendar to select the date.

6. In the dialog box Parameter properties, click **Select only from list** to restrict the user choice to values selectable from the list.
   - The option is selected by default if the filtered object has an associated list of values in the universe, and cannot be deselected if the filtered object is a hierarchy.
   - Do not select this option if the filtered object is a date and you want users to see a popup calendar to select the date.

7. In the dialog box Parameter properties, select **Keep last values selected** to ensure that, by default, the prompt selects the values the user selected the last time they answered the prompt.

   The option is selected by default if the filtered object has an associated list of values in the universe, and cannot be deselected if the filtered object is a hierarchy.

8. In the dialog box Parameter properties, click **Set default values** if you want the prompt to select values by default when it displays, and type a value in the **Type a value** box, or click ... and select default values in the **List of Values** dialog box.

   **Note:**
   This button is disabled if the filtered object has no associated list of values.

9. In the dialog box Parameter properties, select **Optional prompt** to make the prompt optional. If the user does not supply a value for an optional prompt, the prompt is ignored.

10. Click the icon next to the text box and use the dialog box that appears to set the prompt properties.
    The prompt appears at each document refresh.
9.4 To select an existing prompt

You can select from pre-existing prompts to add to a query. Only pre-existing prompts that are compatible with the object you are filtering are displayed,

1. Drag the object on which you want to apply a prompt and drop it onto the Query Filters pane.
   The query filter appears in outline in the Query Filters pane.
2. Click the arrow at the right of the Query Filter and select Prompt from the menu.
3. Click Select from universe, select an existing prompt and click OK.
   The list displays only those universe prompts that are compatible with the object you are filtering. For example, the filtered object and the universe prompt must have the same data type.

9.5 To remove a prompt

• Select the prompt in the Query Filters pane and click the Delete key.

9.6 Defining how prompts display

By default, prompts display a box and a list of values. You answer the prompt by either typing the value(s) in the box or by selecting value(s) from the list.

You can modify how prompts display by checking one, some, or all of the following options (these options are available in the dialog box Parameter properties):

<table>
<thead>
<tr>
<th>If you want the prompt to display...</th>
<th>(useful when you...)</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the list of values associated with the filtered dimension, measure, or detail,</td>
<td>want to view all the values for the object and then select from those values</td>
<td>leave the option selected by default: Prompt with List of Values</td>
</tr>
</tbody>
</table>
If you want the prompt to display...

<table>
<thead>
<tr>
<th>If you want the prompt to display...</th>
<th>(useful when you...)</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the value(s) specified the last time the prompt was answered (users can select a different value(s)),</td>
<td>often reselect the same value(s) when you refresh the document, but want the ability to select a different value when necessary, such as the name of the current month</td>
<td>select the option: <strong>Keep last values selected</strong></td>
</tr>
<tr>
<td>the value(s) you specify as the default (users can select a different value(s)),</td>
<td>almost always reselect the same value(s) when you refresh the document, but want the ability to select a different value when necessary, such as the number for the current year</td>
<td>select the option: <strong>Set default value(s)</strong></td>
</tr>
<tr>
<td>a list of values from which users select a value(s),</td>
<td>prevent users from typing a value that might not exist on the database</td>
<td>select the option: <strong>Select only from List</strong></td>
</tr>
</tbody>
</table>

To make the prompt optional, select **Optional prompt**. You are not obliged to specify a value for the prompt, in which case it is ignored.

**Note:**
If the prompt is for a date, the users will see the popup calendar and a list of values. If you want users to see the popup calendar in order to select the date(s) then unselect **Prompt with List of Values**.

### 9.7 Combining prompts

Combining multiple prompts on a single query enables you to filter the data returned to the document so that each person viewing the reports sees only the information relevant to their business need. For example, you can combine the following three prompts on a Customer Accounts document:

- Which customer?
- Which account?
- Which calendar period: from? to?

This enables each accounts manager viewing the document to view report values for a specific customer account during a specific period.

You combine prompts in the same way that you combine query filters.
9.7.1 Combining prompts with query filters

Combining prompts and filters on a single query enables you decide the values for some of the selected objects on the query using filters and allow users to decide the values of other selected objects using prompts. For example, if you combine the following filters and prompts on a HR document:

- [Year] Equal to This Year
- [Job title] Not equal to Senior Executive
- Which employee?

Users viewing the document can choose which employee they view information for, but they can only view data for the current year and they can’t view data for senior executives.

9.8 To change the order of prompts

The query panel is open.

1. Click **Query properties** on the query panel toolbar.
2. Select the prompt you want to move up or down in the prompt order in the **Prompt Order** box, then press the Up or Down arrow next to the box.
Filtering data using prompts
Using combined queries

10.1 Combined queries defined

A combined query is a group of queries that work together to return a single result. You can combine queries in three relationships:

- union
- intersect
- minus

A UNION query takes all the data from both queries, eliminates duplicate rows, and builds a combined data set.

An INTERSECT query returns the data that is common to both queries.

A MINUS query returns the data in the first query that does not appear in the second.

Note:
You cannot combine BEx queries or OLAP queries.

Example: Union, intersect and minus queries

In this example you have two queries that return lists of countries as shown in the following table:

<table>
<thead>
<tr>
<th>Query</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; Germany; France</td>
</tr>
<tr>
<td>Query 2</td>
<td>US; Spain</td>
</tr>
</tbody>
</table>

The different types of combined query return the following values:

<table>
<thead>
<tr>
<th>Combination type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNION</td>
<td>US; UK; Germany; France; Spain</td>
</tr>
<tr>
<td>INTERSECT</td>
<td>US;</td>
</tr>
<tr>
<td>MINUS</td>
<td>UK; Germany; France</td>
</tr>
</tbody>
</table>
10.2 Uses of combined queries

Combined queries allow you to answer questions that are otherwise difficult or impossible to frame in standard query.

Example: **Return a data set using a combined query**

The Island Resorts Marketing sample universe contains the dimension Year, which returns guests who have already stayed in a resort, and Reservation Year, which returns guests who have reserved to stay in the future. Because of the structure of the database and universe, these objects are incompatible, which means that you cannot include them in the same block in a report.

What if you want to return a single list of years that includes those years where more than n guests stayed in a resort and those years where more than n guests reserved to stay in a resort? You can do this using a combined query, as follows:

<table>
<thead>
<tr>
<th>Query</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>Years where more than n guests stayed in a resort</td>
</tr>
<tr>
<td>UNION</td>
<td></td>
</tr>
<tr>
<td>Query 2</td>
<td>Years where more than n guests reserved to stay in a resort</td>
</tr>
</tbody>
</table>

The union between these two queries returns the list of years that you want.

10.3 How combined queries are generated

If your database supports the type of combination in your query, combined queries work at the database level: they alter the query submitted to the database. They do so by generating query script containing UNION, INTERSECT and MINUS operators.

If your database does not support the type of combination in your query, the combination occurs after data retrieval. Multiple queries return data to the report and this data is then resolved into the same result generated by a database-level combined query.
10.4 To build a combined query

1. Create an initial query in the query panel.
2. Click the Add a Combined Query icon on the toolbar to display the Combined Queries panel beneath the list of query objects.
   The Combined Queries panel shows the current query. You can change the query name by clicking the query in the panel, selecting Edit Name from the menu, then typing a new name in the Name box in the dialog box that appears.
3. Click Add a query to add another query. The second query appears in the Combined Queries pane and is:
   • Combined with the original query in a UNION relationship.
   • Named Combined Query #n.
4. To switch to a query, click it in the Combined Queries pane.
5. To delete a query select it in the Combined Queries pane and press the Delete key, or drag and drop the query to the universe outline.
6. To change the combination type, double-click on the operator. The operator moves through the sequence UNION, MINUS, INTERSECT.
7. Build each query within the combined query as you build any normal query.
8. Click Run Query.

10.5 Combined query structure

The queries within a combined query must return the same number of objects of the same data type and the objects must be in the same order. You cannot combine queries when the number of objects in the query results and the data types of those objects are not identical. For example, you cannot combine a query that returns Year with a query that returns Year and Revenue, and you cannot combine a query that returns Year with a query that returns Revenue.

You must also pay attention to the semantics of your combined queries. While it is possible to combine a query that returns Year with a query that returns Region if both dimensions are of the same data type, the result - a mixed list of years and regions - is unlikely to be meaningful. Typically, if your first query contains a Year dimension, your second query also contains a dimension that returns a list of years.

10.5.1 To return a list of years and reservation years based on the number of guests
You want to build a query that returns a list of years consisting of years where more than n guests stayed in a resort and years where more than n guests reserved to stay in a resort. The object you are filtering on must also be in the "Result Objects" pane.

1. Select the Island Resorts Marketing universe in the list of universes to open the Query Panel.
2. Drag the Year, Number of Guests, and Future Guests objects to the Result Objects pane.
3. Drag the Number of Guests object to the Query Filters pane and create a report filter that restricts Number of Guests to greater than n.
4. Click Combined Query.
   The Combined Query pane appears in the bottom left of the Query panel with the two queries joined by UNION.
5. Click on the second query and remove the Year and Number of Guests objects.
6. Drag the Reservation Year object to the Result Objects pane.
7. Drag the Future Guests object to the Query Filters pane and create a report filter that restricts the future guests to greater than n.
8. Click Run Query.
   The query returns the combined list of years and reservation years.

### 10.6 Combined query precedence

The order of execution in a combined query is crucial in determining the final result.

In the simplest form of combined query you combine two or more queries in a relationship as follows:

<table>
<thead>
<tr>
<th>Query</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1</td>
<td>US; UK; France; Germany</td>
</tr>
<tr>
<td>INTERSECTION</td>
<td></td>
</tr>
<tr>
<td>Query 2</td>
<td>US; France; Finland</td>
</tr>
<tr>
<td>INTERSECTION of 1 and 2</td>
<td>US; France</td>
</tr>
</tbody>
</table>
10.6.1 Nesting combined queries

By default, each time you add a combined query, it is combined at the initial combination level with existing queries. Each added query extends the list of combined queries. If you add Query 3 to Query 1 and Query 2, which are already combined in a UNION relationship, you get the following result:

<table>
<thead>
<tr>
<th>Query</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 3</td>
<td>US; Spain</td>
</tr>
<tr>
<td>Final INTERSECTION</td>
<td>US</td>
</tr>
</tbody>
</table>

You can also nest combined queries in complex, multi-level relationships to control the order of execution, as in the following example, which combines the result of Query 1 MINUS Query 2 in an INTERSECT relationship with Query 3.

<table>
<thead>
<tr>
<th>Query</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query 1 MINUS Query 2</td>
<td>US; UK; Spain</td>
</tr>
</tbody>
</table>

Query groups are processed from right to left and from top to bottom within each group. (Higher-precedence groups, such as the MINUS group in the above example, appear indented to the right.) In the above example the first query to be calculated is the MINUS query. The result of the MINUS query is then combined in an INTERSECT query with Query 3.
10.6.2 To set the order of precedence of combined queries

1. Build the queries you want to organize in the Combined Queries panel.
2. To nest a pair of queries, click on the "add new combined query node" button in order to create a new combined query node, then drag and drop a query on to the query with which you want to associate the nested pair.
   The new combined query node is by default a UNION relationship.
3. Continue adding queries to the nested group by dragging and dropping them on to the space between any two queries already in the group.
4. To create further nested groups within an existing higher-precedence group, repeat the previous two steps.
5. Click the combination operators of all the groups in the query to change them as required.

Related Topics
• To build a combined query
Filtering data using subqueries

11.1 Subqueries defined

A subquery is a more flexible kind of query filter that allows you to restrict values in more sophisticated ways than is possible with a ordinary query filters.

Subqueries are more powerful than ordinary query filters for the following reasons:

- They allow you to compare the values of the object whose values are used to restrict the query with values from other objects.
- They allow you to restrict the values returned by the subquery with a WHERE clause.
- They allow you to pose complex questions that are difficult or impossible to formulate with simple query filters. For example: what is the list of customers and their associated revenue where the customer purchased a service that had previously been reserved (by any customer) in Q1 of 2003?

Subqueries work by modifying the SQL that is generated to retrieve the query data. The SQL contains a subquery that restricts the data returned by an outer query. SQL is the query language supported by all relational databases (RDBMS), although each database has its own syntax. For more information on SQL subqueries, see any book on SQL.

Note:

- Subqueries are not supported in all databases. If they are not supported, the option to build subqueries does not appear in the query panel.
- You can build subqueries using dimensions, attributes and measures only. You cannot build subqueries using hierarchical objects.

Related Topics

- To build a subquery
- Subquery parameters

11.2 To build a subquery

1. Add the objects that you want to appear in the query to the Result Objects pane.
2. Select the object in the **Result Objects** pane that you want to filter with a subquery and click **Add a subquery** at the top right of the **Query Filters** pane.

   - The subquery outline appears in the **Query Filters** pane. By default the object you selected appears as the Filter object and Filter By object.

3. To add a **WHERE** condition to the subquery, drag a report object to the area of the subquery below the **Drop an object here** boxes.

4. To add a **WHERE** condition to the subquery, drag a report object to the area of the subquery below the **Drop an object here** boxes.

   - You can use an existing subquery or standard query filter as a **WHERE** condition in a subquery. To do so, drag and drop the existing filter or subquery to the area of the subquery below the **Drop an object here** boxes. To copy rather than move the existing filter to the **WHERE** condition, hold down the Control key while dragging and dropping. In this case the existing filter remains in its initial place and becomes part of the **WHERE** condition of the subquery.

5. Select the operator and values used to filter the object in the **WHERE** condition.

6. Click **Subquery** to add an additional subquery to the query filter.

   - In addition to linking subqueries in AND or OR relationships, you can nest them (create subqueries within subqueries) by dragging an existing subquery to the area beneath the **Drop an object here** boxes. In this case the inner subquery becomes part of the **WHERE** condition of the outer subquery. To copy rather than move the subquery to the **WHERE** condition, hold down the Control key while dragging and dropping. In this case the second subquery remains at the same level as the first, and becomes part of the **WHERE** clause of the first.

   - By default the two subqueries are linked in an AND relationship. Click the AND operator to toggle between AND and OR.

7. To nest a subquery (create a subquery within a subquery), drag an existing subquery to the area beneath the **Drop an object here** boxes.

   - To copy rather than move the subquery to the **WHERE** condition, hold down the Control key while dragging and dropping. In this case the second subquery remains at the same level as the first, and becomes part of the **WHERE** clause of the first.

   - The inner subquery becomes part of the **WHERE** condition of the outer subquery.

**Related Topics**

- Subqueries defined
- To find out which customers bought a service that had previously been reserved in Q1 of 2003, and how much revenue have they generated
- Subquery parameters

11.3 **To find out which customers bought a service that had previously been reserved in Q1 of 2003, and how much revenue have they generated**

   - The query panel is open.
1. Drag the Customer and Revenue objects to the Result Objects pane of the Query Panel.
2. Select the Service object.
3. Click **Subquery**.
   The subquery outline appears in the Query Filters pane.

   **Note:**
   The selected object appears in both boxes in the subquery outline. You often use the same object in both boxes, although this is not required. If the objects do not return any common values, the subquery returns no values, and the query therefore returns no values.

4. Drag the Reservation Year object to the area of the subquery outline beneath the Service objects to add a WHERE condition on the Reservation Year object.
5. Set the Reservation Year condition operator to Equal To.
6. Type ‘FY2003’ in the **Type a constant** box.
7. Drag the Reservation Quarter object to the area of the subquery outline beneath the Service objects to add the Reservation Quarter object to the WHERE condition.
8. Set the Reservation Quarter condition operator to Equal To.
9. Type ‘Q1’ in the **Type a constant** box.
10. Click **Run Query** to run the query.

### 11.4 Subquery parameters

A subquery or set of subqueries contains the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Object(s)</td>
<td>The object whose values are used to filter the result objects.</td>
</tr>
<tr>
<td></td>
<td>You can include more than one Filter Object. If you do, the values of the</td>
</tr>
<tr>
<td></td>
<td>objects you select are concatenated.</td>
</tr>
<tr>
<td>Filter By Object(s)</td>
<td>The object that determines which Filter Object values the subquery returns.</td>
</tr>
<tr>
<td></td>
<td>You can include more than one Filter By object. If you do, the values of</td>
</tr>
<tr>
<td></td>
<td>the objects you select are concatenated.</td>
</tr>
</tbody>
</table>
Filtering data using subqueries

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>The operator that specifies the relationship between the Filter object and the Filter By object. Because of database restrictions you cannot use certain combinations of operators and Filter By objects together. For example, if you use the Equal To operator with a Filter By object that returns multiple values, the database rejects the SQL because this type of subquery requires the Filter By object to return one value only. In cases where the generated SQL is rejected by the database, you see an error message showing the error description returned by the database.</td>
</tr>
<tr>
<td>WHERE condition (optional)</td>
<td>An additional condition that constrains the list of values of the Filter By object. You can use ordinary report objects, predefined conditions or existing query filters (including subqueries) in the WHERE condition.</td>
</tr>
<tr>
<td>Relationship operator</td>
<td>If there is more than one subquery, this operator determines the relationship between the subqueries. AND - the conditions in all of the subqueries must be satisfied. OR - the conditions in any one of the subqueries must be satisfied.</td>
</tr>
</tbody>
</table>
Ranking data using database ranking

12.1 Database ranking defined

When you rank data you sort and filter it according to ranking criteria. You can return unranked data from a database, then rank it in your report. Database ranking allows you to rank data at the database level, so that the data returned by the query is already ranked.

Database ranking has the following advantages:

• Ranking data can be processing-intensive. By ranking at the database level you allow the server, which is typically far more powerful than the client machine, to perform this processing.

• Pre-ranking data reduces the amount of data retrieved across the network and stored in your document.

Database ranking works by modifying the script generated by the query. If the database on which your query is based does not support ranking, the option to build a ranking is not available in the query panel.

Note:
You cannot include hierarchical objects in database rankings.

Related Topics
• Ranking data

12.2 Database ranking parameters

A database ranking is available in the Query Filters pane of the Query Panel. The following table describes the parameters from left to right in the ranking:
## Ranking data using database ranking

### Parameter | Description
---|---
**Ranking direction and type** | - Top - ranks the first [number of records] values of the ranked dimension in descending order.
- Bottom - ranks the first [number of values] values of the ranked dimension in ascending order.
- Top% - ranks the first [number of records] percent of the values of the ranked dimension in descending order.
- Bottom% - ranks the first [number of records] percent of the values of the ranked dimension in descending order.

<table>
<thead>
<tr>
<th>Number of records /percentage</th>
<th>The number of records (for example, the top 10) or the percentage of records (for example, the bottom 10%) to return in the ranking</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ranked dimension</strong></td>
<td>The dimension used in the ranking. For example, if the dimension is Region and the ranking is Top 10, the ranking returns the top 10 regions.</td>
</tr>
<tr>
<td><strong>Based on</strong></td>
<td>The measure by which the dimension is ranked. For example, if the measure is Revenue and the dimension is Region, the ranking orders regions by the amount of revenue they generate.</td>
</tr>
<tr>
<td><strong>Ranked by (optional)</strong></td>
<td>Dimension that specifies additional calculation context for the ranking. For example, if the ranking dimension is Region, the measure is Revenue and the Ranked by dimension is Country, the regions are ranked by revenue within each country.</td>
</tr>
<tr>
<td><strong>Where condition (optional)</strong></td>
<td>Additional restriction on the values returned in the ranking that appears below the other parameters. For example, a ranking of regions with a condition that restricts Country to &quot;USA&quot; ranks only those regions in the USA.</td>
</tr>
</tbody>
</table>

### 12.3 To create a database ranking

1. Add the objects that you want to appear in your query to the **Result Objects** pane of the query panel.
2. Click **Add ranking** on the toolbar at the top of the **Query Filters** pane.
The ranking outline appears in the Query Filters pane.

**Note:**
The Add ranking button is disabled if your database does not support ranking.

3. Select the ranking direction and type (Top, Top%, Bottom, Bottom%).

4. Type the number of records (if you selected Top or Bottom) or percentage of records (if you selected Top% or Bottom%) you want the ranking to return in next box.

You can specify a prompt instead of a constant by clicking on the arrow next to the number and selecting **Prompt**. When you select a prompt the user must enter the ranking number when the query is run.

5. Drag the ranking dimension to the box to the left of the **Based on** box.

6. Drag the measure on which you want to base the ranking to the **Based on** box.

7. Drag the dimension that provides the calculation context for the measure to the **Ranked by** box. This dimension is optional. To display the **Ranked by** box, click the arrow to the right of the **Based on** measure.

8. Drag any dimensions that you want to include in the WHERE restriction to the area at the bottom of the ranking.

9. Click Run Query.

**Related Topics**
- Subqueries defined

### 12.4 To rank the top 10 employees by salary in each department

The query panel is open.

1. Drag the Department, Employee Name, and Salary objects to the **Report Objects** pane within the Query Panel.

2. Click Add ranking at the top of the Query Filters pane. An outline database rank is added to the Query Filters pane.

3. Rank the top 10 employees in descending order by setting the ranking direction/type to Top, and the number of records to 10 in the box next to Top.

4. Rank employees by dragging the Employee Name object to the box to the right of the number of records.

5. Base the ranking of employees on salary by dragging the Salary object to the **Based on** box.

6. Click the arrow next to the **Based on** measure if the **Ranked by** box is not already visible to display the **Ranked by** box.

7. Rank employees based on salary by department by dragging and dropping the Department object to the **Ranked by** box.

8. Run the query to return the ranking.
13.1 Hierarchical and non-hierarchical data

Depending on their data source, reports can contain non-hierarchical or hierarchical data. Non-hierarchical and hierarchical data behaves differently and you work with it in different ways.

13.1.1 Working with non-hierarchical data

Non-hierarchical data has no parent-child relationships. A dimension is an example of a non-hierarchical object. For example, the [Country and ][City] dimensions, displayed in a table, display their values as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
</tr>
<tr>
<td>US</td>
<td>Atlanta</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
</tr>
<tr>
<td>France</td>
<td>Rennes</td>
</tr>
</tbody>
</table>

Although the data has a hierarchical relationship (for example, "New York" and "Atlanta" are child values of "US", the data appears in non-hierarchical columns and the parent-child relationship is not expressed in the data structure.

You can analyze non-hierarchical data in many ways in your reports, for example by sorting or filtering it.

13.1.2 Working with hierarchical data
Hierarchical data organizes data in parent-child relationships, and you can use these relationships to navigate and analyze the data and the results returned by related measures.

Measures associated with hierarchies are aggregated based on the position of the data in the hierarchy. For example, the [Revenue] measure calculates total revenue for [San Diego] and total revenue for [California] (at a less detailed level of aggregation) when associated with a [Geography] hierarchy. Navigating the hierarchy allows you to explore different measure values at different levels of the hierarchy.

How hierarchical data appears and behaves depends on the report element that contains it.

Related Topics

- Working with non-hierarchical data

13.1.2.1 Restrictions concerning reporting with hierarchical data

The table below lists the restrictions that apply when reporting on hierarchical data. These restrictions are repeated in the appropriate sections in this guide.

Table 13-2: Restrictions when reporting with hierarchies

<table>
<thead>
<tr>
<th>The limitation concerns...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEx query measures</td>
<td>BEx query measure: the measure which aggregates with sum function and without exception of aggregation, aggregates in sum in Web Intelligence. The other types of measure aggregation are delegated.</td>
</tr>
<tr>
<td>Break on measure or detail</td>
<td>A break is always associated with the sort on the object where it is applied. For this reason, any hierarchy in the table the where break applies, the hierarchy becomes flat. The user can remove the break on the underlying object to restore the hierarchy.</td>
</tr>
<tr>
<td>The limitation concerns...</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Delegated measure aggregation</td>
<td>Delegated measure aggregation returns #TOREFRESH, when the required aggregation is not available in the query. The user has to refresh the document to get the new level of aggregation. This occurs for example when using the filter bar when the user selects a value before “all value” and vice versa when selecting “all value” before a selected value. Delegated measure aggregation returns #unavailable if it is asked in the context of a formula on a dimension, or multi-valued filter on dimension not in the context of the aggregation of the measure. This occurs for example when defining a URL on top of a dimension in a table where there is a delegated measure. In that case it is recommended to create a variable on top of the URL formula as a detail of the original dimension and include (but hide) the original dimension in the block.</td>
</tr>
<tr>
<td>Drilling</td>
<td>There is no drill-replace capability on objects from a BEx query (there is no navigation path). There is no query drill on OLAP .unx sources.</td>
</tr>
<tr>
<td>Expand/Collapse</td>
<td>Symmetric-Asymmetric expand/collapse: when the user is doing collapse/expand on a hierarchy that is to the right of another hierarchy, the system is doing an asymmetric collapse/expand: the collapse/expand action is done only for the selected member for a given member on the hierarchy on the left. The user can explicitly ask for a symmetric collapse/expand, in that case the action is done for any instances of the selected member (for all the members of the hierarchy on the left). The system is doing symmetric collapse expand by default on a hierarchy that is at the right of a dimension (in that case default collapse/expand and symmetric collapse/expand is producing the same result). Collapse-expand on hierarchy which is changing on refresh (hierarchy node variable, prompted member selection, modification at the cube level), may be blocked after a refresh from the preview from the query panel. In that case, the user can drag and drop the hierarchy again in the column to recover from that situation.</td>
</tr>
</tbody>
</table>
### The limitation concerns...

<table>
<thead>
<tr>
<th>Filtering on hierarchies</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A report/table filter where there is a hierarchy may remove rows without respecting the hierarchy structure. For this reason, a filter can remove a parent node currently expanded and but keep leaves or nodes collapsed. To avoid returning an empty table in this case the system automatically expands the hierarchy in the block to shows the resulting members.</td>
<td></td>
</tr>
<tr>
<td>A filter can remove an intermediary node of a hierarchy. In that case, the user cannot access to the next level of member from the parent node with a simple expand action. To see the descendant of the parent node, the user can do an expand all.</td>
<td></td>
</tr>
<tr>
<td>It is not possible to filter on a merge object based on hierarchy.</td>
<td></td>
</tr>
<tr>
<td>Filter bar (drill bar): when filtering through the filter bar on a hierarchy, selecting a node that is not shown in the table because it is collapsed, the table is shown empty. The user can do an expand all to see all the value.</td>
<td></td>
</tr>
<tr>
<td>Filtering from the filter bar is filtering on the caption (even for OLAP business objects that have a key).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flattening hierarchies</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a hierarchy is flattened: when a hierarchy becomes flat the system shows all the members of the hierarchy at the same level like for a dimension without using + - to navigate and without contextual menu “collapse/expand”.</td>
<td></td>
</tr>
<tr>
<td>The limitation concerns...</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Merged objects</td>
<td>It is not possible to filter on a merged object based on a hierarchy. Merged object with hierarchy: a merge object based on a hierarchy cannot be directly used in the report. This is because in some case where the original hierarchy as conflicting hierarchy structure (a member A is descendant of another member B, whereas in the other hierarchy the member A is ancestor of member B) the system cannot build a merge hierarchy. In that case the system prevents form dragging the merge object. In case of the user build a formula using the merge object the system returns #SYNTAX. The user can use directly the original hierarchy instead in the report. Merge on key for OLAP business object: the data synchronization of the same object from the same source (cube or BEx query) is based on the internal key of the value of these objects. In the other case it is based on the caption.</td>
</tr>
<tr>
<td>OLAP</td>
<td>The order of an OLAP dimension member in a report LOV (filter bar, input control) are ordered ascending in lexicographical order. Filtering on OLAP object from the filter UI filter based on the key of the given object. Filtering from input control on OLAP dimension is filtering on caption. Filtering on a hierarchy is filtering on key.</td>
</tr>
<tr>
<td>Query stripping</td>
<td>Query stripping is available for .unv, OLAP, and BEx query sources. For other type sources it is not available.</td>
</tr>
<tr>
<td>Ranking on hierarchical data in a table</td>
<td>A ranking on a table where there is a hierarchy does not take into account the hierarchy structure of the data. For this reason, any hierarchy in a table where the user defines a ranking becomes flat.</td>
</tr>
</tbody>
</table>
13.1.2.2 Working with hierarchical data in tables

Hierarchies appear in tables as hierarchical columns. A hierarchical column displays the hierarchy in parent-child relationships. You can explore the hierarchy by expanding and collapsing its values.

Example:
The following table displays the [Product] hierarchy and the [Revenue] measure:

<table>
<thead>
<tr>
<th>Product</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>203,124</td>
</tr>
<tr>
<td>Baking Goods</td>
<td>100,101</td>
</tr>
<tr>
<td>Beverages</td>
<td>54,345</td>
</tr>
<tr>
<td>Breads</td>
<td>48,678</td>
</tr>
</tbody>
</table>

The measure displays the total revenue for the corresponding value in the hierarchy. For example, the total revenue for Grocery products is 203,124.

You can find more information about Beverages by clicking on the [Beverages] member:
When you expand the member, the Revenue column also displays the measure values associated with different kinds of beverage.

### 13.1.2.3 Hierarchical data in cross tables

Hierarchical data behaves similarly in cross tables to how it behaves in tables. If an axis of the crosstab is based on a hierarchy, you can click a data item to expand it.

**Example: Hierarchical data in a cross table**

The following crosstab has the [Time] hierarchy on the vertical axis and the [Product] hierarchy on the horizontal axis.

<table>
<thead>
<tr>
<th>Time</th>
<th>Grocery</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>203,110</td>
</tr>
<tr>
<td>2009</td>
<td>321,400</td>
</tr>
<tr>
<td>2010</td>
<td>350,444</td>
</tr>
</tbody>
</table>

If you click the [Grocery] item, it expands to display its child items and displays the corresponding measure values..
13.1.2.4 Exploring hierarchies

13.1.2.4.1 To expand and collapse all the hierarchies in a table
You can expand all the hierarchies in a table to show all possible combinations of hierarchy members.
1. To expand all the hierarchies in a table, right-click anywhere in the table and select Hierarchical Navigation > All > Expand All Hierarchies.
2. To collapse all the hierarchies in a table, right-click anywhere in the table and select Hierarchical Navigation > All > Collapse All Hierarchies.

13.1.2.4.2 Exploring a hierarchy asymmetrically
Asymmetric exploration is the way you explore a hierarchy by default when you click on members to expand or contract them.

When you explore a hierarchy asymmetrically, your expand and collapse actions are applied only to the current value of the other dimensions that appear to the left of the explored hierarchy.

Example: Asymmetric exploration

<table>
<thead>
<tr>
<th>Product</th>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>California</td>
<td>540,000</td>
</tr>
<tr>
<td>Beverages</td>
<td>California</td>
<td>453,300</td>
</tr>
</tbody>
</table>

If you expand the [California] member to display cities in California in the first row of the table, the expansion applies only to the current value (Grocery) of the [Product] dimension.
### To explore a hierarchy asymmetrically

1. To expand the child members of a member, click the member, or right-click and select **Expand Children** from the menu.
   
   The hierarchy expands only for the current value of the dimensions or hierarchies to the left of the expanded hierarchy in the table.

2. To expand all descendant members of a member, click the member, or right-click and select **Expand Descendants**.
   
   The hierarchy collapses only for the current value of the dimensions or hierarchies to the left of the expanded hierarchy in the table.

3. To collapse the child members of a member, click the expanded member, or right-click and select **Collapse Children**.
   
   The hierarchy collapses only for the current value of the dimensions or hierarchies to the left of the collapsed hierarchy in the table.

### 13.1.2.4.3 Exploring a hierarchy symmetrically

When you explore a hierarchy symmetrically, your expand and collapse actions are applied in relation to all values of the other hierarchies or dimensions that appear to the left of the explored hierarchy in the table.

**Example:** *Symmetric exploration*

If you expand the [California] member on the first row to display cities in California, the expansion applies to both values of the [Product] dimension.

<table>
<thead>
<tr>
<th>Product</th>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>California</td>
<td>540,000</td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>320,000</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>100,000</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>120,000</td>
</tr>
<tr>
<td>Beverages</td>
<td>California</td>
<td>453,300</td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>120,000</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>200,000</td>
</tr>
<tr>
<td></td>
<td>San Francisco</td>
<td>133,300</td>
</tr>
</tbody>
</table>

**To explore a hierarchy symmetrically**

1. To expand the child items of a member, right-click the member and select *Hierarchical Navigation > Symmetric > Expand Children*.
   The hierarchy expands for all values of the dimensions or hierarchies to the left of the expanded hierarchy in the table.

2. To expand all descendant items of a member, right-click the member and select *Hierarchical Navigation > Symmetric > Expand Descendants*.
   The hierarchy expands for all values of the dimensions or hierarchies to the left of the expanded hierarchy in the table.

3. To collapse the child members of a member, right-click the member and select *Hierarchical Navigation > Symmetric > Collapse Children*.
   The hierarchy collapses for all values of the dimensions or hierarchies to the left of the collapsed hierarchy in the table.

13.1.2.4.4 Changing the drill focus of a hierarchy

You can change the drill focus when exploring hierarchies. When you change the drill focus you filter out the parent member and all members at and above its level when expanding it.

Changing the drill focus is useful when creating charts on hierarchical data. Because measure values associated with parent members are more aggregated than their child members, it is difficult to display them on the same chart axis using the same scale. By removing the parent member, it is possible to display the values for the child members using the same scale.
Example: Drilling down on a hierarchy

You have the following data in a table:

<table>
<thead>
<tr>
<th>Time</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>29,358,677.22</td>
</tr>
<tr>
<td>2009</td>
<td>30,242,323</td>
</tr>
<tr>
<td>2010</td>
<td>45,320,243</td>
</tr>
</tbody>
</table>

When you drill down on the [2010] member, you see the following display:

<table>
<thead>
<tr>
<th>Time</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>12,500,650</td>
</tr>
<tr>
<td>Q2</td>
<td>14,353,231</td>
</tr>
<tr>
<td>Q3</td>
<td>8,342,231</td>
</tr>
<tr>
<td>Q4</td>
<td>10,124,131</td>
</tr>
</tbody>
</table>

The year members, with values that are much larger than the measure values of the quarter members, do not appear in the display.

To change the drill focus of a hierarchy

1. To drill down on a hierarchy, in the Web interface, right-click the member you want to expand and select Start Drill > Drill down to.
   a. In the Rich Internet Application interface, right-click the member you want to expand and select Start Drill > Drill
2. To drill up on a hierarchy, right-click any child member of a member you previously drilled down on and select Drill Focus > Drill Up.

13.1.2.5 Aggregating hierarchical data

13.1.2.5.1 How hierarchical data is aggregated

Hierarchical measure data is aggregated differently depending on whether the method of aggregation is default or explicit. The aggregation logic is based on the following rules:

- Data sets used for aggregation:
1. When there is a hierarchy in a measure context, the measure values for the root members of the hierarchy are aggregated—this is by default (the Aggregate() mechanism is not explicitly declared).
2. For explicit types (sum, max, min), the hierarchical nature of the data is ignored. All the visible data is aggregated, including data that has already been aggregated (parent members already aggregated).

- Sensitivity to the collapse/expand status.
  1. Explicit aggregation only aggregates visible data, except when the set expression is used for a specific hierarchy, then an aggregation is performed on the objects defined in the set expression.
  2. Default aggregation including the aggregate() function is not sensitive to the state of the collapse/expand.

Default aggregation

With default aggregation (including Aggregate() function), we do a non-redundant aggregation (no double-counting). Default aggregation uses the default aggregation function for the data in the hierarchy. If you include a measure in a cell without specifying an aggregation function, or if you use the Aggregate() function, the measure is calculated using the default aggregation function.

Default aggregation uses the rolled-up values returned by the database—in other words, it is compatible with the aggregated values returned by the database. Default values are calculated by applying the default aggregation function to all the root values in the hierarchy. This means that default aggregation does not count values more than once except in situations where the same value appears beneath different root items in a hierarchy. (In the example below, the root items are [Drink] and [Food] and no items appear beneath both root items.)

Example: Default aggregation

You place [Unit Sales] in a free-standing cell in a report that contains the hierarchy below. The default aggregation function is sum; as a result, the value in the free-standing cell is 43,791 (24,597 + 19,194). The application returns a value by applying the default aggregation function to the root values of the hierarchy.

<table>
<thead>
<tr>
<th>Product</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drink</td>
<td>24,597</td>
</tr>
<tr>
<td>Alcoholic Beverages</td>
<td>6,838</td>
</tr>
<tr>
<td>Beverages</td>
<td>13,573</td>
</tr>
<tr>
<td>Food</td>
<td>19,194</td>
</tr>
<tr>
<td>Baked Goods</td>
<td>7,870</td>
</tr>
</tbody>
</table>
**Explicit aggregation**

With explicit aggregation (excluding Aggregate() function), we do a redundant aggregation (without caring of parent-child relation). Explicit aggregation includes a specific aggregation function (for example Sum) directly in a formula.

In explicit aggregation, the application references the visual state of the hierarchy. As a result, values can be counted more than once, and the result of calculations can change depending on whether an item is expanded or collapsed.

If the same value is included more than once in an explicit aggregation, it can be counted more than once depending on the visual state of the hierarchy. For example, if an item is expanded, and an explicit aggregation references both the item and one if its child items, the value of the child item is counted twice in the calculation.

**Related Topics**

- Examples of default and explicit aggregation

**Examples of default and explicit aggregation**

**Example:** Default and explicit aggregation

You have a hierarchy with the following data and the hierarchy appears fully expanded in a report:

<table>
<thead>
<tr>
<th>Product</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drink</td>
<td>24,597</td>
</tr>
<tr>
<td>Alcoholic Beverages</td>
<td>6,838</td>
</tr>
<tr>
<td>Beverages</td>
<td>13,573</td>
</tr>
<tr>
<td>Food</td>
<td>19,194</td>
</tr>
<tr>
<td>Baked Goods</td>
<td>7,870</td>
</tr>
</tbody>
</table>

- Placed in the table footer, [Unit Sales] returns 43,791. This default aggregation returns the total aggregated value of the measure (24,597 + 19,194).
- Placed in a table footer, Sum([Unit Sales]) returns 72,072. This explicit aggregation counts every visible value in the hierarchy (24,597 + 6,838 + 13,573 + 19,194 + 7,870).
- The explicit aggregation Sum([Unit Sales]; [Product]&[Drink].children) returns 20,411 (6,838 + 13,573) because [Drink] is expanded.
- The explicit aggregation Sum([Unit Sales]; ([Product]&[Drink]; [Product]&[Beverages])) returns 38.170 (24,597 + 13,573). The value for [Beverages] appears twice in the calculation because [Drinks] is expanded.
• The default aggregation Aggregate([Unit Sales]; {[Product].&[Drink]; [Product].&[Beverages]}) returns 24,597. The value for [Beverages] does not appear twice in the calculation.

If you collapse the [Drink] node in the report, the calculations are as follows:

• [Unit Sales] returns 43,791. The default aggregation is not affected by the change in display.
• Sum([Unit Sales]) returns 51,661 (24,597 + 19,194 + 7,870). The explicit aggregation uses all the visible values to return the value.
• Sum([Unit Sales]; [Product].&[Drink].children) returns a non-NULL value even though the child members of [Drink] are not visible.
• Sum([Unit Sales]; {[Product].&[Drink]; [Product].&[Beverages]}) returns 38,170 because [Beverages] is not visible. The explicit aggregation uses visible values only.
• Aggregate([Unit Sales]; {[Product].&[Drink]; [Product].&[Beverages]}) returns 24,597. The default aggregation is not affected by the change in display.

13.2 Finding text

13.2.1 To find text in a report

1. Click Find on the bottom toolbar to display the Find bar beneath the reports.
2. Type the text you want to find in the Find box.
3. Click the arrow next to the box and select Match case to perform a case-sensitive search, or Ignore case.
4. If the text occurs more than once, click Next or Previous to highlight other occurrences of the text, or Highlight all to highlight all occurrences of the text.

13.3 Viewing modes

13.3.1 Viewing modes defined
You can view reports in different modes depending on how you want to work with data and how you want the data to appear.

13.3.1.1 Page mode

Page mode displays the page layout of reports, including page margins, headers, and footers.

Use Page mode when you want to fine-tune the formatting of tables and charts and the layout of report pages.

13.3.1.1.1 Setting the report size in Page mode

You can set a report size to a specific percentage, or to a specific number of pages in its height and width. For example, if you set a report to be one page tall, all elements on the report are re-organized to fit on one horizontal page.

Setting the report size overrides all other settings that control the page layout of a report. For example, if you have a report with three sections and the report is set to start each section on a new page, the report still contains one page only if the report is set to be one page tall.

The report size setting takes effect in Page mode only.

To set the report size
1. In Design mode, select the Page Setup tab.
2. Select the report width in the Width box and the height in the Height box, or set the report size as a percentage in the Scale box.
   If you define a percentage, the width and height are calculated automatically.

13.3.1.2 Quick Display mode

Quick Display mode is the default display mode. It is a pagination mode that is based on the data, rather than the physical size of report pages. Quick Display mode displays just the tables, reports, and free standing cells in reports and displays a maximum number of records vertically and horizontally, depending on the Quick Display settings. Quick Display mode also specifies the minimum page width and height and the amount of padding around the edges of the report.

Because Quick display mode restricts the number of horizontal and vertical rows, a report might not contain all possible data.

Use Quick Display mode when you want to focus on analyzing results, add calculations or formulas, or add breaks or sorts to tables to organize results.
The Quick Display mode properties are configurable either by your administrator, or directly in the application.

<table>
<thead>
<tr>
<th>Property</th>
<th>Configuration</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum vertical records</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>Maximum horizontal records</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>Minimum page width</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>Minimum page height</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>Right padding</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>Bottom padding</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>Vertical records per page</td>
<td>Application</td>
<td>• Impacts horizontal tables and crosstabs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Horizontal tables are never cut vertically</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The number of rows in a horizontal table is ignored in vertical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>records calculation</td>
</tr>
<tr>
<td>Horizontal records per page</td>
<td>Application</td>
<td>• Impacts vertical tables, forms and crosstabs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The number of rows in a vertical table is ignored in horizontal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>records calculation</td>
</tr>
</tbody>
</table>

Other notes:
- Table headers and footers do not count as rows.
- Free standing cells and charts do not count as rows.
- Section cells do not count as rows when the section is not empty.
- Sections cells count as vertical rows when the section is empty.
- The Avoid Page Break in Block option has no effect in Quick Display mode

13.3.1.2.1 To change Quick Display mode settings

You can change the number of horizontal and vertical records per page in Quick Display mode.

1. Right-click the report and select **Format Report** to display the "Format Report" dialog box.
2. Select the **General** tab.
3. Select the number of horizontal and vertical records per page in the **Page Content (Quick Display mode only)** section.

13.3.2 To switch between viewing modes
1. To display a report in Quick Display mode, click **Quick Display** on the status bar.
2. To display a report in Page mode, click **Page** on the status bar.

### 13.4 Folding and unfolding report data

You can hide and display report data by folding and unfolding the display of different report elements. You can fold and unfold sections, breaks and tables. Data is concealed and displayed in different ways depending on the report element.

<table>
<thead>
<tr>
<th>Report element</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section</strong></td>
<td>When a section is folded, section details are hidden and free cells only are displayed. In Reading mode, you can fold and unfold sections with the DHTML viewer (web viewer), the Java Applet (Rich internet application), and Web Intelligence Rich Client.</td>
</tr>
</tbody>
</table>
| **Table or break** | When a table or break is folded, the rows are concealed and headers and footers only are displayed. (Tables must have headers and footers to be folded and unfolded.)

Vertical tables, horizontal tables and cross tables can be folded and unfolded.

In Reading mode, you can fold and unfold sections with the Java Applet (Rich internet application) and Web Intelligence Rich Client. You cannot fold and unfold tables with the DHTML viewer (web viewer). |

### 13.4.1 To fold and unfold report data

You can fold and unfold data in Reading and Design mode by activating the Outline.

1. In Reading mode, select **Outline** on the toolbar to display the Fold/Unfold bar to the top and left of the report.

   With the DHTML viewer, you can fold and unfold sections only in Reading mode. With Web Intelligence Rich Client and the Java Applet (Rich internet application), you can can fold and unfold sections and tables while in Reading mode.

2. In Design mode, select **Analysis > Interact > Outline** to display the Fold/Unfold bar to the top and left of the report.
3. Use the +/- icons on the bar, which correspond to and are aligned with individual report elements, to fold and unfold specific report elements.

4. Use the icons at the bottom left or upper right of the bar to fold and unfold all instances of a type of report element.

13.5 To redisplay all hidden content in a report

You can hide tables, cells and sections in reports.

- Right-click the report containing hidden content and click **Show All Hidden Content**.

13.6 Printing reports

You print documents report-by-report. You can print one or multiple reports from a single document.

Reports are printed from left to right, and then top to bottom. If a report is wider than the width of the paper size defined in the Report Page Layout, page breaks are inserted.

The paper size and page orientation for printing can be different from the paper size and page orientation set for the reports when you view them in the in the Java or desktop interface. This enables users using different printers to specify the appropriate layout when they print.

You print documents directly from the Java and desktop interfaces. When you print from the HTML interface, you export the document to a PDF file that you can then print.

13.6.1 To print reports

1. Click **Print** on the **File** tab.
   - If you are using the HTML interface, the "File Download" dialog box appears.
   - If you are using the Java or desktop interface, the "Print" dialog box appears.

2. Choose your printing options and print the report.
Displaying data in tables

14.1 Overview of tables

When you create a new document and run the query the first time to display the results, the document contains a report that includes the query results in a vertical table. You can do the following

- Modify how the table is organized
- Remove or add data
- Insert other rows or columns
- Change the table type to display the results differently
- Turn the table into a chart to display the results differently
- Insert other tables

14.2 Table types

14.2.1 Vertical table

Vertical tables display header cells at the top of the table and the corresponding data in columns. By default, the header cells display the names of the dimensions, details, and measures included in the table. The body cells display the corresponding values.
14.2.2 Horizontal table

Horizontal tables display header cells at the left of the table and the corresponding data in rows. By default, the header cells display the names of the dimensions, details, and measures included in the table. The body cells display the corresponding values.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Sales revenue</th>
<th>Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$9,114,546</td>
<td>$3,809,135</td>
</tr>
<tr>
<td>City Shirts</td>
<td>$347,775</td>
<td>$152,302</td>
</tr>
<tr>
<td>City Trousers</td>
<td>$284,734</td>
<td>$104,346</td>
</tr>
<tr>
<td>Dresses</td>
<td>$2,915,620</td>
<td>$1,173,881</td>
</tr>
<tr>
<td>Jackets</td>
<td>$677,307</td>
<td>$286,130</td>
</tr>
<tr>
<td>Leather</td>
<td>$187,413</td>
<td>$70,999</td>
</tr>
<tr>
<td>Outerwear</td>
<td>$1,183,083</td>
<td>$474,302</td>
</tr>
<tr>
<td>Overcoats</td>
<td>$436,668</td>
<td>$186,522</td>
</tr>
<tr>
<td>Shirt Waist</td>
<td>$4,016,220</td>
<td>$1,616,218</td>
</tr>
<tr>
<td>Sweaters</td>
<td>$2,839,036</td>
<td>$1,000,673</td>
</tr>
<tr>
<td>Trousers</td>
<td>$903,320</td>
<td>$327,615</td>
</tr>
</tbody>
</table>

14.2.3 Cross tables

Cross tables display values for dimensions across the top axis and on the left axis. The body displays the values of a measure that correspond to the cross-section of the dimensions. For example, this cross table displays values for [Quarter] across the top axis and displays values for [State] on the left axis. The body displays values that [Sales Revenue] for each quarter in each state.
You can include multiple dimensions in cross tables. For example, this crosstable displays two dimensions. The values for the [Sales Revenue] measure are values each state by quarter for each line.

When you create cross tables that include a dimension(s) in the body, the body cell values are calculated according to a multi-dimensional data model. The values displayed in the body are calculated according to all of the coordinates on the table axes, whether or not there is a row for the specific coordinate in the data.

### 14.2.4 Forms

Forms are useful in your report if you want to display detailed information per customer, product, or partner. For example, a form is a useful way of displaying individual customer records with information such as the customer account, name, address, and so on.

Forms are also useful for formatting address labels for envelopes.

### 14.3 Creating and editing tables
14.3.1 To create a table by dragging objects onto a report

You have already selected a data source and created a query for the document you are working with. You are working with a report and want to insert a table in the report. You use the available objects that were created when you created your queries.

1. In Design mode, click **Available Objects** to the left of the report to display the "Available Objects" screen in the Left Pane.
2. Select an object or objects and drag and drop them to an empty part of the report. When you release the cursor the objects appear as columns in a vertical table.
3. To add another object or objects to the table, drag them onto an existing table. To add a column to the left of an existing column, drag the object to the left of the column. To add a column to the right of an existing column, drag the object to the right of the column. To replace an existing column, drag the object to the middle of the column.

14.3.2 To create a table by selecting a template

1. Click **Design > Structure only** to switch to Structure mode. Working in Structure mode allows you to define and preview the new table without requesting the server to apply each of your modifications.
2. Click **Report Elements > Tables > Define Vertical Table/Define Horizontal Table/Define Cross Table/Define Form**.
3. Click the report at the position where you want the table to appear. The "Insert Report Element" dialog box appears.
4. To add table components (column, rows or body cells) depending on whether you are building a vertical, horizontal or cross table or a form, click + to the right of an existing component in the right pane of the dialog box, then select the object to associate with the column, row or body cell from the drop-down list.

**Note:**
You can associate a formula rather than a report object with the component by clicking the arrow next to the component, selecting **Edit Formula** and defining the formula in the "Formula Editor".

5. To delete a table component, click the arrow to its right and select **Delete** from the menu.
6. When you have finished defining the table, select **Design > With Data** to populate it with data.
14.3.3 To apply a different template to a table with Turn Into

You can turn a table into a different format or into a chart. use the right-click option Turn Table Into, or you can select the table or chart style from the "Tools" section of the "Report Elements" tab.

1. Right-click the table you want to reformat, then select Turn Table Into to display the "Turn Into" dialog box.
2. Choose the new table type or chart type.
3. Click OK to close the dialog box.

If you turned a table with a unicode font to a chart, the font is not retained if unicode is not defined as your default font for charts. You need to format the chart with the unicode font. Contact your administrator for further information.

14.3.4 To add table rows or columns

1. Select a cell in the column or row next to which you want to insert another column or row.
2. Right-click and select Insert > Insert row above/Insert row below/Insert column on left/Insert column on right, or select Report Element > Table Layout > Insert > Insert row above/Insert row below/Insert column on left/Insert column on right.
3. Drag an object from the Available Objects pane on the Left Pane to the empty column or row you inserted.

14.3.5 To remove table rows or columns

1. Right-click the table column or row you want to remove and select Delete from the menu.
2. Select Row or Column.
3. Click OK.

14.3.6 To move a row or column

- Drag the selected column or row and drop it before or after another column or row on the table. When you drag a row or column, the column or row header displays next to your pointer.
14.3.7 To swap a row or column

- Drag the selected column or row onto the column or row with which you want to make the swap.

14.3.8 To clear cell contents from a table

You can clear cell contents and then use the empty cells to display images, hyperlinks, formulas, or text you type.

You can clear the following types of cell in a table:
- header cells – you can clear each header cell separately
- footer cells – you can clear each footer cell separately
- related body cells – when you clear one body cell, you automatically clear all of the body cells in the same column or row of the table

1. To select the cell you want to clear, click the cell.
   The cell borders are highlighted.
2. Right-click the selected cell and click Clear contents.

14.3.9 To remove a table

1. To select the table you want to remove, click the top edge of the table.
   A gray border appears around the table.
2. Press the Delete key, or right-click the selected table and select Delete from the shortcut menu.

14.3.10 To copy a table

You can copy and paste tables within a report or into external applications such as Microsoft Word and Excel. You cannot copy tables from one Web Intelligence instance to another.

1. Select the table, right-click and select Copy on the menu.
2. To paste the table to another part of the report, right-click where you want the table to appear and click Paste on the menu.
3. To paste the table into another application, paste the contents of the clipboard from within the other application.

You can also copy a table into another application by dragging and dropping the table directly into the open document in the target application.

The table appears as a picture in the open document if pasted to another application.

14.4 Formatting tables and table cells

14.4.1 To select a background color for the table or cells

You can set the background color for a table or its cells. When the background color of cells are defined (even as white), they take precedence over the table background color. If you try to apply a background color to all of a table, and the cells remain white, make sure that the cells are not set with a white background.

1. Select the table or cell, right-click, then select Format Table or Format Cell.
2. Select the Appearance tab on the dialog box.
3. Click the radio button next to the color palette icon to the right of the No color option.
4. Click the arrow next to the color palette icon to display the palette.
5. Select the color using the palette.
6. Click OK.

14.4.2 To define alternate row and column colors for a table

1. Select the table, right-click, then select Format Table.
2. Select the Appearance tab in the dialog box.
3. In the Alternate Color section, set the frequency with which you want the alternate color to appear for the alternate row color in the combo box next to Frequency.
4. Click the arrow next to Color and select the color using the color palette.
5. Click OK.
14.4.3 To insert an image or skin in a table

1. Select the table, right-click, then select Format Table.
2. Select the Appearance tab in the dialog box.
3. To display a skin, select Skin then select the skin from the list. When you apply a skin to a table, ensure that the horizontal or vertical padding value is greater than 0.00, otherwise the skin will not be displayed.
4. To reference an image using a URL, select Image from URL then type the URL.
   - To access an image on the corporate server, type the image name. The application inserts boimg:// when you click Apply.
   - To access an image file directly, click Image from file, then click Browse to browse to the file.
5. If you chose to reference an image file, use the Display and Position lists to determine how the image appears.
6. Click OK to close the dialog box.
7. To remove the image or pattern, select None for the pattern.

14.4.4 To format table or cell borders

1. Right-click the table or cell, then select Format Table or Format Cell from the shortcut menu.
2. Select the Border tab.
3. Use the controls in the tab to set the border styles and colors.

14.4.5 To format text in table cells

1. Select the cells whose text you want to format. (To select multiple columns or cells, select the first column or cell, hold down the Ctrl key, then continue selecting columns or cells.)
   If you select a cell in a column, all cells in the column are selected.
2. Format the text in the selected cells using the Format Cell > Font toolbox.
3. Select the font, style, size and effects, as required.
4. Click OK.
14.4.6 To set cell height and width

You can define the height and width of cells by using drag and drop or specifying the size of cells in the "Format Cell" dialog box box.

If you want to hide cell contents on reports, you can set the cell width to 0.1 cm so that the cell width can be modified to display the cell contents later.

1. Drag the cell borders until the cell is the height and width you want, or:

2. Select the cells you want to change, right-click and select "Format Cell".

3. Select the General tab.

4. Set the cell height and width.

5. If you want to set the cell to autofit, select Autofit width to content and/or Autofit height to content and set the minimum width and height.

Some functions are incompatible with AutoFit cells. If you place any of these functions in an AutoFit cell, the function returns the #RECURSIVE error message.

You can also set AutoFit cell width and height by double-clicking the cell borders.

- To set AutoFit cell width, double-click the right border of the cell
- To set AutoFit cell height, double-click the bottom border of the cell

AutoFit retains the current cell size as the minimum size and enlarges the cell size, if the string that the cell contains is larger than the minimum size specified.

Note:

- Documents that contain tables with the cell size set to AutoFit, take longer to display than documents where tables contain cells with a fixed cell width and cell height.
- Auto-Height and Auto-Width properties don't work correctly when Read Cell Content is set to HTML in a Web Intelligence report.

14.4.6.1 Effects of autofit and wrap text

The following table lists the effects of the autofit and wrap text features, when used separately and in combination:
<table>
<thead>
<tr>
<th>Feature</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrap text</td>
<td>Text is wrapped at the end of the cell.</td>
</tr>
<tr>
<td>Autofit width</td>
<td>Cell width is adjusted to display all the text.</td>
</tr>
<tr>
<td>Autofit height</td>
<td>Cell height is adjusted to display all the text.</td>
</tr>
<tr>
<td>Autofit width + autofit height</td>
<td>Cell width and height is adjusted to display all the text.</td>
</tr>
<tr>
<td>Wrap text + autofit width</td>
<td>Cell width is adjusted to accommodate the longest word. Because the cell height is not adjusted to the number of lines of text, text might be truncated vertically.</td>
</tr>
<tr>
<td>Wrap text + autofit height</td>
<td>Cell height is adjusted to accommodate the number of lines of text created by the wrap text. Because the cell width is not adjusted to the longest word, text might be truncated horizontally.</td>
</tr>
<tr>
<td>Wrap text + autofit height +</td>
<td>Cell height and width is adjusted to the text and there is no horizontal or vertical truncation.</td>
</tr>
<tr>
<td>autofit width</td>
<td></td>
</tr>
</tbody>
</table>

### 14.4.7 To copy formatting using the Format Painter

You can quickly apply the formatting from a report, table or cell to other reports, tables or cells using the Format Painter. The **Format Painter** tool is available in the "Tools" section of the "Formatting" tab.

The formatting options applied depend on the objects you choose as the source and target. In general, only properties that affect the visual formatting (for example font style, background color) are applied. Properties that affect the display of data (for example, table properties such as "Avoid duplicate row aggregation" property) are not applied.

1. Select the report, table or cell whose formatting you want to apply.
2. Click the **Format Painter** to apply the formatting once, or double-click to apply the formatting multiple times.
   
   The Format Painter is in the **Format > Tools** toolbox.
3. Click the report, table or cell to which you want to apply the formatting.
   
   If you single-clicked the Format Painter, it is deactivated.
   
   If you double-clicked the Format Painter, it remains activated.
4. If you double-clicked, click the Format Painter again or press Esc to cancel the formatting operation. (You can do this before applying the formatting for the first time if you decide to abandon the formatting operation.)
14.4.8 To set the position of a table or chart on the report page

Below are the directions for positioning a table or chart on a report page. You can also reach the same Layout box by either Report Elements > Position > Align or by right clicking the table or chart and selecting Align.

1. Select the border of the table or chart, right-click and select Format Table ... or Format Chart ....
2. Select Layout.
3. Use the controls in the Position section to set the position of the table or chart in relation to other report elements.

14.4.9 To layer tables and cells

Layering determines how tables and cells appear when they occupy the same space in a report. An object further forward in the layering order appears over an object further backward in the layering order.

1. Select the table or cell whose layer you want to set.
2. Right-click, click Order and click the layering option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bring to front</td>
<td>Make the table or cell the first object in the layering order.</td>
</tr>
<tr>
<td>Send to back</td>
<td>Make the table or cell the last object in the layering order.</td>
</tr>
<tr>
<td>Bring forward</td>
<td>Bring the table or cell one layer forward in the layering order.</td>
</tr>
<tr>
<td>Send backward</td>
<td>Send the table or cell one layer backward in the layering order.</td>
</tr>
</tbody>
</table>

14.4.10 To merge table cells

1. Select the cells you want to merge by holding down the Ctrl button and clicking the cells.
2. Keep the Ctrl button pressed, right-click and select Merge.

When you merge cells the merged cell contains the data from the first cell you selected only. Data from all the other cells is lost.
14.5 Controlling the display of tables

14.5.1 To show or hide tables, rows or columns

Sometimes tables or specific rows and columns display no values. For example, if a sales of a specific product are discontinued, table rows or columns that normally show results for that product appear empty. By default, these empty rows, columns, or tables are displayed. You can choose to display or hide them. When a table or element is hidden, its name is italicized in grey in the "Document Structure" and Filters pane.

You can also display and hide tables based on the result of a formula.

1. Select the table, right-click and select **Format Table**.
2. Select the **General** tab.
3. Select **Hide always** to hide the table.
4. Select **Hide when empty** to hide the table when it is empty.
5. Select **Hide when following formula is true** and type a formula in the box to hide the table when the formula is true.
6. Select **Show rows with all empty measure values** to display rows with empty measure values.
7. Select **Show rows with empty dimension values** to display rows with empty dimension values.
8. If the table is a cross table, click **Show rows/columns with empty dimension values** to display rows/columns with empty dimension values.

14.5.2 To redisplay hidden tables, cells or sections

Tables, cells and sections can be hidden unconditionally, if they contain no data, or based on the result of a formula. You can redisplay these tables. To show all hidden elements in a report: right-click in the report and select **Show all hidden content**. You can also do the following:

1. Select the hidden table, free-standing cell or section in the **Document Structure and Filters** tab in the Left Pane, or select the hidden report object in the table in which it is displayed.
2. Right-click and select **Hide > Show**.
14.5.3 To hide dimensions in tables

1. In Design mode, select the column containing the dimension.
2. Select Report Elements > Behaviors > Hide > Hide Dimension to hide the dimension.

14.5.4 To redisplay hidden dimensions

1. In Design mode, select the table containing the hidden dimensions.
2. Select Report Elements > Behaviors > Hide > Show Hidden Dimensions to redisplay the dimensions.
3. If the hidden dimensions were the only objects in the table, right-click the table in the Document Structure and Filters pane of the Left Pane and select Hide > Show Hidden Dimensions.

14.5.5 To avoid duplicate row aggregation

When rows contain duplicate data, measure values are aggregated by default. You can choose not to aggregate measure values in this situation.

1. Select the table, right-click and select Format Table.
2. Select the General tab.
3. Select Avoid duplicate row aggregation.

14.5.6 To show or hide table headers and footers

1. Select the table, right-click and select Format Table to display the "Format Table" dialog box.
2. Select the General tab.
3. Select Table headers to display the headers.
4. Select Table footers to display the footers.

Note:
In a cross table the options are Show top header, Show left header, Show bottom footer, Show right footer.
14.5.7 To start tables on a new report page

1. Select the table, right-click and select Format Table.
2. Select the Layout tab.
3. Select Start on a new page in the Vertical or Horizontal panes.
   The Horizontal and Vertical panes refer to the table axes.

14.5.8 To display object names in headers on cross tables

1. Select the table, right-click and select Format Table.
2. Select the General tab.
3. Click Show object names to display the object names in additional headers on the cross table.

14.5.9 To avoid page breaks in tables

1. Select the table, right-click and select Format Table.
2. Select the Layout tab.
3. Select Avoid page breaks in table in the Vertical or Horizontal panes.
   The Horizontal and Vertical panes refer to the table axes.

14.5.10 To repeat table headers or footers on report pages

1. Select the table, right-click and select Format Table.
2. Select the Layout tab.
3. Select Repeat header on every page or Repeat footer on every page in the Vertical or Horizontal panes.
   The Horizontal and Vertical panes refer to the table axes.
Displaying data in free-standing cells

15.1 Free-standing cells defined

Free-standing cells are single cells that stand alone in a report. You can place any text or formula in a blank free-standing cell, or you can use pre-defined free standing cells that display specific information.

The available free-standing cells are listed below.

- **Formula and Text Cells:**
  - Blank Cell - Empty cell in which you can enter any text or formula.
  - Drill Filters - Uses the `DrillFilters` function to display details of the drill filters applied to the report.
  - Last Refresh Date - Uses the `LastExecutionDate` function to display the last date when the document was refreshed.
  - Document Name - Uses the `DocumentName` function to display the document name.
  - Query Summary - Uses the `QuerySummary` function to display details of the queries in the document.
  - Prompt Summary - Uses the `PromptSummary` function to display details of the prompts in the document.
  - Report Filter Summary - Uses the `ReportFilterSummary` function to display the report filters applied to the report.

- **Page Number Cells:**
  - Page Number - Uses the `Page` function to display the number of pages in the report.
  - Page Number/Total Pages - Uses the `Page` and `NumberOfPages` functions to display the current page number and the total number of pages in the report.
  - Total Number of Pages - Uses the `NumberOfPages` function to display the total number of pages in the report.

For more information on the functions used in free-standing cells, see the *Using Functions, Formulas and Calculations in Web Intelligence* guide, or see the online help.

15.2 To insert a free-standing cell in a report

You must be in Design mode to insert a free-standing cell.
1. Select Report Element > Cell > Blank to insert a blank cell.
2. Select Report Element > Cell > Pre-Defined and select from the list of cells to insert a pre-defined cell.
3. Place your mouse over the part of the report where you want to insert the cell and click the left mouse button.
4. If you inserted a blank cell, type the text or formula of the cell in the Formula box in the Analysis menu.
5. To delete the cell, select it and click the Delete button.

15.3 To hide free-standing cells

You can hide free-standing cells unconditionally, when they are empty, or based on the result of a formula.
1. Right-click the free-standing cell and click Format Cell to display the "Format Cell" dialog box.
2. Select the General tab.
3. To hide the cell unconditionally, select Hide always.
4. To hide the cell when it is empty, select Hide when empty.
5. To hide the cell based on the result of a formula, click Hide when the following formula is true and type the formula in the box.

15.4 To redisplay hidden tables, cells or sections

Tables, cells and sections can be hidden unconditionally, if they contain no data, or based on the result of a formula. You can redisplay these tables. To show all hidden elements in a report: right-click in the report and select Show all hidden content. You can also do the following:
1. Select the hidden table, free-standing cell or section in the Document Structure and Filters tab in the Left Pane, or select the hidden report object in the table in which it is displayed.
2. Right-click and select Hide > Show.

15.5 To copy a free-standing cell

You can copy and paste free-standing cells within a report or into external applications such as Microsoft Word and Excel. You cannot copy free-standing cells from one application instance to another.
1. Select the free-standing cell, then click Copy on the toolbar.
2. To paste the free-standing cell to another part of the report, right-click where you want the free-standing cell to appear and click **Paste** on the menu.

3. To paste the free-standing cell into another application, paste the contents of the clipboard from within the application.
   You can also copy a free-standing cell into another application by dragging and dropping the free-standing cell directly into the open document in the target application.
   The free-standing cell appears as a picture in the open document if pasted to another application.
Organizing data with sections, breaks and sorts

16.1 Using sections to group data

16.1.1 Grouping information with sections

Sections allow you to split report information into smaller, more comprehensible parts.

Example: Grouping quarterly revenue results into sections on a report

You are the regional sales manager in Texas. You receive a report showing 2003 annual revenue for stores in your region, broken down by cities and quarters.

<table>
<thead>
<tr>
<th>City</th>
<th>Quarter</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>Q1</td>
<td>314430</td>
</tr>
<tr>
<td>Austin</td>
<td>Q2</td>
<td>273608</td>
</tr>
<tr>
<td>Austin</td>
<td>Q3</td>
<td>294798</td>
</tr>
<tr>
<td>Austin</td>
<td>Q4</td>
<td>252644</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q1</td>
<td>215874</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q2</td>
<td>194689</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q3</td>
<td>204066</td>
</tr>
<tr>
<td>Dallas</td>
<td>Q4</td>
<td>188791</td>
</tr>
<tr>
<td>Houston</td>
<td>Q1</td>
<td>572177</td>
</tr>
<tr>
<td>Houston</td>
<td>Q2</td>
<td>619924</td>
</tr>
<tr>
<td>Houston</td>
<td>Q3</td>
<td>533765</td>
</tr>
<tr>
<td>Houston</td>
<td>Q4</td>
<td>520332</td>
</tr>
</tbody>
</table>
To make a comparison of the results for each city per quarter, you set [Quarter] as a section value. The report is broken up into four separate sections by quarter.

**Q1**

<table>
<thead>
<tr>
<th>City</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>314430</td>
</tr>
<tr>
<td>Dallas</td>
<td>215874</td>
</tr>
<tr>
<td>Houston</td>
<td>572177</td>
</tr>
</tbody>
</table>

**Q2**

<table>
<thead>
<tr>
<th>City</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>273608</td>
</tr>
<tr>
<td>Dallas</td>
<td>194689</td>
</tr>
<tr>
<td>Houston</td>
<td>619924</td>
</tr>
</tbody>
</table>

**Q3**

<table>
<thead>
<tr>
<th>City</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>294798</td>
</tr>
<tr>
<td>Dallas</td>
<td>204066</td>
</tr>
<tr>
<td>Houston</td>
<td>533765</td>
</tr>
</tbody>
</table>

**Q4**

<table>
<thead>
<tr>
<th>City</th>
<th>Sales revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austin</td>
<td>252644</td>
</tr>
<tr>
<td>Dallas</td>
<td>188791</td>
</tr>
<tr>
<td>Houston</td>
<td>520332</td>
</tr>
</tbody>
</table>

You can create a single section or include multiple sections with subsections in a report. You can also remove and reposition sections within a report.

You can create a section from one of two sources:
• on a dimension already displayed on a table or chart: right-click the dimension and select Set as section.
• on a dimension included in the document but not displayed on a table or chart
You cannot create a section with a measure object.

16.1.2 Applying filters to sections

You can apply section filters based on the values in the section header or on values that appear within the section.

Applying a section filter to the section header
If you have a report with a section on [Country], the filter [Country] = "US" filters out all sections on countries other than the US.

Applying a section filter to the section data
If you have a report with a section on [Region] and you apply the filter [Product]="Drinks" to the section, the report contains all sections that contain the product "Drinks".

In this case, the sections remaining in the report contain products other than drinks if these products were sold in these regions. This is because the section filter retains regions in which drinks were sold, but does not exclude other products from the data in the section.

In other words, the filter is based on the data in the section, but applied indirectly to the data in the section header.

16.1.3 To create a section from a column

• Right-click the column you want to define as a section and click Set as Section.

16.1.4 To create a section from a dimension

1. Select Report Elements > Section > Insert Section.
2. Click on the report at the position where you want to insert the section.
3. Select the dimension in the dialog box that appears and click OK to insert the section.
16.1.5 Creating sections from a hierarchy

If you create a section on a hierarchy, each member of the hierarchy becomes a section header. You can expand sections in the same way as you expand members in a column in a table.

You have a report that displays the following data:

<table>
<thead>
<tr>
<th>Customer Geography</th>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Customers</td>
<td>Male</td>
<td>235.243</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>254,342</td>
</tr>
<tr>
<td>Australia</td>
<td>Male</td>
<td>34,342</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>45,464</td>
</tr>
<tr>
<td>Canada</td>
<td>Male</td>
<td>12,232</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>14,242</td>
</tr>
<tr>
<td>France</td>
<td>Male</td>
<td>17,343</td>
</tr>
<tr>
<td></td>
<td>Female</td>
<td>18,001</td>
</tr>
</tbody>
</table>

If you create a section on [Customer Geography], the report initially appears as follows:

All Customers

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>235.243</td>
</tr>
<tr>
<td>Female</td>
<td>254,342</td>
</tr>
</tbody>
</table>

If you expand the section header, the report appears as follows:

All Customers

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>235.243</td>
</tr>
<tr>
<td>Gender</td>
<td>Internet Sales Amount</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Female</td>
<td>254,342</td>
</tr>
</tbody>
</table>

Australia

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>34,342</td>
</tr>
<tr>
<td>Female</td>
<td>45,464</td>
</tr>
</tbody>
</table>

Canada

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>12,232</td>
</tr>
<tr>
<td>Female</td>
<td>14,242</td>
</tr>
</tbody>
</table>

France

<table>
<thead>
<tr>
<th>Gender</th>
<th>Internet Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Male</td>
<td>17,343</td>
</tr>
<tr>
<td>Female</td>
<td>18,001</td>
</tr>
</tbody>
</table>

### 16.1.6 Creating subsections

You can create a report containing sections within sections (subsections) by creating a section within an existing section.
16.1.7 To remove a section cell or section

- Right-click the section cell and select **Delete > Cell Only** to delete the section cell, or **Delete > Section and Cell** to delete the section and the cell.

16.1.8 To set the page layout of a section

1. Right-click the section and select **Format Section** from the menu.
2. Select the **Layout** tab in the dialog box.
3. Select **Start on a new page** to start each section on a new page.
4. Select **Avoid page breaks** to avoid page breaks in the section.
5. Select **Repeat on every page** to repeat the section header on every page.

16.1.9 To hide sections

1. Select the section.
2. Select **Report Elements > Behaviors > Hide** to hide the section.
3. Select **Report Elements > Behaviors > Hide When Empty** to hide the section when it is empty.
4. Select **Report Elements > Behaviors > Hide When**, select **Hide when the following formula is true**, and type a formula in the box to hide the section when the formula is true.
   The formula must return a boolean value (True or False).

16.1.10 To redisplay hidden tables, cells or sections

Tables, cells and sections can be hidden unconditionally, if they contain no data, or based on the result of a formula. You can redisplay these tables. To show all hidden elements in a report: right-click in the report and select **Show all hidden content**. You can also do the following:

1. Select the hidden table, free-standing cell or section in the **Document Structure and Filters** tab in the **Left Pane**, or select the hidden report object in the table in which it is displayed.
2. Right-click and select **Hide > Show**.
16.1.11 To define colors and images in a section

1. Right-click the section and select **Format Section**.
2. Click the **Appearance** tab in the dialog box.
3. Define the colors and images using the controls in the **Appearance** tab.

16.2 Using breaks

16.2.1 Breaks defined

A break is a division within a block in which data is grouped according to a selected dimension, detail, or measure into self contained sections. These sections are represented as smaller tables within the same block of data.

You use breaks to display all the data for each unique value of an object in separate parts.

Using breaks has two main advantages:
- You can more efficiently organize how your data is represented.
- You can display subtotals.
- You can display sub-aggregations.

16.2.2 Breaks compared to sections

A section breaks up the data into multiple free-standing cells called section headers. Each section header contains one value for a dimension, with a block of data that corresponds to the dimension value.

A break divides the data up within one block. One column contains the values for a dimension, detail, or measure, which are repeated for each other row of values in the block.
16.2.3 Applying breaks to hierarchies

When you apply a break to a hierarchy, the break occurs on all hierarchy members at all levels.

Example: A break applied to a hierarchy

You have a report displaying the following data:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
<tr>
<td>USA</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
<tr>
<td>CA</td>
<td>F</td>
<td>36,759</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>37,989</td>
</tr>
</tbody>
</table>

If you apply a break to the [Customer] hierarchy, the display appears as follows. The break is applied on each member of [Customer].

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>F</td>
<td>131,587</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>138,215</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer</th>
<th>Gender</th>
<th>Unit Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
16.2.4 Default sort order in breaks

When you insert a break on an object, the values for the object are automatically sorted in ascending order as follows:

- If the values are numeric, the lowest value appears in the first row of the table, the highest in the last row.
- If the values are alphabetical characters, then the values are sorted in alphabetical order from top to bottom.

You can change this sort order at any time.

You can set multiple breaks and set a sort priority on each break, so that you control how the data is displayed when you insert multiple breaks across several dimensions details, or measures.

16.2.5 To insert a break

**Note:**
You cannot insert breaks in Form tables.

You must be in Design mode to add breaks.

1. Select the column on which you want to apply the break.
2. Select **Analysis > Display > Break > Add Break**.
   - The table is divided into as many mini tables as there are unique values in the column. Each mini table has a footer.

**Related Topics**
- To manage breaks
16.2.6 To remove a break

You must be in Design mode to remove breaks.

1. Select the column on which the break is defined.
2. Select Analysis > Display > Break > Remove Break.
   The Remove Break menu item is not available if the column does not have a break defined.
3. To remove all breaks, select any column in the table and select Analysis > Display > Break > Remove All Breaks.
   The Remove All Breaks menu item is not available if the table has no breaks defined.

16.2.7 To manage breaks

You must be in Design mode to manage breaks.

1. Select any column in the table.
2. Select Analysis > Display > Break > Manage Breaks.
   The dialog box shows the breaks defined in the table. If the table is a crosstab, the dialog box shows
   the breaks on both the horizontal and vertical axes. Each break is represented by the dimension on
   which it is defined. The order in which the dimensions appear indicates the order in which the breaks
   are applied.
3. To change the priority of a break, select the dimension and click Up or Down to move the dimension
   in the break priority.
4. To add a break, click Add and select the dimension on which you want to apply the break.
5. To remove a break, select the dimension and click Remove.
6. To set the properties of a break, select the dimension and select the properties on the right of the
   dialog box. See the link at the bottom of this topic for more information on the break properties you
   can set.

Related Topics
• Break properties

16.2.8 Break properties
You can set the following properties of a break:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break header</td>
<td>Displays a header for each part of the table, crosstab, or form when you insert a break.</td>
</tr>
<tr>
<td>Break footer</td>
<td>This displays a footer for each break in a section, including a footer after the last row for a table or column for a crosstab when you insert a break. When you apply a calculation to the data, the result is shown in the footer.</td>
</tr>
<tr>
<td>Apply sort</td>
<td>Applies the default sort order to the values in the break.</td>
</tr>
<tr>
<td>Duplicate values: Display all</td>
<td>Displays all values in the break, even when they are duplicated.</td>
</tr>
<tr>
<td>Duplicate values: Display first</td>
<td>Displays the first value only when values are duplicated.</td>
</tr>
<tr>
<td>Duplicate values: Merge</td>
<td>Merges cells containing duplicate values and displays a single value over the merged cells.</td>
</tr>
<tr>
<td>Duplicate values: Repeat first on new page</td>
<td>Displays the first value in a group of duplicate values at the beginning of the break and on each new page.</td>
</tr>
<tr>
<td>Start on a new page</td>
<td>Displays each part of the table or form created by a break on a new page.</td>
</tr>
<tr>
<td>Avoid page breaks</td>
<td>Where possible, keeps each break section on the same page. This option is not taken into account when a block is larger than one page.</td>
</tr>
<tr>
<td>Repeat header on every page</td>
<td>Repeats the header at the top of the table on every new page when a table goes over onto a new page.</td>
</tr>
<tr>
<td>Repeat footer on every page</td>
<td>Repeats the footer at the bottom of the table on every new page when a table goes over onto a new page.</td>
</tr>
</tbody>
</table>

**16.3 Using sorts to organize data**
16.3.1 Sorting the results displayed on reports

You can apply sorts to the values displayed in tables, sections and charts to organize the order in which values are displayed in a report. Default sorting is in the order of the dimensions from the left to the right of the result object.

Note:
When sorting in reports where the underlying query has already performed a sort, ensure that the sorted query dimension is first in the table on the report, otherwise you will lose the effect of the sorted dimension in the report. Alternatively, edit the query so that the sorted dimension is returned first.

The following sort orders are available:

<table>
<thead>
<tr>
<th>Sort order</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>This is sometimes referred to as the natural order. Depending on the type of data in the column or row, the results are sorted as follows: • ascending numeric order for numeric data • ascending chronological order for date • Chronological order for months • alphabetical order for alphanumeric data</td>
</tr>
<tr>
<td>Ascending</td>
<td>When selected, results are arranged in ascending order: The smallest value at the top of the column moving to the highest value at the bottom. For example: 100, 200, 300 or California, Colorado, Florida.</td>
</tr>
<tr>
<td>Descending</td>
<td>When selected, results are arranged in descending order: The highest value at the top of the column moving to the smallest value at the bottom. For example: 300, 200, 100 or Florida, Colorado, California.</td>
</tr>
</tbody>
</table>
You define your own sort order. Custom Order is available on dimensions and attributes. Note the following restrictions:

- Custom Order is not available on hierarchies, levels, and measures.
- It is not possible to manually add values to the Custom Order list. (For detail objects the field is active, but the values entered are not added to the list.)
- You cannot set the Custom Order in DHTML (Web mode) in modify mode.

**Note:**
By default, the maximum number of values for dimensions are set to different values on the client and server. To avoid conflicts, it is recommended to set both to the same value.

Server default value: 100 items (Maximum Custom Sort Size parameter in the WebIntelligence-ProcessingServer properties in the CMC)

Client default value: 1000 items (WebiParamCustomSortMaxSize parameter in WebIContainer_ClientDescriptor.xml)

<table>
<thead>
<tr>
<th>Sort order</th>
<th>Description</th>
</tr>
</thead>
</table>
| Custom     | You define your own sort order. Custom Order is available on dimensions and attributes. Note the following restrictions:  
  - Custom Order is not available on hierarchies, levels, and measures.  
  - It is not possible to manually add values to the Custom Order list. (For detail objects the field is active, but the values entered are not added to the list.)  
  - You cannot set the Custom Order in DHTML (Web mode) in modify mode. |

### 16.3.2 Sorting hierarchical data

Sorts apply on hierarchical data within each parent item in the hierarchy. Sorts do not break links between parent and child items.

**Example: Sorting hierarchical data**

The following table contains the [Product] hierarchy in an unsorted state:

<table>
<thead>
<tr>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
</tr>
<tr>
<td>Baking Goods</td>
</tr>
</tbody>
</table>
After a descending sort is applied, the hierarchy appears as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Grocery</td>
<td>Breads</td>
</tr>
<tr>
<td>Breads</td>
<td>Beverages</td>
</tr>
<tr>
<td>Beverages</td>
<td>Soft Drinks</td>
</tr>
<tr>
<td></td>
<td>Soda</td>
</tr>
<tr>
<td></td>
<td>Milk</td>
</tr>
<tr>
<td>Baking Goods</td>
<td></td>
</tr>
</tbody>
</table>

The sort places grocery types in descending order and beverages in descending order in their parent item. The sorted beverages retain their hierarchical link with their parent item.

### 16.3.3 To insert a sort

1. Click **Design** to work in Design mode.
2. Select the column you want to sort.
3. Select **Analysis > Display > Sort > Ascending/Descending** to sort the column in ascending or descending order.
16.3.4 To remove a sort

1. Select the sorted column.
2. Select Analysis > Display > Sort > None.
   You can also select any column and select Analysis > Display > Sort > Remove All Sorts to remove all sorts from the table.

16.3.5 To manage sorts

1. Select the table or chart in which you want to manage sorts and select Analysis > Display > Sort > Manage Sorts.
   The dialog box displays the sorts applied to the table or chart. In a cross table, the sorts on both the horizontal and vertical axes are displayed. Each sort is represented by the name of the sorted dimension, and an arrow indicates the sort direction (ascending or descending). The order in which the sorted dimensions appear indicates the order in which the sorts are applied.
2. To change the priority of a sort, select the dimension and click Up or Down to move the dimension in the sort priority
   **Note:**
   You cannot change the priority of a sort if a sorted break is defined on the dimension.
3. To change the direction of a sort, double-click the dimension, or select it and select Ascending or Descending from the Order list.
4. To add a sort, click Add and select the dimension you want to sort from the list.
5. To remove a sort, select the dimension and click Remove.
6. To customize a sort by choosing your own sort order or adding values to the list of values to sort, click Values beneath Custom Order and define your custom sort. The Values button is disabled if the custom sort is not applicable. The custom order is applied to the entire document and not just the dimension in the selected block.
7. To reset a custom sort order to the standard sort order, select the dimension and click Reset.
   **Note:**
   • The Reset button is disabled if the sort on the selected dimension is not customized.
   • Refer to the table in the topic Sorting the results displayed on reports for the restrictions of the Custom Order option.

**Related Topics**
• Sorting the results displayed on reports
Displaying data in charts

17.1 Creating charts

You can include one or multiple charts on the reports in a document. You can create a chart when you build a new document or insert charts into an existing document.

Note:
When you export a document that contains a chart to excel format, the chart is converted into an image.

Related Topics
• To add a chart to a report

17.1.1 Opening charts created with Web Intelligence 3.x

This version of the software supports backward compatibility with Web Intelligence XI 3.x.

Existing charts are converted automatically when you open them except that if you open an existing 3D chart, other than a 3D bar chart, it will be converted into a 3D bar chart.

17.2 Chart types

A report displays results in a block. You can format the block as a specific type of chart.

Note:
3D line, 3D area, and 3D surface are no longer provided in this version of the product. When any of these charts are present documents and reports that are migrated to 4.x, they are transformed into 3D bars.
17.2.1 Bar charts

Bar charts display data in rectangular form horizontally. Bar charts are useful if you want to compare similar groups of data; for example, revenue from one time period to another. There are three types of bar charts:

- **Bar:** A chart constructed of horizontally-oriented rectangles. The lengths of rectangles are proportional to the values associated to different category items.
- **Stacked bar chart:** A chart constructed of horizontally-oriented stacked colored rectangles. The heights of the rectangles are proportional to the values associated to different category items. Rectangles are colored according to legend entries.
- **100% stacked bar chart:** A chart with data displayed as parts of a whole (as percentages). A whole being a rectangle and a series being a subdivision of the rectangle.

17.2.2 Box plot charts

A chart (also called a stock chart) that displays a five-number summary based on the distribution of a dataset: the maximum, the minimum, the first quartile, the third quartile, and the median. It can also show abnormal values called outliers.

17.2.3 Column charts

Column charts display a series as a set of vertical bars that are grouped by category. Column charts are useful for showing data changes over a period of time or for illustrating comparisons among items.

There are the following seven types of column charts:

- **Column chart:** A chart constructed of vertically-oriented rectangles. The heights of the rectangles are proportional to the values associated to different category items.
- **Column chart with dual value axes:** A chart with two value axes. It allows a part of a data series to be plotted against one axis and a part of the data series to be plotted against the other axis.
- **Combined column and line chart:** A chart displaying a combination of a column chart and a line chart. The chart types share the same value axis.
- **Combined column and line chart with dual value axes:** A chart displaying a combination of a column chart and a line chart. The chart types each have their own value axis.
• Stacked column chart: A chart constructed of vertically-oriented stacked colored rectangles. The heights of rectangles are proportional to the values associated to different category items. Rectangles are colored according to legend entries.
• 100% stacked column chart: A chart with data displayed as parts of a whole (as percentages) with a whole being a column and a series being a subdivision of the column. If there is only one series in your chart, all the column bars will fit to 100% of the chart area.
• 3D column chart: A chart similar to a column chart with an added 3D dimension.

17.2.4 Line charts

Line charts connect specific data values with lines, either horizontally or vertically. Line charts are useful if you want to show trends or changes in data over time. There are two types of line charts:

There are two kinds of line charts:
• Line Chart: An XY chart that displays lines connecting plots. Value axis plot positions are expressed by analysis category items. The secondary value axis plot positions represent the associated values.
• Dual Line Chart: An XY chart with two axes displaying lines connecting plots. Category axis plot positions signify analysis category items. The value axis plot positions, on both axes, represent the associated values.

17.2.5 Area charts

An area chart is an XY chart that displays a surface made up of a connection of plots.

17.2.6 Tree map charts

A chart that displays values within nested rectangles that can be colored. The levels of nesting correspond to the level of hierarchical breakdown. The size of the rectangles and their color both express a set of values.
17.2.7 Pie charts

Pie charts display data as segments of a whole. Pie charts are useful if you want to show how each part of your report data contributes to the total.

You can only include one measure object in a simple pie chart or two in a pie chart with depth. If you have several measures in your report, you should choose another chart type.

There are three types of pie charts:

- Pie chart: A circular chart made up of sectors. The area of the circle represents a whole, and the sectors of the circle represent the parts of a whole.
- Pie chart with variable slice depth: A circular chart made up of sectors. The area of the circle represents a whole, and the sectors of the circle represent the parts of a whole. The sectors may have some depth expressing a third value.

Additionally, a donut chart can be displayed from a pie chart. It is similar to a pie chart, but with an empty center; it is ring shaped.

17.2.8 Heat map charts

A chart that displays values that are represented by colors in a map using a category axis and optionally a second category axis. The colors of the rectangles are determined by a measure value.

17.2.9 Point charts

There are four types of Point charts.

Scatter charts are similar to line graphs, except that the data points are plotted without a line connecting them. Scatter charts are useful if you want to make a comparison between specific data points. There are two types of scatter charts.
• Scatter Chart: An XY chart displaying plots. Plots are positioned with coordinates given by a pair of values. Each plot may have colored symbols representing the analysis category item associated with the values.
• Bubble Chart: A two-dimensional chart of points representing a collection of data. Extra variables are represented by the size of the points.

Polar charts are XY charts displaying plots. Plots are positioned with coordinates given by a pair of values. Each plot may be sized according to extra values. There are also polar bubble charts.

There are two kinds of bubble charts:
• Polar Scatter Plot: A chart with one radial axis and one angular axis, where each data point is represented with a symbol. Similar to a bubble chart, but without the sizing of points.
• Polar Bubble Chart: A two-dimensional chart with one radial axis and one angular axis of points representing a collection of data. Extra variables are represented by the size of the points.

17.2.10 Radar charts

This chart (also known as a Spider chart) displays several axes starting from a unique origin and with a common scale. Each axis represents an analysis category item. Plots are directly placed on an axis according to the associated values. Plots can be linked by lines.

Radar charts are useful if you want to look at several different factors related to one item. For example, you could use a radar chart to display revenue data for different services within a hotel. On one axis, you could display revenue for the rooms. On another you could display revenue for the restaurant, and so on.

17.2.11 Tag cloud charts

A mono-dimensional visualization representing data as words where the word font size represents its relative weight in the dataset.

17.2.12 Waterfall charts

Waterfall charts (also known as Bridge charts) display vertical bars. Each one of these bars starts at the level where the preceding bar ends, making the bars look as if they were floating. This type of chart is useful for showing how a measure increases or decreases, for representing positive or negative changes or for illustrating up and down effects.
There are two types of waterfall charts:
- Simple Waterfall chart: a chart generated from a flat dimension.
- Complex Waterfall chart: a chart generated from hierarchical data.

Note that for subtotal management:
- Intermediate totals are generated from hierarchical treenodes only. To generate intermediate totals from a flat dimension, you have to use grouping.
- Intermediate totals (treenodes) are displayed as a waterfall.

For feeding restriction:
- The category axis is limited to one dimension (or hierarchy).
- The value axis is limited to one measure.

For color management:
- It is not possible to assign specific colors to initial values, totals, subtotals or positive/negative variations.
- Since only one color is used in the waterfall chart, no color legend is displayed.

17.3 Adding, copying and removing charts

17.3.1 To add a chart to a report

You must be in Design mode. If you are in Structure Only Design mode, all the charts will appear grayed out.

There are three ways to add a chart to a report:
1. In the "Reports Elements" toolbox, drag and drop the chart you want into the report. Then drop the dimensions and measures you want into the chart from the "Available Objects" pane. The chart appears empty in light gray. This is sometimes called a ghost chart. You now know that you can feed the chart.
2. Using the right click contextual menu option, insert a chart by selecting Insert > Insert a Report Element.
3. Select the table you want to turn into a chart and then press Turn Table Into.

Related Topics
- To feed a chart
17.3.2 Chart feeding: Binding objects to a chart

The table explains the different elements for feeding a chart.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Feeds</th>
<th>Object type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binding object to axes</td>
<td>Value axes</td>
<td>Measures</td>
</tr>
<tr>
<td>Category axes</td>
<td></td>
<td>Dimensions, Details or</td>
</tr>
<tr>
<td>Defining series (*)</td>
<td>Region Color</td>
<td>Measure Names</td>
</tr>
<tr>
<td></td>
<td>Region Shape (Radar &amp; Point charts)</td>
<td></td>
</tr>
<tr>
<td>Defining series size</td>
<td>Pie sector size / sector height</td>
<td>Measures</td>
</tr>
<tr>
<td></td>
<td>TreeMap rectangle weight</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bubble height / Bubble width</td>
<td></td>
</tr>
<tr>
<td>Conditional coloring (*)</td>
<td>Map rectangles</td>
<td>Measures</td>
</tr>
<tr>
<td></td>
<td>TagCloud text zones</td>
<td></td>
</tr>
</tbody>
</table>

(*) Optional

17.3.2.1 To feed a chart

You must be in Design mode. You must have already inserted a chart.

There are two ways to feed a chart.

1. In the left-hand panel, select "Available Objects". From the "Available Objects" pane, drag and drop the measures, dimensions, and/or details into the chart. They will automatically be dispatched to the relevant area.

2. Select the chart. Right click to display the contextual menu. Select Edit. The "Edit" dialog box appears displaying the values chosen. You can add, delete, reorder (move up, down, to the top, or to the bottom), or hide the values plus edit or create a formula.

You have fed the chart.
17.3.3 To apply a chart style

You must be in Design mode and have selected a chart.

The best practice: Create a chart; feed it with all needed dimensions; apply the style, then change the settings to refine the chart format. If you modify setting before applying a template, you may alter your modifications if these settings are included in the template definition (the only way to get them back is to use Undo).

A chart style is a group of settings stored within a source file. The chart style is used to manipulate a chart (at several levels - graphic, region, and property) before it is rendered. Chart styles allow charts to assembled using a set of predefined settings which include modern chart styles (such as anti-alias, gloss, and emboss). Adapted chart styles offer straightforward chart output customization with pre-settings and themes. They contain the group of settings for a chart including:

- layout - the settings that determine how each chart is displayed
- chart items (such as the title, the legend, the axes)
- chart location (for example, where chart items are placed, if they are visible)
- theme - the settings that determine how the chart looks
- color palettes, etc.
- textures (such as the texture of the background)
- shadows
- fonts

**Note:**
You can choose among pre-defined color palettes but cannot create your own in this version of the software.

- In the "Chart Style" toolbox, choose the first icon Chart Style to select: Flashy, Normal, or High Contrast style.
  
  The style is applied.

17.3.4 To copy a chart
1. Select the chart, right-click and select **Copy** on the menu.
   The chart is copied to the clipboard.

2. To paste the chart to another part of the report, right-click where you want the chart to appear then click **Paste** on the menu.

3. To paste the chart into another application, paste the contents of the clipboard from within the other application.
   You can also copy a chart into another application by dragging and dropping it directly into the open document in the target application.
   Within the same application, your copied chart will be dynamic. However, if the chart is pasted into another application, the chart appears as a picture.

**Related Topics**
- To format a chart

### 17.3.5 To remove a chart

There are three ways to remove a chart.

1. Right-click the chart and click **Delete**.
2. Activate the "Document Structure and Filters" panel. Then right click on the chart name. Click **Delete**.
3. Select the chart. Then in the upper lefthand pane, click the delete icon.

The chart has been deleted.

**Related Topics**
- To format a chart

### 17.4 Changing the chart type

#### 17.4.1 To change the chart type by using Turn Into

**Note:**
It is also possible to transform individually bar series into lines or surface.
1. Right-click the table or chart.
2. Select Turn Into. A number of shortcuts appear. To get a dialog box with all your options, select More Transformations...
   The "Turn Into" dialog box appears.
3. Click the chart category you want, then click a chart icon.
4. Click OK.
   The selected template is applied to the block and displays the data in the chart type you chose.

Related Topics
• To format a chart
• Line charts
• Area charts

17.4.2 Turning Hierarchical queries into charts

You can turn a hierarchical query into a chart.

Note:
• Best Practice: Hierarchical totals should not be displayed in Pies or Tag Cloud. In other charts, displaying the totals may generate scale distortions, especially if the measure type is aggregative. To hide hierarchical totals, use levels for feeding or navigate within the table with the Drill Focus option or uncheck the option "Show parent nodes" in the Format Chart Dialog Box 'Chart Block > General).
• Use only one hierarchy to feed a Tree Map.

Related Topics
• Hierarchical queries defined
• To change the chart type by using Turn Into

17.4.3 To switch between bars, lines and surfaces

You must be in Design mode. You must open the "Format Chart " dialog box.
1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Region Type
   b. In the Rich Internet Application (Java applet), select Global > Region Type
2. For each measure, select the appropriate region type: Bars, Lines, or Surfaces.
17.5 Positioning and sizing charts

17.5.1 To set the position of a table or chart on the report page

Below are the directions for positioning a table or chart on a report page. You can also reach the same Layout box by either Report Elements > Position > Align or by right clicking the table or chart and selecting Align.

1. Select the border of the table or chart, right-click and select Format Table ... or Format Chart ....
2. Select Layout.
3. Use the controls in the Position section to set the position of the table or chart in relation to other report elements.

17.5.2 To position a chart in relation to another chart or table

If you have more than one block (table, chart, or form) in your report, you can use relative positioning. Relative positioning allows you to position a selected block (for example, a chart) in relation to other blocks in the report.

If new data on the database modifies the size of the tables or charts, relative positioning ensures that the different tables and charts display correctly without overlapping each other.

Below are the directions for positioning a table or chart on a report page. You can also reach the same Layout box by either Report Elements > Position > Align or by right clicking the table or chart and selecting Align.

Note:
If you position a chart in relation to another block (that is, a chart, table, or form), the position of the related block changes automatically, if you reposition the chart.

1. Right-click the chart and click Format.
2. Open the Page layout > Relative Position property group on the Properties tab.
3. Click ... next to the Relative Position property to open the Relative Position dialog box.
   If the report does not contain multiple elements, the Relative Position dialog box is not available.
4. Select the distance of the upper left point of the chart in relation to another report element by entering - the number of pixels; the part of the other report element from which you want to measure the
5. Repeat this for the distance of the lower left point of the chart.

17.5.3 To resize a chart

You can also resize the chart graphically using the mouse.
1. Right-click the chart and click **Format Chart**.
2. Open the **General** tab.
3. Type the chart width in the **Width** property and the height in the **Height** property.

**Related Topics**
* To format a chart

17.6 Formatting charts

17.6.1 Formatting chart areas

You can format a chart area or a selected chart area (title, legend, axes, plot area, area title) and format it using the Format Toolbar.

17.6.2 To format a chart

You must be in Design mode.

There are several ways to format a chart. One way is given below. Alternatively, select the chart and then **Report Elements > Chart Style > the last icon**.

How to access the "Format Chart “ dialog box.
1. Right-click the chart and click **Format Chart**.
2. Select the chart area: Chart Block, Title, Legend, Chart Axis, or Plot Area.
If you have preselected a chart area before calling the dialog box, this area is displayed automatically without you having to navigate.

3. In Web Intelligence Rich Client, select the functional tab that you want to change in the left pane. In Web Intelligence, expand the tab of the chart area you want to format, then select the functional tab.

4. Change what you want. Then, click **Apply** if you want to see the changes before you close the dialog box. You may want to make some other changes before you close the dialog box. Otherwise, click **OK** if you want to save the changes and close the dialog box.

You have formatted the chart.

### 17.6.3 Formulas in chart elements

The following chart elements can use a formula:

- Chart title
- Legend title
- Axis titles
- Maximum and minimum values for axis scaling

You can directly enter text in **Custom Value** or **Fixed Value**. Otherwise, you can use the **Formula Editor**.

For more information on the functions used in free-standing cells, see the *Using Functions, Formulas and Calculations in Web Intelligence* guide, or see the online help.

### 17.6.4 Warning icons in charts

There are four kinds of warning icons:

- General Warnings: icons are displayed on the top left corner of the chart
  - Red X in a white background: impossible to generate the chart. (This could be due to a cache problem - try clearing temporary objects from cache.
  - White X in a red circle: cannot find the image, the administrator should check load balancing settings and enable service monitoring as described in the Administrator's Guide.
  - Yellow warning: e.g. dataset too large (technical limit of the server), need to refresh the dataset, other cube errors.
  - Blue alert: limit for optimal rendering

- Error Prevention Warnings: Small yellow warning icon displayed on the data point (if warning icons are activated in the chart format options) the dataset is inconsistent with the chart parameters (e.g. pie chart with negative values, negative values for a logarithmic scale, inconsistent hierarchical values for a treemap.)
<table>
<thead>
<tr>
<th>Restriction</th>
<th>Definition</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical limits of the CVOM Server</td>
<td>Max number of rows</td>
<td>Partial rendering of the dataset and warning icon and tooltip</td>
</tr>
<tr>
<td></td>
<td>Defined by the administrator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default value = 50,000</td>
<td></td>
</tr>
<tr>
<td>Limit for optimal rendering</td>
<td>Calculated by CVOM based on the chart type and size</td>
<td>Alert icon and tooltip with optimization guidelines</td>
</tr>
</tbody>
</table>

### 17.6.4.1 To display warning icons in charts

You must be in Design mode. You must open the "Format Chart" dialog box.

1. Select **Chart Block**.
2. Select **General**.
3. Check **Show Warning Icons**.

The warning icons will now be displayed.

### 17.6.5 To insert and format a chart title

You must be in Design mode. You must open the "Format Chart" dialog box.

Information about the title can be changed in two places: In **Chart Area > Chart block > Area Display**, you can only display or hide the title, type a label for the title or use a formula, and modify/define the title position. In **Select Chart Area > Title > Design**, you can modify all the settings for the title.

1. Click **Adjust Layout** to see more options. For the chart title width and length, fixed is an absolute value and proportional is a percentage of the chart size.
2. For the border and background colors, you can select either a color and transparency or define a gradient. If you choose a color, a slider appears for you to choose the transparency value. 0% is transparent and 100% is opaque.

**Related Topics**
- To format a chart
17.6.6 To display a chart with a 3D look

You must be in Design mode. You must open the "Format Chart" dialog box.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Palette Style Type
   b. In the Rich Internet Application (Java applet), select Global > Palette and Style

2. Select 3D look.
   Some types of bar charts (where bar display effects have been activated) do not look very attractive if they also use 3D look.

Related Topics
• To format a chart

17.6.7 Assigning colors to charts

You can select a chart series or a legend item and assign it a color using the "Format" Toolbar. The color assignment is saved with the chart; you can reset all colors by applying a palette to the chart.

Rules for conservation at Turn Into:
• The dimension driving legend color (assigned to Region Color or Pie Selector Color) must be the same.
• The legend items must be the same (no adding or removing a dimension driving Region shape).

Note:
• You cannot assign colors to dual value axis charts.
• The series selection feedback is not available in DHTML. The feedback on a selected chart instance is only available in Web Intelligence Rich Client and Applet.

17.6.8 To add background colors to a chart

You must be in Design mode. You must open the "Format Chart" dialog box.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Background
   b. In the Rich Internet Application (Java applet), select Global > Background
2. Select either a color and transparency or define a gradient. If you choose a color, a slider appears for you to choose the transparency value. 0% is transparent and 100% is opaque.

Related Topics
• To format a chart

17.6.9 To modify chart borders

You must be in Design mode. You must open the "Format Chart "dialog box.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Border
   b. In the Rich Internet Application (Java applet), select Global > Border
2. Use the Border Editor to format the borders.

Related Topics
• To format a chart

17.6.10 To format the Plot Area background

You must be in Design mode. You must open the "Format Chart " dialog box.

The options available vary depending on the type of chart.

There are two options for grid and background:
• Plain background
  • Background color
  • Grid color for vertical / horizontal grids (note that the grid options slightly differ depending on the chart type: no grid for pies, radial/concentric grid for radars and specific options, three grids for 3D chart)
• Striped background (no grid definition, but alternate colors). The striped background option may not be available depending on the chart type (e.g. Pies and 3D charts)

1. Select Chart Area > Plot Area > Background.
2. Adjust the Background color.
3. Select whether you want a gradient or not.

Related Topics
• To format a chart
17.6.11 To hide the floor of a 3D chart

You must be in Design mode. You must open the "Format Chart " dialog box.
1. Select Chart Area > Plot Area > Background.
2. Change the Show Floor setting.

Related Topics
• To format the Plot Area background

17.6.12 To show and format chart legend

You must be in Design mode. You must open the "Format Chart " dialog box.

Information about the title can be changed in three places: In Chart Area > Chart block > Area Display, you can only display or hide the legend and the legend title. In Chart Area > Legend > Design, you can modify all the settings for the legend. In Chart Area > Legend > Title, you can format the legend title.

1. In the "Design" tab, you can make the legend visible or not, adjust the symbol size, position and layout, group by dimension, adjust the text settings and border and background settings.
2. In the "Title" tab, you can choose show or hide the title of the legend, and choose Automatic Title or Custom Title. Custom Title allows you to define a formula to be used for the Legend title.

Related Topics
• To format a chart
• Formulas in chart elements

17.6.13 To avoid page breaks in charts

You must be in Design mode. You must open the "Format Chart " dialog box.

• Open Chart Block > Layout, select Avoid page breaks in chart. It can be selected for both horizontal and vertical breaks.
17.6.14 To manage stacking options

You must be in Design mode. You must open the "Format Chart" dialog box.
Globally stacked means that the measures are also stacked.
100% stacked is transversal to the selected stacking mode.
Because the stacking is done axis by axis, you can choose to stack some data and not other data. (for instance, stacking bars, but not lines.)

1. Select Value Axis > Design.
2. Under "Stacking", select "Unstacked", "Stacked Chart", or "Globally Stacked Chart".

17.6.15 To assign axis labels in data values

You must be in Design mode. You must open the "Format Chart" dialog box.

1. Select Chart block > Data Values.
2. Check Data label displaying mode.
3. Select the appropriate Data Type.
4. You can also change the other Data Value settings on this page.

17.6.16 To format axis label text, borders, and background

You must be in Design mode. You must open the "Format Chart" dialog box.

1. Select Category Axis or Value Axis.
2. Select Design to make the axis visible. Under "Layout", you select whether to display axis, show labels, the orientation of the labels and other settings.
3. Under "Color Options", select the axis color, grid color, grid background color, and the text options.

Related Topics
• To format a chart

17.6.17 To format the axis grid

You must be in Design mode. You must open the "Format Chart" dialog box.
1. Select Category Axis > Design.
2. Under "Layout", select "Automatically Reduce Font Size of Labels displayed in grid".
3. Under "Color Options", select the "grid color" and "grid background color".

Related Topics
• To format a chart

17.6.18 To format axis values, numbers and text

You must be in Design mode. You must open the "Format Chart" dialog box.
1. Select Category Axis or Value Axis.
2. Select Design to format axis values, numbers, and text.
3. Under General, you can select that the axis is visible.
4. Under "Layout", you can display the axis, show labels, change the orientation, adjust label, automatically reduce the font size of labels displayed in grid, reverse order on the category axis, set the axis label delete mode and show continuous axis layout.
5. Under "Color Options", you can set the axis color, grid color and grid background color.
6. Under "Text", you can choose the font and the text policy (wrap or truncate).
7. Under "Number""Format Pattern", select the pattern you want for your numbers. (This only appears where you have numbers.)

Related Topics
• To format a chart
17.6.19 To show a specific range of axis values

You must be in Design mode. You must open the "Format Chart" dialog box.

**Note:**
Overscaling - a specific display indicates that a bar is incomplete. (Its value is out of the axis Max/Min values.)

1. Select **Value Axis, Design**.
2. Under **Scaling**, enter the "Minimum Value" and the "Maximum Value".
   The application displays the minimum and/or maximum values you specified on the axis.

**Related Topics**
- To format a chart

17.6.20 Linear and logarithmic axis scales

By default, the application displays the Value axis on charts as a linear scale. You can set the axis to a logarithmic scale. Logarithmic scales allow you to examine values that span many orders of magnitude without losing information on the smaller scales.

In a linear scale, the axis markers are evenly spaced. Linear scales are based on addition. Consider, for example, the linear sequence: 1, 3, 5, 7, 9

To get the next number in the sequence, you add 2 to the previous number.

Logarithmic scales are based on multiplication rather than addition. In a logarithmic scale, the steps increase or decrease in size. Logarithmic scales are based on multiplication (or division). Consider, for example, the logarithmic sequence: 2, 4, 8, 16, 32

To get the next number in the sequence, you multiply the previous number by 2. We can say that this sequence represents "base 2."

Consider the following sequence: 1, 10, 100, 1000, 10000

This sequence represents "base 10," because you get the next term in the sequence by multiplying the previous term by 10.
17.6.20.1 To display the Value Axis logarithmically

You must be in Design mode. You must open the "Format Chart " dialog box.

**Note:**
If you have a negative data value, a warning icon appears, if you have activated the warning icons.

1. Select Value Axis > Design.
   A logarithmic scale uniformly presents percent changes rather than point changes. In other words, the distance from 1 to 2 (100% increase) is the same as the distance from 2 to 4 (another 100% increase).

**Related Topics**
- To format a chart
- Linear and logarithmic axis scales

17.6.21 Displaying and formatting chart data

17.6.21.1 To hide an empty chart

You must be in Design mode. You must open the "Format Chart " dialog box.

Sometimes charts display no values. For example, if sales of a specific product are discontinued, a chart that normally displays results for that product will appear empty. By default, the application displays such empty charts on reports. If wished, you set the application to hide charts whenever they are empty.

1. Select the Chart block > General tab.
2. Select Hide always to hide the chart.
3. Select Hide when empty to hide the chart when it is empty.
4. Select Hide when following formula is true and type a formula in the box to hide the chart when the formula is true.

**Related Topics**
- To format a chart
17.6.21.2 To exclude rows containing zero values in tables and charts

You must be in Design mode. You must open the "Format Chart" or Format table dialog box. Rows that contain zero values or sums that are zero can be suppressed from charts since the data may not be useful. You can include rows that contain measure values that are zero, or where any sum or measure values is zero, or both.

When this option is disactivated, there will be no row in the table or item/detail in the chart. The zero values are suppressed. Sum is mostly used in crosstables.

1. Select the General tab.
2. In the Display section, unselect Show rows for which all measure values = 0 if you want to suppress measure values that are equal to zero.
3. In the Display section, unselect Show rows for which all sums of measure values = 0 if you want to suppress measure values where the sum of the measure values is zero. This option applies to crosstables.

Your chart or table will exclude the selected data.

17.6.21.3 To specify a palette style for the chart data

You must be in Design mode. You must open the "Format Chart" dialog box.

Note:
Dual axis charts use two color palettes.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Palette Style
   b. In the Rich Internet Application (Java applet), select Global > Palette and Style
2. Select the Color Palette and the percent of transparency.
3. Under "Marker", you can also choose symbols, symbol size, symbol palettes, border, border color.
4. Under "Chart Series Style", you can choose "Bar Effects".
5. Under "Light and Shadow Effects", you can select many light and shadow effects: offset, color, shadow, and 1-sided shadow.

Related Topics
* To format a chart
17.6.21.4 To apply special effects to bar charts, pie charts, and bubble charts

You must be in Design mode. You must open the "Format Chart" dialog box.
1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Palette Style
   b. In the Rich Internet Application (Java applet), select Global > Palette and Style
2. In "Chart Series Style", you can select an effect. For pie charts, you can choose a texture and an effect.

17.6.21.5 To apply light and shadow effects

You must be in Design mode. You must open the "Format Chart" dialog box.
1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Palette Style
   b. In the Rich Internet Application (Java applet), select Global > Palette and Style
2. In "Light and Shadow effects", you can select an effect.

17.6.21.6 To manage measure-based coloring in Tree maps, Heat maps and Tag Cloud charts

Associate a measure to the coloring method feed (Rectangle Color for maps, Tags Family for TagCloud).

You must be in Design mode. You must open the "Format Chart" dialog box.

The coloring method determines the color of rectangles or tags based on the value of a reference measure.

There are four coloring methods available.

• Palette coloring: You can define the number of ranges and the colors are associated automatically based on the selected palette. You can also define range definition and the color for null or empty values.
• Gradient-based palette coloring: Additionally, for this coloring you can define a 2 or 3 color gradient associated to the ranges.
• Gradient-based palette coloring using measure polarity: Additionally, for this color you can define a 2 or 3 color gradient associated to Measure with Neutral Polarity.
Custom range coloring: You can define the ranges manually and associate the colors by either percentage or absolute value.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Palette Style
   b. In the Rich Internet Application (Java applet), select Global > Palette and Style
2. Select a coloring method and define the number of color ranges.
3. If needed, define a range for the measure values and associate a color to out of range values.
4. Select a color for null or empty values.
5. Define the gradient for gradient methods or associate a color to each range for the custom method. For custom range coloring, define the Maximum and Minimum values of the color ranges. (It is automatic for other methods)

17.6.21.7 To show or hide data values

You must be in Design mode. You must open the "Format Chart " dialog box.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Data Values
   b. In the Rich Internet Application (Java applet), select Global > Data Values
2. Select Data label displaying mode to show the data.
3. You can adjust the settings for various parameters, depending on the chart type. For instance for a pie chart, select the data type, the data position, border size, background color, etc.

Related Topics

• To format a chart

17.6.21.8 To format data markers

You must be in Design mode. You must open the "Format Chart " dialog box.

1. Select the chart, right-click and select Format Chart.
   a. In the Web interface, select Chart Block > Palette Style
   b. In the Rich Internet Application (Java applet), select Global > Palette and Style
2. Under "Marker", you can select symbols, symbol size, symbol palettes, mono symbol, border, and border color.
Related Topics

- To format a chart
Formatting numbers and dates

18.1 Predefined and custom formats

You can change how values display in specific cells or on chart axes. You do this by applying predefined formats available in the application or by creating your own custom formats. You can save your custom formats for reuse on multiple blocks and reports in the same document.

18.1.1 Predefined formats

You can change how values display in specific cells or on chart axes. You do this by applying predefined formats or by creating your own custom formats. You can save your custom formats for reuse on multiple blocks and reports in the same document.

The following predefined formats are available for cells:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>The format defined for the object on the universe.</td>
</tr>
<tr>
<td>Number</td>
<td>Formats for decimal or integer values.</td>
</tr>
<tr>
<td>Currency</td>
<td>Formats for currency values.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date and time formats.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Formats for true and false values.</td>
</tr>
</tbody>
</table>

Related Topics

- To apply a custom number format to a cell
- To define a custom format
18.1.1 To apply a predefined format to a cell

1. Click Design to work in Design mode.
2. Select the cell.
3. Click Format > Numbers > Custom and select the format from the list.

18.1.2 Custom formats

You can use the Custom format type to define a customized format for any cell.

**Note:**
You cannot apply custom formats to numbers in the Web interface (DHTML interface).

The following table lists the strings you can use to create custom formats:

<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Display(s)</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The corresponding digit. If the number has less digits than the number of # characters used to specify the format, no leading zeros are inserted.</td>
<td>‘12345’ with the format #, ###0 gives ‘12,345’ (if your locale defines the grouping separator as a comma) or ‘12 345’ (if your locale defines the grouping separator as a space)</td>
</tr>
<tr>
<td>0</td>
<td>The corresponding digit. If the number has less digits than the number of 0 characters used to specify the format, a leading zero(s) is inserted before the number.</td>
<td>‘123’ with the format #0, 000 gives ‘0,123’</td>
</tr>
<tr>
<td>,</td>
<td>The grouping separator as defined by your locale.</td>
<td>‘1234567’ with the format #, ###0 gives ‘1,234,567’ (if you locale defines the grouping separator as a comma) or ‘1 234 567’ (if your locale defines the grouping separator as a non-breaking space)</td>
</tr>
<tr>
<td>Character(s)</td>
<td>Display(s)</td>
<td>Example</td>
</tr>
<tr>
<td>-------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>.</td>
<td>The decimal separator as defined by your locale.</td>
<td>‘12.34’ with the format #.#0 gives ‘12.34’ (if your locale defines the decimal separator as a period) or ‘12,34’ (if your locale defines the decimal separator as a comma)</td>
</tr>
<tr>
<td>[%]%</td>
<td>Displays a percentage sign (%) after the result and multiplies the result by 100.</td>
<td>‘1234567’ with the format # #0 gives ‘1234 567’</td>
</tr>
<tr>
<td>%</td>
<td>The % sign after the result, but does not multiply the result by 100.</td>
<td>‘1234567’ with the format # #0 gives ‘1234 567’</td>
</tr>
<tr>
<td></td>
<td>A non-breaking space ( )</td>
<td>‘1234567’ with the format # #0 gives ‘1234 567’</td>
</tr>
<tr>
<td>1, 2, 3, a, b, c, $, f, € (and so on)</td>
<td>The alphanumerical character.</td>
<td>‘705.15’ with the format $#. #0 gives ‘$705.15’ or with the format #.#0 € gives ‘705,15 €’</td>
</tr>
<tr>
<td>[Red], [Blue], [Green], [Yellow], [Gray], [White], [Dark Red], [Dark Blue], [Dark Green]</td>
<td>The value in the specified color.</td>
<td>‘150’ with the format #,##0[Red] gives ‘150’</td>
</tr>
<tr>
<td>Day/date characters</td>
<td>(day, date)</td>
<td>The first day of a month with the format d gives ‘1’</td>
</tr>
<tr>
<td>d</td>
<td>The number of the day in the month with no leading zeros. If the date for day is less than two characters, the date displays without a zero before it.</td>
<td>The first day of a month with the format d gives ‘1’</td>
</tr>
<tr>
<td>dd</td>
<td>The number of the day with leading zeros. If the date for day is less than two characters, the date displays with a zero before it.</td>
<td>The first day of a month with the format dd gives ‘01’</td>
</tr>
<tr>
<td>ddd</td>
<td>The name of the day abbreviated. The first letter is capitalized.</td>
<td>Monday’ with the format ddd gives ‘Mon’</td>
</tr>
<tr>
<td>dddd</td>
<td>The name of the day in full. The first letter is capitalized.</td>
<td>‘Monday’ with the format dddd gives ‘Monday’</td>
</tr>
<tr>
<td>Character(s)</td>
<td>Display(s)</td>
<td>Example</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>ddddd dd</td>
<td>The day of the week followed by a space and the number of the day.</td>
<td>‘Monday’ with the format ddddd dd gives ‘Monday 01’</td>
</tr>
<tr>
<td>Calendar characters</td>
<td>(month, year)</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>The number of the month with no leading zeros. If the number for month is less than two characters, the number displays without a zero before it.</td>
<td>‘January’ with the format M gives ‘1’</td>
</tr>
<tr>
<td>MM</td>
<td>The number of the month with leading zeros. If the number for month is less than two characters, the number displays with a zero before it.</td>
<td>‘January’ with the format MM gives 01</td>
</tr>
<tr>
<td>mmm</td>
<td>The name of the month abbreviated. The first letter is capitalized.</td>
<td>‘January’ with the format mmm gives Jan</td>
</tr>
<tr>
<td>mmmm</td>
<td>The name of the month in full. The first letter is capitalized.</td>
<td>‘January’ with the format mmmm gives January</td>
</tr>
<tr>
<td>yy</td>
<td>The last two digits for year.</td>
<td>‘2003’ with the format yy gives ‘03’</td>
</tr>
<tr>
<td>yyyy</td>
<td>All four digits for year.</td>
<td>‘2003’ with the format yyyy gives ‘2003’</td>
</tr>
<tr>
<td>Time of day characters</td>
<td>(hours, minutes, seconds, am/pm)</td>
<td></td>
</tr>
<tr>
<td>hh:mm:ss a</td>
<td>The hour with no leading zeros and the minutes and seconds with leading zeros. The “a” character displays AM or PM after the time when available.</td>
<td>‘21:05:03’ with the format hh:mm:ss a gives ‘9:05:03 PM’ for English locale</td>
</tr>
<tr>
<td>HH</td>
<td>The hour according to the 24-hour clock.</td>
<td>‘21:00’ with the format HH gives ‘21’</td>
</tr>
<tr>
<td>hh</td>
<td>The hour according to the 12-hour clock.</td>
<td>‘21:00’ with the format hh gives ‘09’</td>
</tr>
<tr>
<td>HH:mm</td>
<td>The hour and minutes with leading zeros.</td>
<td>‘7:15 am’ with the format HH:mm gives ‘07:15’</td>
</tr>
</tbody>
</table>
### 18.1.2.1 To define a custom format

1. In Design mode, click **Format > Numbers**
2. Click **Custom** to display the “Custom Format” dialog box.
3. Select a format listed in the **Properties** pane, and then edit the selected format by typing additional characters in one or more text boxes.
   For example, if you want to create a custom format for Number values, type the custom format you want in the **Positive**, **Negative**, and **Equal to Zero** boxes. If you want to create a custom format for Boolean values, type the custom format you want in the **True** and **False** boxes.
4. Click **Add**.
   You cannot delete or edit custom formats. To change a custom format, you need to create a new custom format and apply the new format to the selected cells. Any custom formats not applied to cells in a document are deleted automatically when you end your session.

### 18.1.2.2 To apply a custom number format to a cell

1. Select the cells to which you want to apply the custom format.
2. Click **Edit** on the main menu.

### 18.2 To format a number as a currency

1. Click **Design** to work in Design mode.
2. Select the cell.
3. Click **Format > Numbers > Currency** and select the currency from the list.
Formatting numbers and dates
Highlighting data using conditional formatting

Conditional formatting enables you to highlight results or change formatting based on data. You can, for example, conditionally format results to highlight particularly high or low results with specific colors or with text comments, such as "High Performer" or "Low Performer".

You can apply conditional formatting to the following elements:

- Columns in a vertical table
- Rows in a horizontal table
- Cells in forms and cross-tables
- Section headers
- Free-standing cells

You can apply up to 30 conditional formatting rules in a document. You can apply these rules to a maximum of 20 table columns or rows, free-standing cells, or section cells on the reports. You can apply up to 10 different rules on a single table column or row, free-standing cell, or section cell.

You can define conditional formatting rules to activate the following formatting changes:

- text color, size and style
- cell border colors and style
- cell background display – specific colors, images, or hyperlinks to web pages

You can also define rules that display a text or formula, an image, or a hyperlink. In this case, the results that meet the condition defined in the rule will be replaced by the text or formula.

Conditional formatting is dynamic. When you refresh reports with the latest data from the database, the rules highlight the new results accordingly.

If you apply conditional formatting to a table row or column with a break, the rule is only activated when the value that meets the conditional rule appears on the first row of that break.

19.1 Conditions in conditional formatting

Conditional formatting rules contain multiple conditions, allowing you to apply multiple formats depending on the data. Expressed in words, a conditional formatting rule operates as follows:

If <Main Condition> is true, Apply <Main Format>
ElseIf <Second Condition> is true, Apply <Second Format>
ElseIf <Third Condition> is true, Apply <Third Format>
ElseIf...
Else Apply <Default Format>
In the above example, if <Main Condition> is Sales Revenue > 100,000 and <Main Format> formats the text in blue, the conditional formatting displays the measure in blue whenever the Sales Revenue measure is greater than 100,000.

If <Second Condition> is Sales Revenue < 10,000 and <Second Format> formats the text in red, the conditional formatting also displays the measure in red whenever its value is less than 10,000.

Each condition can contain multiple tests, and all tests must return True for the conditional formatting to be applied. For example, a condition can test the values of the [Country] and [Resort] objects. Both objects must return the value specified in the test for the formatting to be applied.

19.2 To build a conditional formatting rule

Note:
This option is not available in Web mode. To create or edit conditional formatting, use the Rich Internet Application interface.

You must be in Design mode to build a conditional formatting rule.
1. Select Analysis > Conditional > New Rule to display the Conditional Format Editor.
2. Type the rule name in the Rulename box.
3. Type the rule description in the Description box.
4. To make the rule act on the content of whichever cells the rule is applied to, select Cell contents in the Filtered object or cell box.
   You cannot define a rule on a cell containing a date or numeric type data (for example, a date or a calculation) because the application considers any value you type into the Value text box as a character string.
5. To make the rule act on the value of an object, click ... next to the box and select the object from the list.
6. Select the operator from the Operator list.
7. Enter the value that triggers the formatting rule in the Operands box.
   - To enter a value directly, type it in the box.
   - To select a value from the list of values of the object you chose in the Filtered object or cell box, click ... to the right of the Value box, click Select Value on the menu, then select the value in the "List of Values" dialog box.
   - To select another object or variable as the value, click ... to the right of the Value box, click Select Object or Variable on the menu, then select the object or variable in the "Objects and Variables" dialog box.
   - To clear the Value box, click ... to the right of the box, the select Empty on the menu.
8. To add an additional test within the condition, click + by the existing conditions, then then choose the filtered cell or object, operator and value as described above.
9. To remove a condition, click x in the top right corner of the Condition box.
10. To trigger the condition using a formula, click Fx at the top of the Condition box, then type the formula. Click Fx to the right of the formula box to display the Formula Editor, which you can use to build the formula if you wish.
   - If you want your formula to return a text string, do not include quote marks before or after the text. For example, if you want the alerter to display OVERDUE, then type: OVERDUE.
   - The formula must return True or False. True triggers the condition; False does not. For example, if the formula is RowIndex() = 3, the conditional formatting appears on the fourth row of the table.

11. To add an additional condition to the rule, click + at the top left corner of the Condition box to display an Else Condition box, then define the conditions or build a formula as described above.
You can add multiple Else conditions to a condition.

12. To set the format that appears when the rule is triggered, click Format then use the Conditional Format Display dialog box to set the format.

19.3 To set the format displayed by a conditional formatting rule

Note that when you select Read content as: HTML, the two properties Autofit Width and Autofit Height do not work because the size of the HTML data in a cell cannot be decoded by the browser properly. The HTML content that is provided by the user is rendered by the browser directly. Our application does not modify the HTML code that is provided by the user to set the Width and Height.

1. Build the rule, then click Format in the “Conditional Format Editor” dialog box to display the “Conditional Format Display” dialog box.
2. To display text or a formula, select the Display tab and build the formula in the box.
3. To interpret the displayed text or formula as HTML, an image URL or a hyperlink, click Read content as, then select HTML, Image URL or Hyperlink from the list.
4. To change the number format, select the format from the Format Number list or click Custom and select the format from the “Format Number” dialog box.
5. To change the font style, click the Text tab, and define the font using the controls in the tab.
6. To change the background style, select the Background tab then define the background using the controls in the tab.
7. To change the border style, select the Border tab and define the border using the controls in the tab.

19.4 To apply conditional formatting

You must be in Design mode to apply conditional formatting to a document.

You can apply previously-defined conditional formatting rules to report elements. You can format the following report elements:
   - Columns in a vertical table
• Rows in a horizontal table
• Cells in forms and cross-tables
• Section headers
• Free-standing cells

1. Select the report element you want to conditionally format.
2. Select **Analysis > Conditional > Formatting Rules** and check the rule you want to apply from the list.

19.5 To manage conditional formatting rules

**Note:**
Not possible in the Web interface.

You must be in Design mode to manage conditional formatting rules.

1. Select **Analysis > Conditional > Formatting Rules > Manage Rules** to display the "Conditional Formats" dialog box.
2. To give a rule higher or lower priority in the list, select the rule and click the Up or Down button to the side of the list. Rules are applied from low priority up to high priority.
3. To duplicate a rule, select the rule and click **Duplicate**.
4. To remove a rule, select the rule and click **Remove**.

19.6 Using formulas to create advanced conditional formatting rules

You can build advanced conditional formatting rules using the formula language rather than using the Filtered object or cell, Operator and Value choices offered by in the Conditional Formatting Editor.

Example: **Highlighting three ranges of quarterly sales revenue results calculated as percentages of the average sales revenue**

In this example, you build three rules to color-code sales revenues, depending on their relationship to the average sales revenue. The table includes results for three years, and this is the average to which you want to compare each sales revenue result calculated per quarter per product line.

Using the Formula option in the Conditional Formatting Editor, you build the following rule, which contains three conditions. The conditions are as follows:

**Condition:**

\[ \text{[Sales revenue]} < \left(\text{Average([Sales revenue]) In Block} \times 0.8\right) \]
Else Condition:

=([Sales revenue] < ((Average([Sales revenue]) In Block) * 1.2))

Else Condition:

=([Sales revenue] > ((Average([Sales revenue]) In Block) * 1.2))

The formula you specify for each condition works as follows:

- The first condition applies when sales revenues are are < 0.8, or 80%, of the average.
- The second condition applies when sales revenues are < 1.2, or less than 120%, of the average.
- The third applies when sales revenue are > 1.2, or greater than 120%, of the average.

You then use the "Conditional Format Display" dialog box to specify the conditional formatting you want displayed in report cells that meet one the conditions. You choose the following formatting:

- Report cells containing sales revenue that is less than 80% of the average revenue (the first condition) display the revenue in red.
- Report cells containing sales revenue that is less than 20% above the average revenue (the second condition) display the revenue in blue. Note that this condition covers values also covered by the first condition. For example, if the average is 100, 79 is both less than 80% below the average and less than 20% above the average. In this case, the first condition takes precedence.
- Report cells containing sales revenue that is greater than 20% above the average revenue (the third condition) display the revenue in green.

This formatting enables you to see at a glance which product lines are generating above average, below average, or close to average sales revenue.
Highlighting data using conditional formatting
Filtering report data

20.1 Report filters defined

You can filter reports to limit the results that are displayed to specific information that interests you. For example, you can limit the displayed results to information for a specific customer or a sales period. The data you filter out remains in the document; it is simply not displayed in the report tables or charts. This means you can change or remove report filters in order to view the hidden values, without modifying the query behind the document.

You can apply different filters to different parts of a report. For example, you can limit the results in the entire report to a specific product line and then limit results in a table or chart further to focus on results for a specific region or customer profile.

To create a report filter, you need to specify three elements:

- a filtered object
- an operator
- filter values
- the report element to be filtered (the whole report, sections, or blocks)

Related Topics

- Applying filters to sections

20.2 Query filters and report filters compared

You can apply filters at two levels within a document:

- query filters – these filters are defined on the query; they limit the data retrieved from the data source and returned to the document.
- report filters – these filters limit the values displayed on reports, tables, charts, sections within the document, but they don’t modify the data that is retrieved from the data source; they simply hide values at the report level.
20.3 Report filter operators

20.3.1 Equal To operator

Use the Equal to operator to obtain data equal to a value.
For example, to return data for the US only, create the filter "County Equal To US".

20.3.2 Not Equal To operator

Use the Not Equal To operator to obtain data not equal to a value.
For example, to return data for all countries except the US create the filter "County Not Equal To US".

Note:
This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx queries.

20.3.3 Different From operator

Use the Different From operator to retrieve data different from a value.
For example, to retrieve data for all quarters except Q4, create the filter [Quarter] Different From "Q4"

Note:
This operator is not available in Web Intelligence Rich Client.

20.3.4 Greater Than operator

Use the Greater Than operator to retrieve data greater than a value.
For example, to retrieve data for customers aged over 60, create the filter "[Customer Age] Greater than 60".

**Note:**
This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx queries.

### 20.3.5 Greater Than Or Equal To operator

Use the Greater Than Or Equal To operator to retrieve data greater than or equal to a value.

For example, to retrieve data for revenue starting from $1.5M, create the filter "[Revenue] Greater than or equal to 1500000".

**Note:**
This operator cannot be used for OLAP unx universe parent-child hierarchies, or for BEx hierarchies.

### 20.3.6 Less Than operator

Use the Less Than operator to retrieve data lower than a value.

For example, to retrieve data for exam grades lower than 40, create the filter "[Exam Grade] Less Than 40".

**Note:**
This operator cannot be used for OLAP unx universes, and hierarchies in filters, or for hierarchies in BEx queries.

### 20.3.7 Less Than Or Equal To operator

Use the Less Than Or Equal To operator to retrieve data less than or equal to a value.

For example, to retrieve data for customers whose age is 30 or less, create the filter "[Age] Less Than Or Equal To 30".

**Note:**
This operator cannot be used for OLAP unx universes and hierarchies in filters, or for hierarchies in BEx queries.
**20.3.8 Between operator**

Use the Between operator to retrieve data between and including two values.

For example, to retrieve data for weeks starting at week 25 and finishing at 36 (including week 25 and week 36), create the filter "[Week] Between 25 and 36".

**Note:**
This operator cannot be used for OLAP unx universe and for BEx hierarchies in filters.

---

**20.3.9 Not Between operator**

Use the Not Between operator to retrieve data outside the range of two values.

For example, to retrieve data for all the weeks of the year, except for and not including weeks 25 through 36, create the filter "[Week] Not between 25 and 36".

**Note:**
This operator cannot be used for OLAP unx universe and for BEx hierarchies in filters.

---

**20.3.10 In List operator**

Use the In List operator to retrieve data corresponding to values in a list of values.

For example, to retrieve data for the US, UK and Japan only, create the filter [Country] In List ("US";"UK";"Japan").

When used in a query filter with a hierarchical list of values (either from a dimension associated with a hierarchical list of values or a hierarchy object), In List allows selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the In List operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

When used in a report filter, In List produces a flat list of values.

---

**20.3.11 Not In List operator**
Use the Not In List operator to retrieve data that does not correspond to multiple values.

For example, if you do not want to retrieve data for the US, UK and Japan, create the filter [Country] Not In ("US";"UK";"Japan").

When used with a hierarchical list of values (either from a dimension associated with a hierarchical list of values, a hierarchy object or a level object), In List allows selection of multiple members from any levels of the hierarchy. For example, a prompt on the [Geography] hierarchy using the Not In List operator allows selection of [Paris] at the City level and [Canada] at the Country level in the prompt.

**Note:**
This operator can only be used in certain types of hierarchies - for example, it can be used in level-based hierarchies.

### 20.3.12 Is Null operator

Use the Is Null operator to retrieve data for which there are no values in the database.

For example, to retrieve customers without children (the children column in the database has no value), create the filter [Children] Is Null.

### 20.3.13 Is Not Null operator

Use the Is Not Null operator to return data for which there is a value in the database.

For example, to return customers with children, create the filter [Children] Is not Null.

### 20.4 Types of report filter

There are two types of report filter:

- **Standard report filters.**
  
  Standard report filters are the most flexible type of report filter. They can use any filter operator and can filter on single values or lists of values.

- **Simple report filters.**
  
  Simple report filters provide an easy way to create filters using the Equal To operator. They can filter on single values only.
20.5 To create, edit and delete standard report filters

1. Select the report element you want to filter and select Filter > Add Filter.
   a. In the Rich Internet Application interface, select Analysis > Filters, then click on the Filter List box.

2. Click Add Filter on the dialog box to display the objects you can filter.

3. Select the objects you want to filter and click OK.
   If you selected more than one object the filtered objects appear in an AND relationship. Double-click the AND operator to change it to OR.

4. For each filter, select the filter operator from the list.

5. Type values directly in the box above the list of values of the object, or select values from the list and click > to add them to the list of filtered values on the right.
   The values you can type or select depend on the operator. For example, if you select the Equal To operator, you can type or select one value only.
   If the filtered object is a hierarchy, the values are displayed hierarchically. All members of the hierarchy are visible even if they are collapsed in the report. You must select hierarchy members from the hierarchy - you cannot type them manually.
   If the filtered object is a level, the values are displayed in a list.

6. Click OK to apply the report filter to the element.

7. To edit a report filter, select the report element and select Analysis > Filter > Edit Filter and edit the filter using the dialog box.

8. To delete a report filter, select the report element and select Analysis > Filter > Remove Filter.

20.5.1 To select values from a list

In a query, values in a list of values can appear either as a single-column list, a multicolumn list, or a hierarchy, depending on the object. In a multicolumn list, additional columns provide related values to the main value. In a hierarchical list, values appear in a hierarchical relationship.

In a report, values appear in a flat list without multiple columns.

1. If the list of values does not display when the dialog box opens, refresh the list, or search the list to retrieve values. (See later in this topic for details of searching lists of values.)
   Some list of values require an initial search to display values because the list is too large to be loaded in full.

2. If the list of values is divided into ranges, use the control above the list to navigate through the ranges.
Some large lists of values are divided into ranges to reduce the amount of data retrieved from the database. When you select a range, the list displays the values in that range.

3. If the list of values depends on other lists of values, specify the dependent values first in the prompt dialog box that displays.

A list of values can be dependent on other lists of values, for example when it is part of a hierarchical list of values. For example, if the list of values contains cities, and the City object is part of the hierarchy Country > Region > City, you need to specify values for country and region first to filter the list of cities.

**Note:**
Dependent lists of values appear in queries only. They do not appear when you are selecting from a list of values in a report.

When you first display the list of values, you see the Prompt dialog box that you use to specify the dependent values. Once you have specified the dependent values, you can select the values from the filtered list.

4. To display the value keys, click **Show/hide key values**.
Some lists of values contain key values, which are unique values that can be used to identify values with the same display value. If the list of values contains multiple columns, only the key of the filtering column is displayed.

5. To search for values in the list, type the search text in the box below the list and select the **Match case**, **Search in keys** or **Search on database** option.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Match case</strong></td>
<td>The search is case-sensitive. This option is not available when the <strong>Search in keys</strong> or <strong>Search on database</strong> options are selected.</td>
</tr>
<tr>
<td><strong>Search in keys</strong></td>
<td>The search uses unique value keys rather than display values. This option is available only on lists of values that support key values.</td>
</tr>
<tr>
<td><strong>Search on database</strong></td>
<td>The search includes all values stored in the database rather than being restricted to the values loaded into the list. It improves search accuracy but reduces search speed.</td>
</tr>
<tr>
<td></td>
<td>This option is available only on lists of values that support database searches.</td>
</tr>
<tr>
<td></td>
<td>Database searching improves search accuracy at the cost of performance. It is useful when not all values in the list of values were retrieved. This can happen when the total number of values in the list exceeds the <strong>Max rows retrieved</strong> query property.</td>
</tr>
<tr>
<td></td>
<td>Database searching is particularly useful when the list of values is hierarchical because values are loaded from the database only in response to their parent value being expanded in the hierarchy. For example, in a geographical hierarchy, the child values of the California value (cities in California) are not loaded from the database until the value is expanded. If the option is selected, the search includes these items even when the California value has not been expanded.</td>
</tr>
<tr>
<td></td>
<td>The search includes all ranges if the list of values is divided into ranges.</td>
</tr>
<tr>
<td></td>
<td>In search patterns, the &quot;<em>&quot; wildcard represents any string of characters and the &quot;?&quot; wildcard represents any single character. For example, the value &quot;March&quot; can be returned by the search patterns &quot;M</em>&quot; or &quot;Mar?h&quot;. To include the &quot;*&quot; and &quot;?&quot; characters literally rather than as wildcards, precede them with &quot;&quot; in the search pattern.</td>
</tr>
<tr>
<td></td>
<td>6. Type values from the list directly (if the list supports direct data entry) or select values from the list.</td>
</tr>
</tbody>
</table>

**Related Topics**

- [Max rows retrieved query property](#)

### 20.6 To create simple report filters

The **Report Filter** toolbar provides a quick method for adding simple report filters to reports.
Simple report filters have the form `<report_object>=<value>`. They can contain the `="` operator only and can filter on a single value only.

For more complex filters, use standard report filters, which can contain any operator.

**Note:**
You also use the **Report Filter** toolbar when drilling on reports. In the context of Drill, the **Report Filter** toolbar is known as the Drill toolbar.

1. Click **Interact > Filter Bar** to display the toolbar.
2. Click the icon on the toolbar and select the object on which you want to filter from the menu.
   You can add multiple objects to the toolbar to create multiple filters.
3. Select the value on which you want to filter from the drop down list of values.
   The report is filtered on the value of the object you selected. For example, if you selected "US" from the list of values of the Country object, the report is filtered to exclude all rows where Country does not have the value "US".
4. To remove a filter, select it and click **Remove**.
Filtering report data
Filtering data with prompts

You can filter report data by supplying values for prompts.

The "Prompts" dialog box displays a summary of all the defined prompts in the Prompt summary pane. You select the prompt you want to answer, and supply values in the Specify values for prompt pane of the dialog box.

Depending on the prompt you select, you type values directly, or select values from a list. A list of values can contain display values only, or the display values and their corresponding database key values. Database key values are unique values used to identify the display value within the database.

Lists of values can be organized hierarchically if the list was defined as a hierarchy by the universe designer, or the prompt is based on a hierarchy or level object.

Lists of values can be split into ranges to improve performance.

You can search or filter lists of values for easier access to the values you are interested in.

Prompts can be optional or mandatory. If you do not supply a value for an optional prompt, the prompt is ignored. You must supply values for all mandatory prompts before you can filter the data by running the prompts.

Prompts can depend on other prompts. For example, a prompt on a City object can be dependent on a prompt on a Region object. By supplying values to the Region prompt, you restrict the number of possible values of the City prompt.

You can supply values for dependent prompts only when you have supplied values for all the prompts on which they depend. If you wish to supply values to dependent prompts of an optional prompt, you must supply values for the optional prompt.

21.1 To supply values for prompts

A prompt has already been defined in the "Filter" pane of the "Query Panel".

1. Refresh the data.
2. Select the prompt in the Prompts summary pane.
3. If the prompt has a list of values and the values are not displayed, click Refresh values to display them. (In this case, the list displays the text "To see the contents of the list, click Refresh Values."
If the prompt is dependent on other prompts, the list of values displays links to the dependent prompts. You must supply values for the dependent prompts before you can supply a value for the current prompt. Groups of dependent prompts appear in separate groups in the Prompt Summary pane.

The values can appear as single values, in multiple columns (where the additional columns supply further information about the main filtering column), or hierarchically, depending on the prompt.

If the list of values is too large to display all at once, the list is split into ranges and a box above the list of values displays the current range. You can scroll through the ranges to see all the values in the list.

4. Select values and click > to supply the values to the prompt, or type values directly if the prompt allows you to do so.

You cannot type values directly if the list of values is hierarchical.

If the prompt requires a date, you can select it from the calendar that appears on the right of the box where you select the value

Note:
SAP Key Dates appear as date prompts, with other prompts in the same data provider appearing as dependent prompts.

5. Repeat the previous step if the prompt allows you to select multiple values.

If a prompt allows you to make multiple selections from a hierarchical list of values, you can select values at different levels of the hierarchy. If the prompt allows single values only, you can select values only from the bottom level of the hierarchy.

If a prompt allows you to type values directly and allows multiple values, you can specify multiple values separated by ",", for example California;Nevada;Iowa. After you have typed or pasted the separated list, click the tooltip that says "Click here to interpret as multiple values." (If you click >, the list is interpreted as a single value.)

6. In the Web interface, click Run Query to run the query.
   a. In the Rich Internet Application, click OK to run the query

The report data is filtered based on the selection you made.

Related Topics
• To select values from a list

21.2 To select values from a list

In a query, values in a list of values can appear either as a single-column list, a multicolumn list, or a hierarchy, depending on the object. In a multicolumn list, additional columns provide related values to the main value. In a hierarchical list, values appear in a hierarchical relationship.

In a report, values appear in a flat list without multiple columns.
1. If the list of values does not display when the dialog box opens, refresh the list, or search the list to retrieve values. (See later in this topic for details of searching lists of values.)
   Some list of values require an initial search to display values because the list is too large to be loaded in full.

2. If the list of values is divided into ranges, use the control above the list to navigate through the ranges.
   Some large lists of values are divided into ranges to reduce the amount of data retrieved from the database.
   When you select a range, the list displays the values in that range.

3. If the list of values depends on other lists of values, specify the dependent values first in the prompt dialog box that displays.
   A list of values can be dependent on other lists of values, for example when it is part of a hierarchical list of values. For example, if the list of values contains cities, and the City object is part of the hierarchy Country > Region > City, you need to specify values for country and region first to filter the list of cities.

   **Note:**
   Dependent lists of values appear in queries only. They do not appear when you are selecting from a list of values in a report.

   When you first display the list of values, you see the Prompt dialog box that you use to specify the dependent values. Once you have specified the dependent values, you can select the values from the filtered list.

4. To display the value keys, click **Show/hide key values**.
   Some lists of values contain key values, which are unique values that can be used to identify values with the same display value. If the list of values contains multiple columns, only the key of the filtering column is displayed.

5. To search for values in the list, type the search text in the box below the list and select the **Match case**, **Search in keys** or **Search on database** option.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Match case</strong></td>
<td>The search is case-sensitive.</td>
</tr>
<tr>
<td></td>
<td>This option is not available when the <strong>Search in keys</strong> or <strong>Search on database</strong> options are selected.</td>
</tr>
<tr>
<td><strong>Search in keys</strong></td>
<td>The search uses unique value keys rather than display values.</td>
</tr>
<tr>
<td></td>
<td>This option is available only on lists of values that support key values.</td>
</tr>
<tr>
<td><strong>Search on database</strong></td>
<td>The search includes all values stored in the database rather than being restricted to the values loaded into the list. It improves search accuracy but reduces search speed.</td>
</tr>
<tr>
<td></td>
<td>This option is available only on lists of values that support database searches.</td>
</tr>
<tr>
<td></td>
<td>Database searching improves search accuracy at the cost of performance. It is useful when not all values in the list of values were retrieved. This can happen when the total number of values in the list exceeds the <strong>Max rows retrieved</strong> query property.</td>
</tr>
<tr>
<td></td>
<td>Database searching is particularly useful when the list of values is hierarchical because values are loaded from the database only in response to their parent value being expanded in the hierarchy. For example, in a geographical hierarchy, the child values of the California value (cities in California) are not loaded from the database until the value is expanded. If the option is selected, the search includes these items even when the California value has not been expanded.</td>
</tr>
</tbody>
</table>

The search includes all ranges if the list of values is divided into ranges.

In search patterns, the "*" wildcard represents any string of characters and the "?" wildcard represents any single character. For example, the value "March" can be returned by the search patterns "M*" or "Mar?h". To include the "*" and "?" characters literally rather than as wildcards, precede them with "\" in the search pattern.

6. Type values from the list directly (if the list supports direct data entry) or select values from the list.

**Related Topics**
- **Max rows retrieved query property**
Filtering data using input controls

22.1 Input controls defined

Input controls provide a convenient, easily-accessible method for filtering and analyzing report data. You define input controls using standard windows controls such as text boxes and radio buttons. You associate these controls with report elements such as tables or section headers, and use the controls to filter the data in the report elements. When you select values in the input control, you filter the values in the associated report elements by the values you selected.

You can also define tables and charts as input controls. When you select a value in the table or chart, you filter the values in the associated report elements by the values you selected.

You can use input controls to analyze different scenarios by changing the value of variables. You define a variable with a constant value, then assign an input control, for example a slider, to the variable. You can then change the value of the variable using the slider control; if the variable is part of a formula, you can use the slider control to examine different formula results based on the variable value.

Input controls are report-specific. They are grouped on the Input Controls tab on the Left Pane.

22.2 Using input controls with hierarchical data

You can use input controls on hierarchical data. When you select a node of a hierarchy, you can select a single value and use the operator equal to, or you can select multiple values from a hierarchical tree list.

When you select a hierarchical tree list, right-click on a member and select the member, the children, or the descendants of the hierarchy. The elements of the hierarchies that you select display in the report pane. Refer to the pdf version of the documentation for more information.

22.3 To add an input control

You must have sufficient document modification rights and be in Design mode to add input controls.
1. Click **Analysis > Filters > Controls > Define Control** to display the "Select Report Object" screen. If you selected an entire table or chart before clicking **Define Control**, you can select **Include objects from selected block only** to restrict the list of objects in the wizard to the objects in the table or chart you selected.

You can also select the type of input control directly from the list of controls under **Analysis > Filters > Controls** instead of selecting **Define Control**. Those controls not compatible with the data from the report element you selected are disabled. The control is automatically associated with the report object that supplies data to the selected report element and uses its default properties, and you move directly to selecting the report elements you want the input control to filter.

2. Select the report object to supply values for the input control, then click **Next**.

3. Select the input control type.

   The list of control types is determined by the data type of the report object.

4. Define the input control properties.

   The available properties are determined by the control type.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The name of the input control</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the input control</td>
</tr>
<tr>
<td>List of values</td>
<td>The list of values available in the input control. You can use all values of the report object on which the input control is based (the default) or define your own custom list of values.</td>
</tr>
<tr>
<td>Use restricted list of values</td>
<td>If you define a custom list of values for the report object, this setting filters the data in the report element you assign to the input control based on this list of values. Even when no values are selected in the input control, any values not in the restricted list are excluded from the report element filtered by the input control. For example, if an input control based on the Country dimension is restricted to the values &quot;US&quot; and &quot;France&quot;, a table filtered by the input control shows data for US and France only, even when no value is selected in the input control. If you deselect <strong>Use restricted list of values</strong>, all values of Country appear in the table when no value is selected in the input control.</td>
</tr>
<tr>
<td>Operator</td>
<td>The operator that the input control uses to filter the associated report element</td>
</tr>
<tr>
<td>Default values</td>
<td>The default values that the input control uses to filter the associated report element</td>
</tr>
<tr>
<td>Number of lines</td>
<td>The number of lines that the input control displays in the Input Control pane. For example a list of five radio buttons with <strong>Number of lines</strong> set to 3 displays three radio buttons only by default. You access the other two radio buttons by using the scrollbar.</td>
</tr>
</tbody>
</table>
Filtering data using input controls

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum value</td>
<td>The minimum numerical value you can select in the input control</td>
</tr>
<tr>
<td>Maximum value</td>
<td>The maximum numerical value you can select in the input control</td>
</tr>
<tr>
<td>Increment</td>
<td>The amount by which the input control increases/decreased a numerical value when you are choosing a value</td>
</tr>
</tbody>
</table>

5. Click **Next** to display the **Assign Report Elements** wizard step.
6. Select the report elements you want the input control to filter.
   
   **Note:**
   Each time you save a document, any input controls that have no associated report elements are removed.

7. Click **Finish**.
   The input control appears on the **Input Controls** pane.

### 22.4 To edit an input control

1. Select the **Input Controls** tab in the Left Pane.
2. Click **Edit** on the input control to display the **Edit Input Control** dialog box.
3. In the Web interface, edit the input control properties in the **Properties** tab.
   a. In the Rich Internet Application interface, edit the input control properties in the **Control** tab.
4. Edit the report elements associated with the input control on the **Dependencies** tab.

### 22.5 To highlight input control dependencies

1. Click the **Input Controls** tab.
2. In the Web interface, click **Highlight dependencies** on the input control.
   a. In the Rich Internet Application interface, click **Show dependencies** on the input control.
   The report elements associated with the input control are highlighted.

### 22.6 To organize input controls

1. Select the **Input Controls** tab.
2. Drag and drop input controls to move them up or down on the Input Controls pane.
3. Select an input control, then click Remove at the top of the control to remove it from the Input Controls pane.

22.7 To view the input controls map

1. Select the Input Controls tab.
2. Click Map at the top of the Input Controls tab.

22.8 Using tables and charts as input controls

You can define tables and charts as input controls. Table- and chart-based input controls appear in the Input Controls panel in the same way as regular input controls, but you select values in the table or chart itself to filter the dependent report elements. When you select cells, columns or rows in tables, or clickable data areas in charts, the values in the associated report elements are filtered according to the values you selected.

When you click on a table or chart-based control in the Input Controls panel, the table or chart used as an input control is highlighted.

When a report is in drill mode, table- and chart-based input controls are disabled. They are re-enabled when drill mode is deactivated.

22.8.1 To define a table or chart as an input control

1. Select the table or chart, right-click and select Linking > Add Element Link.
2. Select All objects to define all the objects in the table or chart as the filtering objects, or select Single object and select the object to define a single object in the table or chart as the filtering object.

   Note:
   You can select dimensions only as filtering objects when you define a table or chart as an input control.

3. Click Next and type a name and a description for the input control.
4. Click Next and select the report elements to be filtered by the input control.
Note:
You cannot select the table or chart that you are defining as an input control from the list of report elements.

5. Click Finish.
The table or chart input control appears in the Input Controls pane. When you click on Show Dependencies, the table or chart defined as the input control is highlighted.

6. To modify the way a table or chart filters other report elements, right-click the table or chart and select Linking > Edit Element Link.

7. To remove a link between a table or chart and other report elements, right-click the table or chart and select Linking > Remove.

Related Topics
• To edit an input control

22.9 To filter data using input controls

1. Display the Input Controls pane by selecting the Input Controls tab in the Left Pane.
   
   Note:
The input control displays the message No dependent report elements if the report elements filtered by the input control are no longer in the report.

2. Select values in the input control.
The associated report elements are filtered based on the values you select. For example, if you select the "US" value of the [Country] dimension, the filter operator is Equal To, and there is a table associated with the input control, the table is filtered on the condition [Country] = "US".

3. To filter using a table or chart defined as an input control, select dimension values in the table (rows, columns or cells) or chart (clickable data areas).

Note:
• Tables or charts defined as input controls can filter using dimension values only.
• In the Rich Internet Application interface, a warning message displays when you delete objects used by an input control.
• The input control shows the message The table or chart is not in the report if the table or chart is no longer in the report.
• The input control shows the message Filtering dimensions not available if the filtering dimensions are no longer in the table or chart. The input control becomes usable again if you add the dimensions to the table or chart.
• The input control shows the message Control not usable while the report is in drill mode if the report is in drill mode. Drill mode must be turned off to make the input control usable.
• Table- and chart-based input controls are indicated by an icon in the top right-hand corner of the table or chart. Right-clicking the icon displays the following menu:
### Filtering data using input controls

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Edits the input control</td>
</tr>
<tr>
<td>Highlight dependencies (Web interface)</td>
<td>Highlights the report elements filtered by the input control</td>
</tr>
<tr>
<td>Show dependencies (Rich Internet Application interface)</td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Removes the filters applied by the input control</td>
</tr>
<tr>
<td>Disable/Enable</td>
<td>Disables or enables the input control</td>
</tr>
</tbody>
</table>

4. To remove all filters applied by input controls, click **Reset** at the top of the **Input Controls** pane.
Enhancing reports with calculations, formulas and variables

23.1 Calculations, formulas and variables

You can add calculations, formulas and variables (named formulas) to reports. For detailed information on the available calculations, see the Using Functions, Formulas and Calculations in Web Intelligence guide or the online help.

23.2 Working with standard calculations

23.2.1 To insert a standard calculation in a table or cross table

You must be in Design mode to insert calculations.

You can insert standard calculations in tables or cross tables to make quick calculations on table data. For more information on the standard calculations, see the Using Functions, Formulas and Calculations in Web Intelligence guide or in the online help.

You can insert multiple calculations in a table or cross table. When you apply two calculations to a table or crosstab, a footer is added for each calculation result. You insert multiple calculations in a table or cross table in the same way that you insert one calculation, but you repeat the procedure for as many calculations as you want to insert.

1. Click the table cell that contains the data you want to calculate.
2. Click Analysis > Functions and select the calculation you want to add, or double-click a cell to launch the "Formula Editor".
   You can repeat this step to add multiple calculations to the same column.
   A footer containing the result of the calculation is added below the column.
23.2.2 To remove a standard calculation

1. Right-click the cell that contains the calculation.
2. Select a cell in the row or column containing the calculation, right-click and select **Delete** from the menu.
3. In the dialog box, select **Row** to delete the row or **Column** to delete the column.

23.3 Working with formulas

23.3.1 To enter a formula by typing

You must be in Design mode to enter a formula.
1. Click **View > Formula Bar** in the left pane to display the **Formula** bar.
2. Type the formula in the **Formula** box and click **Validate** to validate it.

23.3.2 To build a formula using the Formula Editor

1. Select the cell where you want to enter the formula.
2. Select **View > Formula Bar** on the **Properties** tab to display the Formula Bar.
3. Click the **Formula Editor** icon on the Formula bar to display the Formula editor.
4. Build the formula using the Formula Editor.

23.4 Working with variables
23.4.1 To create a variable

You must be in Design mode to create a variable from a formula.

**Note:**
If a cell is selected before you open the formula editor, the formula you create is assigned to the cell.

1. Click **View > Formula bar** in the **Properties** tab to display the Formula bar.
2. Click the **Create Variable** icon in the Formula Bar to display the Variable Editor.
   
   If the **Formula** box contained a formula, it appears in the Variable Editor. Otherwise, the Variable Editor is blank.
3. Type the variable name in the **Name** box.
4. Build the formula for the variable if it is not already displayed.
5. Select the variable type by selecting **Dimension**, **Measure** or **Detail**.
6. If you select **Attribute**, an "Associated Dimension" box appears. Click ... next to the box to open the "Objects and Variables" dialog box and select the dimension you want to associate with the detail.
7. Click **OK**.

23.4.2 To edit a variable

1. Select the variable in the list of report variables on the **Available Objects** tab on the Left Panel.
2. Click the right mouse button and click **Edit** on the shortcut menu.
   
   The Variable Editor appears.
3. Edit the variable.
4. Click **OK** to save the new variable definition.

23.4.3 To delete a variable

1. Select the variable in the list of report variables on the **Available Objects** tab on the Left Panel.
2. Click the right mouse button and click **Remove** on the shortcut menu.
23.4.4 To rename a variable

This action is possible in the Rich Internet Application and Desktop interfaces, but not in the Web interface.

1. Select the variable in the list of report variables on the "Available Objects" tab in the left panel.
2. Click the right mouse button and click **Rename** on the shortcut menu.
3. Rename the variable and save it.
Drilling on report data

24.1 Drill defined

You use drill to analyze the results displayed in reports. Drilling on reports lets you look deeper into your data to discover the details behind a good or bad summary result displayed in tables, charts, or sections.

Table 24-1: Restrictions

<table>
<thead>
<tr>
<th>Restriction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queries on BEx queries</td>
<td>You cannot use drillpath on BEx queries. Navigation path (previously called the drillpath) is replaced by the collapse/expand workflow on the real hierarchy.</td>
</tr>
<tr>
<td>Queries on .unv and .unx universes</td>
<td>You can only drill on a .unv or .unx universe if the drill paths are already defined in the universe.</td>
</tr>
</tbody>
</table>

Example: **Why did sales of accessories, outwear, and overcoats rise in Q3?**

You work for a US national fashion retail chain, and are in charge of sales of accessories, outerwear and overcoat clothing lines in western states. You see that revenue is much higher for Q3 than the other quarters. To understand why, you drill down to look at the factors behind the result and you see that jewelry sales were much higher in July.

24.1.1 Scope of analysis

The scope of analysis for a query is extra data that you can retrieve from the database to give more details on the results returned by each of the objects in a query. This extra data does not appear in the initial result report, but it remains available in the data cube, so you can pull this data into the report to allow you to access more details at any time. This process of refining the data to lower levels of detail is called drilling down on an object.
**Note:**
This option in the Query Panel is only available for relational universes and not for OLAP.

In the universe, the scope of analysis corresponds to the hierarchical levels below the object selected for a query. For example, a scope of analysis of one level down for the object Year, would include the object Quarter, which appears immediately under Year.

You can set this level when you build a query. It allows objects lower down the hierarchy to be included in the query, without them appearing in the Results Objects pane. The hierarchies in a universe allow you to choose your scope of analysis, and correspondingly the level of drill available. You can also create a custom scope of analysis by selecting specific dimensions to be included in the scope.

**Note:**
You cannot set the scope of analysis when working in query drill mode because this drill mode modifies the scope dynamically in response to drill actions.

### 24.1.1.1 Levels of scope of analysis

You can set the following levels for scope of analysis:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Only the objects that appear in the Results Objects pane are included in the query.</td>
</tr>
<tr>
<td>• One level down</td>
<td>For each object in the Result Objects pane, one, two, or three objects lower down the hierarchy tree are included in the query. The data from these objects is stored in the cube until you add them to the document.</td>
</tr>
<tr>
<td>• Two levels down</td>
<td></td>
</tr>
<tr>
<td>• Three levels down</td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>All objects added manually to the Scope of Analysis panel are included in the query.</td>
</tr>
</tbody>
</table>

Including a scope of analysis in a document increases the document size significantly. This is because the data necessary for the scope you specify is saved with the document, even though it is not visible in the reports unless you start drill mode and drill down to the data to display the corresponding values.

In order to minimize the size of documents and optimize performance, include a scope of analysis only in documents where you are certain that users will need to drill.

### 24.1.2 To set the scope of analysis
1. Click Show/Hide Scope of Analysis Pane on the Query toolbar to display the Scope of Analysis pane.
   All the dimensions in the Result Objects pane appear in the Scope of Analysis pane. This corresponds to the default scope of analysis - None. (There are no additional levels available for analysis.)
   
2. Select the analysis level from the Scope level list at the top-right corner of the Scope of Analysis pane.
   The objects hierarchically below the objects in the Result Objects pane appear in the Scope of Analysis pane down to the number of levels you selected.

3. To add selected dimensions to the scope of analysis or create a custom scope of analysis, select dimensions in the Query Manager and drag them across to the Scope of Analysis pane.

24.1.3 Drill paths and hierarchies

When you analyze data in drill mode, you move along a drill path. These paths are based on the dimension hierarchies set by the designer of the universe. Universe designers organize objects in classes in a hierarchy with the most summary objects at the top and the most detailed at the bottom. So if you want to make a high-level report, you know that your query should include objects at the top of the list. If you want to see more detailed information, you can then switch to Drill mode and drill down on each dimension value displayed in the reports.

For example, if the data from [Quarter] did not sufficiently explain a result, you could drill down to [Month] or [Week], depending on how the universe designer set up the hierarchy. When you drill to a different level, measures, such as a [Revenue] or [Margin], are recalculated accordingly.

Drill paths usually follow the same hierarchy order as the classes on a universe. For example, a class called Time typically includes the [Year] dimension at the top of the class, followed by the [Quarter], [Month], and [Week] dimensions. The hierarchies for drill within the Time hierarchy typically follow the same order, because users want to drill annual results to analyze details for quarter, month, and so on. However, the universe designer can also define custom hierarchies.

Note:
A dimension can belong to several hierarchies. When you drill a result on a dimension that belongs to more than one hierarchy, you must answer a prompt to select the drill path.

24.1.3.1 To view drill hierarchies

1. In Data or Design mode, click Data Access > Edit to edit the data provider in the Query Panel.
2. Select Display by Navigation Paths from the menu at the bottom left of the Query Panel.
Drilling on report data

24.2 Setting drill options

Drilling on reports lets you look deeper into data to discover the details behind a good or bad summary result displayed on a table, chart, or section. Before you begin a drill session, you can set your drill options to specify how reports will change each time you drill. How you set the drill options depends on the interface you are using:

- BI launch pad
- Web Intelligence Rich Client

24.2.1 To set drill options in the BI launch pad

- In the BI launch pad, click Preferences, click Web Intelligence to display the available options, then select the drill options under Drill options and Start drill session.

24.2.2 To set drill options in Web Intelligence Rich Client

1. Click Properties > Application to display the application properties dialog box.
2. In Web Intelligence Rich Client, click Tools, and select Options from the menu in the top-right corner next to the Help menu to display the "Options" dialog box, select the Drill tab, then select the drill options.

24.3 Drill options explained

24.3.1 Prompt when drill requires additional data option

When you drill the results displayed on a report, you may want to drill to higher- or lower-level information that isn’t included in the scope of analysis for the document. A new query is required to retrieve this data.
Since queries on large selections of data may take a long time to be completed, you can choose to be prompted with a message every time a new query is necessary. The prompt message asks you whether you want to run the additional query or not. In addition, the prompt lets you apply filters to the extra dimensions you include in the new query. This means you can restrict the size of the query to only the data necessary for your analysis.

You need permission from your administrator to drill out of the scope of analysis during a drill session.

### 24.3.2 Synchronize drill on report blocks option

When you select the **Synchronize drill on all report blocks** option, the display of all blocks changes to correspond with your drill actions. For example, if you drill down on a block from year to quarter, and your report also contains a chart showing data by year, the chart display also changes to display data by quarter.

If you do not select the option, only the structure of the drilled block changes. Drill filters are applied to the whole report.

### 24.3.3 Hide drill toolbar option

When you drill on a value displayed on a report, the Drill toolbar appears and displays the value on which you drilled. The value displayed on the toolbar filters the results displayed on the drilled report.

For example, if you drill on year 2010, the results displayed on the drilled table are Q1, Q2, Q3, and Q4 for year 2010. This means that the quarterly values you drilled to are filtered by 2001.

**Note:**

The Drill toolbar allows you to select alternative values on the same level, in order to filter the results differently. For example, if you use the Drill toolbar illustrated above to select "2002," the results displayed on the drilled table would be Q1, Q2, Q3, and Q4 for year 2002.

You can opt to hide the Drill toolbar when you start drill mode. The Drill toolbar is only useful if you want to select filters during your drill session.

### 24.3.4 Start drill session on existing report option

When you select **Start drill session on existing report**, the current report becomes drillable when you start drill mode. When you end drill mode, the report displays the drilled values.
24.3.5 Start drill session on a duplicate report option

When you select Start drill on a duplicate report, you drill on a duplicate of the current report when working in drill mode. This allows you to compare the results of the original report with the results you discover during your drill analysis.

24.4 To switch to drill mode

To start drilling on a report you either switch to Drill mode or, if the report is saved in Drill mode, drill directly.

1. Select the report you want to drill.
2. Click Analysis > Interact > Drill > Start Drill.

Note: When you open a document that was saved in Drill mode, the document opens in Drill mode if you have the right to drill on documents.

By default, a drill icon appears on the tab of the drillable report. Depending on the drill options you selected on Document Preferences page in the BI launch pad, either the selected report becomes drillable or a drillable duplicate of the selected report is created.

Related Topics
• Start drill session on a duplicate report option

24.5 Retrieving more levels of data to the report

When you are drilling a report, you may want to drill up or down to a dimension that lies outside the scope of analysis defined for the document. Returning the additional data requires running a new query that includes the additional dimensions you specify. This is called extending the scope of analysis.

You can extend the scope of analysis during your drill sessions only if your security profile allows you to do so. Your security profile is controlled by your administrator.

If your Drill options are not set to display the Extend the Scope of Analysis prompt message during drill, you will not be given the option to select filters if you drill beyond the data already available in the document. In this case, the new query runs automatically and returns data for all the values on the dimensions you are drilling.
24.5.1 To drill out of the scope of analysis

1. Hold your mouse cursor over a dimension value that is at the end of the scope of analysis. A ToolTip informs you that a new query is necessary to return the additional data to the document.

2. Drill on the dimension.
   - If your Drill options are set to prompt you when a drill action requires a new query, the "Extend the Scope of Analysis" dialog box appears.
   - The dialog box lists the dimensions in the hierarchy above and below the drilled value. The dimensions already included in the document are checked. The dialog box also displays the filters that you can select to filter the new query.

3. Select the check boxes next to the dimensions you want to drill.

4. Select the check boxes next to the filters you want to use to filter the query.

5. Click OK.
   - A new query returns the additional data to the document and the results for the dimension you drilled to appear on the table.

24.6 To choose a drill path when more than one is available

A dimension can belong to multiple hierarchies. When you drill down on such a dimension value, it is not clear which drill path to follow. You must define the drill path.

Note:
If the dimension value you choose to drill on is the result of a previous drill, the drill path is already known. Therefore you do not need to select a drill path.

1. Drill on the dimension.
   - The "Select Drill Path" dialog box appears. The dialog box lists the dimensions in the hierarchy above and below the drilled value. A check box appears next to each dimensions below the current dimension you are drilling, so that you can select which of these dimensions you want to retrieve from the database, in order to continue your drill action. The dialog box also displays the filters that you can select to filter the new query.

2. Select the path you want to drill.

3. Click OK.
24.7 To take a drill snapshot

- Select Analysis > Interact > Drill > Snapshot.

24.8 Drilling on dimensions in tables and sections

Dimensions typically represent character-type data, such as customer or business names, and dates. Calculations are based around the dimensions in a report. For example, if you create a report that calculates a region's total sales revenue for a given year, the Sales Revenue measure is calculated based on the two dimensions: State and Year.

When you drill on a dimension to see the more data behind the displayed result, the sales revenue is calculated according to the values to which you drill. If you drill on Year in the above example, you display sales revenue by state and quarter, because Quarter is the next dimension in the time hierarchy below Year.

**Note:**
You cannot drill on detail objects.

24.8.1 Drilling down

You drill down to see the lower-level data that makes up the summary results displayed on reports. This helps explain why high or low results occurred.

**Example:** Using drill analysis to find out why sales decreased dramatically in 2003

In this example, you receive a report that shows sales revenue results for the accessories line at the eFashion retail store. The following crosstab shows that the Accessories line decreased in 2003.

<table>
<thead>
<tr>
<th></th>
<th>2001</th>
<th>2002</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$2,468,222</td>
<td>$5,468,919</td>
<td>$1,859,405</td>
</tr>
</tbody>
</table>

To analyze more precisely when the decrease occurred, you drill down on the cell value 2003, to view the detailed data for each quarter.
When you drill down on the cell value 2003, a filter appears in the Drill toolbar to show that the quarterly values you have drilled to are filtered for the year 2003. The drilled chart clearly shows that the problem arose in Q4 of 2003.

<table>
<thead>
<tr>
<th></th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>$257,334</td>
<td>$536,271</td>
<td>$645,055</td>
<td>$370,144</td>
</tr>
</tbody>
</table>

To find out which of the categories within the Accessories line was responsible for the drop in revenue, you drill down again on the cell value Accessories.

<table>
<thead>
<tr>
<th></th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belts, bags, wallets</td>
<td>$195,102</td>
<td>$235,756</td>
<td>$105,772</td>
<td>$223,218</td>
</tr>
<tr>
<td>Hair accessories</td>
<td>$69,574</td>
<td>$1,133</td>
<td>$46,847</td>
<td>$15,490</td>
</tr>
<tr>
<td>Hats, gloves, scarves</td>
<td>$14,954</td>
<td>$1,653</td>
<td>$12,721</td>
<td>$8,310</td>
</tr>
<tr>
<td>Jewelry</td>
<td>$12,118</td>
<td>$10,631</td>
<td>$21,436</td>
<td>$7,406</td>
</tr>
<tr>
<td>Lounge wear</td>
<td>$16,066</td>
<td>$59,282</td>
<td>$149,401</td>
<td>$22,105</td>
</tr>
<tr>
<td>Samples</td>
<td>$35,621</td>
<td>$218,034</td>
<td>$301,828</td>
<td>$33,516</td>
</tr>
</tbody>
</table>

The drilled crosstab shows which categories were responsible for low revenue in Q4.

**Note:**
If you try to drill to a dimension that is already displayed in another column or row of the same table, the next available dimension in the drill path is displayed.

---

### 24.8.1.1 To drill down on a dimension value in a table or section cell

1. Verify you are in Drill mode
2. On a table or section cell, place your pointer over the dimension value on which you want to drill. A ToolTip appears, showing the next dimension in the drill path. If the drilled report includes dimensions from multiple data providers, the ToolTip displays the name of the query and the dimension for the value.
3. Click the value.

The drilled table or section displays data one dimension level down. The Drill toolbar, at the top of the report, displays the values from which you drilled. These values filter the values displayed on the drilled table.
24.8.2 Drilling up

You drill up on a dimension value to see how the more detailed data aggregates to a higher-level result. For example, you may have drilled down on Year to examine data for each quarter. If you want to see how this data aggregates to yearly results, you can drill up.

When you drill up on a dimension value, you move along the drill path from lower- to higher-level data. For example, you may have drilled down on [Year] to [Quarter]. If you drill up on [Quarter], you return to [Year].

You can only drill up on a dimension value if you have previously drilled down to that dimension, or you have defined the appropriate drill path in the scope of analysis.

24.8.2.1 To drill up on a dimension value

1. Verify you are in Drill mode.
2. On a table or section cell, right-click the dimension value on which you want to drill up, then on the shortcut menu click **Drill up**, or click the Drill Up icon next to the dimension value you want to drill up.
   
   If the table is a crosstab without headers that display the names of the dimensions on the table, then the Drill Up icon appears next to each value from which you can drill up.

   The report now displays data one dimension level up. The filters that filtered the value you drilled up from, are removed from the Drill toolbar.

24.8.3 Drilling by

When you drill down or up, you move through a hierarchy one dimension at a time. However, you can get another view of the data by slicing it in a different way, and then look at the data in other hierarchies. To do this, you drill by the other dimensions that interest you.

**Note:**
You can only Drill by to a dimension that is included in the scope of analysis of the document.

**Example:** **Drilling by the Products hierarchy to slice sales revenue results by product**

You work as regional manager for California in a retail clothing store, and have been sent the following report that shows quarterly sales revenue by state:
You are only interested in analyzing the results in the state of California. In addition, you want to analyze the sales revenue broken down by each product line you sell. To drill on California data, you place your pointer on the table cell that says California.

If you drilled down now, however, you would drill to results for each city within California, because [City] is the dimension below [State]. Instead, you select Drill by from the drill menu and then you navigate through the dimensions on the Products hierarchy by selecting the sub-menus until you reach the [Lines] dimension.

The drilled report displays the detailed sales revenue results for each product line sold in California.
24.8.3.1 To drill by a dimension value

1. Verify you are in Drill mode.
2. On a table or section cell, right-click the dimension value you want to drill by.
   A shortcut menu appears, displaying the available drill paths.
3. Place your pointer on **Drill by**, then on the class to which you want to drill.
4. Click the dimension to which you want to drill.
   The report now displays data for the dimension to which you drilled.

### 24.9 Drilling on measures in tables and sections

When you drill on a measure value, you drill one level down for each related dimension in the block, and you see the measure calculated for the displayed dimensions.

**Example:** **Drill on annual sales revenue results to see the breakdown by city and quarter**

For example, you drill down on the year 2003 sales revenue value for California, which is displayed on a crosstab that shows sales revenue by year and by state.
The drilled report displays sales revenue by quarter (one level below Year) and by city (one level below State) for California.

24.9.1 To drill down on a measure value

1. Verify you are in Drill mode.
2. Place your pointer over the measure value on which you want to drill.
   A ToolTip appears, displaying the next dimension(s) in each related drill path
3. Click the measure value.
   Your report now displays data one dimension level down. The table headers display the names of the dimensions you drilled to and the drill up arrow, which indicates you can drill back up to the summary results if wished. The Drill toolbar displays the values that filter the results displayed on the drilled table or section.

24.9.2 To drill up on a measure value

1. Verify you are in Drill mode.
2. Right-click the measure value on which you want to drill up, then click the Drill up option on the shortcut menu, or click the Drill Up icon next to the measure value you want to analyze.
   The drilled table now displays data one dimension level up.

24.10 Synchronizing drill across multiple tables and charts

A report can contain several tables or charts. The generic term used to refer to tables and charts in this guide is a block. There are two ways to drill on a report with multiple blocks:

• drill simultaneously on each block in the report the contains the drilled dimension
• drill on only the current block of data

You set how drill is performed on reports with the Synchronize drill on report blocks option.

If synchronize drilling across all blocks in a report, you drill on each block in the report containing that drilled dimension. The next dimension in the drill path replaces the previous dimension in all blocks in the report.
If you do not synchronize drilling across all blocks in a report, the next dimension in the drill path replaces the previous dimension only in the current block in the report.

Related Topics
• Synchronize drill on report blocks option

24.11 Drilling on charts

Drilling down, up, or by on a chart, provides you with a graphical explanation for why summary results are particularly high or low.

You can drill on:
• dimensions – by drilling on chart axes
• dimensions – by drilling on the chart legend
• measures – by drilling on the data bars or markers in the body of the chart

You cannot Drill by dimensions on chart axes. However, you can Drill by dimensions on chart legends.

Related Topics
• Drilling on axis legends

24.11.1 Drilling on dimensions via chart axes

On 2D charts, you can drill on dimensions via the X-Axis. On 3D charts, you can drill on dimensions via the X-Axis and the Z-Axis. Charts can contain one or multiple dimensions on a single axis. When an axis contains multiple dimensions, each possible combination of the dimension values appear on the axis (this is sometimes referred to as a cartesian product).

When you drill on an axis value with multiple dimensions, the drilled results are filtered by both dimensions.

24.11.1.1 To drill on a chart axis

1. Verify you are in Drill mode.
2. Place your pointer over the dimension value on which you want to drill.
3. If you want to drill down on the dimension value, click the value. If you want to drill up on the dimension value, right-click the value then select **Drill Up**. If you want to drill down on the dimension value, right-click the value then select **Drill Down**. If you want to drill by the dimension value, right-click the value then select **Drill By**

**Note:**
Drill by is not available if the axis has multiple dimensions.

### 24.11.2 Drilling on measures in charts

You can drill on the measures displayed on the following types of chart:

- bar charts – by drilling on the bars
- line and radar line charts – by drilling on the data markers
- pie chart – by drilling on the segments

When you drill on measures, the drill occurs on each dimension displayed on the chart axes. The new measure calculations displayed on the bars or data markers on the drilled chart, correspond to the lower- or higher-level dimensions to which you drilled. The chart axis labels display the names of the drilled dimensions.

**Example:** *Analyze detailed information for the sales revenue measure on a chart*

For example, this 3D bar chart displays values for the [State] dimension on the X-Axis and displays values for the [Lines] dimension on the Z-Axis. This means that the chart bars display values for sales revenue per state per line.

As the example below shows, when you drill down on the bar for “City Trousers” in “California” you also drill down from [State] to [City] on the X-Axis and from [Lines] to [Category] on the Y-Axis.

The drilled chart displays sales revenue per city per category for the “City Trousers” clothing line.
24.11.2.1 To drill on a measure in a chart

1. Verify you are in Drill mode.
2. Place your pointer on the measure value on which you want to drill.
   On charts, each measure is represented by a bar (on bar charts) or by a data marker (on a line charts and radar line charts).
3. If you want to drill down on the measure value, click the bar or data marker. If you want to drill up on the measure value, right-click the bar or data marker, and then click Drill up.

24.11.2.1.1 Restrictions when drilling measures on charts

When you drill on charts that are not bar charts, the drill action might be performed only on certain dimensions instead of on all of the dimensions on the chart axes. When you drill on measures in the following chart types, the drill action is performed only on the values in the axis legend:

- area charts – 2D, 3D, and stacked
- radar and scatter charts – all types

Note:
You cannot drill on measures in 3D area charts.

24.11.3 Drilling on axis legends
You can drill on charts via the chart legend whenever the legend lists the dimensions displayed on the chart. When the chart legend lists the measures displayed on the chart, drilling on the legend is not possible.

Drilling on a legend is useful, if you are working with a pie chart, because the axis labels, which display the names of the dimensions represented by each pie segment, are not often displayed.

**Note:**
You can only Drill by on a chart legend, if there is a single dimension on the axis.

### 24.11.3.1 To drill on an axis legend

1. Verify you are in Drill mode.
2. Place your pointer over the value on which you want to drill.
3. To drill down the dimension value, click the color associated with the value. To drill up the dimension value, right-click the color associated with the value, then click **Drill up**; or click the **Drill Up** icon. To drill by the dimension value, right-click the color associated with the value, then click **Drill by**.

### 24.12 Using filters when you drill

When you drill on a dimension or measure value in a table or chart, the drilled results are filtered by the dimension or measure you drilled on. The filter is applied to all of the results displayed on the drilled report.

Filters appear as list boxes in the **Drill** toolbar. Each list box contains the values associated with that filter. You select the data displayed in a table or chart by choosing the appropriate values from the list boxes.

**Note:**
You can also use the **Drill** toolbar outside Drill mode to quickly add simple report filters to reports. In this context the toolbar is known as the **Report Filter** toolbar.

**Example:** Filtering drilled reports by different US states

For example, if you drill down on a table cell displaying "California" to view results for cities in California, you filter the values in the entire report for California and display results for California only in the report.

By changing the value of each filter, you can then see data for other values on the drilled dimension. For example, you can select Colorado in the filter on State.
Note:
If the drilled report includes dimensions from multiple data providers, a ToolTip appears when you rest your cursor on the value displayed on the filter. The ToolTip displays the name of the query and the dimension for the value.

Related Topics
- To create simple report filters

24.12.1 To change a filter value on the Drill toolbar

1. Verify you are in Drill mode.
2. In the Drill toolbar, click the drop-down arrow relating to the dimension you want to filter.
3. Click the value you want.

24.12.2 To add or remove a drill filter

1. Verify you are in Drill mode.
2. Drag the dimension containing the values around which you want to filter your report and drop it onto the Drill toolbar.
   A list box for the new filter appears on the Drill toolbar. You can select a value from the list of values to filter the results displayed on the drilled table, chart, or report.
3. To remove a drill filter, drag the dimension away from the Drill toolbar.

24.13 Saving reports with drill filters

When you save a document with reports in drill mode, filters generated during drill are saved with the document. When you open a document saved in drill mode, the Drill toolbar appears on the drilled reports and shows the filters generated during the last drill session.

Note:
Documents saved in drill mode take longer to open than documents saved in results mode.
24.14 Refreshing data in a drilled report with prompts

Some reports contain prompts. When you refresh the document, the prompts require you to specify the values you want to retrieve from the database and return to the reports in the document. For example, a prompt can require you to specify a year, for which you want to retrieve data. This drilled report shows values for Year 2003 – the year selected for the prompt.

If the drilled report is filtered for Year 2003, and you then refresh the document and select year 2002 to answer the prompt, the report displays results for 2002 instead of 2003.

24.15 Drilling with query drill

24.15.1 Query drill defined

You can drill in query drill mode, which behaves differently from standard drill mode. When you activate query drill, you drill by modifying the underlying query (adding and removing dimensions and query filters) in addition to applying drill filters.

Example: Drilling down from month to week

In this example, Month is the lowest dimension currently available in the query from a time hierarchy, and Week is the dimension immediately below it in the hierarchy.

If you drill down on Month = January, three things happen:

- Week is added to the scope of analysis.
- A query filter restricts Month to "January".
- A drill filter is added to restrict Month to "January".

If you drill up from Week to Month, the process is reversed:

- Week is removed from the scope of analysis.
- The query filter is removed.
- The drill filter is removed.

Note:

Drill filters are not strictly necessary in query drill mode. They are applied for consistency with standard drill mode. For example, the DrillFilters function returns the correct value in query drill mode because query drill applies drill filters to match the query filters.
24.15.1.1 Using query drill

You use query drill when your report contains aggregate measures calculated at the database level. It is designed in particular to provide a drill mode adapted to databases such as Oracle 9i OLAP, which contain aggregate functions which are not supported in Web Intelligence, or which cannot be accurately calculated in the report during a drill session.

The kinds of aggregate functions that are candidates for drilling in query drill mode are: percentages, distinct counts, ranks, standard deviations and variances, running aggregates, lead and lag functions. Because query drill modifies the query at each drill operation, it ensures that these aggregates are recalculated by the server each time you drill.

Query drill is also useful for reducing the amount of data stored locally during a drill session. Because query drill reduces the scope of analysis when you drill up, it purges unnecessary data.

24.15.1.2 To activate query drill

2. Select Use query drill.
   If your report already has a scope of analysis defined, you see a message telling you to clear the scope of analysis before activating query drill.

24.15.1.3 Drilling with query drill

24.15.1.3.1 Drilling down with query drill

When you drill down, query drill behaves similarly to standard drill at the point where the data moves outside the scope of analysis.

A drilled dimension is filtered in query drill mode by adding a query filter in addition to a drill filter. For example, if you drill on Year=2001, you add a query filter to restrict the Year dimension to 2001. For this reason, the only value that appears in the drill toolbar for the drilled dimension is the value on which you drilled (in this case 2001). This is different from standard drill mode, in which all values of the dimension are visible in the toolbar. As a result, you cannot change filter values in query drill mode (for example, drill on Year=2001 then switch to Year=2003) as you can in standard drill mode.
Because query drill automatically extends the scope of analysis, you can use it only if you have the right to drill outside the scope. See your administrator for more details.

24.15.1.3.2 Drilling up with query drill

When you drill up, query drill removes dimensions from the query. For example, if you drill up from Month to Quarter, you remove Month from the query. This has two consequences:

• Query drill is incompatible with drill snapshots.
• You cannot drill up beyond any dimension that appears as one of the report objects. For example, if your report displays Year, Quarter and Revenue, you cannot drill up from Quarter to Year because this would remove quarter from the list of report objects.

Related Topics

• Query drill and drill snapshots

24.15.1.3.3 Query drill and drill snapshots

Do not use drill snapshots when working in query drill mode, because query drill means that snapshots cannot be guaranteed to stay the same.

In query drill mode, snapshots change when you drill up beyond a dimension that you included in a snapshot. Because the drill up removes the dimension from the underlying query, it also removes the dimension from the snapshot.

24.15.1.3.4 Query drill and other reports based on the same data provider

If your document contains other reports that contain dimensions on which you drill in query drill mode, these reports are affected because the query drill modifies the dimensions they contain.

You can avoid this (at the cost of retrieving duplicate data) by creating a new data provider and rebuilding the other report against it. Now when you drill in query drill mode, the other report remains unaffected.

Example: Drilling on a dimension that appears in another report

If you have two reports based on a query that contains Year, Quarter and Sales Revenue, and you use query drill to drill down to Year = 2001 on the first report, you also filter the data for Year in the second report to include 2001 only.
Drilling on report data
Merging data from dimensions and hierarchies

25.1 Merging defined

You can synchronize the data returned by different dimensions, hierarchies or attributes by creating merged objects which incorporate them. You merge data from different data providers. For example, if you have one data provider that contains detailed customer information and another data provider that contains sales data, you can synchronize the two data providers around the customer.

When you merge data from the same data source (for example the same universe or Bex query), the merge is based on the internal ID of each data member. When you merge data from different data sources, the merge is based on the caption of each data member. For example, if you synchronize two [Geography] hierarchies, the data member [Los Angeles] is merged with [Los Angeles] through its internal ID when the hierarchies are based on the same data source. The members are merged on the caption "Los Angeles" when the hierarchies are in different data sources.

In cases where merging is based on the caption, and different members with the same caption have different parent members, it is not possible to merge the members and the #MULTIVALUE error occurs.

When a merged object contains a hierarchy, you cannot include it directly in a report, but you can still see synchronized hierarchical data by using the original hierarchies. If you include a merged object without hierarchies in a report, the object returns the #COMPUTATION error if hierarchies are subsequently added to it.

Related Topics
• Merging hierarchies

25.1.1 Merging data providers based on keys

When you merge two data sources based on detail objects for a query based on BICS, the BEx query keys are mapped to details. In this way it is possible to merge data providers based on keys. Once merged, the attribute is used in the report in the same way as a dimension.
25.2 Choosing which data to merge

You merge data when your report draws data from different but related sources. For example, you have a report showing revenue and sales targets. The report contains sections based on the year, and each section shows revenue and sales targets. If revenue and sales target data comes from two different data providers, it is not synchronized. You synchronize the data by merging the two data providers on the common dimension, Year.

The only technical restriction imposed on merged dimensions is that they must be of the same data type. You can, for example, merge two dimensions containing character data. But it does not make sense to merge unrelated dimensions even when their data types are the same. For example, it does not make sense to merge a dimension containing customer names with a dimension containing sales regions.

Merged dimensions often have the same name in both data sources, but this is not obligatory. It can make sense to merge dimensions with different names if they contain related data.

To merge dimensions correctly you need to be aware of the semantics of the data (what the data refers to) in the different data sources. The dimension data types and names are an approximate guide only to dimensions’ suitability for merging.

25.3 Merged dimension example

The following example with two data providers illustrates the effect of merging dimensions:

Example: Merging City dimensions

Data Provider 1:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
</tr>
</tbody>
</table>

Data Provider 2:
If you do not merge the City dimensions, you get the following result if you place the Country, City and Revenue objects in a table:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
<td>325000</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
<td>325000</td>
</tr>
</tbody>
</table>

Because there is no link between the two data providers through a merged dimension, city revenues are not related to countries. The table shows the total revenue in data provider 2 against each Country/City pair.

If you merge the City dimensions, you get the following result:

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
<td>100000</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
<td>75000</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
<td>90000</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
<td>60000</td>
</tr>
</tbody>
</table>

### 25.4 Merging hierarchies

When you merge hierarchies, you cannot use the merged hierarchy in a report, but you can take advantage of the data synchronization by using the original hierarchies that make up the merged hierarchy. The data in the report takes the structure of the hierarchy you select.
Example: **Merged hierarchies**

You have two data sources, each using a hierarchy that you have merged into a merged object. Data provider 1 contains the following data:

<table>
<thead>
<tr>
<th>Product</th>
<th>Store Invoice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>5401</td>
</tr>
<tr>
<td>Gym</td>
<td>4073</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1236</td>
</tr>
<tr>
<td>Tops</td>
<td>1208</td>
</tr>
<tr>
<td>Weights</td>
<td>1629</td>
</tr>
<tr>
<td>Swimming</td>
<td>1328</td>
</tr>
<tr>
<td>Camping</td>
<td>16961</td>
</tr>
<tr>
<td>Tents</td>
<td>3534</td>
</tr>
<tr>
<td>Sleeping Bags</td>
<td>3423</td>
</tr>
<tr>
<td>Kitchen Equipment</td>
<td>5352</td>
</tr>
<tr>
<td>Electrical</td>
<td>4652</td>
</tr>
</tbody>
</table>

Data provider 2 contains the following data:

<table>
<thead>
<tr>
<th>Product</th>
<th>Units Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>13348</td>
</tr>
<tr>
<td>Gym</td>
<td>8814</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1231</td>
</tr>
<tr>
<td>Tops</td>
<td>3241</td>
</tr>
<tr>
<td>Weights</td>
<td>4342</td>
</tr>
<tr>
<td>Swimming</td>
<td>4534</td>
</tr>
<tr>
<td>Camping</td>
<td>34234</td>
</tr>
</tbody>
</table>

If you use the first hierarchy in a report, the merged data is structured as follows:
<table>
<thead>
<tr>
<th>Product</th>
<th>Store Invoice</th>
<th>Units Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>5401</td>
<td>13348</td>
</tr>
<tr>
<td>Gym</td>
<td>4073</td>
<td>8814</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1236</td>
<td>1231</td>
</tr>
<tr>
<td>Tops</td>
<td>1208</td>
<td>3241</td>
</tr>
<tr>
<td>Weights</td>
<td>1629</td>
<td>4342</td>
</tr>
<tr>
<td>Swimming</td>
<td>1328</td>
<td>4534</td>
</tr>
<tr>
<td>Camping</td>
<td>16961</td>
<td>34234</td>
</tr>
<tr>
<td>Tents</td>
<td>3534</td>
<td></td>
</tr>
<tr>
<td>Sleeping Bags</td>
<td>3423</td>
<td></td>
</tr>
<tr>
<td>Kitchen Equipment</td>
<td>5352</td>
<td></td>
</tr>
<tr>
<td>Electrical</td>
<td>4652</td>
<td></td>
</tr>
</tbody>
</table>

The child members of [Camping] appear in the hierarchy because they appear in the hierarchy you selected. The [Units Ordered] measure does not display values for these members because they do not exist in the second data source.

If you select the second hierarchy, the merged data is structured as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th>Store Invoice</th>
<th>Units Ordered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sport</td>
<td>5401</td>
<td>13348</td>
</tr>
<tr>
<td>Gym</td>
<td>4073</td>
<td>8814</td>
</tr>
<tr>
<td>Tops</td>
<td>1236</td>
<td>1231</td>
</tr>
<tr>
<td>Bottoms</td>
<td>1208</td>
<td>3241</td>
</tr>
<tr>
<td>Weights</td>
<td>1629</td>
<td>4342</td>
</tr>
<tr>
<td>Swimming</td>
<td>1328</td>
<td>4534</td>
</tr>
<tr>
<td>Camping</td>
<td>16961</td>
<td>34234</td>
</tr>
</tbody>
</table>

The child members of [Camping] do not appear because they do not appear in the original hierarchy you selected.
25.5 Merging different types of object

You can include dimensions, attributes and hierarchies in merged objects. You cannot include a merged object containing a hierarchy directly in a report, but you can include the objects that make up the merged object. The structure of the data that appears in the report depends on which object you chose.

Example: Merging a dimension and a hierarchy

You have two data sources, one containing a dimension and the other a hierarchy. Data provider 1 contains the [Country] dimension as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Stock Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Los Angeles</td>
<td>4545</td>
</tr>
<tr>
<td>San Francisco</td>
<td>6465</td>
</tr>
<tr>
<td>San Diego</td>
<td>4564</td>
</tr>
</tbody>
</table>

Data provider 2 contains the [Geography] hierarchy as follows:

<table>
<thead>
<tr>
<th>Geography</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>54342</td>
</tr>
<tr>
<td>California</td>
<td>6996</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>3423</td>
</tr>
<tr>
<td>San Francisco</td>
<td>2342</td>
</tr>
<tr>
<td>San Diego</td>
<td>1231</td>
</tr>
</tbody>
</table>

You merge the dimension and hierarchy in a merged object. You cannot include the merged object in a report because it contains a hierarchy. If you include the [Country] dimension in a report, the data appears as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Stock Items</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Los Angeles</td>
<td>4545</td>
<td>3423</td>
</tr>
<tr>
<td>San Francisco</td>
<td>6465</td>
<td>2342</td>
</tr>
<tr>
<td>San Diego</td>
<td>4564</td>
<td>1231</td>
</tr>
</tbody>
</table>
If you place the [Geography] hierarchy in a report, the result is as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th>Stock Items</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td></td>
<td>54342</td>
</tr>
<tr>
<td>California</td>
<td></td>
<td>6996</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>4545</td>
<td>3423</td>
</tr>
<tr>
<td>San Francisco</td>
<td>6465</td>
<td>2342</td>
</tr>
<tr>
<td>San Diego</td>
<td>4564</td>
<td>1231</td>
</tr>
</tbody>
</table>

### 25.6 Forcing merged calculations with the ForceMerge function

By default, calculations do not account for merged dimensions if the merged dimensions do not explicitly appear in the calculation context.

**Example: Calculating revenue with ForceMerge**

This example has two data providers as follows:

**Data Provider 1:**

<table>
<thead>
<tr>
<th>Country</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>New York</td>
</tr>
<tr>
<td>US</td>
<td>Los Angeles</td>
</tr>
<tr>
<td>France</td>
<td>Paris</td>
</tr>
<tr>
<td>France</td>
<td>Toulouse</td>
</tr>
</tbody>
</table>

**Data Provider 2:**

<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>100000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>75000</td>
</tr>
<tr>
<td>Paris</td>
<td>90000</td>
</tr>
</tbody>
</table>
If you merge the City dimensions, then create a table with Country and Revenue, you get the following result:

<table>
<thead>
<tr>
<th>Country</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>325000</td>
</tr>
<tr>
<td>US</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>325000</td>
</tr>
<tr>
<td>France</td>
<td>325000</td>
</tr>
</tbody>
</table>

Because City, the merged dimension, does not appear in the table, it does not influence the calculation of the revenue. The total revenue in the second data provider appears against each country.

To display the correct result, replace Revenue in the second column with the formula `ForceMerge([Revenue]):`

<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>175000</td>
</tr>
<tr>
<td>US</td>
<td>175000</td>
</tr>
<tr>
<td>France</td>
<td>150000</td>
</tr>
<tr>
<td>France</td>
<td>150000</td>
</tr>
</tbody>
</table>

The relationship between countries and cities now influences the calculation of the revenue.

**Note:**
If Revenue is a smart measure in the above example, `ForceMerge([Revenue])` returns #MULTIVALE. This is because the grouping set (Country) does not exist for the Revenue measure. `ForceMerge([smart_measure])` always returns #MULTIVALE, unless by chance no aggregation is required to calculate the measure.

25.7 Creating, editing and deleting merged objects
25.7.1 To merge details, dimensions, or hierarchies

1. In Design mode, click Variables > Merge.
   a. In the Rich Client, this option is available through Data Access > Data Objects > Merge
2. Hold down the Ctrl key and select the dimensions or hierarchies you want to merge.
3. Click OK.
   You can view the merged object in the Available Objects pane of the Left Pane. The original hierarchies or dimensions that make up the merged object appear beneath it. You edit or remove the merged dimension or hierarchy in the Available Objects pane. Select the objects, right-click and select Merge.

Related Topics
• To delete merged objects
• To edit merged objects

25.7.2 To merge dimensions automatically

You can merge dimensions automatically under the following circumstances:
• The dimensions have the same name
• The dimensions have the same data type
• The dimensions are in the same universe
1. With a document open in Design mode, click Document on the Properties tab to display the "Document Summary" dialog box.
2. Select Auto-merge dimensions.

25.7.3 To edit merged objects

1. Right-click the merged dimension in the Available Objects pane of the Left Panel then select Edit Properties on the menu to display the "Create Merged Dimension" dialog box.
2. Type the merged dimension name in the Merged Dimension Name in the Merged Dimension dialog box.
3. Type the description in the "Description" box.
4. Select the dimension that provides default properties for the merged dimension in the "Source Dimension" dialog box.

### 25.7.4 To delete merged objects

1. Select the merged dimension in the Available Objects section of the Left Panel. The Merge button at the top of the Left Panel becomes the Unmerge button when you select a merged dimension.
2. Click Unmerge.

### 25.8 Understanding the effects of merged data

Merging data has implications for report results in certain situations. You need to understand these implications to work effectively with merged dimensions and synchronized data.

#### 25.8.1 Synchronizing data providers with different aggregation levels

You can synchronize data providers with different aggregation levels. This can have implications for the calculation of measures.

**Example: Synchronizing data providers with different aggregation levels**

In this example you have two data providers as follows:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>2004</td>
<td>1500</td>
</tr>
<tr>
<td>Jones</td>
<td>2005</td>
<td>2000</td>
</tr>
<tr>
<td>Smith</td>
<td>2005</td>
<td>1200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer</th>
<th>Number of sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>12</td>
</tr>
</tbody>
</table>
If you merge the two data providers and the table properties Avoid duplicate rows aggregation and Show rows with empty dimension values are unchecked, the result is as follows:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Year</th>
<th>Revenue</th>
<th>Number of sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones</td>
<td>2004</td>
<td>1500</td>
<td>12</td>
</tr>
<tr>
<td>Jones</td>
<td>2005</td>
<td>1200</td>
<td>12</td>
</tr>
<tr>
<td>Smith</td>
<td>2005</td>
<td>1200</td>
<td>10</td>
</tr>
</tbody>
</table>

It is not possible to determine the number of sales per year for customer Jones because the data provider that stores the number of sales does not break them down by year. Instead you see the total number of sales on each row.

**Note:**
Although the Number of Sales values are duplicated, if you add a standard calculation to the bottom of the column (for example a Sum or Average calculation), the result is correct.

One way of addressing this issue is to add the dimensions to the second data provider that allow calculation to the appropriate level of data. If this is not possible, you must be aware of any situations where it is not possible to aggregate the data to the necessary level of detail.

### 25.8.2 Attributes and merged dimensions

Attributes are associated with dimensions and provide additional information about the dimension.

There must be a one-to-one relationship between dimensions and attributes (this means that an attribute can have one value only for each value of its associated dimension) and attribute objects are not taken into account when synchronizing data. The following example illustrates why this is necessary.

**Note:**
Some previous versions of SAP BusinessObjects Web Intelligence (Web Intelligence, Desktop Intelligence and BusinessObjects), allowed a one-to-many relationship between dimensions and attributes. If you migrate a report created using any of these products and the attribute contains multiple values, you see the #MULTIVALE error in the attribute cell.

**Example:** **Synchronizing data providers with attributes**

In this example you have two data providers, and Address is an attribute of Customer:
If you create a merged Customer dimension to synchronize the data providers, and Address can have more than one value for each customer, the result is ambiguous because there is no common value for data synchronization.

In the example, Paul has addresses in Liverpool and London, which means that there is no unique ‘Paul' row for synchronization of Paul's telephone number. Paul has a different telephone number for each address, and we do not know which address to associate with the telephone number:

If the relationship between Customer and Address is one-to-one, Address can be ignored in the synchronization. This removes the ambiguity:

25.8.3 Incompatible objects and merged dimensions

As a general rule, you cannot place dimensions from different data providers in the same table. This is to avoid Cartesian products (the display of all possible combinations of values from unrelated objects) or other ambiguous results, depending on the universe structure.
You can always place measures from different data providers in a table. The measure calculation depends on what dimensions are available. For example, if you place a measure in a table that contains no dimensions from the same data provider as the measure, the calculation displays its total value in the table.

You can place a merged dimension in a table as long as the table contains other dimensions from a data provider that participates in the merge. You can also place attributes from different data providers in a table, as long as the details are associated with dimensions that participate in a merged dimension.

In certain situations, it can be valid to place a dimension from another data provider in a table, even when this is not allowed by the software. This occurs when the incompatible dimension has a one-to-one or one-to-many relationship with a dimension already in the table. The important point is that there is only one value of the incompatible dimension associated with the dimension in the table (one-to-one). On the other hand, the same value of the incompatible dimension can be associated with multiple values of the dimension in the table (one-to-many).

In the table below, the relationship between Address and Name conforms to these rules: Address has a one-to-one or one-to-many association with Name. There is no one-to-many association in the other direction, between Name and Address (one name with more than one address):

<table>
<thead>
<tr>
<th>Dimension in table (Name)</th>
<th>Incompatible dimension (Address)</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>London</td>
</tr>
<tr>
<td>Paul</td>
<td>London</td>
</tr>
<tr>
<td>George</td>
<td>Liverpool</td>
</tr>
</tbody>
</table>

In this case the universe design is incorrect - the incompatible dimension (Address) should be defined as a detail of the dimension in the table (Name). If you encounter this situation, see your administrator and ask for a redesign of the universe.

If it is not practical to change the universe, create a variable at the report level. Define this variable as a detail, associate it with the dimension in the table, and supply the name of the incompatible dimension as the variable definition. The variable simply returns the same values as the incompatible dimension. Because it is defined as a detail of the dimension in the table, you can place it in the same table as the dimension.

### 25.8.4 Filtering merged dimensions

Merging dimensions has implications for the application of filters.

**Note:**
You cannot apply a filter on a merged object containing hierarchies.
25.8.4.1 Report filters and merged dimensions

When you apply a report filter to a dimension that is part of a merged dimension, then the filter will impact all related blocks in the report that use the merged dimension.

Example:

When you have two queries with a common dimension that you have merged, and you have two tables in a report, each table with data coming from a different query, when you filter on the merged dimension in one query, the filter will also impact the corresponding dimension in the second query and therefore in the second table.

25.8.4.2 Section filters and merged dimensions

When a dimension that is part of a merged dimension is set as a section header, any filter applied to the section also applies to blocks from synchronized data providers within the section.

25.8.4.3 Block filters and merged dimensions

When you apply a block filter to a dimension that is part of a merged dimension, the filter is applied to the block. It is not applied to other data providers synchronized through the merged dimension.

25.8.5 Drilling on merged dimensions

When you merge dimensions, the new merged dimension belongs to the hierarchies of all dimensions involved in the merge.

25.8.6 Extending the values returned by merged dimensions
Synchronizing data providers exists in Desktop Intelligence/BusinessObjects but it does not involve the creation of a new merged dimension. BusinessObjects reports use the original dimensions that make up a merged dimension in Web Intelligence.

You can use these original dimensions in an Web Intelligence report. When you place them in the report, it returns by default only those dimension values that have corresponding values in the data providers synchronized through the merge. You need to be aware of this when migrating reports from Desktop Intelligence and BusinessObjects because BusinessObjects/Desktop Intelligence behaves differently.

**Example: Web Intelligence and Desktop Intelligence/BusinessObjects behavior when dimensions are merged**

You have a report with the following data providers:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>470</td>
</tr>
<tr>
<td>Japan</td>
<td>499</td>
</tr>
</tbody>
</table>

If you include the Country of Origin dimension from Data Provider 1 and the Revenue measure from Data Provider 2 in the same block, you get the following result:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td></td>
</tr>
</tbody>
</table>

The same block in Desktop Intelligence/BusinessObjects returns the following result:

<table>
<thead>
<tr>
<th>Country of origin</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td></td>
</tr>
<tr>
<td>Japan</td>
<td>499</td>
</tr>
</tbody>
</table>

The block is different in Desktop Intelligence/BusinessObjects because BusinessObjects extends the values of the Country of Origin dimension through the values returned by the Revenue measure.

**25.8.6.1 To extend dimension values**
1. Right-click your report outside any blocks or charts and select Document Properties on the shortcut menu.
   The Document Properties pane appears on the right side of the report.
2. Check the Extend merged dimension values option.
Ranking report data

26.1 Ranking data

Ranking allows you to isolate the top and bottom records in a set based on a variety of criteria. For example, if you have a block showing countries and associated revenues, ranking allows you to rank the data in the block to show the top 3 countries only, based on the revenue they generate.

Ranking allows you to answer business questions such as:

- Which 3 regions generate the most revenue?
- Which are the bottom 10% of stores in terms of revenue generation?
- What is the group of the best-performing stores that generates a combined revenue of up to $10,000,000?

You can rank data in many ways to answer these kinds of business questions. You can:

- rank the top and/or bottom n records by dimension (for example Country) based on the sum of a related measure (for example Revenue)
- rank the top and/or bottom n% of the total number of records by dimension based on the value of a related measure as a percentage of the total value of the measure
- rank the top and/or bottom n records by dimension based on the cumulative sum of a related measure
- rank the top and/or bottom n records by dimension based on the value of a related measure as a cumulative percentage of the total value of the measure

26.2 Rankings and sorts

When you rank data, the data must be sorted to display the ranking. For example, if you rank the top 3 stores by revenue, the stores are sorted in descending order by revenue generated.

Sorts applied to display rankings take precedence over sorts that you had previously applied to data. For example, if you had previously sorted the list of stores in alphabetical order, the ranking sort overrides the alphabetical sort.
26.3 Tied rankings

Tied rankings are assigned equal ranking values and subsequent ranking values are pushed back to compensate. This means that a bottom n ranking can return more than n records.

Example: Top and bottom tied rankings

The following table shows a tied top 3 ranking and a tied bottom 3 ranking.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
<th>Top 3 Ranking</th>
<th>Bottom 3 Ranking</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>D</td>
<td>30</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Each ranking includes records up to and including rank 3. This results in the following result for a top 3 ranking:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>30</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
</tr>
</tbody>
</table>

It results in the following result for a bottom 3 ranking:

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10</td>
</tr>
<tr>
<td>B</td>
<td>20</td>
</tr>
<tr>
<td>C</td>
<td>30</td>
</tr>
<tr>
<td>D</td>
<td>30</td>
</tr>
</tbody>
</table>
## 26.4 Ranking parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/bottom</td>
<td>When the calculation mode is Count, the ranking returns the top/bottom n records based on the measure specified in the Based on parameter. For example, the top 3 countries by revenue generated, the bottom 3 year/quarter combinations by revenue generated. When the calculation mode is Percentage, the ranking returns the top/bottom n% of the total number of records based on the measure specified in the Based on parameter. For example, if there are 100 records and you rank the top 10%, the ranking returns the top 10 records. When the calculation mode is Cumulative Sum, the ranking returns the top/bottom records for which the cumulative sum of the measure specified in Based on does not exceed n. When the calculation mode is Cumulative Percentage, the ranking returns the top/bottom records for which the cumulative sum of the measure specified in Based on does not exceed n% of the total of the measure.</td>
</tr>
<tr>
<td>n/n%</td>
<td>When the calculation mode is Count - the number of records to retrieve based on the measure. When the calculation mode is Percentage - the percentage of records to retrieve based on the measure. When the calculation mode is Cumulative Sum - the cumulative sum that the measure must not pass. When the calculation mode is Cumulative Percentage - the cumulative sum of the measure, represented as a percentage of the total, that the measure must not pass.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Based on</td>
<td>The measure on which the ranking is based.</td>
</tr>
<tr>
<td>Ranked By</td>
<td>The ranking dimension. If you specify a ranking dimension, the aggregated values of the Based on measure, calculated for the dimension, determine the ranking. If you do not specify this dimension, the values of the Based on measure calculated for all dimensions in the block determine the ranking. (In other words, the ranking returns the top/bottom X rows in the block based on the measure.)</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>The type of calculation used to create the ranking. See the description of the Top/Bottom and n/n% parameters at the top of this table for more information.</td>
</tr>
</tbody>
</table>

### 26.4.1 Example of a ranking

A table contains the following data:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td>Q1</td>
<td>100</td>
</tr>
<tr>
<td>2006</td>
<td>Q2</td>
<td>200</td>
</tr>
<tr>
<td>2006</td>
<td>Q3</td>
<td>300</td>
</tr>
<tr>
<td>2006</td>
<td>Q4</td>
<td>500</td>
</tr>
<tr>
<td>2007</td>
<td>Q1</td>
<td>400</td>
</tr>
<tr>
<td>2007</td>
<td>Q2</td>
<td>700</td>
</tr>
<tr>
<td>2007</td>
<td>Q3</td>
<td>300</td>
</tr>
<tr>
<td>2007</td>
<td>Q4</td>
<td>600</td>
</tr>
<tr>
<td>2008</td>
<td>Q1</td>
<td>200</td>
</tr>
<tr>
<td>2008</td>
<td>Q2</td>
<td>200</td>
</tr>
<tr>
<td>2008</td>
<td>Q3</td>
<td>400</td>
</tr>
</tbody>
</table>
Total for Q1: 700
Total for Q2: 1100
Total for Q3: 1000
Total Q4: 1600

If you rank the top 2 of each Quarter based on Revenue, the ranking filters out all the rows for Q1 and Q3 because Q4 and Q2 have the highest aggregate revenues.

### 26.5 Ranking and data order

You cannot rank on an object whose values depend on the data order. This is because the ranking changes the data order, which in turn changes the object data, which then requires recalculation of the ranking. The result is a circular dependency between the ranking and the object that cannot be resolved.

If you create a rank on a measure whose values depend on the data order, for example a measure that that uses the `Previous` function or any of the running aggregate functions such as `RunningSum`, the #RANK error message appears in all cells in the block.

### 26.6 Ranking workflows

There are two ways of ranking data. You can:

- create a ranking by using the interface
- use the `Rank` function to return a ranking value

A ranking uses sorts and filters that are applied transparently according to the ranking you specify. For example, if you rank the top 3 countries in a block by revenue, you implicitly sort the countries in descending order by revenue, then filter the block to remove all countries other than the 3 with the highest revenue.

**Note:**
When you create a ranking using the interface, the `Rank` function is used behind the scenes to assign ranking values.
26.6.1 To create a ranking

1. Select the block that you want to rank.
2. Click Analysis > Add Ranking.
   The "Create Rank" dialog box appears
3. Click Top and select the number of records if you want to rank the highest records in the block.
4. Click Bottom and select the number of records if you want to rank the lowest records in the block.
5. Select the measure on which the ranking is based in the Based on list.
6. Click Ranked By and select the dimension on which the ranking is based if you want to rank by a particular dimension rather than by all dimensions in the block.
7. Select the rank calculation mode in the Calculation mode list.
8. Click OK.

26.7 Ranking examples

In the following examples, you have a dimension, Region, and a measure, Revenue, which give the following values:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>% of Total Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1000000</td>
<td>7%</td>
</tr>
<tr>
<td>South West</td>
<td>2000000</td>
<td>13%</td>
</tr>
<tr>
<td>North East</td>
<td>3000000</td>
<td>20%</td>
</tr>
<tr>
<td>North West</td>
<td>4000000</td>
<td>24%</td>
</tr>
<tr>
<td>Central</td>
<td>5000000</td>
<td>33%</td>
</tr>
</tbody>
</table>

Example: Rank the top 3 regions by revenue generated

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Top</td>
</tr>
<tr>
<td>n/n%</td>
<td>3</td>
</tr>
</tbody>
</table>
For Each Region (or unspecified because region is the only dimension in the block and therefore the default ranking dimension)

Based on Revenue

Calculation mode Count

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>5000000</td>
</tr>
<tr>
<td>North West</td>
<td>4000000</td>
</tr>
<tr>
<td>North East</td>
<td>3000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:
• Sort the records in descending order
• Display the top 3 records

Example: **Rank the bottom 40% of regions by revenue**

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Bottom</td>
</tr>
<tr>
<td>n/n%</td>
<td>40%</td>
</tr>
<tr>
<td>For Each</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Percentage</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1000000</td>
</tr>
<tr>
<td>South West</td>
<td>2000000</td>
</tr>
</tbody>
</table>
The implicit steps in calculating this ranking are:

- Sorts the record in ascending order
- Work through the records until 40% of the total number of records are displayed

**Example:** Rank the top regions whose cumulative revenue is less than or equal to 10,000,000

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Top</td>
</tr>
<tr>
<td>n/n%</td>
<td>10000000</td>
</tr>
<tr>
<td>For Each</td>
<td>Region</td>
</tr>
<tr>
<td>Based on</td>
<td>Revenue</td>
</tr>
<tr>
<td>Calculation mode</td>
<td>Cumulative sum</td>
</tr>
</tbody>
</table>

This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>5000000</td>
</tr>
<tr>
<td>North West</td>
<td>4000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:

- Sort the records in descending order
- Work through the records until the record that causes the cumulative total of the measure to pass 10,000,000
- Include those records that do not cause the cumulative total to pass 10,000,000

**Example:** Rank the bottom regions whose cumulative revenue is less than or equal to 30% of the total revenue

To perform this ranking you set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>Bottom</td>
</tr>
<tr>
<td>n/n%</td>
<td>30%</td>
</tr>
<tr>
<td>For Each</td>
<td>Region</td>
</tr>
</tbody>
</table>
This ranking gives the following result:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>South East</td>
<td>1000000</td>
</tr>
<tr>
<td>South West</td>
<td>2000000</td>
</tr>
</tbody>
</table>

The implicit steps in calculating this ranking are:

- Sort the records in ascending order
- Work through the records until the record that causes the cumulative total of the measure, expressed as a percentage of the overall total of the measure, to exceed 30%
- Display those records that do not cause the cumulative percentage to pass 30%
Tracking changes in data

27.1 Tracking changes in your data

To make informed and effective business intelligence decisions, you need to understand how the data on which you base those decisions changes over time. You can track and display data changes to help you focus your analysis on key areas and avoid wasting time exploring irrelevant data.

When you track data changes, you select a particular data refresh as a reference point. This data is known as the reference data. When you activate data tracking, you see your data in relation to the reference data.

Here are some examples of data tracking:

- If an outlet no longer appears in a list of the top outlets by sales, you see it as deleted from the list. You can use this information to investigate why the outlet is no longer a top performer.
- If sales have decreased in a region, data tracking displays the decrease. You can then drill down into the data for the region to understand why revenue is falling.

In both these cases, data tracking makes the current data more meaningful by placing it in context with older data. Without this context it is much more difficult to identify trends.

Note:
Tracking data changes operates at document level and not report level. If a document contains several reports, the tracking will apply to all of the reports. The information in the Status Bar indicates the document level status. An asterisk on a report tab indicates that change tracking is activated on the report.

27.2 Types of data change

You can track the following types of data change:

- Inserted data
- Deleted data
- Changed data
- Increased values
- Decreased values
You configure the display of these changes through the interface or the formula language. The formula language provides advanced users with additional power and flexibility in displaying and formatting changed data.

### 27.3 Data tracking modes

#### 27.3.1 Automatic data tracking mode

In automatic data tracking mode, you always compare the current data with the data before the last refresh. This is achieved by automatically setting the current data as the reference data just before each refresh. The reference data is always one refresh behind the current data.

Automatic data tracking is appropriate for scheduled documents when you want to compare the current data with the data before the last refresh.

#### 27.3.2 Manual data tracking mode

In manual data tracking mode, you select the reference data. You continue to use this data as a reference point until you update the reference point.

### 27.4 To activate data tracking

1. Click **Track Changes** on the status bar at the bottom of the window to display the "Data Tracking" dialog box.
2. Select the **Data** tab.
3. To compare the data with the last refresh, select **Compare with last data refresh**.

   When you select this option, the current data becomes the reference data after each data refresh. The report always shows the difference between the most recent data and the data before the last refresh.

   When this option is selected, the status bar displays **Track changes: Auto-update**.
4. To compare the data with a specific data refresh, select **Compare with data refresh from** and select the date of the data refresh from the list.

When you select this option, the data refresh you chose becomes the reference data. The report always shows the difference between the most recent data and the data refresh you chose.

When this option is selected, the status bar displays Track changes: Fixed data.

5. Select the reports that you want to display data tracking from the **Reports with data tracking shown** list.

6. Click **Refresh data now** to refresh the data when the dialog box closes.

7. Click **OK**

**27.5 Displaying changed data**

**27.5.1 To display changed data**

You can choose whether to display changed data when data tracking is activated.

1. Activate data tracking.

2. Select **Track > Show Changes** (in Reading mode) or **Analysis > Data Tracking > Show Changes** (in Design mode) to display changed data. Select the option again to turn off the display of changed data.

**Related Topics**

• Configuring the appearance of changed data
• To activate data tracking

**27.5.2 Configuring the appearance of changed data**

You can configure the appearance (font style, size and color) of changed data in your document. You can separately configure the appearance of the following changes:

• Inserted, deleted dimensions and changed detail values
• Increased or decreased measure values
Measure values can also adopt the formatting of inserted or deleted dimension values. For example, if a dimension value disappears from a list of values in a block, and the block also shows a measure value for the dimension, both the dimension and measure values appear as deleted data.

Your administrator defines the default appearance of changed data in the Central Management Server. When you configure the appearance of changed data locally, you override the CMS defaults.

### 27.5.2.1 To configure the appearance of changed data

You must be in Design mode to configure the appearance of changed data.

1. Click **Track Changes** on the status bar at the bottom of the window to display the "Data Tracking" dialog box.
2. Select the **Options** tab.
3. Select each type of changed data you wish to display and click **Format** to specify how you want the changes to appear.

**Note:**
The **Format** buttons are visible only in Design mode.

**Related Topics**
- **Highlighting data using conditional formatting**

### 27.5.3 How changed data is displayed in blocks

**Example: Changed data in a simple block**

This example uses a document with a block showing [Country], [Year] and [Revenue]. The original data was as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2003</td>
<td>1000</td>
</tr>
<tr>
<td>France</td>
<td>2004</td>
<td>2000</td>
</tr>
<tr>
<td>Japan</td>
<td>2002</td>
<td>1000</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>1200</td>
</tr>
</tbody>
</table>
After a refresh, the data is as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2004</td>
<td>3000</td>
</tr>
<tr>
<td>Japan</td>
<td>2003</td>
<td>900</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>800</td>
</tr>
<tr>
<td>UK</td>
<td>2004</td>
<td>900</td>
</tr>
</tbody>
</table>

When data tracking is activated and data changes displayed, the block appears as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2003</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>France</td>
<td>2004</td>
<td>3000</td>
<td>[increased data formatting on Revenue cell]</td>
</tr>
<tr>
<td>Japan</td>
<td>2002</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>Japan</td>
<td>2003</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>800</td>
<td>[decreased data formatting on Revenue cell]</td>
</tr>
<tr>
<td>UK</td>
<td>2004</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
</tbody>
</table>

- The rows showing revenue for France in 2003 and Japan in 2002 represent data that no longer exist after the refresh.
- The revenue for France in 2004 has increased.
- The revenue for Poland in 2002 has decreased.
- The rows showing revenue for Japan in 2003 and the UK in 2004 appeared after the refresh.

### 27.5.4 How changed data is displayed in reports with merged dimensions

A dimension appears as changed only if all the dimensions that participate in the merge are changed.
Example: Changed data and merged dimensions

In this example, Country is a merged dimension containing the Country dimensions from two data providers. Before data refresh, the data is as follows:

<table>
<thead>
<tr>
<th>Country (DP1)</th>
<th>Revenue (DP1)</th>
<th>Country (DP2)</th>
<th>Sales (DP2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>10000</td>
<td>US</td>
<td>5000</td>
</tr>
<tr>
<td>France</td>
<td>4000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK</td>
<td>5000</td>
<td>UK</td>
<td>3000</td>
</tr>
<tr>
<td>Germany</td>
<td>1000</td>
<td>Germany</td>
<td>1000</td>
</tr>
</tbody>
</table>

After a data refresh, the data becomes:

<table>
<thead>
<tr>
<th>Country (DP1)</th>
<th>Revenue (DP1)</th>
<th>Country (DP2)</th>
<th>Sales (DP2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>10000</td>
<td>US</td>
<td>4000</td>
</tr>
<tr>
<td>France</td>
<td>4000</td>
<td>France</td>
<td>3000</td>
</tr>
<tr>
<td>UK</td>
<td>6000</td>
<td>UK</td>
<td>4000</td>
</tr>
<tr>
<td>Poland</td>
<td>2000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When displayed in a block with the merged Country dimension and data changes displayed, the data appears as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Revenue</th>
<th>Sales</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>10000</td>
<td>4000</td>
<td>[decreased data formatting on Sales cell]</td>
</tr>
<tr>
<td>France</td>
<td>4000</td>
<td>3000</td>
<td>[inserted data formatting on Revenue cell]</td>
</tr>
<tr>
<td>UK</td>
<td>6000</td>
<td>4000</td>
<td>[increased data formatting on Revenue and Sales cells]</td>
</tr>
<tr>
<td>Germany</td>
<td>1000</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>Poland</td>
<td>2000</td>
<td></td>
<td>[inserted data formatting on Country and Revenue cells]</td>
</tr>
</tbody>
</table>
In the France row, France does not appear as inserted because a France row was not inserted in both data providers. Revenue appears as inserted because it is a new measure value after the data refresh.

In the Poland row, Poland appears as inserted because it is a new dimension value after the data refresh.

### 27.5.5 How changed data is displayed in sections

Example: **Changed data in a report with sections**

In this example you have a document with a block showing [Country], [Year] and [Revenue]. The original data was as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2003</td>
<td>1000</td>
</tr>
<tr>
<td>France</td>
<td>2004</td>
<td>2000</td>
</tr>
<tr>
<td>Japan</td>
<td>2002</td>
<td>1000</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>1200</td>
</tr>
<tr>
<td>US</td>
<td>2003</td>
<td></td>
</tr>
<tr>
<td>US</td>
<td>2004</td>
<td></td>
</tr>
</tbody>
</table>

After a refresh, the data is as follows:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>2004</td>
<td>3000</td>
</tr>
<tr>
<td>Japan</td>
<td>2003</td>
<td>900</td>
</tr>
<tr>
<td>Poland</td>
<td>2002</td>
<td>800</td>
</tr>
<tr>
<td>UK</td>
<td>2004</td>
<td>900</td>
</tr>
</tbody>
</table>

If you create a section on [Country] and display data changes, the report appears as follows:

France [no formatting]
<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>2004</td>
<td>3000</td>
<td>[increased data formatting on Revenue cell]</td>
</tr>
</tbody>
</table>

Japan [no formatting]

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>1000</td>
<td>[deleted data formatting on all cells]</td>
</tr>
<tr>
<td>2003</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
</tbody>
</table>

Poland [no formatting]

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2002</td>
<td>800</td>
<td>[decreased data formatting on Revenue cell]</td>
</tr>
</tbody>
</table>

UK [inserted data formatting]

<table>
<thead>
<tr>
<th>Year</th>
<th>Revenue</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004</td>
<td>900</td>
<td>[inserted data formatting on all cells]</td>
</tr>
</tbody>
</table>

The data appears in the section header in either of two ways, depending on the changes in the data in the section:
- If all the rows in the block in the section have changed in the same way, the section header is displayed with the same formatting as the rows.
- If the rows have changed in different ways, or only some rows have changed, the section header retains its default format.

### 27.5.6 How changed data is displayed in blocks with breaks
When a block contains a break and the **Center value across break** block property is set, the display of the centered value follows rules similar to those for section headers.

- If all the rows in the break have changed in the same way, the centered value is displayed with the same formatting as the rows.
- If the rows have changed in different ways, or only some rows have changed, the centered value retains the default formatting.

### 27.5.7 How changed data is displayed in charts

When the data in a chart has changed, a changed data icon appears above the chart. When you click the icon, the chart changes to a table to allow you to see the details of the changes.

### 27.6 Data tracking restrictions

If you change or purge a data provider, the report no longer displays changed data. If the data provider is changed, the current version of the document is no longer compatible with the reference version. If the data is cleared, the old data no longer exists for comparison.

As a result, the following actions are incompatible with data tracking:

- Drill out of scope
- Query drill
- Deleting a query
- Any modification (including modifications to security rights) that changes the SQL generated by a data provider
- Purging the document

When you perform any of these actions, the data history of the document is cleared because the actions are incompatible with the display of changed data. For example, if you modify a query, the data in the document changes because of the modification. Any comparison between this data and old data generated from a different query is misleading.

### 27.6.1 Data tracking and drill

When you use query drill or drill out of scope, the data history is cleared because these actions change the data provider. This should not affect you because, when you start to drill, you have already identified
the data that requires further analysis. Data tracking has served its purpose and you can now continue with your data analysis.

27.6.2 Data tracking and Refresh on Open

When a document is set to refresh its data on opening (when the Refresh on open document property is selected), data tracking does not display the difference between the data prior to the refresh and the data after the refresh. The data after the refresh is considered to be new data because the refresh purges the document.

Note:
The Refresh on open option is dependent on two CMS settings (document and user-related security settings): “Check automatic refresh on open” in the CMC/Application/Webi/Properties and the "Disable automatic refresh on open" in the CMC/Application/user security settings. If the property Check automatic refresh on open security setting is ENABLED/checked in CMC/Application/Webi/Properties and in the CMC/Application/user security settings, the security right Disable automatic refresh on open is DISABLED for this user, then even if the document is not set as being Refresh on open, it will still be refreshed on opening.

27.7 Using the formula language to track changed data

When you use the interface to configure the display of changed data, the changes are tracked using special behind-the-scenes alerters. These special alerters do not appear in the list of standard alerters.

The formula language allows you to build your own custom alerters for formatting data changes. You can also use the formula language to include special calculations based on data changes. For example, you can include a calculation to show the difference between the previous value and the current value of a measure.

27.7.1 The RefValue function

The formula language provides access to changed data through the RefValue function. This function gives the value of the reference data for a measure. If there is no reference data, the function returns null.

For example, if the [Revenue] measure currently has the value 1000, and its reference value is 900, the formula RefValue([Revenue]) returns 900.
27.7.2 The RefValueDate function

The RefValueDate function returns the date of the reference data used for data tracking.

27.7.3 The RefValueUserResponse function

The RefValueUserResponse function is used for tracking prompts and returns the value of the user response of the reference data (prompts) used for data tracking.

27.7.4 Building formulas using the RefValue function

You can use the RefValue function to build formulas that give information about the current data in relation to the reference data.

Example: Finding the difference between the reference value and the current value

The following formula returns the difference between the reference value and the current value of the [Revenue] measure:

=If(Not(IsNull([Revenue])) Or Not(IsNull(RefValue([Revenue]))); [Revenue] - RefValue([Revenue]))

The following table shows data before a data refresh:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson</td>
<td>2000</td>
</tr>
<tr>
<td>Smith</td>
<td>3000</td>
</tr>
<tr>
<td>Wilson</td>
<td>3500</td>
</tr>
</tbody>
</table>

After refresh, the data changes as follows:
Placed in a third column, the formula returns the following figures:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Revenue</th>
<th>Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson</td>
<td>3000</td>
<td>1000</td>
</tr>
<tr>
<td>Smith</td>
<td>2500</td>
<td>-500</td>
</tr>
<tr>
<td>Wilson</td>
<td>3500</td>
<td></td>
</tr>
</tbody>
</table>

---

### 27.8 Changed data and the calculation context

When data tracking is activated, data appears as changed only when the calculation context remains the same.

For example, if a measure value changes because you change the calculation context of a block, the new value is not flagged as changed.

**Example:** *Changing the calculation context*

In this example you have a block showing [City], [Customer] and [Revenue] as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Customer</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>San Francisco</td>
<td>Smith</td>
<td>1000</td>
</tr>
<tr>
<td>San Francisco</td>
<td>Jones</td>
<td>2000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Wilson</td>
<td>3000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Harris</td>
<td>4000</td>
</tr>
</tbody>
</table>

If you remove [Customer] from the block, revenue is aggregated by city:
The revenues do not appear as increased because the amount of revenue has not changed. Only the calculation context has changed - revenues are now aggregated by city only, giving higher figures.

If, after a data refresh, Jones' revenue falls to 1000 and Wilson's revenue rises to 4000, the data appears as follows:

<table>
<thead>
<tr>
<th>City</th>
<th>Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>San Francisco</td>
<td>2000</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>8000</td>
</tr>
</tbody>
</table>

The data appears as changed because, independently of the change of calculation context, the total revenue for San Francisco has decreased and the total revenue for Los Angeles has increased.
Sharing content with other applications

28.1 Publishing content as web services

Note:
You can only publish content as a web service in the "Rich Internet Application" (Java applet) interface and in Web Intelligence Rich Client. This feature is not available for the "Web" interface (DHTML mode).

You can make Web Intelligence content available outside Web Intelligence documents by publishing report blocks (tables, charts or forms) as web services known as BI Services.

Web services provide a standardized mechanism for sharing data between applications. You publish content to a server where other applications can access the web services that supply the content.

Each web service can publish multiple blocks which are made available to web applications through functions that correspond to the blocks. For example, a table published as a web service can be included in a dashboard which can perform filtering and drilling operations on the table through the web service functions.

The structure of a BI service is defined using using WSDL (Web Service Definition Language), the standard format for describing web services. Web applications interact with BI services (by passing parameters to them and receiving data in return) using SOAP, a standard protocol for exchanging structured information.

Related Topics
• BI service structure

28.1.1 To publish a report block as a web service

You use the Publish Content wizard to publish a report block as a Web service.

1. Switch to Design, mode.
2. Select the table, chart or form you want to publish, right-click and select Publish as Web Service to display the Publish Content wizard.
3. Click Next to move to the first publishing step.
Related Topics

• To identify duplicate content

28.1.2 To identify duplicate content

If the report block you are publishing as a web service has already been published, the Identify Duplicate Content screen of the Publish Content highlights the duplicated blocks. The duplicate block appears in bold beneath the web services that publish it.

• Click Next to move to the next step.

Related Topics

• To define the web service

28.1.3 To publish prompts

Note:
Note that for web services, to use multiple values in prompts, you must reproduce the prompt as many times as different responses are expected, and the user will be prompted for each response.

1. Select or unselect the prompts you want to include or exclude in the list of prompts.
2. Click Select all to select all prompts or Clear all to clear all prompts.
3. Click Next to move to the next step.

28.1.3.1 Publishing prompts in web services

You use the Choose Prompts screen in the Publish Content wizard to choose which prompts to publish in the web service when the content you want to publish has related prompts.

If you do not publish a prompt, the web service uses the prompt value supplied when the document was last refreshed and saved. For example, if a user answers "US" to a prompt on [Country], then saves the document, the web service filters data on [Country]="US" the next time it is called with the refresh=true parameter.
If a web service publishes prompts, web applications must supply values for the prompts in the custom data provider web service window if they call the web service with the `refresh=true` parameter. If the user does not enter values for the prompts, the last values entered are used.

### 28.1.4 To define the web service

Before publishing a block as a Web service, you use the **Define Published Content** screen in the **Publish Content** wizard to name the table, make filters available on the block data, and select the server where the block will be published.

**Note:**

The **Share report content for all consumers** option below allows all web service consumers (sessions) get the report block content from the same (and single) instance of document. This option reduces memory load on the Processing server, and should be enabled when content is to be consumed by many concurrent users. Technically, the document is opened by the first consumer who sends a request for it, and is then consumed by any other consumer sending same request after ‘on behalf’ of first user (i.e. using his authorization). Document security cannot therefore be applied with web service calls designed with this option. To avoid any conflicts, all consumers should be granted the permission to open the corresponding document. Users should also be granted permission to view/access data from the underlying data sources.

Filtering and drilling from a web service are not compatible with the **Share report content for all consumers** option. The only way to filter Web Intelligence document data from web services is to use "Section filters" (i.e. Use a report section exposed as filters in the corresponding web service).

1. Type the name and description under which you want to publish the table in the **Name** and **Description** boxes.
2. Select **Share report content for all consumers** when you want all web service consumers (sessions) get the report block content from the same (and single) instance of document. When this option is selected, the **Set Filters** option is disabled. This command is disabled because consumers will not be able to use report filters (section filters being the only available way to filter content through mandatory input parameters. Section headers cannot be removed because corresponding web service parameters are mandatory input parameter, since sections are part of the report element structure.
3. Click **Set Filters** and select the objects you want to make available for filtering in the web service.
4. Select the server where you want to publish the content beneath **Host server**.
5. To add, remove or edit servers in the list of host servers, click **Manage servers**, then click **Add**, **Edit** or **Remove** and update the list of servers.
6. Click **Next** to move to the next step.

**Related Topics**
- To publish prompts
- To save and publish a web service
28.1.4.1 Making data available for filtering in a web service

When you publish a report block as a web service, you can make report objects available that web applications can use to filter the data returned by the web service. For example, if you publish a table containing [Country], [Region] and [Revenue], you can make the [Country] dimension available as a filter. Web applications accessing the web service can then filter on the [Country] dimension.

Filtering objects appear as FilterCondition parameters in the GetReportBlock_<block_name> function in the web service.

You make objects available for filtering in the Define published content screen of the Publish Content wizard. The screen lists all the objects in the report and selects the objects in the block you are publishing by default. You can deselect these objects and select any object in the report to make it available as a filter. For example, you can make the [Country] dimension available as a filter when you publish a table containing the [Region] and [Revenue] objects if the [Country] dimension appears in the report. You can also choose not to make the [Region] and [Revenue] objects available as filters.

You do not have to include any report objects as filters except for objects that appear in section headers. These appear selected and you cannot unselect them.

If you publish a block in a section, by default the web service filters on the value of the section object corresponding to the block you selected. For example, if you have a report containing [Country], [Region] and [Revenue] with [Country] as the section header, and you publish the block in the section where [Country]="France", the web service uses "France" as the default value of [Country]. A web application accessing the web service can supply a different value for [Country] and the data returned by the web service changes to correspond with the filter.

If you publish a block in a report containing report filters, the objects on which report filters are defined are selected by default in the screen. You can unselect these objects. If you publish the block without making the objects available as filters, the web service filters data according to the values of the report filters. If you make the objects available, web applications can apply the report filters using different values.

Related Topics
• GetReportBlock_blockname

28.1.5 To save and publish a web service

You use the Publish new content or re-publish existing content as Web Service screen in the Publish Content wizard to save and publish the Web service to a host server.

1. To re-publish an existing web service, select the web service, click Publish.
2. To publish a new web service, select the folder where you want to publish the content and click **Create** to display the **Publish Web Service** dialog box.

   **Note:**
   Folders are optional, you publish to an existing web service or a new web service, and you can create folders in order to organize your work. Click **New Folder** to add a new folder.

3. Type the name of the web service in the **Web service name** box and the service description in the **Description** box.

4. Select the authentication method for the web service from the **Authentication** list.

5. Click **OK** to close the dialog box and save and publish the web service.

6. Choose the web service where you want to publish to.

7. Click **Finish**.

### 28.2 Viewing and managing published content

You can browse the content published on different Web servers by using the **WebServicePublisher** pane. The **WebServicePublisher** pane also allows you to edit published Web services and import QaaWS (Query as a Web Service) queries, which you can then republish as Web Intelligence content.

### 28.2.1 To view and manage published content

1. In Design mode, display the **WebServicePublisher** pane by clicking on the Web Service Publisher icon of the left pane.

2. Select the server from the **Host server** list.

3. To add, remove or edit servers in the list of host servers, click **Manage servers**, then click **Add**, **Edit** or **Remove** and update the list of servers.

4. Select the **Views** icon and select the way you want the content to be organized from the menu.
Published content is organized as web service > block

**View by web service**
- Published content is organized as web service > block

**View by document and web service**
- Published content is organized as a document > web service > block

**View by document and block**
- Published content is organized as a document > block > web service

**Show Web Services queries**
- QaaWS (Query as a Web Service) queries appear below the published content. (QaaWS queries are stored in the same repository folder as BI services.)

5. To edit a published block, select the block and right-click **Edit** to launch the **Publish Content** wizard.
6. To delete published content, select the published block or the Web service and right-click **Delete**.
7. To rename a web service, select the web service, right-click **Rename** and type the new name.
8. To refresh the list of published content, click **Refresh** or right-click on a folder or web service and select **Refresh list**.
9. To search the list of web services, type the text you want to search for in the search box and select your search options from the menu at the left of the search box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Case sensitive</strong></td>
<td>Match case when searching</td>
</tr>
<tr>
<td><strong>Case insensitive</strong></td>
<td>Ignore case when searching</td>
</tr>
<tr>
<td><strong>Match from start</strong></td>
<td>Return only those web services or blocks whose name starts with the search text</td>
</tr>
<tr>
<td><strong>Match anywhere</strong></td>
<td>Return only those web services or blocks whose name contains the search text</td>
</tr>
</tbody>
</table>

**Related Topics**
- Importing and converting QaaWS (Query as a Web Service) queries
- To publish a report block as a web service

### 28.2.2 To test published content

You can test published content and examine the structure of the Web service that publishes it.
1. Display the Web Service Publisher by using the **Publish new content or re-publish existing content as Web Service** screen in the **Publish Content** wizard.
2. Select the Web service you want to test and click **Test**.
3. Select the web service function you want to test from the Operation drop-down list.
4. Select the parameters and operators for which you want to specify values in the Input pane and type their values on the right of the pane beneath Value.
5. Click Send to call the web service with the values you specified.
   The data returned by the web service appears in the Server response pane.
6. Click Change to tree view/Change to table view to toggle the web service data between a tree view and table format.

28.3 Importing and converting QaaWS (Query as a Web Service) queries

You can import QaaWS queries and run them to produce a block that is inserted in a new report. When you import a QaaWS query, the application builds a query based on the structure of the QaaWS query, then runs this query and inserts the resulting block in a new report. The original QaaWS query is not modified.

Because SAP BusinessObjects Web Intelligence does not support the publication of QaaWS queries directly, you can use this workflow to publish QaaWS queries as BI services by publishing the resulting block as a BI service.

Note:
There is no support for sorts defined on QaaWS queries. When you run the QaaWS query, any sorts it contains are lost.

28.3.1 To publish a QaaWS query

1. Open the Publish new content or re-publish existing content as Web Service screen in the Publish Content wizard by selecting Publish on the main toolbar.
2. Select View > Display QaaWS queries to display QaaWS queries.
3. Select the QaaWS query you want to import and click Import Web Service query.
   The QaaWS query is added to the document as a Web Intelligence query. A report tab is added with the same name as the QaaWS query. The report tab contains a table corresponding to the query objects.
4. Refresh the added query to display the web service query data.
5. Right-click the added table and select Publish as Web Service to publish the table as a web service.

Related Topics
• To publish a report block as a web service
28.4 BI service structure

External web applications access Web Intelligence content published as web services by calling two functions:

- GetReportBlock_blockname
- Drill_blockname

In both these function calls, blockname is the name of the block as defined in the web service.

Applications use the SOAP protocol to call the functions and receive the function output which they can then parse.

28.4.1 GetReportBlock_blockname

<table>
<thead>
<tr>
<th>Function name</th>
<th>GetReportBlock_blockname</th>
</tr>
</thead>
</table>

**Input parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>login</td>
<td>CMS login</td>
<td>Yes, unless sessionID or serialized Session is specified.</td>
</tr>
<tr>
<td>password</td>
<td>CMS password</td>
<td>Yes, unless sessionID or serialized Session is specified.</td>
</tr>
<tr>
<td>reportfilter</td>
<td>One or more report filters. See the table below for more information.</td>
<td>Yes when the report block contains section entries; no otherwise. Blocks with sections therefore have a mix of mandatory and optional reportfilter parameters.</td>
</tr>
<tr>
<td>prompt</td>
<td>Prompt values. See below for more information on LovIndexValue parameters</td>
<td>Yes when refresh = true and the prompt is mandatory; no false otherwise. If you don't enter prompt value then the prompt takes the values previously defined. The consumption of web services having prompts in Web Intelligence does not mean that you will be prompted, you must enter prompt values in Custom Data Provider - Web Service window.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Mandatory?</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>closeDocument</td>
<td>Force document to be closed once the web service has replied with the requested content. This behavior helps in optimizing memory consumption on the server, as consumers can control how long documents are stored.</td>
<td>Boolean, default value: false (by default document is kept open, when web service is replied). Values: false or true.</td>
</tr>
<tr>
<td>endRow</td>
<td>Defines the last row number retrieved from the source. This parameter is used with the startRow parameter, to define the chunk size to retrieve in table output parameter (e.g. startRow = 10 / endRow= 55, will retrieve 46 rows between row n°10 and row n°55 included). The last row of a table has rank set equal to table size, any greater value is internally corrected to that number.</td>
<td>Optional. If not declared, the entire table contents are retrieved. By default, the entire table contents are retrieved.</td>
</tr>
<tr>
<td>startRow</td>
<td>Defines the first row number retrieved from the source. This parameter is used with the endRow parameter, to define the chunk size to retrieve in table output parameter (e.g. startRow = 10 / endRow= 55, will retrieve 46 rows between row n°10 and row n°55 included). First row of a table has is 1, any lower value is internally corrected to 1.</td>
<td>Optional. If not declared, the entire table contents are retrieved. By default, the entire table contents are retrieved.</td>
</tr>
<tr>
<td>resetState</td>
<td>Re-opens the document when the web service is called, resetting drills and filters.</td>
<td>No - default value is false.</td>
</tr>
<tr>
<td>refresh</td>
<td>Forces document refresh.</td>
<td>No - default value is false.</td>
</tr>
<tr>
<td>getFromLatestDocumentIn-</td>
<td>Retrieves data from the latest document instance.</td>
<td>No - default value is true.</td>
</tr>
<tr>
<td>stance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>getFromUserInstance</td>
<td>Retrieves data from user inbox if the document has been published.</td>
<td>No - default value is false.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Mandatory?</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>turnOutput-ToVTable</td>
<td>Turns the output to a vertical table. Note: If the block is a chart it is always turned to a vertical table even if this parameter is set to false.</td>
<td>No - default value is false.</td>
</tr>
<tr>
<td>sessionID</td>
<td>Session token to avoid submitting login/password. Increases the session count when submitted.</td>
<td>No.</td>
</tr>
<tr>
<td>serialized-Session</td>
<td>Serialized session to avoid submitting login/password. Does not increase the session count when submitted.</td>
<td>No.</td>
</tr>
</tbody>
</table>

**reportFilter parameter**

reportFilter parameters contain two elements:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>filtering_value</td>
<td>The value used to filter the data</td>
<td>Any</td>
</tr>
<tr>
<td>filtering_operator</td>
<td>The filter operator</td>
<td>EQUAL (default)</td>
</tr>
</tbody>
</table>

**Example of reportFilter parameter**

The filter [Country]="US" is specified as follows:

```xml
<Country>
   <value>US</value>
   <operator>EQUAL</operator>
</Country>
```

**Output parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>TTable</td>
<td>Table cells</td>
</tr>
<tr>
<td>headers</td>
<td>THeader</td>
<td>Table headers</td>
</tr>
<tr>
<td>footers</td>
<td>TFooter</td>
<td>Table footers</td>
</tr>
<tr>
<td>user</td>
<td>string</td>
<td>Login used by the web service call</td>
</tr>
<tr>
<td>documentation</td>
<td>string</td>
<td>The web service description supplied by the service designer</td>
</tr>
<tr>
<td>documentname</td>
<td>string</td>
<td>The document name</td>
</tr>
<tr>
<td>lastrefreshdate</td>
<td>dateTime</td>
<td>The date of the last document refresh</td>
</tr>
</tbody>
</table>
The table type
string
The table type

The number of columns in the output table
int
nbColumns
The number of columns in the output table

The number of rows in the output table
int
nbLines
The number of rows in the output table

**Related Topics**

- Drill_blockname
- Sample BI service return data

### 28.4.2 Drill_blockname

**Function name**

Drill_blockname

**Note:**

This web service call cannot be used when the document sharing option (*Share report content for all consumers*) in the "Publish Content" wizard is enabled (such methods will not be specified in web service WSDL file), an error will be returned to the consumer if called when this option is enabled.

**Input parameters**

The syntax of the `Drill_<block_name>` function is similar to `GetReportBlock_<block_name>`, with the following differences:

- there are no `reportfilter` parameters
- there are additional `drillpath` parameters
- there is an additional `drillfilter` parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>drillpath</td>
<td>Specifies a drill instruction</td>
<td>Yes</td>
</tr>
<tr>
<td>drillfilter</td>
<td>Specifies a filter to apply when drilling</td>
<td>No</td>
</tr>
</tbody>
</table>

**Drillpath parameter**

Drillpath parameters are of type DrillPath. They contain three elements:
### Drill parameter

**Name** | **Description** | **Values**
---|---|---
from | The dimension to drill | Any
value | The value to drill on | Any
drilloperation | The type of drill operation | UP | DOWN

**Note:**
- As well as single values (for example "Los Angeles"), value can pass definitions such as "All Cities".
- If the drill instruction is invalid, the web service returns the original table data.
- At the end of the drill hierarchy, the web services returns the last available values in the drill hierarchy.
- You can supply more than one drillpath parameter providing that the parameters do not refer to different levels in the same drill hierarchy.

### Drillfilter parameter

**Name** | **Description** | **Values**
---|---|---
dimension | The dimension to filter | Any.
value | The value to filter on | Any
operator | The filter operator | EQUAL | GREATER | GREATER_OR_EQUAL | LESS | LESS_OR_EQUAL | NOT_EQUAL | INLIST | NOT_INLIST

**Note:**
- As well as single values (for example "Los Angeles"), value can pass definitions such as "All Cities".
- If the drill instruction is invalid, the web service returns the original table data.
- At the end of the drill hierarchy, the web services returns the last available values in the drill hierarchy.
- You can supply more than one drillpath parameter providing that the parameters do not refer to different levels in the same drill hierarchy.

**Related Topics**
- GetReportBlock_blockname

### 28.4.3 BI Services output parameters

The following table lists the output parameters returned by a BI Service:

---

Sharing content with other applications
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>TTable</td>
<td>Table cells</td>
</tr>
<tr>
<td>headers</td>
<td>THeader</td>
<td>Table headers cells</td>
</tr>
<tr>
<td>footers</td>
<td>TFooter</td>
<td>Table footers cells</td>
</tr>
<tr>
<td>user</td>
<td>string</td>
<td>Login used by the web service call</td>
</tr>
<tr>
<td>documentation</td>
<td>string</td>
<td>The web service description supplied by the service designer</td>
</tr>
<tr>
<td>documentname</td>
<td>string</td>
<td>The document name</td>
</tr>
<tr>
<td>lastrefreshdate</td>
<td>dateTime</td>
<td>The date of the last document refresh</td>
</tr>
<tr>
<td>creationdate</td>
<td>dateTime</td>
<td>The date the web service was created</td>
</tr>
<tr>
<td>creator</td>
<td>string</td>
<td>User name of the web service creator</td>
</tr>
<tr>
<td>isScheduled</td>
<td>boolean</td>
<td>Specifies if document is scheduled</td>
</tr>
<tr>
<td>scheduleStartTime</td>
<td>dateTime</td>
<td>The schedule start time if the document is scheduled</td>
</tr>
<tr>
<td>scheduleEndTime</td>
<td>dateTime</td>
<td>The schedule end time if the document is scheduled</td>
</tr>
<tr>
<td>tableType</td>
<td>string</td>
<td>The table type</td>
</tr>
<tr>
<td>nbColumns</td>
<td>int</td>
<td>The number of columns in the output table</td>
</tr>
<tr>
<td>nbLines</td>
<td>int</td>
<td>The number of rows in the output table</td>
</tr>
</tbody>
</table>

**Example of table parameter**

```
<table>
  <row>
    <cell xsi:type="xsd:string">Australia</cell>
    <cell xsi:type="xsd:string">Accommodation</cell>
    <cell xsi:type="xsd:string">Bungalow</cell>
    <cell xsi:type="xsd:double">172980</cell>
  </row>
...,
</table>
```

**Example of headers parameter**

```
<headers>
  <row>
    <cell xsi:type="xsd:string">Country</cell>
    <cell xsi:type="xsd:string">Service Line</cell>
    <cell xsi:type="xsd:string">Service</cell>
    <cell xsi:type="xsd:string">Revenue</cell>
  </row>
</headers>
```

**Related Topics**

- Sample BI service return data
### 28.4.4 Sample BI service return data

Web services return data using SOAP. The following is a sample SOAP file returned by a web service:

```xml
<soap:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance...">
  <soap:Body>
    <GetReportBlock_Block1BeachResponse xmlns="multidocmultiuniversesmultime">
      <table>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Accommodation</cell>
          <cell xsi:type="xsd:string">Bungalow</cell>
          <cell xsi:type="xsd:double">172980</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Accommodation</cell>
          <cell xsi:type="xsd:string">Hotel Room</cell>
          <cell xsi:type="xsd:double">345510</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Accommodation</cell>
          <cell xsi:type="xsd:string">Hotel Suite</cell>
          <cell xsi:type="xsd:double">464850</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Food & Drinks</cell>
          <cell xsi:type="xsd:string">Fast Food</cell>
          <cell xsi:type="xsd:double">19530</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Food & Drinks</cell>
          <cell xsi:type="xsd:string">Poolside Bar</cell>
          <cell xsi:type="xsd:double">27073</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Food & Drinks</cell>
          <cell xsi:type="xsd:string">Restaurant</cell>
          <cell xsi:type="xsd:double">41160</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Recreation</cell>
          <cell xsi:type="xsd:string">Activities</cell>
          <cell xsi:type="xsd:double">59820</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Recreation</cell>
          <cell xsi:type="xsd:string">Excursion</cell>
          <cell xsi:type="xsd:double">113170</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Recreation</cell>
          <cell xsi:type="xsd:string">Sports</cell>
          <cell xsi:type="xsd:double">69575</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Travels</cell>
          <cell xsi:type="xsd:string">Car Rent</cell>
          <cell xsi:type="xsd:double">49160</cell>
        </row>
        <row>
          <cell xsi:type="xsd:string">Australia</cell>
          <cell xsi:type="xsd:string">Travels</cell>
          <cell xsi:type="xsd:string">Travels</cell>
          <cell xsi:type="xsd:double">49160</cell>
        </row>
      </table>
    </GetReportBlock_Block1BeachResponse>
  </soap:Body>
</soap:Envelope>
```
<table>
<thead>
<tr>
<th>Country</th>
<th>Service Type</th>
<th>Accommodation Type</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>France</td>
<td>Travel Reservation</td>
<td>Travel Reservation</td>
<td>63300</td>
</tr>
<tr>
<td>France</td>
<td>Accommodation</td>
<td>Bungalow</td>
<td>126240</td>
</tr>
<tr>
<td>France</td>
<td>Accommodation</td>
<td>Hotel Room</td>
<td>316790</td>
</tr>
<tr>
<td>France</td>
<td>Accommodation</td>
<td>Hotel Suite</td>
<td>320220</td>
</tr>
<tr>
<td>France</td>
<td>Food &amp; Drinks</td>
<td>Fast Food</td>
<td>28440</td>
</tr>
<tr>
<td>France</td>
<td>Food &amp; Drinks</td>
<td>Poolside Bar</td>
<td>46320</td>
</tr>
<tr>
<td>France</td>
<td>Food &amp; Drinks</td>
<td>Restaurant</td>
<td>32640</td>
</tr>
<tr>
<td>France</td>
<td>Recreation</td>
<td>Activities</td>
<td>9000</td>
</tr>
<tr>
<td>France</td>
<td>Recreation</td>
<td>Excursion</td>
<td>120050</td>
</tr>
<tr>
<td>France</td>
<td>Recreation</td>
<td>Sports</td>
<td>35720</td>
</tr>
<tr>
<td>Nepal</td>
<td>Accommodation</td>
<td>Bungalow</td>
<td>323231</td>
</tr>
<tr>
<td>Nepal</td>
<td>Accommodation</td>
<td>Hotel Room</td>
<td>330240</td>
</tr>
<tr>
<td>Nepal</td>
<td>Accommodation</td>
<td>Hotel Suite</td>
<td>320754</td>
</tr>
<tr>
<td>Nepal</td>
<td>Food &amp; Drinks</td>
<td>Fast Food</td>
<td>32960</td>
</tr>
<tr>
<td>Location</td>
<td>Category</td>
<td>Subcategory</td>
<td>Price</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>Nepal</td>
<td>Food &amp; Drinks</td>
<td>Poolside Bar</td>
<td>37915</td>
</tr>
<tr>
<td>Nepal</td>
<td>Food &amp; Drinks</td>
<td>Restaurant</td>
<td>32980</td>
</tr>
<tr>
<td>Nepal</td>
<td>Recreation</td>
<td>Activities</td>
<td>78200</td>
</tr>
<tr>
<td>Nepal</td>
<td>Recreation</td>
<td>Excursion</td>
<td>96440</td>
</tr>
<tr>
<td>Nepal</td>
<td>Recreation</td>
<td>Sports</td>
<td>102720</td>
</tr>
<tr>
<td>Nepal</td>
<td>Travels</td>
<td>Car Rent</td>
<td>56370</td>
</tr>
<tr>
<td>Nepal</td>
<td>Travels</td>
<td>Travel Reservation</td>
<td>74495</td>
</tr>
<tr>
<td>US</td>
<td>Accommodation</td>
<td>Bungalow</td>
<td>368870</td>
</tr>
<tr>
<td>US</td>
<td>Accommodation</td>
<td>Hotel Room</td>
<td>746828</td>
</tr>
<tr>
<td>US</td>
<td>Accommodation</td>
<td>Hotel Suite</td>
<td>842046</td>
</tr>
<tr>
<td>US</td>
<td>Food &amp; Drinks</td>
<td>Fast Food</td>
<td>66330</td>
</tr>
<tr>
<td>US</td>
<td>Food &amp; Drinks</td>
<td>Poolside Bar</td>
<td>88508</td>
</tr>
<tr>
<td>US</td>
<td>Food &amp; Drinks</td>
<td>Restaurant</td>
<td>331860</td>
</tr>
</tbody>
</table>
### 28.4.5 BI service WSDL definition

```xml
<definitions xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/">
  <types>
    <s:schema elementFormDefault="qualified" targetNamespace="zozo2">
      <s:simpleType name="Operator">
        <s:restriction base="s:string">
          <s:enumeration value="EQUAL"/>
          <s:enumeration value="GREATER"/>
          <s:enumeration value="GREATER_OR_EQUAL"/>
          <s:enumeration value="LESS"/>
          <s:enumeration value="LESS_OR_EQUAL"/>
          <s:enumeration value="NOT_EQUAL"/>
          <s:enumeration value="INLIST"/>
          <s:enumeration value="NOT_INLIST"/>
        </s:restriction>
      </s:simpleType>
    </s:schema>
  </types>
  ...
</definitions>
```
Sharing content with other applications

<message name="GetReportBlock_Block1SoapIn">
  <part name="parameters" element="s0:GetReportBlock_Block1"/>
  <part name="request_header" element="s0:QaaWSHeader"/>
</message>

<message name="GetReportBlock_Block1SoapOut">
  <part name="parameters" element="s0:GetReportBlock_Block1"/>
  <part name="response_header" element="s0:QaaWSHeader"/>
</message>

<schema xmlns="http://www.w3.org/2001/XMLSchema">
  <element name="Drill_Block1ffResponse">
    <complexType>
      <sequence>
        <element name="table" type="s0:TTable"/>
        <element name="headers" type="s0:THeader"/>
        <element name="footers" type="s0:TFooter"/>
        <element name="user" type="s:string"/>
        <element name="documentation" type="s:string"/>
        <element name="documentname" type="s:string"/>
        <element name="lastrefreshdate" type="s:dateTime"/>
        <element name="creationdate" type="s:dateTime"/>
        <element name="creator" type="s:string"/>
        <element name="isScheduled" type="s:boolean"/>
        <element name="scheduleStartTime" type="s:dateTime"/>
        <element name="scheduleEndTime" type="s:dateTime"/>
        <element name="tableType" type="s:string"/>
        <element name="nbColumns" type="s:int"/>
        <element name="nbLines" type="s:int"/>
      </sequence>
    </complexType>
  </element>

  <element name="GetReportBlock_Block1Response">
    <complexType>
      <sequence>
        <element name="table" type="s0:TTable"/>
        <element name="headers" type="s0:THeader"/>
        <element name="footers" type="s0:TFooter"/>
        <element name="user" type="s:string"/>
        <element name="documentation" type="s:string"/>
        <element name="documentname" type="s:string"/>
        <element name="lastrefreshdate" type="s:dateTime"/>
        <element name="creationdate" type="s:dateTime"/>
        <element name="creator" type="s:string"/>
        <element name="isScheduled" type="s:boolean"/>
        <element name="scheduleStartTime" type="s:dateTime"/>
        <element name="scheduleEndTime" type="s:dateTime"/>
        <element name="tableType" type="s:string"/>
        <element name="nbColumns" type="s:int"/>
        <element name="nbLines" type="s:int"/>
      </sequence>
    </complexType>
  </element>

  <element name="Drill_Block1Response">
    <complexType>
      <sequence>
        <element name="table" type="s0:TTable"/>
        <element name="headers" type="s0:THeader"/>
        <element name="footers" type="s0:TFooter"/>
        <element name="user" type="s:string"/>
        <element name="documentation" type="s:string"/>
        <element name="documentname" type="s:string"/>
        <element name="lastrefreshdate" type="s:dateTime"/>
        <element name="creationdate" type="s:dateTime"/>
        <element name="creator" type="s:string"/>
        <element name="isScheduled" type="s:boolean"/>
        <element name="scheduleStartTime" type="s:dateTime"/>
        <element name="scheduleEndTime" type="s:dateTime"/>
        <element name="tableType" type="s:string"/>
        <element name="nbColumns" type="s:int"/>
        <element name="nbLines" type="s:int"/>
      </sequence>
    </complexType>
  </element>

  <element name="QaaWSHeader">
    <complexType>
      <sequence>
        <element name="sessionID" type="s:string" minOccurs="0" maxOccurs="1" nillable="true"/>
        <element name="serializedSession" type="s:string" minOccurs="0" maxOccurs="1" nillable="true"/>
      </sequence>
    </complexType>
  </element>
</schema>
<part name="parameters" element="s0:GetReportBlock_Block1Response" />
</message>
<message name="Drill_Block1SoapIn">
<part name="parameters" element="s0:Drill_Block1" />
<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Block1SoapOut">
<part name="parameters" element="s0:Drill_Block1Response" />
</message>
<message name="GetReportBlock_Block1ffSoapIn">
<part name="parameters" element="s0:GetReportBlock_Block1ff" />
<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Block1ffSoapOut">
<part name="parameters" element="s0:GetReportBlock_Block1ffResponse" />
</message>
<message name="Drill_Block1ffSoapIn">
<part name="parameters" element="s0:Drill_Block1ff" />
<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Block1ffSoapOut">
<part name="parameters" element="s0:Drill_Block1ffResponse" />
</message>
<message name="GetReportBlock_Bloc1SoapIn">
<part name="parameters" element="s0:GetReportBlock_Bloc1" />
<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="GetReportBlock_Bloc1SoapOut">
<part name="parameters" element="s0:GetReportBlock_Bloc1Response" />
</message>
<message name="Drill_Bloc1SoapIn">
<part name="parameters" element="s0:Drill_Bloc1" />
<part name="request_header" element="s0:QaaWSHeader" />
</message>
<message name="Drill_Bloc1SoapOut">
<part name="parameters" element="s0:Drill_Bloc1Response" />
</message>
</portType>
</binding>
</soap:binding>
</portType>
</binding>
</portType>
</service>
</types>
</types>
</service>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>
</types>

Sharing content with other applications
Sharing content with other applications
Sharing content with other applications

</service>
</definitions>
Linking to other documents

29.1 Linking to other documents

Document cells can be defined as hyperlinks. Hyperlinks in cells are similar to the hyperlinks found on the World Wide Web that allow you to open a different web page from the page you are currently viewing.

When you click a cell that contains a hyperlink, the target document specified in the link opens. The target document can be another Web Intelligence document, a site on the world wide web, a PDF, Excel or Word document, or any resource accessible through a hyperlink.

Hyperlinks can be either static or dynamic. A static hyperlink always links to the same document in the same way. A dynamic hyperlink can link differently depending on the data in the document containing the hyperlink.

You can create different types of hyperlink:

- A cell where the cell text is the hyperlink text.
- A cell with an associated hyperlink.
- A link to another document in the CMS. Use the DHTML mode (Web mode) for this action. For target documents that refer to BEX queries, .unx universes, or .unv universes that contain prompts that use Index Awareness, there are additional parameters to set.

When you create a link using the application interface, the link is defined using the OpenDocument syntax. If you wish, you can build links manually using OpenDocument. For detailed information on OpenDocument syntax, see the Viewing Documents using OpenDocument guide.

As well as linking between documents, you can also link report elements in the same report by defining elements as "input controls" that filter the values in other report elements.

29.1.1 Cell text defined as a hyperlink

When you define the text in a cell as a hyperlink, the cell text itself becomes the hyperlink text. For example, if you define a free-standing cell containing the text `http://www.sap.com` as a hyperlink, clicking on the cell takes you to the SAP web page.

This method is best suited for static hyperlinks, where the text in the cell always remains the same and links to the same resource in the same way.
**Note:**

It is possible to make this type of hyperlink dynamic by using the formula language to change the cell text based on report data.

### 29.1.1.1 To define cell text as a hyperlink

1. Type the hyperlink text in the cell.
2. Right-click the cell and select **Linking > Read Contents as Hyperlink**.

### 29.1.2 A hyperlink associated with a cell

When you associate a hyperlink with a cell, you define a hyperlink that links to the source document when the cell is clicked. The cell text itself is not the hyperlink.

This is the recommended method for creating dynamic hyperlinks, for the following reasons:

- It is specially tailored for working with the parameters in dynamic hyperlinks.
- It shields you from the complexity of hyperlink syntax - you define your hyperlink using a graphical interface and the hyperlink syntax is generated and managed behind the scenes.
- It allows you to define hyperlink text that is different from the cell text.

### 29.1.2.1 To add a hyperlink to a cell

1. Select the cell and select, right-click and select **Linking > Add Hyperlink** to display the "Create Hyperlink" dialog box.
2. Select the **Link to web page** tab.
3. Type or paste the hyperlink text into the box.
4. Click **Parse** to extract the hyperlink parameters into the **Customize URL parameters** area (which is not visible until you click **Parse**).

Dynamic hyperlinks contain parameters whose values can change. Parameters appear as name=value parts at the end of the hyperlink after the question mark. For example, the URL

```
http://salesandproductreport/default.asp?reportname=products
```

contains one parameter, reportname, whose value is "products".
After you click **Parse**, each parameter appears on a separate line with the parameter name on the left and the parameter value on the right. The static part of the hyperlink (the part without the parameters) appears in the **Main** section.

5. To supply data from formulas or variables as parameter values, click the arrow next to each parameter value and select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build formula</strong></td>
<td>You build a formula in the Formula Editor to supply the formula output as the parameter value.</td>
</tr>
<tr>
<td><strong>Select object</strong></td>
<td>You choose the object from the list in the &quot;Select Object&quot; dialog box to supply its value as the parameter value.</td>
</tr>
</tbody>
</table>

**Note:**
When you modify a parameter, the full hyperlink syntax changes to reflect the modification in the box at the top of the screen.

6. To add or remove a parameter, modify the hyperlink syntax, then click **Parse**.

**Note:**
You cannot add or remove parameters directly in the parameter list in the **Customize URL parameters** area. You must modify the URL syntax directly.

7. Click the arrow next to **Cell content** to change the text displayed in the hyperlink cell and choose one of the options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build formula</strong></td>
<td>You build a formula in the Formula Editor to supply the formula output as the cell content.</td>
</tr>
<tr>
<td><strong>Select object</strong></td>
<td>You choose the object from the list in the &quot;Select Object&quot; dialog box to supply its value as the cell content.</td>
</tr>
</tbody>
</table>

8. Type the tooltip text in the **Tooltip** box or build a dynamic tooltip by using the **Build formula** or **Select variable** options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build formula</strong></td>
<td>You build a formula in the Formula Editor to supply the formula output as the tooltip.</td>
</tr>
<tr>
<td><strong>Select object</strong></td>
<td>You choose the object from the list in the &quot;Select Object&quot; dialog box to supply its value as the tooltip.</td>
</tr>
</tbody>
</table>

The tooltip appears when you hover your mouse pointer over the cell containing the hyperlink.

9. Click the arrow next to **Target window** to define how the target URL appears.
### 29.1.3 A link to another document in the CMS

You link to another document in the CMS using the "Create Hyperlink" dialog box. The link uses the `OpenDocument` function behind the scenes. The parameters passed to the function are determined by the choices you make in the dialog box.

You can also work with the `OpenDocument` function directly by typing the syntax into a cell.

### 29.1.3.1 To link to another document in the CMS

Use this option to link to another document. The **Add Document Link** is only available when a report is edited in DHTML mode (Web mode). It is not available in Applet mode (Rich Internet Application mode) or in Web Intelligence Rich Client.

**Note:**
When the target document refers to a .unx universe, a .unv universe containing an Index Awareness Prompt, or to a BEX query, there are additional objects to select.

1. Right-click the cell where you want to create the link and select **Linking > Add Document Link** from the menu to display the "Create Hyperlink" dialog box.
2. Select the **Link to a document** tab.
3. Click **Browse** and select the target document in the **Choose Document** dialog box, or type the document ID in the **Document ID** box.
4. Select the format of the target document from the **Document Format** list in the **Customize the look and behavior of the hyperlink** section.

   The format of the document determines which options are available when defining the link. For example, you cannot link to a report part in a PDF document.

   a. For a document referring to a BEX query, a .unx universe, or a .unv universe with a prompt that uses index awareness, in the "Document prompts" section, select the **key**.
   b. Click on the key drop-down box and select **Build formula** and type `=<objectname>.key()`.
      The object must not be a variable, and the object must have a key.
   c. Test that the `<objectname>.key()` returns the expected results.
If the result does not return the key, ask the universe designer to provide help on how to obtain the key.

5. Select **New window** or **Current window** from the **Target window** list in the **Customize the look and behavior of the hyperlink** section to determine how the target document opens.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New window</td>
<td>The document opens in a new browser window.</td>
</tr>
<tr>
<td>Target window</td>
<td>The document opens in the current browser window and replaces the document containing the hyperlink.</td>
</tr>
</tbody>
</table>

6. Type the tooltip text in the **Tooltip** box in the **Customize the look and behavior of the hyperlink** section, or build a dynamic tooltip by using the **Build formula** or **Select object** options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build formula</td>
<td>You build a formula in the Formula Editor to supply the formula output as the tooltip.</td>
</tr>
<tr>
<td>Select object</td>
<td>You choose the variable from the list in the &quot;Select an Object&quot; dialog box to supply its value as the tooltip.</td>
</tr>
</tbody>
</table>

The tooltip appears when you hover your mouse pointer over the cell containing the hyperlink.

7. Click **Use complete URL path to create hyperlink** to ensure that the link uses the full URL path rather than a relative path from the current document.

8. Click **Refresh on open** if you want to refresh the data of the target document when the hyperlink is selected.

9. Click **Link to document instance**, then select an option from the drop down-list, to link to an instance of the selected document.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Most recent</strong></td>
<td>The hyperlink opens the most recent instance.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You cannot specify parameter values in the hyperlink when you choose this option.</td>
</tr>
<tr>
<td><strong>Most recent - current user</strong></td>
<td>The hyperlink opens the most recent instance owned by the current user.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>You cannot specify parameter values in the hyperlink when you choose this option.</td>
</tr>
<tr>
<td><strong>Most recent - matching prompt values</strong></td>
<td>The hyperlink opens the most recent instance whose prompt values correspond to the values passed by the hyperlink.</td>
</tr>
<tr>
<td></td>
<td>This option is useful when you want to link to a large document that contains prompts.</td>
</tr>
</tbody>
</table>

10. Click **Report name** and select the name of the report to link to a specific report if you are linking to a Web Intelligence document.

11. Click **Report part**, then click **Select** and right-click the report part (for example a table), to link to a specific part of a report.

12. If you selected **Report part**, select **Display report part only** open the report part only in the target document, or **Position at report part (full document available)** to focus on the report part but display the whole report in the target document.

13. If the document contains prompts, for each prompt in the **Document prompts** section, select one of the following options from the drop-down list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Build formula</strong></td>
<td>You use the Formula Editor to build a formula to pass a value to the prompt.</td>
</tr>
<tr>
<td><strong>Select object</strong></td>
<td>You select an object whose value is passed to the prompt.</td>
</tr>
<tr>
<td><strong>Prompt user at runtime</strong></td>
<td>The user specifies a value for the prompt when they click the hyperlink.</td>
</tr>
<tr>
<td><strong>Use document default</strong></td>
<td>You configure the hyperlink to not pass a parameter to the target document, and the target document opens with the default value for the prompt. The default value is either the last value specified for the prompt, or the default specified in the document.</td>
</tr>
</tbody>
</table>

14. Choose **Build Formula** or **Select Variable** from the **Cell content** list to specify the content of the hyperlink cell.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Formula</td>
<td>You build a formula in the Formula Editor to supply the formula output as the cell content.</td>
</tr>
<tr>
<td>Select Variable</td>
<td>You choose a variable from the list in the &quot;Select an Object&quot; dialog box to supply its value as the cell content.</td>
</tr>
</tbody>
</table>

#### 29.1.3.2 Document instances and values passed to prompts

Hyperlinks supply values to prompts in the target document in two ways: by passing values directly to prompts, or by opening a document instance based on passed values.

In the first case, the hyperlink feeds values directly to the prompts in the target document. In the second case, the link opens the document instance whose stored prompt values correspond to the values passed by the hyperlink.

It is more efficient to choose a document instance based on passed parameters if the target document is large.

Certain combinations of instance and parameter settings are incompatible or mutually dependent, as described in the following table:

<table>
<thead>
<tr>
<th>Instance setting</th>
<th>Impact on parameter setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most recent</td>
<td>The hyperlink does not pass parameter values. All parameters are set to Use document default and cannot be modified.</td>
</tr>
<tr>
<td>Most recent - current user</td>
<td>The hyperlink does not pass parameter values. All parameters are set to Use document default and cannot be modified.</td>
</tr>
<tr>
<td>Most recent - matching prompt values</td>
<td>You must specify at least one parameter value. Without at least one specified value, the hyperlink returns an error when clicked. The error occurs because the hyperlink is designed to retrieve an instance based on parameter values, but no value is provided for comparison against the instance.</td>
</tr>
</tbody>
</table>
Related Topics

- Linking to large documents

### 29.1.3.3 Linking to large documents

When the target document contains a large amount of data, it is more efficient to link to an instance than to open and retrieve the document with a passed parameter value. You can schedule and pre-retrieve multiple instances with different parameter values. This allows the document to be scheduled and pre-retrieved in advance with different parameter values.

When you click the hyperlink, the link opens the appropriate pre-retrieved instance rather than using the passed value to open the document and retrieve the data.

**Example:** Linking to a large sales report

In this example you link to a large sales report that retrieves sales by region. The report has a parameter that allows the user to select the region. There are four regions - North, South, East, and West.

Your source document has a [Region] dimension. You do the following:

- Configure the hyperlink to pass the value of [Region] as a parameter
- Create four instances of the sales report, one for each value of [Region]
- Schedule these instances for pre-retrieval
- Configure the hyperlink to open the latest instance whose parameter value matches the value passed by the hyperlink

Assuming that the document has a [Region] dimension, the settings are as follows:

<table>
<thead>
<tr>
<th>Link to document instance setting</th>
<th>Latest value match</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most recent - matching prompt values</td>
<td>[Region]</td>
</tr>
</tbody>
</table>

### 29.2 Working with hyperlinks

#### 29.2.1 To link to another document from a hyperlink
To link to another document from a hyperlink, the hyperlink must first have been created.

1. Hover your mouse pointer over the cell to display the tooltip if a tooltip is defined.

   **Note:**
   If you used the "Hyperlink" dialog box to define the link and the Formula Bar is displayed, the generated syntax of the hyperlink appears in the Formula Bar. Do not modify this syntax directly - use the "Hyperlink" dialog box if you need to update it.

2. Click the hyperlink to open the target document.
   Depending on how the hyperlink is configured, the target document opens in a new browser window, or it replaces the current document in the current browser window.

### 29.2.2 To edit a hyperlink

1. Right-click the cell containing the hyperlink and select Hyperlink > Edit from the menu to display the "Hyperlink" dialog box.
2. Edit the hyperlink using the "Hyperlink" dialog box.

### 29.2.3 To delete a hyperlink

- Select the cell containing the hyperlink and select Linking > Remove.

### 29.2.4 Formatting hyperlink colors

You can define the colors used to display hyperlinks that have already been clicked (visited hyperlinks) and hyperlinks that have not been clicked (unvisited hyperlinks).

#### 29.2.4.1 To set hyperlink colors

1. Right-click a blank area on the report that contains hyperlinks and select Format Report on the menu.
2. Click the Appearance tab.
3. In the Hyperlink color section, click the arrows next to Visited and Unvisited, then either select a predefined color or click More colors to define a custom color.

4. Click OK.

### 29.3 Linking report elements in a document

You can create links between report elements by defining a report element as an "input control" that filters the values in other report elements. For example, if you have a report containing two tables, you can filter the values in one table depending on the values selected in the other.

**Related Topics**

- Input controls defined
- Using tables and charts as input controls
Formatting your reports using Cascading Style Sheets

30.1 Style sheets explained

Web Intelligence Cascading Style Sheets (CSS) define how to display your reports and determine the presentation of documents. You can edit the CSS to apply a specific style to the presentation of documents. You can export the file, modify the styles according to your needs and then import the file back. You can also distribute the style sheet to other users as a standard style.

**Note:**
The CSS style sheet does not control the color of charts. There is a separate file for defining corporate palettes for charts.

**Using a CSS allows you to:**
- Define a company-wide style sheet in order to define standard settings (such as a company logo).
- Define different styles to present a specific type of information. For example, you can use one color for products sold, another color for expenses and another color for revenues.
- Create a style sheet in order to encode personal preferences.
- Personalize the presentation of the documents you create.

**Note:**
The Cascading Style Sheets are derived from the W3C CSS.

In order to modify the CSS of your documents, you must be familiar with the CSS core syntax of the W3C.

**Related Topics**
- [About corporate palettes](#)

30.2 Using the style in documents

When you create a new report or a new report element in a Web Intelligence document, the formatting is entirely based on the default style.
If specific formatting is done on these elements by the user from the Context menu (Right-click > Format), the modified properties overwrite locally the values taken from the default style.

To remove this specific formatting, go to Format > Clear Format.

30.3 Modifying the document default style

- The document default style is stored in a Cascading Style Sheet (CSS) file that is embedded into the document itself.
- You can modify the default style by exporting the CSS file.
  
  To export a CSS file go to Properties > Document > Change Default Style > Export Style.
- You can use any text editor to edit the CSS file. Once you have edited the CSS, save the file and import it to apply the changes.

  **Note:**
  
  You have to import the CSS file every time you edit it.

- To import a CSS file go to Properties > Document > Change Default Style > Import Style. The CSS file you import is applied to the report.

  **Note:**
  
  If the properties of an element have been set through the user interface (toolbox, context menu, dialog box), these properties are not affected by the CSS you import.

- To apply a CSS to an element that has already been formatted through the user interface, you have to clear its format. To clear the format of an element, select the element and go to Format > Clear Format.

- To clear the format of all the elements in a page, select the BODY and go to Format > Clear Format.

  **Note:**
  
  You have to clear the format of the HEADER and the FOOTER manually as they are not contained in the BODY.

- You can undo changes at any time by using the UNDO option.
- You can restore the default CSS at any time by going to Properties > Document > Reset standard Default Style.

30.4 Modifying and using the standard default style
The standard CSS file is named WebIDefaultStyleSheet.css and it is located in `c:\Program Files(x86)\SAP BusinessObjects Enterprise XI\images\WebIDefaultStyleSheet.css`.

When you create a new document or when you edit a Web Intelligence 3.X document for the first time, the standard CSS is taken and embedded into the Web Intelligence document to become the document style. This default style document diverges from the standard and can be locally modified.

If you want to reset the document default style to the standard style, go to Properties > Document > Reset standard Default Style. The standard CSS will replace the previous CSS in the document.

To publish a standard default file, you must have access to the `../images/` folder of your servers and Web Intelligence Rich Client installations to put a new version of `WebiDefaultStyleSheet.css`.

### 30.5 Web Intelligence CSS syntax

The Web Intelligence CSS conforms to the W3C CSS core syntax. However, the core syntax does not imply anything about property names, types and semantic.

Web Intelligence CSS supports locale-specific style sheets.

**Related Topics**

- W3C CSS core syntax

### 30.5.1 Elements

In order to modify the way your document is displayed, you have to modify the Web Intelligence CSS elements of the document. To modify an element, you have to modify its properties.

This table shows the elements you can edit in the CSS file:

<table>
<thead>
<tr>
<th>Element</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPORT</td>
<td>Tag that contains the report</td>
</tr>
<tr>
<td>PAGE_BODY</td>
<td>Tag that contains the page</td>
</tr>
<tr>
<td>PAGE_HEADER</td>
<td>Tag that contains the area on top of the PAGE_BODY</td>
</tr>
<tr>
<td>PAGE_FOOTER</td>
<td>Tag that contains the area in the bottom of the PAGE_BODY</td>
</tr>
<tr>
<td>SECTION</td>
<td>Tag that contains an area inside the PAGE_BODY</td>
</tr>
<tr>
<td>TABLE</td>
<td>Tag that contains a table</td>
</tr>
<tr>
<td>VTABLE</td>
<td>Tag that modifies a table vertically</td>
</tr>
<tr>
<td>Element</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>HTABLE</td>
<td>Tag that modifies the table horizontally</td>
</tr>
<tr>
<td>COLINFO</td>
<td>Tag that contains the columns of a table</td>
</tr>
<tr>
<td>ROWINFO</td>
<td>Tag that contains the rows of a table</td>
</tr>
<tr>
<td>CELL</td>
<td>Tag that contains the cells of a table</td>
</tr>
<tr>
<td>AXIS</td>
<td>Tag that defines the relationship between the columns and rows of a table</td>
</tr>
<tr>
<td>FORM</td>
<td>Tag that contains a form</td>
</tr>
<tr>
<td>XELEMENT</td>
<td>Tag that contains a graphic</td>
</tr>
<tr>
<td>BAG</td>
<td>Tag that contains elements and places them relatively using X and Y</td>
</tr>
<tr>
<td>WOB</td>
<td>Tag that contains elements and places them automatically</td>
</tr>
</tbody>
</table>

### 30.5.2 Properties

For many properties, Web Intelligence CSS uses the same names as the W3C CSS. However, some property names change and some are ignored.

Example:

Web Intelligence CSS uses the property `min-width` and the W3C CSS uses the property `width`. Both properties have the same use.

### Related Topics

- [For CSS 2.1](#)
- [For CSS 3](#)

### 30.5.2.1 Page related properties

This table shows the properties that can be applied to the element REPORT:
<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>page-format-dimension-height</td>
<td>Height of page</td>
<td>42094</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-dimension-width</td>
<td>Width of page</td>
<td>29764</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-bottom</td>
<td>Size of the bottom margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-left</td>
<td>Size of the left margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-right</td>
<td>Size of the right margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-margin-top</td>
<td>Size of the top margin of the page</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-format-orientation</td>
<td>Orientation of page</td>
<td>portrait</td>
<td>landscape, portrait</td>
</tr>
<tr>
<td>page-records-horizontal</td>
<td>In 'quick display mode', specifies how many data records can be horizontally displayed before triggering a page break</td>
<td>150</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-records-vertical</td>
<td>In 'quick display mode', specifies how many data records can be vertically displayed before triggering a page break</td>
<td>50</td>
<td>Numeric value</td>
</tr>
<tr>
<td>page-scaling-factor</td>
<td>Zoom percentage</td>
<td>100</td>
<td>Numeric value</td>
</tr>
</tbody>
</table>
### 30.5.2.2 Report element properties

This table shows the properties that you can edit to modify the Report elements:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>autofit-height</td>
<td>Specifies whether the height of the element can be adjusted to fit its content</td>
<td>yes</td>
<td>yes/no</td>
</tr>
<tr>
<td>autofit-width</td>
<td>Specifies whether the width of the element can be adjusted to fit its content</td>
<td>yes</td>
<td>yes/no</td>
</tr>
<tr>
<td>bookmark</td>
<td>Specifies whether the element will be bookmarked</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>h-align</td>
<td>Horizontal positioning of the element</td>
<td>none</td>
<td>none, top, center, bottom</td>
</tr>
<tr>
<td>hide</td>
<td>Specifies whether the element is hidden</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>min-height</td>
<td>Minimal height of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>min-width</td>
<td>Minimal width of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>never-alternate</td>
<td>This property can be used to avoid the application of the alternate style on the element</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>padding-bottom</td>
<td>How much space to put between the bottom border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>padding-left</td>
<td>How much space to put between the left border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
<td>Default value</td>
<td>Value range</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>padding-right</td>
<td>How much space to put between the right border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>padding-top</td>
<td>How much space to put between the top border and the content of the element</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>struct-min-height</td>
<td>Minimal height of the element when displayed in structure mode</td>
<td>900</td>
<td>Numeric value</td>
</tr>
<tr>
<td>struct-min-width</td>
<td>Minimal width of the element when displayed in structure mode</td>
<td>4050</td>
<td>Numeric value</td>
</tr>
<tr>
<td>v-align</td>
<td>Vertical positioning of the element</td>
<td>none</td>
<td>none, top, center, bottom</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:
- BAG
- WOB
- CELL
- VTABLE
- HTABLE
- XTABLE
- TABLE
- XELEMENT
- SECTION

### 30.5.2.3 Formatting properties

This table shows the properties that you can edit to modify the Formatting elements:
<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>background-color</td>
<td>Color to be displayed in background</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>background-fill</td>
<td>Describes what will be displayed in background</td>
<td>none</td>
<td>color, bitmap, bitmapAndColor, skin, none</td>
</tr>
<tr>
<td>background-h-align</td>
<td>Horizontal position of the background image</td>
<td>center</td>
<td>left, center, right</td>
</tr>
<tr>
<td>background-image</td>
<td>Image to be displayed in background</td>
<td>None</td>
<td>Any image you want</td>
</tr>
<tr>
<td>background-inner-height</td>
<td>Inner height of background</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>background-inner-width</td>
<td>Inner width of background</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>background-type</td>
<td>Determines how the background image will be laid out or repeated</td>
<td>box</td>
<td>box, tile, vtile, htile, stretch</td>
</tr>
<tr>
<td>background-v-align</td>
<td>Vertical position of the background image</td>
<td>center</td>
<td>top, center, bottom</td>
</tr>
<tr>
<td>border-bottom-color</td>
<td>Color of an element's bottom border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-bottom-style</td>
<td>Style of an element's bottom border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-bottom-width</td>
<td>Width of an element's bottom border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>border-left-color</td>
<td>Color of an element's left border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-left-style</td>
<td>Style of an element's left border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-left-width</td>
<td>Width of an element's left border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>border-right-color</td>
<td>Color of an element's right border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-right-style</td>
<td>Style of an element's right border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-right-width</td>
<td>Width of an element's right border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>Property name</td>
<td>Description</td>
<td>Default value</td>
<td>Value range</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>border-top-color</td>
<td>Color of an element's top border</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>border-top-style</td>
<td>Style of an element's top border</td>
<td>none</td>
<td>none, dashed, dotted, double, plain</td>
</tr>
<tr>
<td>border-top-width</td>
<td>Width of an element's top border</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>color</td>
<td>Foreground color</td>
<td>#000000</td>
<td>Any hexadecimal color</td>
</tr>
<tr>
<td>default-date-h-align</td>
<td>Default horizontal alignment when a date is being displayed</td>
<td>right</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>default-numeric-h-align</td>
<td>Default horizontal alignment when a numeric value is being displayed</td>
<td>right</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>default-text-h-align</td>
<td>Default horizontal alignment when a text is being displayed</td>
<td>left</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>font-family</td>
<td>Name of font family</td>
<td>default</td>
<td>Webi supported fonts</td>
</tr>
<tr>
<td>font-orientation</td>
<td>Describes the orientation of the displayed text</td>
<td>normal</td>
<td>normal, hotel, 45D, 90D, 180D, 270D, 315D</td>
</tr>
<tr>
<td>font-size</td>
<td>Size of the displayed font</td>
<td>0</td>
<td>Numeric value in points (pt.)</td>
</tr>
<tr>
<td>font-style-italic</td>
<td>Activates the italic font style</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>font-weight-bold</td>
<td>Activates the bold font style</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>text-align</td>
<td>Horizontal alignment of the text</td>
<td>left</td>
<td>left, center, right, auto</td>
</tr>
<tr>
<td>text-decoration-line-through</td>
<td>Activates the line-through text decoration</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>text-decoration-under-line</td>
<td>Activates the underline text decoration</td>
<td>no</td>
<td>yes/no</td>
</tr>
<tr>
<td>text-v-align</td>
<td>Vertical alignment of the text</td>
<td>bottom</td>
<td>top, center, bottom</td>
</tr>
<tr>
<td>text-wrap</td>
<td>Specifies whether the text may be wrapped</td>
<td>no</td>
<td>yes/no</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:

* BAG
• WOB
• CELL
• VTABLE
• HTABLE
• XTABLE
• TABLE
• XELEMENT
• SECTION

### 30.5.2.4 Spacing properties

This table shows the properties that you can edit to modify the Spacing elements:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>h-spacing</td>
<td>Horizontal spacing of children</td>
<td>0</td>
<td>Numeric value</td>
</tr>
<tr>
<td>v-spacing</td>
<td>Vertical spacing of children</td>
<td>0</td>
<td>Numeric value</td>
</tr>
</tbody>
</table>

These properties can be applied to the following elements:

- BAG
- WOB

### 30.5.2.5 Hyperlink properties

This table shows the properties that you can edit to modify the Hyperlink elements:
These properties can be applied to the following elements:

- BAG
- WOB
- CELL
- VTABLE
- HTABLE
- XTABLE
- TABLE
- XELEMENT
- SECTION

### 30.5.2.6 Break properties

This table shows the properties that can be applied to the element **BREAK**:

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
<th>Default value</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>break-newpage</td>
<td>Reports always start on a new page</td>
<td>false</td>
<td>true/false</td>
</tr>
<tr>
<td>break-onepage</td>
<td>Reports start on a new page only if they do not fit in the current page</td>
<td>true</td>
<td>true/false</td>
</tr>
</tbody>
</table>

### 30.5.3 Units

When you assign a numeric value to the property **font-size** you can only use the unit "points" (pt).
Example:

font-size : 14pt;

When you assign a numeric value to any other dimension property, you can use centimeters (cm), inches (in) or "metric" (without any unit).

Example:

width : 1.0in; would be the same as width : 2.54cm; and the same as width : 3600;

### 30.6 Style and 3.x documents

The Web Intelligence CSS replaces the old way of personalizing your documents.

When you open a Web Intelligence 4.x document with a Web Intelligence 3.x format, the style of the document does not change, regardless of the style defined in the standard CSS. However, the style used while creating new report elements or during **Turn into** operations will come from the CSS.

To set the default style defined by the report elements in the document, select the report elements and go to **Format** > **Clear Format**. The formatting of the selected objects will be cleared and the default style will be applied.

The **DefaultConfig.xml** file used in the previous versions is obsolete.

Here are some correspondances between the entries of Web Intelligence CSS and the obsolete entries of the **DefaultConfig.xml** file used in previous versions.

<table>
<thead>
<tr>
<th>WebI selector</th>
<th>Corresponding entry in defaultConfig.xml</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLE</td>
<td>table*Table</td>
</tr>
<tr>
<td>FORM</td>
<td>table*Form</td>
</tr>
<tr>
<td>SECTION</td>
<td>Section*background</td>
</tr>
<tr>
<td>CELL</td>
<td>freeCell*default</td>
</tr>
</tbody>
</table>

### 30.7 Web Intelligence CSS restrictions

- The options **Export Style, Import Style** and **Reset standard Default Style** only work in the Web Intelligence Rich Client and the Web Intelligence applet.
- The Web Intelligence CSS does not define the style of the application (applet, DHTML).
- It is not possible to modify the style sheet of a document through the user interface (applet or DHTML).
• The Web Intelligence CSS is not a document template: it does not define the default structure of documents.
• The Web Intelligence CSS does not accept ID selectors since users cannot manage objects IDs.
Creating a corporate palette for charts

31.1 About corporate palettes

You can define a corporate palette for charts so that your reports have the corporate style. The palette colors are defined in the configuration file called VisualizationConfig.xml. You can only define one corporate palette and the palette ID must not be changed.

The default palette contains 32 defined colors. You can define more colors, but you must define at least two colors. You define a color by defining the strengths of red (R), green (G), blue (B), and the transparency (A).

Example:

```xml
<COLOR R="200" G="0" B="0" A="255" />
```

Related Topics

- To create a new query based on a BEx query

31.2 Corporate palette configuration file syntax

The corporate chart palette configuration file VisualizationConfig.xml is in the C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\images directory and contains the following elements:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<CONFIG>
    <!-- Rename this file to VisualizationConfig.xml which will activate a custom default palette. -->
    <!-- The following section allows to define a corporate palette which will be used by default in all new visualization. -->
    <!-- TOMCAT must be restarted after each modification of this file -->
    <PALETTES>
        <PALETTE ID="corporate">
            <!-- Add a list of colors so as to define your palette (default palettes contain 32 colors): R for Red, G for Green, B for Blue and A for managing the transparency -->
            <!-- Each attributes must take an integer value from 0 to 255 -->
            <!-- The palette ID should not be changed. -->
            <COLOR R="200" G="0" B="0" A="255" />
            <COLOR R="0" G="200" B="0" A="255" />
            <COLOR R="0" G="0" B="200" A="255" />
```

379 2012-03-16
31.3 To define a corporate palette for charts

The Administrator can define a corporate palette using the following configuration file: VisualizationConfig.xml. This corporate palette will then be used as default for all new charts.

1. In the directory C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\images, open the template file: VisualizationConfig.template.xml.
2. Define at least two colors, or edit the ones present in the template file.
3. Rename the file: VisualizationConfig.xml and save it in the same directory.
4. Restart TOMCAT.

This corporate palette will be used as default for all new charts. Make sure there are no errors in the configuration file, otherwise the standard palette will be applied.

Restart TOMCAT each time you modify this file.
Error Messages

The following section covers the different error messages and their solutions that might appear under certain conditions while using this application.

32.1 Web Intelligence Error Messages

Web Intelligence error messages include the following ranges and categories:

- Web Intelligence Java interface (WIJ) Error Messages
- Web Intelligence HTML interface (WIH) Error Messages
- Web Intelligence Desktop (WIO) Error Messages
- Web Intelligence Server (WIS) Error Messages
- Web Intelligence Report Engine (RWI) Error Messages

32.1.1 Web Intelligence (WIJ) Error Messages

Web Intelligence Java interface error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIJ 10000 - WIJ 77778</td>
<td>Web Intelligence Java interface</td>
</tr>
</tbody>
</table>

You need to use the Formula Editor to create a formula. (Error: WIJ 10000)

Cause

You typed a formula into a cell using the Cell Properties panel instead of the Formula Editor.
**Action**
Launch the Formula Editor and define the formula in the Formula Definition pane.

You cannot create a variable that has the same name as an existing document object. Give the new variable a different name. (Error: WIJ 10001)

**Cause**
A single document cannot contain multiple objects or variables with the same name.

**Action**
To save a new variable, give the variable a name that is different from the objects and variables already included in the document.

You cannot position this report component in relation to a block, cell, or section that is positioned relative to this report component. Select a different block, cell or section in the dropdown list or unselect the Relative To option. (WIJ 10500)

**Cause**
When you position a report component in relation to another report component that references the selected one, you create a circular attachment.

**Action**
Remove relative positioning, or select a different block, cell, or section for relative positioning.

Web Intelligence requires the Java Runtime Environment (JRE) 1.4.2_01. The currently installed JRE is {0}. Contact your administrator to upgrade to 1.4.2_01 or select the [default VM] entry in the [Java Plug-in Control Panel], if you already have the required version installed. (WIJ 11111)

**Cause**
When you use the Java interface, a Java applet is installed on your local PC. The Java Runtime Environment 1.4.2_01 (or later version) needs to be installed and selected in order for the report panel to function.

**Action**
If Java Runtime Environment 1.4.2_01 (or later version) is already installed on your PC, then launch the Java Plugin Control panel. To do this:
• Select the Windows menu: **Start > Settings > Control Panel**.
• Double-click Java Plug-in.
• On the **Advanced** tab, select Use Java Plug-in Default, then click Apply.

Or
Contact your administrator, and request help with installing Java Runtime Environment 1.4.2_01 (or later version).

**An error occurred while the document was being decoded. Try to open the document in the BI Launch Pad, or contact your administrator for further information.** (WIJ 20000)

**Cause**
Web Intelligence cannot decode and open the document in the Java Report Panel.

**Action**
Open the document in InfoView by clicking the document title where the document is listed on the InfoView Corporate Documents or Personal Documents page.

If this does not work, see your administrator.

**An unexpected problem occurred when during document refresh and open. The data source has been modified or deleted, or a prompt on the document has no value selected.** (WIJ 20001)

**Cause**
The document has the Refresh on open option selected. One or more of the following explanations can account for this error:
• The data source has been modified since the document was created.
• The data source has been deleted since the document was created.
• One or more prompts have no values selected.

**Action**
See your administrator.
Unexpected error. If you cannot reconnect to the server, close your session and start again. (WIJ 20002)

**Cause**
The server may be down or your user session may be closed.

**Action**
See your administrator.

Unable to get the first page of the current report. Check the validity of your report. (ERR WIJ 20003).

**Cause**
The report cannot be displayed because it contains structural errors.

**Action**
Do one of the following:

- View the report in Structure View and verify the report structure. For example, errors can be caused if report blocks overlap or if the structure of a table contains cells that create an asymmetrical table format. Modify the report structure appropriately.
- Contact your administrator and request them to search for structural anomalies in the report.

The current query contains unresolvable objects. The query will be updated (WIJ 20004).

**Cause**
There are objects that cannot be resolved in the query.

**Action**
Check that the related objects have not been deleted from the data source.

The current request has returned corrupted data. Contact your administrator for further information (WIJ 20005).

**Cause**
The returned data is corrupted. This could be due to data source or network issues.
**Action**
Contact your administrator.

**Unable to contact the application server. Contact your administrator for further information (WIJ 20010).**

**Cause**
The application server could be down, or address different to the one expected.

**Action**
Contact your administrator.

**The {0,number} MB report element you want to copy is too large to be exported to an external application.\nThe maximum allowed size is {1,number} MB. (Error: WIJ 30004)**

**Cause**
The report element you want to copy is too large to be copied.

**Action**
Do not attempt to copy the report element.

**Your user profile does not give you access to a document domain to save corporate documents. Save this document as a personal document or contact your administrator (ERR WIJ 40000).**

**Cause**
You do not have the rights to save the document to the corporate repository.

**Action**
Save the document as a personal document or ask your administrator for the rights to save the document to the repository.
The query in this document is empty. Check that the Result Objects pane on the query tab includes objects before running the query (ERR WIJ 30000).

**Cause**
The query does not contain any result objects.

**Action**
Edit the query and add result objects.

At least one query in this document is empty. Check that the Result Objects pane on each query tab includes objects before running the queries (ERR WIJ 30001).

**Cause**
A query does not contain any result objects.

**Action**
Add the result objects to the empty query.

Out of memory. Reduce the browser window size or re-launch the report panel. (WIJ 30003).

**Cause**
Your computer has run out of the memory. This may be because your browser window size is too large.

**Action**
Do one of the following:
- Reduce the size of the browser window.
- Relaunch the Java interface.

Your user profile does not allow you to save personal or corporate documents. Contact your administrator for further details. (WIJ 40001)

**Cause**
Your user profile, defined by your administrator, does not allow you to save personal or corporate documents.
**Action**
If you think you need to be allowed to save personal documents and/or corporate documents to InfoView, contact your administrator to request they modify your security profile.

**Your version of Web Intelligence Rich Client is not up-to-date to connect to this system (ERR WIJ 50003). You must upgrade your Web Intelligence Rich Client by clicking <a href="{0}">here</a>.

**Cause**
Your version of Web Intelligence Rich Client is not recent enough to connect to the repository.

**Action**
Upgrade your version of Web Intelligence Rich Client by following the link.

**The information sent to the server contains invalid character(s). Use the Undo button to cancel the latest changes to the document and then retry. (Error: WIJ 55555)**

**Cause**
There is an error in the XML sent to the server by the application.

**Action**
Use the **Undo** feature to remove the erroneous modification made to the document, and then run the query or refresh the document again.

**The session timed out. The document {document_name}.wid has been autosaved in the Favorites\~InteractiveAnalysis folder. Click Restore to retrieve it. (WIJ 60001)**

**Cause**
Due to a server timeout, the current document was autosaved in the Favorites\~InteractiveAnalysis folder.

**Action**
Click **Restore** to retrieve the autosaved document.

If you cannot restore the document automatically, retrieve it manually from the folder. The name of the autosaved document is the original document name with an automatically-generated prefix and postfix.

Retrieve the document from the autosave folder as quickly as possible. This folder is not a permanent storage location for autosaved documents.
The session timed out, but the document could not be autosaved because the following security rights are not assigned (WIJ 60002): {list_of_rights}

**Cause**
The document could not be autosaved because you do not have some or all of the following security rights:
- Edit object
- Delete object
- Add object

**Action**
Ask your administrator to assign you the appropriate security rights.

The document cannot be retrieved due to a server problem (WIJ 77777).

**Cause**
The document cannot be retrieved because the server is down.

**Action**
See your administrator.

The Central Management System is not functioning. Contact your administrator for further information. (WIJ 77779)

**Cause**
The Central Management System (CMS) is not running.

**Action**
Contact your administrator.

Your session timed out. Please close the Java interface and log on again. (WIJ 77778)

**Cause**
You have remained logged in to the Bi launch pad without using the Java interface for longer than the maximum time allowed by the system.
**Action**

Log out and then log back into the BI launch pad to continue using the Java interface (you will lose any unsaved modifications you made previous to timeout).

To increase the length of time you are allowed to remain logged in to the BI launch pad ask your administrator to increase your session timeout parameter.

### 32.1.2 Web Intelligence Desktop (WIO) Error Messages

Web Intelligence Desktop (Rich Client) error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIO 00001 - WIS 30284</td>
<td>Web Intelligence Desktop</td>
</tr>
</tbody>
</table>

**Web Intelligence Desktop cannot log in. (WIO 00001)**

**Cause**

The browser cache might be full – under certain circumstances this can prevent Web Intelligence Desktop from logging in.

**Action**

Empty the browser cache if it is full. If Web Intelligence Desktop still cannot log in, see your administrator.

**Cannot open the hyperlink (WIO 00002).**

**Cause**

- The URL in the hyperlink is incorrectly constructed.
- The hyperlink references a document in a “CMC”. Documents in a “CMC” are not always accessible from Web Intelligence Desktop for two reasons:
  - The hyperlink does not specify the name of the server hosting the document because the **Use complete URL path to build document hyperlink** setting is not selected. Incomplete URLs are invalid when used outside the BI launch pad.
  - The hyperlink builds the complete URL, but the server specified in the URL is not accessible from the computer running Web Intelligence Rich Client.
**Action**
Correct the hyperlink or see your administrator for help.

**There is no more memory available. (WIS 30280) (WIO 30280)**

**Cause**
Your system is out of memory.

**Action**
Close open documents to free memory.

**Cannot continue because memory is low. Please close documents to free memory. (WIO 30284)**

**Cause**
Your system memory is low.

**Action**
Close open documents to free memory.

### 32.1.3 Web Intelligence Server (WIS) Error Messages

Web Intelligence Server error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIS 30000 - WIS 40000</td>
<td>Web Intelligence Server</td>
</tr>
</tbody>
</table>

**The query in this document is empty. (WIS 30000)**

**Cause**
No data is defined for this document.

**Action**
Add result objects to the query.
At least one query in the document is empty. (WIS 30001)

**Cause**
No data is defined for at least one of the queries in this document.

**Action**
Add result objects to the query.

Your security profile does not include permission to edit queries. (WIS 30251)

**Cause**
You do not have the right to edit queries.

**Action**
Contact your administrator to request the ability to edit the queries in documents.

Your security profile does not include permission to edit documents. (WIS 30252)

**Cause**
You do not have the right to edit documents.

**Action**
Contact your administrator and request the ability to edit documents.

Your security profile does not include permission to refresh documents. (WIS 30253)

**Cause**
You do not have the right to refresh documents.

**Action**
Contact your administrator to request the ability to refresh documents.
Your security profile does not include permission to refresh lists of values. (WIS 30254)

**Cause**
You do not have permission to refresh lists of values.

**Action**
Contact your administrator to request the ability to refresh lists of values in documents.

Your security profile does not include permission to use lists of values. (WIS 30255)

**Cause**
You do not have permission to use lists of values.

**Action**
Contact your administrator to request the ability to use lists of values in documents.

Your security profile does not include permission to view the script generated by the query. (WIS 30256)

**Cause**
You do not have the permission to view the script generated by the query.

**Action**
Contact your administrator to request the ability to view the script in queries.

Your security profile does not include permission to use the formula language. (WIS 30257)

**Cause**
You do not have permission to use the formula language or create variables.

**Action**
Contact your administrator to request the ability to use the formula language and create variables in documents.
Your security profile does not include permission to perform drill analysis. (WIS 30258)

Cause
You do not have permission to perform drill analysis.

Action
Contact your administrator to request the ability to drill on reports.

Your security profile does not include permission to extend the scope of analysis. (WIS 30259)

Cause
You attempted to perform a drill operation outside the defined scope of analysis, and you do not have permission to drill outside the scope of analysis.

Action
Contact your administrator.

An internal error occurred while calling the {api_name} API. (WIS 30270)

Cause
Information about the document or the data source is invalid or not available.

Action
Your administrator can trace the problem that caused the error by activating the tracking and verifying the trace associated with the API.

The document is too large to be processed by the server. (WIS 30271)

Cause
When you view a document in Portable Document Format (PDF) or Microsoft Excel format, the server generates binary based output, which is then interpreted by your web browser. This error occurs if the size of the binary output is greater than the maximum size specified by your administrator for the server.

Action
Contact your administrator and ask them to increase the maximum size.
The document is too large to be processed by the server. (WIS 30272)

**Cause**
When you view a document in HTML format, the server generates character-based output, which is then interpreted by your web browser. This error occurs if the size of the character output is greater than the maximum size specified by your administrator for the server.

**Action**
Ask your administrator to increase the maximum document size.

The query or report could not be generated. (WIS 30351)

**Cause**
It was not possible to complete one or more of the steps required to define a query and generate a report. This is due to one of the following reasons:

- the document was not initialized
- the data source is not valid
- the query was not defined
- the query context was not defined at the universe level
- no values were specified for prompts at the universe level

**Action**
Contact your administrator and ask them to check the connection to the data source, and that the universe does not contain unspecified contexts and prompt values.

A query with this name already exists. (WIS 30371)

**Cause**
Another query used in this document already has this name.

**Action**
Enter a different name for this query.
The Web Intelligence server memory is full. Log off and try to connect later. If the problem persists, contact your administrator. (Error: ERR_WIS_30280) (WIS 30280)

**Cause**
The server memory is full.

**Action**
Try again later. If the problem persists, see your administrator.

The Web Intelligence server is busy. Save any pending change and try again later. If the problem persists, contact your administrator. (Error: ERR_WIS_30284) (WIS 30284)

**Cause**
The server is busy.

**Action**
Save any changes and try again later. If the problem persists, see your administrator.

The Web Intelligence server is running out of memory, your document has been closed. If the problem persists, contact your administrator. (Error: ERR_WIS_30285) (WIS 30285)

**Cause**
The server memory is full.

**Action**
Try again later. If the problem persists, see your administrator.

You cannot edit this document because the query property option "Allow other users to edit the query" was not enabled when the document was created. (WIS 30381)

**Cause**
The creator of the document did not select the query property option: "Allow other users to edit the query".
Action
Do one of the following:
• Ask the document creator to enable the option and re-save the document.
• Save a copy of the document as a personal document and then edit the query in the copy.

An internal error has been generated by the WIQT. (WIS 30551)

Cause
An unexpected error occurred on the WIQT.

Action
Contact your administrator.

Your WIQT session has reached timeout. Log out and log in again to the BI launch pad. (WIS 30553)

Cause
You have remained logged into the BI launch pad without using Web Intelligence for longer than the maximum time allowed by the system.

Action
Log out and then log back into the BI launch pad (you will lose any unsaved modifications you made previous to timeout).
To increase the length of time you are allowed to remain logged in to the BI launch pad, ask your administrator to increase your session timeout parameter.

No more WIQT servers are available. The maximum number of concurrent users is already logged in. (WIS 30554)

Cause
The maximum number users are already logged in.

Action
Try again later, or ask your administrator to increase the maximum number of concurrent users.
Your security profile does not include permission to save documents as corporate documents or to send documents using the BI launch pad. (WIS 30555)

**Cause**
Your security profile does not allow you to save documents as personal or corporate documents, or to schedule documents.

**Action**
Contact your administrator to request the ability to do the following:
- Save corporate documents
- Send documents to users in own groups
- Send documents to users in other groups

A corporate document with this name already exists. Your security profile does not include permission to delete corporate documents created by other users. (WIS 30556)

**Cause**
Your security profile does not allow you to overwrite existing corporate documents.

**Action**
Contact your administrator to request the ability to delete corporate documents saved by other users.

There is no document with this name in the repository. Specify a different document name. (WIS 30557)

**Cause**
There is no document with this name in the repository for one of the following reasons:
- You have typed the document name incorrectly
- The document with this name has been deleted from the repository

**Action**
Check that you have entered the document correctly.

**Note:**
Deleted documents cannot be retrieved.
Cannot perform the intended action on this document. (WIS 30650)

**Cause**
The server is unable to complete the current task because of lack of resources or access problems.

**Action**
Do one of the following:
- Close your session, log out of the BI launch pad then log in again.
- Ask your administrator to verify that your security profile allows you access to the corporate repository.

The server failed to load the XML document. (WIS 30751)

**Cause**
When you migrate a BusinessObjects document to Web Intelligence 6.x, an XML file is created that can be opened by the Web Intelligence Report Server. (The related module on the Administration Console is called the WIFeportServer). In this case an unexpected error occurred on the Web Intelligence Report Server while migrating a document to Web Intelligence 6.x.

**Action**
Your administrator can trace the problem that caused this error by activating the tracking and verifying the trace associated with the WIFeportServer. Contact your administrator with this information.

The XML file for this document cannot be opened. Contact your administrator. (WIS 30752)

**Cause**
When you migrate a Desktop Intelligence document to Web Intelligence 6.x, an XML file is created that can be opened by the server. This error occurs when the XML file cannot be opened by the server, and so migration cannot be completed. There are two common causes:
- The XML is Read Only.
- The file path to the XML file is incorrect.

**Action**
Contact your administrator with this information.
An error occurred while parsing the XML document. Contact your administrator. (WIS 30753)

Cause
When you migrate a Desktop Intelligence document to Web Intelligence 6.x, an XML file is created that can be opened by the server. This error occurs when the XML file contains structural anomalies that the server cannot interpret, and so migration cannot be completed.

Action
There are two possible actions that an administrator can take to solve this problem:

- Open the XML file with an XML editing tool and verify the structure of the document.
- Activate the tracking and verify the trace associated with the WIReportServer.

The Web Intelligence 2.x document could not be migrated. (WIS 30761)

Cause
An unexpected error occurred when trying to migrate a Web Intelligence 2.x document to the current document format.

Action
An administrator may be able to identify the cause of this error by activating the tracking and verifying the trace associated with the server. Contact your administrator with this information.

This document cannot be migrated. The query and report of the original Web Intelligence 2.x document are not synchronized. Try to refresh and save the original document; then attempt migration again. (WIS 30762)

Cause
In the original Web Intelligence 2.x document, there is a discrepancy between the objects included in the query and the objects included in the report. This means that the server is unable to interpret the document correctly to migrate it to the current document format.

Action
To synchronize the data definition in the query and report of the original Web Intelligence 2.x document:

1. Use Web Intelligence 2.x to open the original document again.
2. Either run the query or refresh the document data.
3. Save the refreshed document.
4. Try to migrate the document again using the Migration Tool.

If you do not have access to Web Intelligence 2.x or the Migration Tool, contact your administrator with this information.

**The Web Intelligence 2.x document could not be migrated, because the WIQT module returned an error. Contact your administrator. (WIS 30763)**

**Cause**
The original Web Intelligence 2.x document could not be migrated to the current document format, due to an error generated by the WIQT process.

**Action**
Your administrator can trace the problem that caused this error by activating the tracking and verifying the trace associated with the WIQT. Contact your administrator with this information.

**Your user profile does not provide you with access to a document domain to save corporate documents. Save this document as a personal document or contact your administrator. (WIS 40000)**

**Cause**
Your user profile does not include permission to save documents to a corporate document domain in the repository.

**Action**
Do one of the following:
- Save the document as a personal document.
- Contact your administrator and request access to a corporate document domain.

### 32.1.4 Web Intelligence Desktop HTML Interface (WIH) Error Messages

Web Intelligence Desktop HTML interface error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIH 00000 - WIH 00020</td>
<td>Web Intelligence Desktop HTML interface</td>
</tr>
</tbody>
</table>
32.1.4.1 The document could not be saved. (WIH 00014)

**Cause**
The document could not be saved to the repository. This error can occur for a number of reasons. For example: you do not have the security rights to the folder where you tried to save the document.

**Action**
See your administrator to determine why you could not save the document.

The session timed out. The document {document_name}.wid has been autosaved in the Favorites\~WebIntelligence folder. Click Restore to retrieve it. (WIH 00015)

**Cause**
Due to a server timeout, the current document was autosaved in the Favorites\~WebIntelligence folder.

**Action**
Click **Restore** to retrieve the autosaved document.

If you cannot restore the document automatically, retrieve it manually from the folder. The name of the autosaved document is the original document name with an automatically-generated prefix and postfix.

Retrieve the document from the autosave folder as quickly as possible. This folder is not a permanent storage location for autosaved documents.

The session timed out, but the document could not be autosaved because the following security rights are not assigned (WIH 00016): {list_of_rights}

**Cause**
The document could not be autosaved because you do not have some or all of the following security rights:
- Edit object
- Delete object
- Add object

**Action**
Ask your administrator to assign you the appropriate security rights.
32.1.5 ReportEngine Web Intelligence (RWI) Error Messages

ReportEngine Web Intelligence error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>RWI 00000 - RWI 00850</td>
<td>ReportEngine Web Intelligence</td>
</tr>
</tbody>
</table>

32.1.5.1 RWI 00000 - RWI 00314

User input is required for the prompt in the query. (RWI 00000)

**Cause**
The server requires prompt values in order to fulfill the request.

**Action**
Enter values for all mandatory prompts.

User input is required to select an universe context for the query. (RWI 00001)

**Cause**
The server requires context(s) selection in order to fulfill the request.

**Action**
Supply context(s) choice.

The argument cannot be null. (RWI 00010)

**Cause**
The specified argument is "null".
**Action**
Enter a non-null value for the argument.

Invalid value: {0}. (RWI 00011)

**Cause**
The specified argument value is invalid.

**Action**
Enter a valid value for the argument.

The argument is out of range. (RWI 00012)

**Cause**
The specified argument value is not within the allowed range.

**Action**
Specify a value within the allowed range.

Unable to retrieve the requested report part(s). Either the report part references are invalid, or the corresponding data does not exist anymore. (RWI 00013)

**Cause**
One or more report part references are invalid, or the corresponding data is not available.

**Action**
Ensure that you are using valid report part references. Subsequently, ensure that the requested data is available after refreshing the document's data providers.

Cannot retrieve more than one report part simultaneously in DHTML output format. (RWI 00014)

**Cause**
You cannot retrieve more than one report part in DHTML output format simultaneously.

**Action**
Enter a single report part reference.
Cannot turn off search mode for delegated search. (RWI 00015)

**Cause**
A list of values defined as "delegated" search cannot have search mode disabled.

**Action**
Before disabling the search mode, check if the list of values is defined as "delegated search".

One of the supplied OutputCacheEntry instances is invalid or not supported by the Web Intelligence server. (RWI 00016)

**Cause**
While preloading the server output cache, one or more output formats specified are invalid or unsupported.

**Action**
Ensure that the requested output formats are valid and supported.

Could not read {0}bytes from the specified stream. (RWI 00017)

**Cause**
Upon upload of the resource into a document, the supplied data could not be read.

**Action**
Ensure that the specified parameters are correct and consistent.

The Web Intelligence server returned an invalid XML output. Contact your administrator. (RWI 00200)

**Cause**
The server returned an invalid or incorrect XML output.

**Action**
Contact your technical support.
Could not get page number. (RWI 00223)

**Cause**
The requested page could not be retrieved because of an invalid page number.

**Action**
Ensure that the requested page number is valid.

Cannot initialize Report Engine server. (RWI 00226)

**Cause**
Communication with the server could not be established. This may occur when attempting to create or open a document.

**Action**
Ensure that the server is installed correctly. Also, check if the server is started and enabled.

Your Web Intelligence session is no longer valid because of a timeout. (RWI 00235)

**Cause**
The server session allocated to a particular document has been closed, either explicitly or because of a timeout.

**Action**
Ensure that the document has not been explicitly closed. Alternatively, increase the server session timeout value.

To modify the server session timeout value:
1. Log on to the Business Intelligence platform Central Management Console (CMC).
2. Click on Servers.
3. Expand Server Categories, and click on Web Intelligence.
5. In Properties window, under Web Intelligence Processing Service, enter the value for Idle Connection Timeout.
**The Web Intelligence server cannot be reached. Contact your administrator. (RWI 00236)**

**Cause**  
An error occurred while attempting to communicate with the server.

**Action**  
Contact the administrator to ensure that the server is enabled and running. Also, check for network problems.

**Cannot write output stream. Contact your administrator. (RWI 00237)**

**Cause**  
An I/O error occurred when writing data in response to a view request.

**Action**  
Contact the administrator to ensure that the specified destination parameter is valid.

**Connection failed. The server has reached the maximum number of simultaneous connections. (RWI 00239)**

**Cause**  
The maximum number of server connections allowed has been reached.

**Action**  
Either raise the value of the `maximum connections` server parameter, or add another server instance.

To modify the maximum connections value:
1. Log on to the Business Intelligence platform Central Management Console (CMC).
2. Click on Servers.
3. Expand Server Categories, and click on Web Intelligence.
5. In Properties window, under Web Intelligence Processing Service, enter the value for Maximum Connections.
Your server version is incompatible with this client version. Contact your administrator. (RWI 00240)

**Cause**
The server does not support this SDK version.

**Action**
Contact the administrator to ensure that the server version is compatible with the client version.

Cannot find an XML transformer. (RWI 00301)

**Cause**
Unable to instantiate the XSLT transformer used for XML to HTML transformation.

**Action**
Try again later.

Cannot create translet. (RWI 00309)

**Cause**
Unable to compile the XSLT stylesheet used for XML to HTML transformation.

**Action**
Try again later.

Cannot get an output file for the document. (RWI 00314)

**Cause**
While serializing a document state, an error occurred. This might be due to insufficient memory or an I/O error.

**Action**
Ensure that there is sufficient memory available. Also, check for any `webi.properties` customization.

32.1.5.2 RWI 00315 - RWI 00605
Cannot retrieve an XML parser ID. (RWI 00316)

**Cause**
An error occurred during XSLT transformation. This might be because you are requesting output in XML format using a client supplied stylesheet.

**Action**
Ensure that the specified XSLT stylesheet is correct.

Cannot transform XML to HTML. (RWI 00317)

**Cause**
During XSLT transformation, an error occurred while requesting output in HTML.

**Action**
Try again later.

The Java Runtime Environment does not support UTF-8 encoding. (RWI 00321)

**Cause**
The JRE does not support UTF-8 encoding.

**Action**
Switch to a JRE that supports UTF-8 encoding.

An error occurred while retrieving the document from the storage token. (RWI 00322)

**Cause**
An error occurred during document state deserialization. This might be due to insufficient memory or an I/O error.

**Action**
Ensure that there is sufficient memory available. Also check for any `webi.properties` customization.
Cannot retrieve the document with the passed obsolete token. (RWI 00323)

**Cause**
An error occurred during document state deserialization. This might be caused by a storage token that identifies a document state, which is no longer available in the storage tokens stack.

**Action**
In the `webi.properties` file, increase the value of `storage tokens stack size`. Also, ensure that the storage token is valid before using it.

Cannot retrieve the document with the passed malformed token. (RWI 00324)

**Cause**
An error occurred during document state deserialization. This might be due to an invalid storage token.

**Action**
Specify a valid storage token.

There are too many operands for the current operator. (RWI 00501)

**Cause**
For the current operator, the condition or filter has too many operands to be able to add a new one.

**Action**
Remove existing operands before attempting to add a new one.

There are not enough operands for the current operator. (RWI 00502)

**Cause**
The condition or filter does not have enough operands with respect to the current operator.

**Action**
Add operand(s) to the condition or filter.
Prompts are not supported on filters created at the report level. (RWI 00503)

**Cause**
Report filters do not support prompts. Only query conditions support prompts.

**Action**
Do not use prompts in report filters.

You cannot modify operators and operands in predefined filters. (RWI 00504)

**Cause**
While using a pre-defined condition, you cannot specify an operator for a condition or filter.

**Action**
Ensure that the operator in the pre-defined condition does not have any filters or conditions.

LIKE and NOT_LIKE operators are allowed only on ObjectType.TEXT objects. (RWI 00506)

**Cause**
You attempted to use "LIKE" or "NOT_LIKE" operators for objects that are not of character type.

**Action**
When the object used in a filter is not of character type, ensure that you do not use the "LIKE" and "NOT_LIKE" operators.

The specified operator cannot be applied to a document filter. (RWI 00507)

**Cause**
The specified operator cannot be used with report filters. It can be used only with query conditions.

**Action**
Do not use this operator when working with report filters.
Web Intelligence is unable to attach a LOV (List of Values) to the prompt because the associated source object does not have a LOV. (RWI 00508)

**Cause**
Cannot use a list of values with the prompt being defined. This is because the object used in this condition does not contain a LOV.

**Action**
Before requesting the prompt to use the list of values, ensure that the object used within the condition has a defined list of values.

There are incompatible data source objects in the filter condition comparison. (RWI 00509)

**Cause**
You have attempted to compare two objects of different types within a condition.

**Action**
Use objects of the same type.

Cannot create a report filter on a formula. (RWI 00511)

**Cause**
Formulas cannot be used as report filters. Only data providers and variable expressions can be used.

**Action**
Use a data provider or variable expression when defining a report filter.

A percentage rank cannot have values greater than 100. (RWI 00512)

**Cause**
When you defined the percentage ranking, you chose a rank size that was greater than 100.

**Action**
Ensure that the rank size is less than 100.
The expression is not available in the axis. (RWI 00602)

**Cause**
You have attempted to create a break, calculation, or sort using an expression that is not in the axis.

**Action**
Use an expression that is available in the axis.

Only measure objects can be included on the y-axis. (RWI 00603)

**Cause**
You have attempted to add an expression to the axis, where the expression is not of measure type.

**Action**
Specify an expression of measure type.

You cannot base a section on a measure. (RWI 00604)

**Cause**
A section cannot be based on an expression of measure type.

**Action**
Do not use an expression of measure type as the basis for a section.

You cannot add more than one expression to a section axis. (RWI 00605)

**Cause**
A section axis does not support more than one expression.

**Action**
Do not use several expressions in a section axis.

32.1.5.3 RWI 00606 - RWI 00850
You cannot include a circular attachment in a document. (RWI 00606)

**Cause**
You have attempted to define a report attachment that causes a circular attachment.

**Action**
Define a report that does not generate a circular attachment.

The expression is different from the table cell expression. (RWI 00607)

**Cause**
You have attempted to create a calculation on a table cell, specifying an expression different from the one contained in the table cell.

**Action**
Create a calculation table with the expression that is already defined in the table cell.

You cannot copy a ReportElement object to an element in a different ReportElementContainer. (RWI 00608)

**Cause**
Report attachments can only be defined between report elements belonging to the same container.

**Action**
Ensure that you are creating report attachments between report elements that belong to the same container.

You cannot create a horizontal attachment on a section. (RWI 00609)

**Cause**
You have attempted to create a horizontal attachment in a section.

**Action**
Do not create horizontal attachments in a section, as sections cannot exceed the maximum allowed width.
You cannot remove all rows and columns from the table body. The table must contain at least one row and column. (RWI 00610)

**Cause**
You have attempted to remove the last row or column in a table body.

**Action**
Ensure that the table contains at least one row and column.

Dimension and detail objects only are allowed on this axis. (RWI 00611)

**Cause**
You have attempted to add an expression of incompatible type on an axis where only dimension and detail expression types are allowed.

**Action**
Specify an expression of compatible type.

Additional objects cannot be added to the block axis based on the block shape. (RWI 00612)

**Cause**
Cannot add more expressions to the specified block axis.

**Action**
Do not add more expressions.

This report element cannot have a double side attachment. (RWI 00613)

**Cause**
A report element cannot be horizontally and vertically attached to two distinct report elements.

**Action**
Ensure that the report element is attached (horizontally and vertically) to the same report element.
The table cell has been removed from its table. (RWI 00614)

Cause
You have attempted to use a table cell that has been removed from its containing table.

Action
You cannot use a table cell after it has been removed from its containing table.

You cannot run an empty query. (RWI 00701)

Cause
You have attempted to run an empty query.

Action
Before running a query, add result objects to it.

Cannot delete the last data provider. (RWI 00702)

Cause
You have attempted to delete the last data provider in a document.

Action
A document must contain at least one data provider.

A data provider with this name already exists. (RWI 00703)

Cause
You have attempted to give a data provider a name that already exists in the document.

Action
Every data provider within a document must have a unique name.

Combined queries are incompatible with sampling mode activated. (RWI 00706)

Cause
Sampling cannot be used with combined queries.
**Action**
Do not use sampling with combined queries.

**Processing remove data source objects while there are only two data source expressions. (RWI 00800)**

**Cause**
You have attempted to remove an expression from a synchronized dimension that contains only two expressions.

**Action**
Ensure that a synchronized dimension always contains at least two expressions.

**Cannot create a Link with a name that already exists ({0}). (RWI 00801)**

**Cause**
You have attempted to create a synchronized dimension with a name that already exists.

**Action**
Provide a unique name for each synchronized dimension.

**Cannot update CustomSortLov with a new list of values more than the size supported by CustomSortLov. (RWI 00825)**

**Cause**
You have attempted to update the list of values of a custom sort definition with more values than allowed.

**Action**
Ensure that the number of values in the list is within the specified custom sort range.

**Cannot create CustomSortLov while Report Expression's Lov size is greater than the size supported by CustomSortLov . (RWI 00826)**

**Cause**
You have attempted to create the list of values of a custom sort definition with more values than allowed.

**Action**
Ensure that the number of values in the list is within the specified custom sort range.
{0} feature is not supported. (RWI 00850)

**Cause**
You have attempted to use a particular feature that is not supported in the current context.

**Action**
Before using this feature, ensure that it is supported.

### 32.1.6 Custom Data Source (CDS) Framework Error Messages

Custom Data Source (CDS) Framework error messages include the following categories:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDS 00001 - CDS 00013</td>
<td>Custom Data Source User Interface Framework error messages</td>
</tr>
<tr>
<td>CDS 10100 - CDS 10400</td>
<td>Web Services Custom Data Source Plugin error messages</td>
</tr>
<tr>
<td>CDS 15102 - CDS 15122</td>
<td>Custom Data Source Framework error messages</td>
</tr>
</tbody>
</table>

#### 32.1.6.1 Custom Data Source User Interface Framework error messages

**The selected file extension is not correct. (CDS 00001)**

**Cause**
The extension of the file is not as expected or is different from the previously selected file.

**Action**
Check whether the correct file is selected.
Cannot access the file. (CDS 00002)

**Cause**
You have entered an incorrect file path.

**Action**
Check whether the correct path is entered.

The file does not exist. (CDS 00003)

**Cause**
The file does not exist at the path specified.

**Action**
Check whether you have specified valid path and filename.

The selected file is a directory. (CDS 00004)

**Cause**
The path entered points to a directory instead of a file.

**Action**
Enter the correct filename.

Error in processing data source - There was an invalid operation for the plug-in. (CDS 00005)

**Cause**
The plugin is not able to retrieve all the data source parameters.

**Action**
Check the logs and verify that the plug-in code is working properly.

An error occurred in the user interface of the plug-in. (CDS 00006)

**Cause**
An error has occurred in the plug-in user interface.
**Action**
Check the logs and verify that the plug-in code is working properly.

**An error occurred while accessing the updated inputs. (CDS 00007)**

**Cause**
An error occurred while accessing the data source parameters retrieved from the plug-in.

**Action**
Check the logs and verify that the plug-in code is working properly.

**An object with this name already exists. (CDS 00008)**

**Cause**
Another object with this name exists.

**Action**
Change the name of the object to a unique value.

**The query with this name already exists. (CDS 00009)**

**Cause**
Another query with this name exists.

**Action**
Change the name of the query to a unique value.

**A problem was detected with the install. Please check and try again. (CDS 00010)**

**Cause**
A problem was detected with the install.

**Action**
Check the installation setup. Refer to the documentation for more details.
Error in processing data source. (CDS 00011)

Cause
A problem was detected while identifying the data source.

Action
Check the logs to get the detailed error message.

The requested action could not be completed. (CDS 00012)

Cause
An error was detected.

Action
Check the logs to get the detailed error message.

Could not retrieve plug-in display component. (CDS 00013)

Cause
A error occurred while retrieving the plug-in component.

Action
Check the logs to get the detailed error message. Verify that the plugin-in code is correct.

32.1.6.2 Web Services Custom Data Source Plugin error messages

An error occurred while processing the requested action. (CDS 10100)

Cause
An unexpected error occurred while processing the requested action.

Action
Contact your enterprise administrator.
No selection made in Output Message panel. (CDS 10101)

**Cause**
User has not selected the field(s) for the query from the Output Message panel.

**Action**
Select the field(s) that need to be displayed in the report from the Output Message panel.

An error occurred while invoking Web Service. {0}(CDS 10200)

**Cause**
An error occurred while invoking a web service.

**Action**
Contact your enterprise administrator.

Error executing web service: "{0}" (CDS 10201)

**Cause**
The Web Service Endpoint could not be invoked because of incorrect input parameters.

**Action**
Enter the correct values while invoking the Web Service.

An error occurred while instantiating the Web Service plugin. (CDS 10202)

**Cause**
The extension descriptor of the web service plug-in did not return the correct dstype.

**Action**
Contact your administrator to fix the problem.
Parsing Exception: The input WSDL type or structure is not supported. (CDS 10203)

**Cause**
The structure of the WSDL is not supported by Web Services Custom Data Source plug-in.

**Action**
Refer the documentation for supported WSDLs.

WSDLs that refer to Microsoft's types namespace are not supported. (CDS 10204)

**Cause**
WSDLs that refer to http://microsoft.com/wsdl/types/ namespace are not supported.

**Action**
Modify the WSDL or select the supported WSDL.

WSDLs that have cyclical references are not supported. (CDS 10205)

**Cause**
WSDL type definitions contain cyclical references.

**Action**
Modify the WSDL or select the supported WSDL.

WSDLs that do not have type definitions are not supported. (CDS 10206)

**Cause**
WSDL does not contain any type definitions in <types> tags.

**Action**
Modify the WSDL or select the supported WSDL.
Unable to send SOAP request as the target URL is malformed. (CDS 10207)

**Cause**
The SOAP action target URL mentioned for this service in the WSDL is malformed.

**Action**
Modify the WSDL or select another WSDL that is supported.

WSDLs that use encoded messages are not supported. (CDS 10208)

**Cause**
The WSDL has operations that expect encoded messages.

**Action**
Modify the WSDL or select another WSDL that is supported.

An error was detected while parsing the response. (CDS 10400)

**Cause**
An error was detected while parsing the response from server.

**Action**
Check the product logs to get the actual cause of error.

**32.1.6.3 Custom Data Source Framework error messages**

Unable to create or update the Custom Data Provider: unable to retrieve information from the provided source. (CDS 15102)

**Cause**
An unexpected error occurred while trying to retrieve information from the provided source.

**Action**
Contact your administrator to resolve the error.
Unable to create or update the Custom Data Provider: unable to retrieve structure information from the provided source. (CDS 15103)

**Cause**
An unexpected error occurred while trying to retrieve the structure information from the provided source.

**Action**
Contact the plug-in support to verify that the plug-in is working properly. If the error is not resolved contact SAP support to resolve the error.

Unable to create or update the Custom Data Provider: unable to build the iterator on the data set. (CDS 15104)

**Cause**
An unexpected error occurred while trying to build the iterator on the dataset.

**Action**
Contact the plug-in support to verify that the plug-in is working properly. If the error is not resolved contact support to resolve the error.

Unable to create or update the Custom Data Provider: a problem was encountered in Data Source plug-in management and the requested action cannot be completed. (CDS 15106)

**Cause**
An unexpected error has occurred.

**Action**
Contact support to resolve the error.

Unable to create or update the query on this file: the file "{filename}" does not exist in the file system. (CDS 15107)

**Cause**
The file does not exist at the specified location.

**Action**
Check whether the file path specified for source file is correct.
Unable to create or update the Custom Data Provider : the path is invalid. (CDS 15108)

**Cause**
The file path mentioned is incorrect.

**Action**
Check that the path specified for the source is correct.

Unable to create or update the Custom Data Provider : invalid information retrieved while trying to get the structure. (CDS 15109)

**Cause**
An error occurred while trying to retrieve the structure information from the data provider.

**Action**
Contact the plug-in support to verify that the plug-in is working properly. If the error is not resolved, contact support to resolve the error.

Unable to create or update the Custom Data Provider : could not find matching Data Source plug-in for this request. (CDS 15110)

**Cause**
An error occurred while trying to retrieve the plug-in information.

**Action**
Check that plug-in implementation returns required plug-in information correctly. Refer to documentation for information on configuring the plug-in.

Unable to create or update the Custom Data Provider : could not instantiate matching Data Source plug-in for this request. (CDS 15111)

**Cause**
An error occurred while trying to instantiate the plug-in.

**Action**
Check that the plug-in details and MODULE-PATH in the plug-in MANIFEST file is correct. Refer to the documentation for information on configuring the plug-in.
Unable to create or update the Custom Data Provider: could not instantiate Data Source plug-in's Data Provider for this request. (CDS 15112)

Cause
An error occurred while trying to instantiate the Data Provider component of the plug-in extension.

Action
Contact the plug-in support to verify if the plug-in is working properly.

Unable to create or update the Custom Data Provider: an error occurred while retrieving the data sampling. (CDS 15113)

Cause
An error occurred in the plug-in while trying to retrieve sample data from the data provider.

Action
Contact the plug-in support to verify if the plug-in is working properly.

Unable to retrieve data from the Custom Data Provider: an error occurred while creating the data iterator. (CDS 15114)

Cause
An error occurred in the plug-in while trying to retrieve the data iterator.

Action
Contact the plug-in support to verify if the plug-in is working properly.

Unable to retrieve data from the Custom Data Provider: an error occurred while fetching data through the iterator. (CDS 15115)

Cause
An error occurred in the plug-in while trying to fetch the data through the iterator.

Action
Contact the plug-in support to verify if the plug-in is working properly.
Unable to create or update the Custom Data Provider: unsupported object type was provided by the Data Source plug-in while trying to get the structure. (CDS 15116)

**Cause**
The plug-in has data types that are not supported.

**Action**
Refer to the documentation for the list of supported data types.

Unable to create or update the Custom Data Provider: an internal error occurred while trying to open the session. (CDS 15117)

**Cause**
An error occurred in the plug-in while trying to open a session.

**Action**
Contact the plug-in support to verify if the plug-in is working properly.

Unable to create or update the Custom Data Provider: the source in the provided path is protected. (CDS 15118)

**Cause**
The plug-in could not proceed as the source file provided is a password-protected file.

**Action**
Refer to the plug-in documentation.

Unable to create or update the Custom Data Provider: the provided URL is invalid. (CDS 15119)

**Cause**
The plug-in could not proceed as the URL is invalid.

**Action**
Refer to the plug-in documentation.
Unable to create or update the Custom Data Provider: the provided URL cannot be found. (CDS 15120)

**Cause**
The plug-in could not proceed as the provided URL could not be found.

**Action**
Refer to the plug-in documentation.

Unable to interact with the Custom Data Provider on the provided source. (CDS 15121)

**Cause**
An unexpected error has occurred.

**Action**
Contact support to resolve the error.

A problem was encountered. The requested action cannot be completed. (CDS 15122)

**Cause**
An unexpected error has occurred.

**Action**
Contact support to resolve the error.

### 32.2 Information Engine Services (IES) Error Messages

Information Engine Services error messages include the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>IES 00001 - IES 10903</td>
<td>Information Engine Services error messages</td>
</tr>
</tbody>
</table>
32.2.1 Information Engine Services (IES) Error Messages

Some objects are no longer available in the universe. (IES 00001)

**Cause**
One or more objects in a universe are no longer available to a document.

**Action**
Delete the missing objects from the query by comparing the objects in the query with the available objects.

Some objects are not available to your user profile. You cannot refresh this document. (IES 00002)

**Cause**
You do not have the correct user rights to access the data for one or more objects included in a query. As you are not permitted to access the data for these objects, you cannot refresh the report.

**Action**
Ask your administrator to change your user profile to make these objects accessible.

Some pre-defined filters are no longer available in the universe. (IES 00003)

**Cause**
"Compare universe objects with query objects. If you don't have rights, contact your universe designer or administrator.

**Action**
Compare universe objects with query objects. If you don't have rights, contact your universe designer or administrator.
Some database tables are no longer available in the universe. (IES 00004)

**Cause**
One or more database tables referenced by objects in the universe are no longer available. The tables may have been renamed, or removed from the database.

**Action**
Ask your universe designer to refresh the universe to remove non-existent tables or update table names.

Invalid prompt definition. (IES 00005)

**Cause**
The syntax in a prompt is not valid, or the prompt makes reference to an object that no longer exists in the universe.

**Action**
Ask your universe designer to verify the prompt.

Invalid definition of aggregate aware object. (IES 00006)

**Cause**
One or more objects in the query use aggregate awareness, and the aggregate awareness syntax in the universe is not valid.

**Action**
Ask your universe designer to verify the aggregate awareness syntax.

A filter contains an incorrect value. You cannot run this query. (IES 00007)

**Cause**
A filter has a incorrect operand. For example, a filter has an empty constant, or a filter that expects a numeric value is defined with an alphanumeric value.

**Action**
Correct the filter.
The query cannot run because it contains incompatible objects. (IES 00008)

**Cause**
The query contains objects that return data sets that cannot be combined or synchronized, possibly because the universe does not allow multiple SQL statements for each context or measure.

**Action**
Ask your universe designer to do the following:
- Allow multiple SQL statements for each context and measure.
- Create a new context that includes the incompatible objects.

The query cannot run because an advanced filter contains an incompatible object. (IES 00009)

**Cause**
An advanced filter uses incompatible objects.

**Action**
Change the advanced filter to use compatible objects only.

The universe does not allow complex expressions in a GROUP BY statement. (IES 00010)

**Cause**
A query contains a GROUP BY clause that uses formulas or aliases. The universe does not allow these expressions in GROUP BY clauses. The behavior is determined by the parameter `<Parameter Name="GROUPBY_EXCLUDE_COMPLEX">Y</Parameter>` in the PRM file for the target RDBMS.

**Action**
- Modify the query so that objects using formulas or aliases are not included in the query.
- If your RDBMS supports complex GROUP BY expressions, ask your universe designer to change the value of the GROUPBY_EXCLUDE_COMPLEX parameter to N.
The object {obj_list} contains multiple attributes. This syntax is no longer supported. (IES 00011)

**Cause**
One or more objects in the query use a comma ("," instead of a concatenation operator in their definition. This syntax is no longer supported.

**Action**
Ask your universe designer to perform one of the following actions:
- Redefine the objects that use the comma to concatenate the data for two objects using the standard concatenation operator for the RDBMS.
- Add the following line to the PRM file for the target RDBMS:

  `<Parameter Name = "REPLACE_COMMA_BY_SEPARATOR"="Y">`

  This will enable the comma to be accepted syntax for concatenation in object definitions.
- Set the value of REPLACE_COMMA_BY_CONCAT to "Yes" in the universe.

You cannot run this query because it will produce a Cartesian product. (IES 00012)

**Cause**
The query will produce a Cartesian product. A Cartesian product returns all possible combinations of rows from the tables referenced by objects in the query and is rarely correct.

**Action**
Ask your universe designer to perform one of the following actions:
- Prevent Cartesian products by modifying the universe table schema to include appropriate joins and restrictions.
- Allow the universe to return Cartesian products if they are acceptable.

SQL generation failed. (IES 00013)

**Cause**
Errors occurred during generation of the query SQL.

**Action**
Ask your universe designer to verify the SQL.
Aggregate aware resolution failed. (IES 00014)

**Cause**
The query objects exclude all possible SQL choices for an aggregate aware function.

**Action**
Ask your universe designer to remove the incompatibility between the objects.

Multiple query filters contain a prompt with the same text, but the prompts use a different operand type or number of values. (IES 00015)

**Cause**
The query has multiple prompts that display the same message. Prompts with the same message are usually combined, but this is not possible if some require you to enter one value and others require multiple values.

**Action**
Modify the prompts so they all require one or multiple values.

The query contains a @script() function, which is not supported. (IES 00016)

**Cause**
The SQL generated by the query for this document includes a @script() function, which is not supported.

**Action**
Ask your universe designer to remove the @script() function.

The following objects cannot be used as result objects: {obj_list}. (IES 00017)

**Cause**
The query includes objects that cannot be used as result objects in queries.

**Action**
Remove the objects, or ask your universe designer to allow the objects to be included in as result objects in queries.
The following objects cannot be used as query filters: {obj_list}. (IES 00018)

**Cause**
The query contains objects used as query filters that are not valid as query filters.

**Action**
Remove the objects, or ask your universe designer to allow them as query filters.

A query filter contains too many values. (IES 00019)

**Cause**
A query filter contains too many values.

**Action**
Select fewer values.

The SQL generated by the query is invalid. (IES 00020)

**Cause**
The SQL generated by the query is invalid.

**Action**
Ask your universe designer to verify the SQL.

The combined query cannot run because one of the queries contains incompatible objects. (IES 00021)

**Cause**
A query in a combined query contains incompatible objects.

**Action**
Remove the incompatible objects.
The query does not reference a table in the WHERE clause. (IES 00022)

**Cause**
The WHERE clause of the generated SQL does not reference a table.

**Action**
Modify the query to reference a table.

Invalid sub-query. (IES 00023)

**Cause**
The query contains an invalid sub-query. Either data cannot be retrieved or no result objects are defined.

**Action**
Modify the sub-query.

Incompatible object types in the subquery. (IES 00024)

**Cause**
The subquery contains incompatible object types.

**Action**
Remove the incompatible object types.

The query is too complex to apply a sampling function. (IES 00025)

**Cause**
The query is too complex to apply a sampling function.

**Action**
Try to simplify the query.

Failed to regenerate SQL for optional prompts -- one or more required prompts were skipped. (IES 00026)

**Cause**
The SQL relating to optional prompts could not be regenerated.
Action
See your universe designer.

Removing optional prompts from the query will introduce new prompts. This introduces complexities that cannot be supported. (IES 00027)

Cause
The query cannot be processed due to optional prompts.

Action
Remove the optional prompts from the query.

No value specified for the Keydate parameter. (IES 00028)

Cause
No value was specified for the Keydate parameter.

Action
Specify a value for the Keydate.

The universe is already open with write permission by another user. (IES 00029)

Cause
The universe could not be opened because it is already opened with write permission by another user.

Action
See your administrator.

Syntax error in formula '%1%' at position %2%. (IES 10001)

Cause
There is a syntax error in your formula at the position indicated.

Action
Correct the formula.
**Problem initializing the dictionary of functions. (IES 10002)**

**Cause**
The dictionary of functions could not be initialized.

**Action**
See your administrator.

**The object '%1%' at position '%2%' is not unique in the report. (IES 10005)**

**Cause**
An object has a name that conflicts with the name of another object in the report

**Action**
Use the fully-qualified name for the object.

**The object '%1%' at position '%2%' does not exist in the report. (IES 10006)**

**Cause**
The formula refers to an object that no longer exists in the report.

**Action**
Remove the reference to the object from the formula.

**The integer '%1%' at position '%2%' is too long. (IES 10013)**

**Cause**
An integer in a formula exceeds the maximum limit.

**Action**
Edit the formula.
The number '%1%' at position '%2%' has a format that is incompatible with your regional settings. (IES 10014)

**Cause**
The format of the real number {number} is not compatible with your regional settings.

**Action**
Change the number format to conform with the format permitted by your regional settings.

Missing quotation mark after '%1%' at position '%2%'. (IES 10016)

**Cause**
There is a missing closing quotation mark in the formula.

**Action**
Add the closing quotation mark.

The list of dimensions in the input or output context is empty. (IES 10032)

**Cause**
The list of dimensions in the input or output context is empty.

**Action**
Specify a list of dimensions.

The variable '%1%' cannot be deleted because it has dependant formulas or variables linked to: '%2%'. (IES 10033)

**Cause**
The variable cannot be deleted because it is referenced by other variables or formulas.

**Action**
Delete the dependent formulas/variables before deleting the variable.
You attempted to create a variable or update a variable name using a variable name that already exists. (IES 10034)

**Cause**
You attempted to create a variable or update a variable name using a variable name that already exists.

**Action**
Choose a variable name that does not already exist.

The date or time format '%1%' at position '%2%' is not valid. (IES 10035)

**Cause**
The formula contains an invalid date/time format (for example, "bb/MM/yyyy").

**Action**
Specify a valid date/time format in the formula.

The expression or sub-expression at position '%2%' is not valid. (IES 10036)

**Cause**
The formula contains an invalid expression/sub-expression.

**Action**
Specify a valid expression/sub-expression.

The expression or sub-expression at position '%2%' in the '%1%' function uses an invalid data type. (IES 10037)

**Cause**
An expression contains an invalid data type. (For example, you have attempted to pass a string to a function that requires a date.)

**Action**
Use a valid data type in the expression.
Invalid character '%1%' in variable name at position '%2%'. (IES 10038)

**Cause**
The character {character} is not valid in the variable name.

**Action**
Remove {character} from the variable name.

The formula for variable '%1%' contains a reference to a variable with the same short name. (IES 10040)

**Cause**
The formula of a variable references another variable with the same short name.

**Action**
The formula of a variable references another variable with the same short name.

Incorrect use of multiple comparison operators (<,>,<>,<=,>=,=) at position '%2%'. (IES 10041)

**Cause**
The formula uses multiple comparison operators incorrectly (for example: if(1<2=3;0;-1)).

**Action**
Re-structure the formula to avoid using comparison operators incorrectly.

There is a circular reference because the formula for variable '%1%' references a variable whose formula references '%1%'. (IES 10042)

**Cause**
A formula contains a circular reference.

**Action**
Remove the circular reference.
The function '%1%' has missing arguments or closing parenthesis at position %2%. (IES 10061)

**Cause**
Arguments or a closing parenthesis are missing from the formula.

**Action**
Supply the arguments or closing parenthesis.

Missing ';' or closing parenthesis in list '%1%' at position %2%. (IES 10064)

**Cause**
A semicolon or closing parenthesis is missing from the formula.

**Action**
Supply the semicolon or closing parenthesis.

Missing object identifier in '%1%' at position %2%. (IES 10069)

**Cause**
An object identifier is missing from the formula.

**Action**
Correct the formula.

Incorrect reset context at position %2%. (IES 10072)

**Cause**
The formula contains an incorrect reset context.

**Action**
Correct the reset context.
The object '%1%' at position %2% is incompatible. (IES 10077)

**Cause**
The formula contains an incompatible object.

**Action**
Correct the formula.

Invalid string '%1%' at position %2%. (IES 10082)

**Cause**
The formula contains an invalid string.

**Action**
Correct the string.

The qualification of the variable '%1%' cannot be changed. (IES 10083)

**Cause**
You cannot change the qualification of the variable. (For example, you cannot change a measure to a dimension if its definition includes an aggregate.)

**Action**
Create a new variable with the appropriate qualification.

Invalid set definition. (IES 10086)

**Cause**
A query contains an invalid set definition.

**Action**
Verify the query.

Custom functions could not be loaded. (IES 10100)

**Cause**
The custom function library could not be loaded because it is not correctly defined. This could be due to invalid XML, a duplicate function name or duplicate function ID.
**Action**
See the trace log for more details and provide these details to your administrator.

**Your database server does not support the Both and Except operators. (IES 10701)**

**Cause**
The database on which this document is based does not support the Both and Except operators. This means that you cannot use the Both operator or the Except operator when you define filters on the query.

**Action**
Remove the operators from the query filters.

**A filter is defined on an object that is incompatible with the result objects. (IES 10702)**

**Cause**
One of the query filters is defined on an object which is incompatible with all the result objects returned by the query.

**Action**
Remove the query filter or the result objects.

**The numeric value for the query filter based on '{object}' is invalid. (IES 10703)**

**Cause**
You specified an invalid numeric value for a query filter.

**Action**
Edit the query filter and specify a valid numeric value.

**The date for the prompt '{prompt}' is invalid. (IES 1070) (IES 10704)**

**Cause**
You specified an invalid date for a query filter.
Action
Edit the query filter and specify a valid date.

The prompt '{prompt}' contains an invalid numeric value. (IES 10705)

Cause
You specified an invalid numeric value for a prompt.

Action
Specify a valid numeric value.

The date for the prompt '{prompt}' is invalid. (IES 10706)

Cause
You specified an invalid date for a prompt.

Action
Edit the prompt and specify a valid date.

The server cannot build the SQL for the query. (IES 10707)

Cause
Your query cannot be converted to SQL to run against the database.

Action
Reformulate the query or see your administrator.

The object '{ObjName}' in the prompt '{PromptName}' can no longer display a list of values. Remove the prompt from the query or contact your administrator to clear the "Select only from list" option of the object properties tab. (IES 10708)

Cause
The object in the prompt can no longer display a list of values.

Action
Remove the prompt, or ask your administrator to allow the prompt to accept values not selected from a list.
You do not have the right to refresh this document. (IES 10801)

**Cause**
Your user profile does not permit you to view data for one of the objects included in the query for this document.

**Action**
Cancel the refresh, or ask your administrator for the security rights necessary to refresh the document.

The query SQL has \{nbHaving\} instead of \{nbWanted\} columns. (IES 10810)

**Cause**
The SQL generated by the query has an invalid number of columns.

**Action**
See your administrator.

The data type of a column in the query is not valid. (IES 10811)

**Cause**
The data type of a column in the query is not valid.

**Action**
See your administrator.

Custom SQL cannot contain optional prompts. (IES 10812)

**Cause**
Optional prompts are not supported in custom SQL.

**Action**
Remove the optional prompts.

Incompatible objects cannot be used in combined queries. (IES 10820)

**Cause**
A combined query contains incompatible objects.
A subquery in the '{dp_name}' data provider has missing objects. (IES 10830)

Cause
Objects necessary to generate query SQL are missing from a subquery in the {dp_name} data provider.

Action
Edit the subquery and add the missing objects.

The filtered object is missing in a ranking in the '{dp_name}' data provider. (IES 10831)

Cause
The filtered object is missing in a ranking.

Action
Edit the ranking and add the filtered object.

The rank-based object is missing in a ranking in the '{dp_name}' data provider. (IES 10832)

Cause
The rank-based object is missing in a ranking.

Action
Edit the ranking and add the rank-based object.

The document cannot be loaded. (IES 10833)

Cause
The interactive analysis document could not be loaded.

Action
See your administrator.
Additional context resolution is not supported with optional prompts. (IES 10834)

**Cause**
The optional prompts in a query generate additional query context resolution that is not supported.

**Action**
Remove the optional prompts or make them obligatory.

Invalid data in column "{col_name}". (IES 10840)

**Cause**
A database column referenced by the query contains invalid data.

**Action**
See your administrator.

Invalid UTF-8 string in column "{col_name}". (IES 10841)

**Cause**
A database column referenced by the query contains invalid data.

**Action**
See your administrator.

The file that is required to create or update the query cannot be found on the file system. File not found: "{filename}". (IES 10850)

**Cause**
The file {filename} cannot be found on the file system.

**Action**
Check the location of {filename} or see your administrator.
Error originates from the Personal Data Provider: {message}. (IES 10853)

**Cause**
The file that supplies data to a personal data provider might be corrupt or missing.

**Action**
Check that the file is present, and that it does not contain errors.

Unable to create or update the Excel personal data provider: the file path is invalid. (IES 10870)

**Cause**
The Excel file could not be found on the file system.

**Action**
See your administrator.

Unable to create or update the Excel personal data provider: cannot retrieve the named ranges. (IES 10872) (IES 10871)

**Cause**
The Excel personal data provider could not be created or updated because the workbook is protected.

**Action**
Remove the protection from the Excel workbook or see your administrator if you do not have access to the Excel file.

Unable to create or update the Excel personal data provider: cannot open the workbook. (IES 10872)

**Cause**
The Excel file could not be opened.

**Action**
Verify the Excel file or see your administrator.
Unable to create or update the Excel personal data provider: cannot retrieve the named ranges. (IES 10873)

**Cause**
Data could not be retrieved from a named range of cells.

**Action**
Check the Excel file or see your administrator.

Unable to create or update the Excel personal data provider: cannot retrieve data from the file. (IES 10874)

**Cause**
Data could not be retrieved from the Excel file.

**Action**
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: cannot retrieve data from the file. (IES 10875)

**Cause**
No data could be retrieved from the Excel file.

**Action**
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: cannot build the iterator on the data set. (IES 10876)

**Cause**
An error occurred when retrieving data from the Excel file.

**Action**
Verify the file or see your administrator.
Unable to create or update the Excel personal data provider: no worksheet available. (IES 10877)

**Cause**
No worksheet could be found in the Excel file.

**Action**
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: unable to retrieve the list of worksheets. (IES 10878)

**Cause**
The list of worksheets could not be retrieved from the Excel file.

**Action**
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: invalid data retrieved from the selected range. (IES 10879)

**Cause**
The data retrieved from a range in the Excel file is invalid.

**Action**
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: the selected worksheet is invalid. (IES 10880)

**Cause**
The Excel worksheet is invalid.

**Action**
Verify the Excel file or see your administrator.
Unable to create or update the Excel personal data provider: an error occurred while retrieving the data sampling. (IES 10881)

**Cause**
An error occurred during data retrieval from the Excel file.

**Action**
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: an error occurred while creating the data iterator. (IES 10882)

**Cause**
An error occurred during data retrieval from the Excel file.

**Action**
See your administrator.

Unable to create or update the Excel personal data provider: an error occurred during data retrieval. (IES 10883)

**Cause**
An error occurred during data retrieval from the Excel file.

**Action**
See your administrator.

Unable to create or update the Excel personal data provider: an internal error occurred. (IES 10884)

**Cause**
An error occurred during data retrieval from the Excel file.

**Action**
See your administrator.
Unable to create or update the Excel personal data provider: the range selection is invalid. (IES 10885)

Cause
An error occurred during data retrieval from the Excel file because the range selected was not valid.

Action
Verify the file or see your administrator.

Unable to create or update the Excel personal data provider: the range selection does not match the worksheet. (IES 10886)

Cause
An error occurred during data retrieval from the Excel file because the range selection does not match the worksheet.

Action
Verify the file or see your administrator.

A condition on an object refers to an object from another query that has a different type. (IES 10887)

Cause
The object in the other query has a different data type from the object in the condition.

Action
Correct the condition.

A condition on an object refers to an object in another query that does not exist. (IES 10888)

Cause
Either the object or query referred to by the condition does not exist.

Action
Correct the condition.
There is a circular dependency in the query. (IES 10889)

**Cause**
The query has a circular dependency.

**Action**
Edit the query to remove the circular dependency.

Database error: {error_db}. (IES 10901)

**Cause**
The database returned the error given in the message.

**Action**
See your administrator with the details of the error that occurred.

Query exceeded fixed time limit: {error_db}. (IES 10902)

**Cause**
The query could not return data because it took too long to run.

**Action**
Run the query again. If the problem persists see your administrator.

Invalid Database Field Type : {db_fieldname}. (IES 10903)

**Cause**
The database field given in the message contains an invalid data type.

**Action**
See your administrator.
More Information

<table>
<thead>
<tr>
<th>Information Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP product information</td>
<td><a href="http://www.sap.com">http://www.sap.com</a></td>
</tr>
<tr>
<td>Access the most up-to-date English documentation covering all SAP BusinessObjects products at the SAP Help Portal:</td>
<td></td>
</tr>
<tr>
<td>• <a href="http://help.sap.com/bobi">http://help.sap.com/bobi</a> (Business Intelligence)</td>
<td></td>
</tr>
<tr>
<td>• <a href="http://help.sap.com/boepm">http://help.sap.com/boepm</a> (Enterprise Performance Management)</td>
<td></td>
</tr>
<tr>
<td>• <a href="http://help.sap.com/boeim">http://help.sap.com/boeim</a> (Enterprise Information Management)</td>
<td></td>
</tr>
<tr>
<td>Certain guides linked to from the SAP Help Portal are stored on the SAP Service Marketplace. Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact your customer support representative.</td>
<td></td>
</tr>
<tr>
<td>To find a comprehensive list of product documentation in all supported languages, visit: <a href="http://help.sap.com/boall">http://help.sap.com/boall</a>.</td>
<td></td>
</tr>
<tr>
<td>SAP Support Portal</td>
<td><a href="http://service.sap.com/bosap-support">http://service.sap.com/bosap-support</a></td>
</tr>
<tr>
<td>The SAP Support Portal contains information about Customer Support programs and services. It also has links to a wide range of technical information and downloads. Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact your customer support representative.</td>
<td></td>
</tr>
<tr>
<td>Developer resources</td>
<td><a href="http://www.sdn.sap.com/irj/sdn/bi-sdk-dev">http://www.sdn.sap.com/irj/sdn/bi-sdk-dev</a></td>
</tr>
<tr>
<td><a href="https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary">https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary</a></td>
<td></td>
</tr>
<tr>
<td>SAP BusinessObjects articles on the SAP Community Network</td>
<td><a href="http://www.sdn.sap.com/irj/boc/articles">http://www.sdn.sap.com/irj/boc/articles</a></td>
</tr>
<tr>
<td>These articles were formerly known as technical papers.</td>
<td></td>
</tr>
<tr>
<td>Information Resource</td>
<td>Location</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notes</td>
<td><a href="https://service.sap.com/notes">https://service.sap.com/notes</a></td>
</tr>
<tr>
<td></td>
<td>These notes were formerly known as Knowledge Base articles.</td>
</tr>
<tr>
<td>Forums on the SAP Community Network</td>
<td><a href="https://www.sdn.sap.com/irj/scn/forums">https://www.sdn.sap.com/irj/scn/forums</a></td>
</tr>
<tr>
<td>Training</td>
<td><a href="http://www.sap.com/services/education">http://www.sap.com/services/education</a></td>
</tr>
<tr>
<td></td>
<td>From traditional classroom learning to targeted e-learning seminars, we can offer a training package to suit your learning needs and preferred learning style.</td>
</tr>
<tr>
<td>Consulting</td>
<td><a href="http://www.sap.com/services/bysubject/businessobjectsconsulting">http://www.sap.com/services/bysubject/businessobjectsconsulting</a></td>
</tr>
<tr>
<td></td>
<td>Consultants can accompany you from the initial analysis stage to the delivery of your deployment project. Expertise is available in topics such as relational and multidimensional databases, connectivity, database design tools, and customized embedding technology.</td>
</tr>
</tbody>
</table>
## Index

- **#MULTVALUE error message**
- **and attributes 301**
- **#RANK error message 311**
- **#RECURSIVE error message 181**

### 2D bar charts
- varying the data markers on 230

### 2D charts
- drilling on 282

### 2D line charts
- varying the data markers on 230

### 3D area charts
- restriction 207

### 3D chart
- hide floor 223

### 3D charts
- drilling on 282

### 3D line charts
- restriction 207

### 3D look
- applying to charts 221

### 3D surface charts
- incompatibility with drilling on measures 284
- restriction 207

### A

- **about BEx queries 55, 82**
- **accessing BEx queries 86**
- **activating conditional formatting rules 242**
- **activating data tracking 318**
- **activating query drill 288**
- **added data**
- **tracking 317**
- **adding a description to merged dimensions 299**
- **adding breaks 200**
- **adding charts to reports 212**
- **adding columns to tables 177**
- **adding conditional formatting rules 242**
- **adding custom query filters 118**
- **adding drill filters 286**
- **adding input controls 259**
- **adding reports to documents 41**
- **adding rows to tables 177**
- **adding sorts 205**
- **adding titles to charts 220**
- **administrator 56**
- **aggregation**
- **avoiding for duplicate rows 185**
- **explicit 167**
- **hierarchical 165**
- **alerters**
- **and data tracking 326**
- **ambiguous queries 75**
- **analysis dimension**
- **defined 56**
- **Analysis panel**
- **organizing input controls on 261**
- **Analysis View 95**
- **creating a new document 37**
- **analyzing data using drill 269**
- **ancestors 69**
- **And operator 124**
- **answering prompts 255**
- **application modes 31, 98**
- **applying 3D look to charts 221**
- **applying conditional formatting to cells tables or sections 239**
- **applying custom formats 237**
- **applying different templates to tables 177**
- **applying formatting with the Format Painter 182**
- **applying predefined formats 234**
- **applying using values from another query 121**
- **ascending sort order 202**
- **associating hyperlinks with cells 356**
- **associating lists of values with input controls 259, 261**
- **associating report elements with input controls 259, 261**
- **associating report objects with input controls 259, 261**
- **attribute objects**
- **defined 57**
- **relationship with dimensions and hierarchies 57**
- **attributes**
- **and #MULTVALUE 301**
- **and merged dimensions 301**
- **in BEx queries 84**
- **relationship with dimensions 301**
- **authorizations**
- **queries and documents 56**
- **Auto-Merge Dimensions document option 51**
- **Auto-Merge Dimensions document property 299**
- **auto-fit height**
- **effect of with auto-fit width 181**
- **effect of with wrap text 181**
- **auto-fit height cell property 181**
- **auto-fit width**
- **effect of with auto-fit height 181**
- **effect of with wrap text 181**
- **auto-fit width cell property 181**
- **automatic data tracking mode 318**
- **automatic dimension merging enabling 299**
- **restrictions on 299**
- **autosaved documents**
- **management of 51**
- **autosaving documents 50**
- **Average standard calculation**
- **inserting in tables 265**
- **avoiding duplicate row aggregation 185**
- **avoiding page breaks in breaks 200**
- **avoiding page breaks in charts 223**
- **avoiding page breaks in sections 196**
- **avoiding page breaks in tables 186**
- **axes**
- **displaying logarithmically 227**
- **formatting labels on in charts 224**
- **formatting numbers on 225**
- **showing labels on charts 224**
- **showing value ranges on 226**
- **axes grid**
- **formatting on charts 225**
- **hiding on charts 225**
- **showing on charts 225**
- **spacing 225**
- **axis legends**
- **drilling on 284, 285**
- **axis scales**
- **linear 226**
- **logarithmic 226**

### B

- **background color**
- **setting on charts 221**
- **background colors**
- **selecting for tables 179**
- **bar charts 208**
- **drilling on measures in 283**
BEx query restrictions (continued)

- nodes 84
- position of lower level nodes 84
- query default layout 84
- query exception 84
- retrieving duplicate rows 81
- row/column display as hierarchy 84
- sample result set 80
- variable orders 84
- variables 84
- variables dependencies 84
- variables on default values 84
- zero suppression 84

BI launch pad

- logging in to 26

BI launch pad

- about 25
- launching Web Intelligence from 19
- logging out of 27
- saving documents in (HTML interface) 47
- saving documents in (Java interface) 43
- selecting the default universe in 63
- selecting the viewing interface in 29
- setting drill options in 272
- setting locale options in 29

BI portal

- setting the Preferred Viewing Locale in 31
- setting the Product Locale in 29

BI services 332

- making data available for filtering in 334
- testing 336

BI Services

- output parameters 342

BICS

- connection to BEx queries 87

BICS connection 82, 86

- block filters
- and merged dimensions 304
- blocks
- synchronizing drill on 273
- boing protocol
- displaying images using 180
- displaying skins using 180

Boolean formats

- custom 233, 234
- predefined 233

Boolean values

- formatting 233, 234

Calculated members 59

- defined 59

Calculations

- (local) in BEx queries 84

Borders

- formatting on tables/cells 180
- modifying on charts 222

Both operator 115, 134

Boxplot charts 208

Breaks

- adding 200
- avoiding page breaks in 200
- centering values across 200
- compared to sections 197
- default sort order in 199, 200
- defined 197
- displaying subtotals using 197
- effect on conditional formatting 239
- inserting 199
- organizing data with 197
- prioritizing 200
- removing 200
- removing duplicate values from 200
- repeating footers in 200
- repeating headers in 200
- repeating values on new page 200
- setting properties of 200
- showing break footers 200
- showing break headers 200
- starting on new page 200

Bring Forward layering option 183

Bring To Front layering option 183

Building a subquery 147, 148

Building advanced conditional formatting rules using formulas 242

Building charts 207

Building combined queries 143

Building conditional formatting rules 240

Building formulas using the Formula Editor 266

Building member selection prompts 74, 93

Building queries 63

Building queries on BEx queries 88

Business Warehouse 55, 82, 83

BW 55, 82, 83
calculations (continued)
including merged dimensions in 297
removing standard calculations 266
standard 300
Cartesian product 302
CDS 00001 417
CDS 00002 418
CDS 00003 418
CDS 00004 418
CDS 00005 418
CDS 00006 418
CDS 00007 418
CDS 00008 418
CDS 00009 418
CDS 00010 419
CDS 00011 419
CDS 00012 419
CDS 00013 419
CDS 10100 420
CDS 10101 421
CDS 10200 421
CDS 10201 421
CDS 10202 421
CDS 10203 421
CDS 10204 421
CDS 10205 421
CDS 10206 421
CDS 10207 422
CDS 10208 422
CDS 10209 422
CDS 10210 422
CDS 10211 422
CDS 10212 422
CDS 10213 422
CDS 10214 422
CDS 10400 422
CDS 15102 423
CDS 15103 423
CDS 15104 423
CDS 15105 423
CDS 15106 423
CDS 15107 423
CDS 15108 423
CDS 15109 423
CDS 15110 423
CDS 15111 423
CDS 15112 423
CDS 15113 423
CDS 15114 423
CDS 15115 423
CDS 15116 423
CDS 15117 423
CDS 15118 423
CDS 15119 423
CDS 15120 423
CDS 15121 423
CDS 15122 423
cell properties
autofit height 181
autofit width 181

cells
applying conditional formatting to 239
applying custom formats to 237
applying predefined formats to 234
associating hyperlinks with 356
clearing the contents of 178
conditionally formatting 241
defining text of as hyperlinks 355, 356
deleting from reports 187
effects of autofit height in 181
effects of autofit width in 181
effects of wrap text in 181
formatting 187
formatting as currency 237
formatting boolean values in 233
formatting borders 180
formatting currencies in 233
formatting dates in 233, 234
formatting numbers in 233, 234
formatting text in 180
free-standing 187
inserting in reports 187
layering 183
merging in tables 183
redisplaying hidden cells 184, 188, 196
removing section cells 196
setting height and width of 181
Center Value Across Break property and data tracking 325
centering values across breaks 200
Central Management Console (CMC) and autosaving 50, 51
configuring Quick Display mode in 169
changed data and the Center Value Across Break property 325
display of in blocks with breaks 325
display of in charts 325
display of in merged dimensions 321
display of in sections 323
display of in tables 320
formatting 319, 320
changing the chart type 215
changing the data source of queries 101
changing the drill focus of hierarchies 164, 165
changing the drill hierarchy when drilling 278, 280
changing the order of prompts 139
changing the order of reports 41
changing the query universe 103
changing the source of a query 98
changing the table type 177
changing variable values using input controls 259
character strings alphabetical order 199, 200
default sort order on 199, 200
chart chart style 214
feeding 213
heat map 229
tag cloud 229
tree map 229
chart axes displaying logarithmically 227
drilling on 282
formatting labels on 224
formatting numbers on 225
formatting text on 225
showing labels on charts 224
showing value ranges on 226
chart axis scales linear 226
logarithmic 226
chart types changing the type of using Turn Into 215
charts adding titles to 220
adding to reports 212
avoiding page breaks in 223
axis labels 208
bar charts 208
boxplot charts 208
building 207
changing the type of using Turn Into 215
charts spider charts 211
color palette 379, 380
copying to other applications 215
copying within reports 215
display of changed data in 325
displaying a hidden chart 227
displaying when empty 227
displaying with 3D look 221
displaying Y axes logarithmically 227
drilling on 282
drilling on axis legends 284, 285
drilling on chart axes 282
drilling on measures in 283, 284
fine-tuning the formatting of 169
formatting axis labels on 224
formatting axis values 225
formatting legends on 223
<table>
<thead>
<tr>
<th>charts (continued)</th>
<th>classes</th>
<th>comma-separated values (CSV)</th>
</tr>
</thead>
<tbody>
<tr>
<td>formatting the axes grid on 225</td>
<td>formatting the Plot Area</td>
<td>saving documents as (HTML interface) 47</td>
</tr>
<tr>
<td>formatting titles of 220</td>
<td>background 222</td>
<td>saving documents as (Java interface) 46</td>
</tr>
<tr>
<td>hiding the axes grid on 225</td>
<td>formatting titles of 220</td>
<td>complex selection</td>
</tr>
<tr>
<td>hiding when empty 227</td>
<td>light and shadow effects 229</td>
<td>in BEx queries 84</td>
</tr>
<tr>
<td>inserting and formatting titles</td>
<td>limitations when saving as Excel</td>
<td>conditional formatting</td>
</tr>
<tr>
<td>220</td>
<td>(HTML interface) 47</td>
<td>applying different formats to an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>object using 239</td>
</tr>
<tr>
<td></td>
<td></td>
<td>applying to data 241</td>
</tr>
<tr>
<td></td>
<td></td>
<td>conditions in 239</td>
</tr>
<tr>
<td></td>
<td></td>
<td>formatting data using 241</td>
</tr>
<tr>
<td></td>
<td></td>
<td>conditional formatting rules</td>
</tr>
<tr>
<td></td>
<td></td>
<td>activating 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>adding 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>building 240</td>
</tr>
<tr>
<td></td>
<td></td>
<td>deactivating 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>duplicating 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>editing 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>prioritizing 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>removing 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>using formulas to create 242</td>
</tr>
<tr>
<td></td>
<td></td>
<td>conditions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in BEx queries 84</td>
</tr>
<tr>
<td></td>
<td></td>
<td>contexts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and universes 75</td>
</tr>
<tr>
<td></td>
<td></td>
<td>choosing when running queries 75</td>
</tr>
<tr>
<td></td>
<td></td>
<td>clearing from queries 76</td>
</tr>
<tr>
<td></td>
<td></td>
<td>defined 75</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in BEx queries 94</td>
</tr>
<tr>
<td></td>
<td></td>
<td>resetting on query refresh 76</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copying charts to other applications 215</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copying charts within reports 215</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copying free-standing cells 188</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copying query script to clipboard 78</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copying tables to other applications 178</td>
</tr>
<tr>
<td></td>
<td></td>
<td>copying tables within reports 178</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Count standard calculation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>inserting in tables 265</td>
</tr>
<tr>
<td></td>
<td></td>
<td>create</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis View document 37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEx document 37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>document based on universe 36</td>
</tr>
<tr>
<td></td>
<td></td>
<td>new document 36</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating a database ranking 152</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating a prompt 135</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating an optional prompt 135</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating charts 207</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating documents 35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating quick query filters 117</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating report filters 250</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating sections 193</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creating sections from 193</td>
</tr>
</tbody>
</table>

| children 69                      | conditions                     |                            |
| choosing a drill path 275        |                                |                          |
| choosing a query context 75      |                                |                          |
| choosing interfaces              |                                |                          |
| creation, viewing and editing    |                                |                          |
| interfaces 27                    |                                |                          |
| choosing which dimensions to     |                                |                          |
| merge 292                        |                                |                          |

| line charts 209                  | columns                       |                            |
| linear axis scales defined 226   | adding to tables 177          |                            |
| logarithmic axis scales defined  | conditionally formatting 241  |                            |
| 226                               | creating sections from 193    |                            |
| modifying borders on 222         | hiding when empty 184         |                            |
| pie charts 210                   | moving in tables 177          |                            |
| point charts 210                 | removing from tables 177      |                            |
| publishing as web services 331   | selecting alternate colors for|                            |
| radar charts 211                 | 179                           |                            |
| removing 215                     | setting alternate colors for 179 |                            |
| resizing 218                     | showing when empty 184        |                            |
| restrictions when drilling on    | swapping in tables 178        |                            |
| measures in 284                   |                                |                            |
| setting the background color on  | combined queries              |                            |
| 221                               | and SQL 142                   |                            |
| setting the position of 183, 217 | building 143                 |                            |
| setting the relative position of | compared with multiple queries|                            |
| 217                               | 96                            |                            |
| showing a range of axis values 226 | compared with synchronized |                            |
| showing axis labels 224          | queries 96                    |                            |
| showing axis labels on 224        | defined 141                  |                            |
| showing legends on 223           | example of 144                |                            |
| showing or hiding values on 230   | how generated 142             |                            |
| showing the axes grid on 225     | how to structure 143          |                            |
| special effects 229              | intersection 141              |                            |
| specifying a palette style for    | minus 141                     |                            |
| data in 228                       | precedence in 144, 145        |                            |
| stacking options 224             | setting precedence in 146     |                            |
| striped background 222           | union 141                     |                            |
| switching between bars, lines,   | uses of 142                   |                            |
| and surfaces 216                 | combining prompts 129, 138    |                            |
| synchronizing drill across 281   | combining prompts with query  |                            |
| types of 207                      | filters 139                   |                            |
| using as input controls 262      | combining query filters 124   |                            |
| varying data markers on 230       | example of 123                |                            |
| VisualizationConfig.xml file 379, |                                |                            |
| 380                               |                                |                            |

| classic measures 59              |                                |                            |
| clearing contexts from queries 76|                                |                            |
| clearing the contents of cells 178|                                |                            |
| CMC                               |                                |                            |
| and autosaving 50, 51             |                                |                            |
| configuring Quick Display mode in |                                |                            |
| 169                               |                                |                            |
| CMS                               |                                |                            |
| linking to documents in 358       |                                |                            |
| color palette for charts 379, 380|                                |                            |
| colors                            |                                |                            |
| defining for charts 379, 380      |                                |                            |
| selecting alternate for           |                                |                            |
| rows/columns 179                 |                                |                            |
| selecting table background color  |                                |                            |
| 179                               |                                |                            |
| setting the background color on   |                                |                            |
| charts 221                        |                                |                            |
| specifying a palette style for    |                                |                            |
| chart data 228                    |                                |                            |
| contexts                         |                                |                            |
| and universes 75                  |                                |                            |
| choosing when running queries 75  |                                |                            |
| clearing from queries 76          |                                |                            |
| defined 75                        |                                |                            |
| in BEx queries 94                 |                                |                            |
| resetting on query refresh 76     |                                |                            |
| copying charts to other applications 215 |                        |                            |
| copying charts within reports 215 |                                |                            |
| copying free-standing cells 188  |                                |                            |
| copying query script to clipboard 78 |                                |                            |
| copying tables to other applications 178 |                        |                            |
| copying tables within reports 178 |                                |                            |
| Count standard calculation       |                                |                            |
| inserting in tables 265          |                                |                            |
| create                            |                                |                            |
| Analysis View document 37         |                                |                            |
| BEx document 37                   |                                |                            |
| document based on universe 36     |                                |                            |
| new document 36                   |                                |                            |
| creating a database ranking 152  |                                |                            |
| creating a prompt 135             |                                |                            |
| creating an optional prompt 135   |                                |                            |
| creating charts 207               |                                |                            |
| creating documents 35             |                                |                            |
| creating quick query filters 117  |                                |                            |
| creating report filters 250       |                                |                            |
| creating sections 193             |                                |                            |
| creating sections from 193        |                                |                            |
creating simple report filters 252
creating subsections 193
creating subsections using table cells 195
creating tables using drag and drop 176
creating tables using table templates 176
creating variables from formulas 267
cross tables 174
crosstabs
conditionally formatting 241
displaying object names in headers 186
drilling up in 278
inserting standard calculations in 265
working with hierarchical data in 161
CSV
saving documents as (HTML interface) 49
saving documents as (Java interface) 46
currency
formatting numbers as 237
currency formats
  custom 233, 234
  predefined 233
currency values
  formatting 233, 234
custom date and time formats 233, 234
custom formats
  applying 237
  defining 237
custom number formats 233, 234
custom query filters 116, 118
  adding and removing 118
custom scope of analysis level 77, 270
custom sort order 202
customizing sorts 205
data
analyzing using drill 269
applying conditional formatting to 241
changes to in charts 325
changes to in merged dimensions 321
changes to in sections 323
changes to in tables 320
comparing in bar charts 208
comparing in boxplot charts 208
displaying 171
data (continued)
displaying changes in 319
displaying date of last refresh 187
displaying in cross tables 174
displaying in forms 175
displaying in horizontal tables 174
displaying in vertical tables 173
displaying segments of 210
displaying trends over time in 209
displaying using the Document Locale 30
displaying using the Preferred Viewing Locale 30, 31
drilling down on 276
example of ranking at database level 153
examples of ranking at report level 312
examples of report-level ranking of 310
filtering at query level 110, 245
filtering at report level 110, 245
filtering using input controls 259, 263
filtering using report filters 245
filtering using simple report filters 252
filtering with drill filters 286
formatting changes to 319, 320
grouping with sections 191
hiding 171
hierarchical 155
highlighting ranges of using conditional formatting 242
highlighting using conditional formatting 239, 241
highlighting using conditional formatting rules 240
non-hierarchical 155
ranking at database level 151, 152
ranking at the report level 307
ranking using the interface 311, 312
ranking using the Rank function 311
refreshing 318
refreshing in drilled reports containing prompts 287
returning reference data using RefValue 326, 327
returning the date of the reference data 327
returning the user response for the reference data 327
setting as reference data 317
sorting 202
data (continued)
specifying a palette style for data in 228
synchronizing from different sources 291
tracking changes to 317
tracking changes to using formulas 326
data manager 98
Data Manager
  managing queries with 97
  setting key dates in 99
data markers
  drilling on in line charts 283
  drilling on in radar line charts 283
Data mode
  managing queries in 98
  switching to 96
data provider
  viewing the data in 97
data providers
  synchronizing with different aggregation levels 300
data source
  changing 101, 103
data tracking
  activating 318
  and alerters 326
  and charts 325
  and merged dimensions 321
  and sections 323
  and table breaks 325
  and tables 320
  and the calculation context 328
  and the Center Value Across Break property 325
  automatic mode 318
  defined 317
  formatting changed data 319
  incompatibility with drilling out of scope 325
  incompatibility with purging documents 325
  incompatibility with query drill 325
  incompatibility with Refresh on Open property 326
  incompatibility with SQL changes 325
  manual mode 318
  returning reference data using RefValue 326
types of data change 317
viewing whether activated 53
data tracking options
Auto-update the reference data 318
data tracking options (continued)
Use the current data as reference 318

database rankings
advantages of 151
and SQL 151
creating 152
example of 153
parts of 151
databases
and queries 78
sampling support in 80
date and time formats
custom 233, 234
predefined 233
date and time values
formatting 233
date prompts 137
dates and times
formatting 233, 234
date and time values
formatting 233
date and time prompts 137
dates and times
formatting 233, 234
default sort order 202
in breaks 199, 200
on character strings 199, 200
on numeric values 199, 200
Default standard calculation
inserting in tables 265
default universe 63
defining cell text as hyperlinks 355, 356
defining custom formats 237
defining filters for web services 333
defining how input controls filter data 259, 261
deleting columns from tables 177
deleting documents from the repository 39
deleting free-standing cells from reports 187
deleting hyperlinks 363
deleting merged dimensions 300
deleting report filters 250
deleting reports 41
deleting rows from tables 177
deleting tables 178
deleting variables 267
descendants 69
descending sort order 202
desktop interface
setting drill options in 272
detail objects
relationship with dimensions 302
details
selecting for merging 299
Different From operator 246
Different From Pattern operator 115, 134
dimension objects
defined 56
dimensions
adding a description to merged dimensions 299
choosing which dimensions to merge 292
creating sections from 193
deleting merged dimensions 300
displaying in cross tables 174
drilling by 280
drilling down on 277
drilling on 276
drilling on in charts 282, 283, 284
drilling on merged dimensions 304
drilling up on 278
extending merged values of 53
extending values returned by 305, 306
hiding 185
merged dimensions defined 291
merging automatically 53, 299
merging when attributes are associated 301
naming merged dimensions 299
ranking dimensions 151
redisplaying when hidden 185
restrictions on placing in tables 302
selecting for merging 299
understanding the effects of merging 300
displaying report data 171
displaying added queries in documents 100
displaying changed data 318, 319
displaying charts when empty 227
displaying charts with 3D look 221
displaying data using the Document Locale 30
displaying data using the Preferred Viewing Locale 30, 31
displaying default values in prompts 137
displaying footers 169
displaying headers 169
displaying images/skins in tables 180
displaying lists of values in prompts 137
displaying object names in crosstab headers 186
displaying page margins 169
displaying subtotals using breaks 197
displaying the current page number 187
displaying the document name 187
displaying the drill filters in a report 187
displaying the last refresh date 187
displaying Y axes logarithmically 227
document instances
linking to in the CMS 358, 361
Document Locale
defined 29, 30
displaying data using 30
document properties
auto-merge dimensions 51, 299
editing 53
enhanced viewing mode 51
extend merged dimensions values 51
hide warning icons in charts 51
permanent regional formatting 51
query stripping 51
refresh on open 51
Refresh on Open 326
use query drill 51
DocumentName function 187
documents
adding reports to 41
changing the order of reports in 41
creating a document on a BEx query 37
creating a document on an Analysis View 37
creating a new document 36
creating and editing 35
creating from BI portal 35
creating on universe 36
creating using desktop interface 35
creation, viewing and editing interfaces 27
displaying from the repository 39
deleting reports from 41
displaying added queries in 100
displaying the names of 187
displaying the queries in 187
editing properties of 53
how autosaving of is managed 51
linking to large documents using hyperlinks 362
linking to using hyperlinks 355, 358, 363
managing reports in 40
opening 38
opening from the repository 38
optimizing for on-screen viewing 53
documents (continued)

permanently associating a locale
with 53
permanently associating locales
with 31
printing 172
recovering autosaved documents
50
Refresh on Open property 326
refreshing on open 53
reports
saving as PDF (HTML interface) 48
saving as text (HTML interface)
48
saving as CSV (HTML interface)
49
saving as CSV (Java interface) 46
saving as Excel (HTML interface)
47
saving as Excel (Java interface) 44
saving as PDF (HTML interface)
48
saving as PDF (Java interface) 45
saving as text (HTML interface) 48
saving automatically 50
saving in drill mode 286
saving in the BI launch pad (HTML interface) 47
saving in the BI launch pad (Java interface) 43
selecting the default universe for 63
sending by FTP 40
sending by mail 39
sending to users 39
viewing the creation date of 53
viewing the creator of 53
viewing the description of 53
viewing the keywords associated with 53
viewing the locale of 53
viewing the name of 53
drill
activating query drill 288
adding and removing drill filters 286
and data tracking 325
and drill paths 271
BE query restriction 269
changing values on drill toolbar 286
choosing a drill path 275
defined 269
drill by 278, 280
drill filters 285
Drill toolbar 285
drill (continued)
drilling down 276
drilling down on dimensions 277
drilling down on measures 281
drilling on axis legends 284, 285
drilling on chart axes 282
drilling on charts 282
drilling on dimensions 276
drilling on measures 280
drilling on measures in charts 284
drilling on merged dimensions 304
drilling out of scope 275
drilling up 278
drilling up on dimensions 278
drilling up on measures 281
hiding the drill toolbar 273
query drill defined 287
restrictions when drilling on charts 284
retrieving more levels of data 274
setting desktop drill options 272
setting drill options 272
starting 273
starting on duplicate report 274
switching to drill mode 274
synchronizing across charts 281
synchronizing across tables 281
synchronizing on blocks 273
taking drill snapshots 276
viewing drill hierarchies 271
drill by 280
drill filters 285
adding and removing 286
and drill down 276
and prompts 287
and query drill 287
changing on Drill toolbar 286
displaying 187
saving reports with 286
Drill Filters function 187
drill hierarchies
and drill by 278
viewing 271
drill mode
and input controls 262
and the scope of analysis 76, 269
switching to 274
drill options
hide drill toolbar option 273
prompt for additional data option 272
setting 272
setting rich client drill options 272
start drill on duplicate report option 274
drill options (continued)
start drill on existing report option 273
synchronize drill on report blocks option 273
drill paths
and universe hierarchies 271
choosing between 275
selecting 271
drill snapshots
and query drill 289
incompatibility with query drill 289
taking 276
Drill toolbar 285
adding and removing filters on 286
changing filter values on 286
filters on during drill down 276
hiding 273
drill up
using query drill 289
DrillFilters function 287
drilling by different hierarchies 278, 280
drilling down 276
drilling down on dimensions in sections 277
drilling down on dimensions in tables 277
drilling down on measures 281
drilling down using query drill 287, 288
drilling on axis legends in charts 284, 285
drilling on chart axes 282
drilling on data 269
drilling on dimensions in sections 276
drilling on dimensions in tables 276
drilling on measures in charts 283, 284
drilling on measures in sections 280
drilling on measures in tables 280
drilling on merged dimensions 304
drilling out of scope 275
incompatibility with data tracking 325
drill up
using query drill 289
drill up 278
drilling in crosstabs 278
drilling up on dimensions 278
drilling up on measures 281
drilling up using query drill 287, 289
drilling using query drill 287
duplicating conditional formatting rules 242
duplicating queries 101
E
editing conditional formatting rules 242
editing document properties 53
editing documents 35
editing hyperlinks 363
editing input controls 261
editing queries 98
editing query script 363
editing variables 267
effects of report filters on merged dimensions 304
empty charts
displaying 227
hiding 227
Enhanced Viewing Mode document option 51
entering formulas by typing 266
Equal To operator 112, 117, 131, 246, 249
error messages
#RANK 311
error message
#RECURSIVE 181
effects of report filters on merged dimensions 304
filtering data with drill filters 286
filter operators
restrictions on 116, 135
filtering blocks containing merged dimensions 304
filtering data in queries 110, 245
filtering data in reports 110, 245
filtering data using input controls 259, 263
filtering data using simple report filters 252
filtering merged dimensions 303, 304
filtering queries on values from other queries 121
filtering sections 193, 304
filters
adding custom query filters 118
creating quick query filters 117
custom query filters 116
nesting query filters 125
predefined query filters 116
query filters defined 109
quick query filters 116
removing custom query filters 118
report filters 245
report filters and merged dimensions 304
selecting a predefined query filter 117
filters as default values
in BEx queries 84
fine-tuning the formatting of reports 169
fixed data sampling 80
footers
displaying 169
repeating on every page 186
showing and hiding in tables 185
ForceMerge function
effect of 297
Format Painter
applying formatting with 182
formats
applying custom formats 237
applying predefined formats 234
defining custom formats 237
formatting
a chart 218
applying with the Format Painter 182
formatting (continued)
chart formatting 218
formatting axis values on charts 225
formatting boolean values 233
formatting changed data 320
formatting chart axis labels 224
formatting chart legends 223
formatting chart titles 220
formatting currency values 233, 234
formatting data using conditional formatting 241
formatting dates and times 233
formatting decreased data 319
formatting free-standing cells 187
formatting increased data 319
formatting inserted data 319
formatting numbers 233
formatting numbers and dates 234
formatting removed data 319
formatting table and cell borders 180
formatting text in cells 180
formatting the axes grid on charts 225
formatting the Plot Area background 222
forms 175
conditionally formatting 241
Formula Editor
building formulas using 266
formulas
adding to reports 265
building conditional formatting using 242
building using the Formula Editor 266
chart elements
formulas 219
creating variables from 267
effect of 297
example using RefValue 327
in chart elements 219
typing 266
using to track data changes 326
free-standing cells 187
and section headers 197
applying conditional formatting to 239
copying as text 188
copying to other applications 188
copying within reports 188
deleting from reports 187
formatting 187
hiding 188
inserting in reports 187
restrictions on copying 188
FTP
sending documents by 40
functions
- DocumentName 187
- DrillFilters 187, 287
- ForceMerge 297
- GetContentLocale 30
- GetLocale 29
- GetPreferredViewingLocale 30
- If 327
- LastExecutionDate 187
- NumberOfPages 187
- Page 187
- PromptSummary 187
- QuerySummary 187
- Rank 311
- RefValue 326, 327
- RefValueDate 327
- RefValueUserResponse 327
- ReportFilterSummary 187
- using to select members of a hierarchy 69, 91

G
- GetContentLocale function 30
- GetLocale function 29
- GetPreferredViewingLocale function 30
- Greater Than operator 113, 131, 246
- Greater Than Or Equal To operator 113, 131, 247
- grouping data with sections 191

H
- HANA 19
- headers
  - displaying 169
  - displaying object names in 186
  - repeating on every page 186
  - showing and hiding in tables 185
- height
  - setting on cells 181
- hierarchies
  - changing the drill focus of 165
  - hidden free-standing cells 188
  - hiding headers in tables 185
  - hiding report data 171
  - hiding sections 196
  - hiding the axes grid on charts 225
  - hiding the drill toolbar 273
  - hiding values on charts 230
  - hierarchical members
    - in BEx queries 67, 89
  - hierarchies
    - in BEx queries 84
  - hierarchical aggregation 165
  - hierarchical data 155
    - and crosstabs 161
      - in tables 160
    - reporting on 155
    - restrictions 156
    - sorting 203
  - hierarchical queries 60, 87
  - hierarchy node variables
    - in BEx queries 69, 89
  - hierarchy objects 58
  - highlighting data ranges using conditional formatting 242
  - highlighting data using conditional formatting 239, 241
  - highlighting data using conditional formatting rules 240
  - highlighting input control dependencies 261
  - horizontal records per page
    - restricting 169
  - horizontal tables 174
  - how prompts are merged 130
  - how to structure combined queries 143
  - HTML interface 27
  - hyperlinks
    - associating with cells 356
    - defining cell text as 355, 356
    - deleting 363
    - editing 363
    - linking to document instances with 361
    - linking to documents with 363
  - hyperlinks (continued)
    - linking to large documents with 362
    - passing values to prompts with 361
    - setting colors 363

I
- IES 00001 429
- IES 00002 429
- IES 00003 429
- IES 00004 430
- IES 00005 430
- IES 00006 430
- IES 00007 430
- IES 00008 431
- IES 00009 431
- IES 00010 431
- IES 00011 432
- IES 00012 432
- IES 00013 432
- IES 00014 433
- IES 00015 433
- IES 00016 433
- IES 00017 433
- IES 00018 434
- IES 00019 434
- IES 00020 434
- IES 00021 434
- IES 00022 435
- IES 00023 435
- IES 00024 435
- IES 00025 435
- IES 00026 435
- IES 00027 436
- IES 00028 436
- IES 00029 436
- IES 10001 436
- IES 10002 437
- IES 10005 437
- IES 10006 437
- IES 10013 437
- IES 10014 438
- IES 10016 438
- IES 10032 438
- IES 10033 438
- IES 10034 439
- IES 10035 439
- IES 10036 439
- IES 10037 439
- IES 10038 440
- IES 10040 440
- IES 10041 440
- IES 10042 440
- IES 10061 441
- IES 10064 441
- IES 10069 441
images (continued)  
displaying using boimg protocol 180
In List operator 114, 117, 133, 248
including database rankings in queries 151
including merged dimensions in calculations 297
including multiple hierarchies in queries 61
incompatible objects
and merged dimensions 302
placing in tables 302
increased data
tracking 317
input controls
adding 259
associating lists of values with 259
associating report elements with 259, 261
associating report objects with 259
changing variable values using 259
defined 259
editing 261
filtering data using 263
highlighting dependencies 261
organizing 261
removing 261
using charts as 262
using tables as 262
viewing the map of 262
inserting breaks in tables 199
inserting free-standing cells in reports 187
inserting sorts 204
inserting standard calculations in tables 265
interface
Rich Client 27
Rich Internet Application 27
Web 27
interface locale
setting 29
interface preferences 25
interrupting queries 100
intersection combined queries 141
Is Not Null operator 249
Is Null operator 249
Java applet 27
K
keys
merging 291
L
LastExecutionDate function 187
launch pad
about the BI launchpad) 25
layering options
Bring Forwards 183
Bring To Front 183
Send Backwards 183
Send To Back 183
layering tables and cells 183
Left Panel
merging dimensions in 299
legends
formatting on charts 223
showing on charts 223
Less Than operator 113, 132, 247
Less Than Or Equal To operator 113, 132, 247
levels
selecting all members from 72
using in query filters 126
line charts 209
drilling on measures in 283
linear axis scales 226
linked nodes
in BEx queries 84
linking report elements 364
linking to document instances using hyperlinks 361
linking to documents in the CMS 358
linking to documents using hyperlinks 355, 363
linking to large documents using hyperlinks 361, 362
list of values
selecting from 119, 250, 256
lists of values
associating with input controls 259, 261
displaying in prompts 137
restricting prompt responses to 137
local calculations
in BEx queries 84
locales
defined 29
Document Locale 29, 30
permanently associating documents with 53
permanently associating with documents 31
locales (continued)
Preferred Viewing Locale 29, 30, 31
Product Locale 29
logarithmic axis scales 226
logging in to the BI launch pad 26
logging out of the BI launch pad 27
lower level nodes in BEx queries 84

M
mail
  sending documents by 39
making query script editable 78
managing host servers for web services 333
managing published web services 335
managing queries 97, 98
managing reports in documents 40
manual data tracking mode 318
Matches Pattern operator 114, 134
Max Rows Retrieved property compared to Sample Result Set property 79
Maximum standard calculation inserting in tables 265
measure objects
  defined 59
measures
  and query drill 288
  displaying in cross tables 174
drilling down on 281
  drilling on in charts 283, 284
  drilling on in sections 280
  drilling on in tables 280
  drilling up on 281
  formatting decreases in 319
  formatting increases in 319
  in BEx queries 84
  restrictions on calculating 300
  restrictions on drill in charts 284
  restrictions on in pie charts 210
  using in hierarchical query filters 127
Member Selector
  searching for members in 74, 92
  selecting members using 66
  working with 65
members
  and named sets 58
  building prompts to select 74, 93
  defined 58
  excluding from hierarchies 73
  in BEx queries 92
members (continued)
  searching for in the Member Selector 74, 92
  selecting all at a level 72
  selecting calculated members 73
  selecting explicitly in hierarchies 67
  selecting from a hierarchy using functions 69, 91
  selecting from hierarchies 66
  selecting in BEx queries 67, 89
merged dimensions
  adding a description to 299
  and attributes 301
  and block filters 304
  and incompatible objects 302
  and section filters 304
  auto-merge dimensions property value 51
  choosing which dimensions to merge 292
defined 291
deleting 300
display of changed data in 321
drilling on 304
example of 292
extend merged dimensions values document property 51
extending values returned by 305, 306
filtering 303, 304
including in calculations with ForceMerge 297
keys 291
merging automatically 299
naming 299
placing in tables 302
selecting default properties for 299
understanding the effects of 300
merging cells in tables 183
merging details 299
merging dimensions 299
merging dimensions automatically 53, 299
merging prompts 130
metadata
  supported in BEx queries 83
  supported in InfoCubes 83
Minimum standard calculation inserting in tables 265
minus combined queries 141
modified data
  tracking 317
modifying chart borders 222
moving rows or columns in tables 177
multiple queries 95, 101
  compared with combined queries 96
  compared with synchronized queries 96
multiple reports and query drill 289

N
named sets 58
  defined 58
  selecting 73
naming merged dimensions 299
nesting prompts 129
nesting query filters 124, 125
NetWeaver BW 55, 82
new document
  creating 36
non-hierarchical data 155
  working with 155
non-hierarchical queries 60
Not Between operator 114, 133, 248
Not Equal To operator 112, 131, 246
Not In List operator 114, 133, 249
number formats
  custom 233, 234
  predefined 233
number of objects in BEx queries 84
NumberOfPages function 187
numbers
  formatting 233, 234
  formatting as currency 237
  formatting on chart axes 225

O
objects
  applying formats to using conditional formatting 239
  attribute 57
  classic measure 59
  dimension 56
  displaying names of in crosstab headers 186
  hierarchy 58
  measure 59
  relationship with classes 56
  smart measure 59
OLAP
  and query drill 288
open document 38
OpenDocument
  linking to documents using 358
opening documents from the repository 38
operators
  And 124
  Between 113, 132, 248
  Both 115, 134
  Different From 246
  Different From Pattern 115, 134
  Equal To 112, 117, 131, 246
  Except 115, 134
  Greater Than 113, 131, 246
  Greater Than Or Equal To 113, 131, 247
  In List 114, 117, 133, 248
  Is Not Null 249
  Is Null 249
  Less Than 113, 132, 247
  Less Than Or Equal To 113, 132, 247
  Matches Pattern 114, 134
  Not Between 114, 133, 248
  Not Equal To 112, 131, 246
  Not In List 114, 133, 249
  Or 124
  restrictions on 116, 135
optimizing documents for on-screen viewing 53
optional prompts
  and query script 78
  creating 135
  defined 129
  Or operator 124
organizing data using breaks 197
organizing input controls 261

P
page breaks
  avoiding in charts 223
  avoiding in sections 196
  avoiding in tables 186
Page function 187
page margins
  displaying 169
Page mode 171
  defined 169
pages
  displaying the current page number 187
  displaying the total number of 187
  setting minimum height of 169
  setting minimum width of 169
  starting sections on new 196
parent 69
parts of a database ranking 151
parts of a report-level ranking 309
parts of a subquery 149
passing values to subqueries 150
PDF
  saving documents as (HTML interface) 48
  saving documents as (Java interface) 45
  saving reports as (HTML interface) 48
PDF format
  saving reports as 42
Percentage standard calculation
  inserting in tables 265
Permanent Regional Formatting
  document option 51
  permanently associating a locale with documents 53
pie charts 210
  drilling on measures in 283
point charts 210
Portable Document Format (PDF)
  saving documents as (HTML interface) 48
  saving documents as (Java interface) 45
position at lower level nodes
  in BEx queries 84
positioning sections 196
precedence in combined queries 144, 145
predefined boolean formats 233
predefined currency formats 233
predefined date and time formats 233
predefined formats
  applying 234
  predefned number formats 233
predefined query filters 116
preferences (interface) 25
Preferred Viewing Locale
  defined 29, 30
  setting 31
previewing query results 99
Previous function
  and report-level rankings 311
printing documents 172
  printing reports 172
prioritizing breaks 200
prioritizing conditional formatting rules 242
prioritizing sorts 205
Product Locale
  defined 29
  setting 29
prompt operators
  Between 113, 132, 248
prompt operators (continued)
  Both 115, 134
  Different From 246
  Different From Pattern 115, 134
  Equal To 112, 117, 131, 246
  Except 115, 134
  Greater Than 113, 131, 246
  Greater Than Or Equal To 113, 131, 247
  In List 114, 117, 133, 248
  Less Than 113, 132, 247
  Less Than Or Equal To 113, 132, 247
  Matches Pattern 114, 134
  Not Between 114, 133, 248
  Not Equal To 112, 131, 246
  Not In List 114, 133, 249
prompts
  answering 255
  building member selection prompts 74, 93
  changing the order of 139
  combining 138
  combining with query filters 139
  creating 135
  defined 129
  displaying a default value in 137
  displaying a summary of 187
  displaying lists of values in 137
  displaying the previously-selected value in 137
  merging 130
  passing values to in hyperlinks 361
  publishing in web services 332
  refreshing data in reports containing 287
  removing 137
  restrictions on operators in 116, 135
PromptSummary function 187
publishing prompts in 332
  publishing prompts in web services 332
publishing QaaWS (Query as a Web Service 337
publishing QaaWS (Query as a Web Service) 337
publishing tables as web services 331
purging documents
  incompatibility with data tracking 325
  purging queries 98
QaaWS
publishing 337
queries (continued)
  including multiple hierarchies in 61
  interrupting 100
  intersection combined queries 141
  managing 98
  managing with the Data Manager 97
  minus combined queries 141
  modification of in query drill mode 287
  multiple queries 95, 101
  multiple, combined and synchronized compared 96
  non-hierarchical 60
  parts of a subquery 149
  precedence in combined queries 144, 145
  previewing the results of 99
  publishing QaaWS as web services 337
  purging 98
  query contexts defined 75
  query filters defined 109
  removing 101
  renaming 98
  restoring previous values to 100
  Retrieve Duplicate Rows property 81
  returning partial results from 100
  running 63
  Sample Result Set property 80
  selecting members in BEx queries 67, 89, 94
  setting combined query precedence 146
  setting the key dates of 99
  setting the maximum run time 81
  sorting the results of 99
  subqueries defined 147
  union combined queries 141
  uses of combined queries 142
  viewing and editing script of 78
  viewing script generated by 78
  Query as a Web Service (QaaWS) publishing 337
  query contexts 75
  and universes 75
  choosing 75
  defined 75
  query default layout
  in BEx queries 84
  query drill
  activating 288
  and drill snapshots 289
  and the scope of analysis 288
  compared to standard drill 287
query drill (continued)
  defined 287
  drilling down with 288
  drilling up with 289
  incompatibility with data tracking 325
  incompatibility with drill snapshots 289
  side effects of 289
  when to use 288
query exceptions
  in BEx queries 84
query filter operators
  Between 113, 132, 248
  Both 115, 134
  Different From 246
  Different From Pattern 115, 134
  Equal To 112, 117, 131, 246
  Except 115, 134
  Greater Than 113, 131, 246
  Greater Than Or Equal To 113, 131, 247
  In List 114, 117, 133, 248
  Less Than 113, 132, 247
  Less Than Or Equal To 113, 132, 247
  Matches Pattern 114, 134
  Not Between 114, 133, 248
  Not Equal To 112, 131, 246
  Not In List 114, 133, 249
query filters 121
  adding complexity by nesting 124
  adding custom query filters 118
  combining 123, 124
  combining with prompts 139
  compared with report filters 110, 245
  creating quick query filters 117
  custom 116, 118
  defined 109
  filtering queries on values from
  other queries 121
  nesting 124, 125
  predefined 116
  predefined query filters defined 116
  quick filters 116
  removing 117
  removing custom query filters 118
  selecting predefined 117
  structure of 110
  types of 116
  using levels in 126
  using measures in 127
query on query 121
query properties
  Max Rows Retrieved 79
query properties (continued)
Retrieve Duplicate Rows 81
Return Non-Empty Rows only 81
Sample Result Set 80
query script
and optional prompts 78
copying to clipboard 78
making editable 78
validating 78
viewing and editing 78
Query toolbar
setting the scope of analysis using 271
QuerySummary function 187
Quick Display mode 171
configuring in the CMC 169
defined 169
setting the number of horizontal
records in 170
setting the number of vertical
records in 170
quick filters
defined 117
quick query filters 116
creating 117
quick report filters 249

R

radar charts
varying the data markers on 230
radar line charts
drilling on measures in 283
random data sampling 80
Rank function
and report-level rankings 311
ranking data at the database level
151, 152
ranking data at the report level 307, 312
ranking data using the interface 312
ranking examples 310
re-publishing web services 334
recovering autosaved documents 50
redisplaying hidden cells 184, 188, 196
redisplaying hidden content 172
redisplaying hidden dimensions 185
redisplaying hidden tables 184, 188, 196
reference data
automatically updating with each
refresh 318
returning the date of using
RefValueDate 327
reference data (continued)
returning the user response of
using RefValueUserResponse 327
returning using RefValue 326, 327
selecting manually 318
setting at a fixed date 318
setting for tracking data changes 317
Refresh on Open document option 51
Refresh on Open document property
incompatibility with data tracking 326
refrshing documents on open 53
RefValue function 326
example of a formula using 327
RefValueDate function
returning the reference date using 327
RefValueUserResponse function
returning the reference date using 327
relational databases
and queries 78
relative postion
setting for charts 217
removed data
tracking 317
removing breaks 200
removing charts from reports 215
removing columns from tables 177
removing conditional formatting rules 242
removing custom query filters 118
removing drill filters 286
removing duplicate values from breaks 200
removing input controls 261
removing prompts 137
removing queries 101
removing query filters 117
removing rows from tables 177
removing section cells 196
removing sections 196
removing sorts 205
removing standard calculations 266
removing tables 178
renaming queries 98
repeating break values on new page 200
repeating footers in breaks 200
repeating headers in breaks 200
repeating sections on new page 196
repeating table footers on every page 186
repeating table headers on every page 186
report elements
associating with input controls 259, 261
conditionally formatting 241
creating links between 364
report filter operators
Between 113, 132, 248
Different From 246
Equal To 112, 131, 246, 249
Greater Than 113, 131, 246
Greater Than Or Equal To 113, 131, 247
In List 114, 133, 248
Is Not Null 249
Is Null 249
Less Than 113, 132, 247
Less Than Or Equal To 113, 132, 247
Not Between 114, 133, 248
Not Equal To 112, 131, 246
Not In List 114, 133, 249
Report Filter toolbar 252, 285
report filters
compared with query filters 110, 245
creating 250
creating simple report filters 252
defined 245
deleting 250
d貌ing 250
effects on merged dimensions 304
quick report filters 249
simple report filters 249
standard report filters 249
report filters
applying to sections 193
report objects
associating with input controls 259
report-level rankings 307
and data order 311
and running aggregate functions 311
and sorts 307
and the #RANK error message 311
and the Previous function 311
and tied rankings 308
creating using the interface 311, 312
creating using the Rank function 311
effects on merged dimensions 304
examples of 310, 312
parts of 309
workflows for creating 311
ReportFilter function 187
Sample Result Set query property compared to Max Rows Retrieved property 80

S

Sample Result Set query property compared to Max Rows Retrieved property 80

SAP BusinessObjects Analysis defined 94

SAP connection

BEx queries 86

SAP NetWeaver BW 55, 82, 83

Save as Excel

Setting preferences 43

saving documents as CSV (HTML interface) 49

saving documents as CSV (Java interface) 46

saving documents as Excel (HTML interface) 47

saving documents as Excel (Java interface) 44

saving documents as PDF (HTML interface) 48

saving documents as PDF (Java interface) 45

saving documents as text (HTML interface) 48

saving documents as Text (Java interface) 46

saving documents in drill mode 286

saving documents in the BI Launch Pad (HTML interface) 47

saving documents in the BI Launch Pad (Java interface) 43

saving reports as Excel (HTML interface) 47

saving reports as PDF (HTML interface) 48

saving reports as text (HTML interface) 48

saving web services on a host server 334

scaling factor 89

scheduled documents and automatic data tracking mode 318

scope of analysis
and drill mode 76, 269
and query drill 288
and universe hierarchies 76, 269
custom 77, 270
defined 76, 269
drilling out of 275
extending 274
impact on document size 77, 270
levels of 77, 270
setting 77, 271

searching for members 74, 92

section cells 197

section filters 193

and merged dimensions 304

sections
applying conditional formatting to

239
applying filters to 193
avoiding page breaks in 196
compared to breaks 197
conditionally formatting 241
creating 193
creating subsections 195
defining colors and images in 197
display of changed data in 323
drilling down on dimensions in 277
drilling on dimensions in 276
drilling on measures in 280
filtering when section header is a
merged dimension 304
grouping data with 191
hiding 196
positioning 196
removing 196
repeating on new pages 196
starting on new page 196
security profile
and extending the scope of analysis 274

segments
drilling on in pie charts 283
selecting a predefined query filter 117
selecting alternate row/column colors 179
selecting calculated members 73
selecting default properties for merged dimensions 299
selecting details for merging 299
selecting dimensions for merging 299
selecting drill paths 271
selecting from a list of values 119, 250, 256
selecting host servers for web services 333
selecting members
in BEx queries 67, 89
selecting members explicitly 67
selecting members from hierarchy levels 72
selecting members of a hierarchy 64
selecting members of a hierarchy using functions 69, 91
selecting named sets 73
selecting table background colors 179
selecting the viewing interface 29

Send Backwards layering option 183
Send To Back layering option 183

sending documents by FTP 40

sending documents by mail 39

sending documents to users 39

server side variable
in BEx query 88
setting break properties 200
setting cell height and width 181
setting combined query precedence 146

setting data as reference data 317

setting desktop drill options 272
setting drill options 272
setting hyperlink colors 363
setting minimum page height 169
setting minimum page width 169
setting the background color on charts 221

setting the interface locale 29

setting the key dates of queries 99
setting the order of sorts 205
setting the position of tables or charts 183, 217

setting the Preferred Viewing Locale 31

setting the Product Locale 29

setting the relative position of charts 217

setting the scope of analysis 77, 271
show floor of a 3D chart 223
showing axis labels on charts 224
showing break footers 200
showing break headers 200
showing chart legends 223
showing empty columns 184
showing empty rows 184
showing empty tables 184

472
showing footers in tables 185
showing headers in tables 185
showing the axes grid on charts 225
showing value ranges on chart axes 226
showing values on charts 230
siblings 69
side effects of query drill 289
simple report filters 249, 252
skins
displaying from a URL 180
displaying in tables 180
displaying using boimg protocol 180
smart measures 59
sort order
ascending 202
custom 202
default 199, 200, 202
descending 202
sorting data 202
sorting hierarchical data 203
sorting query results 99
sorts
adding 205
and QaaWS queries 337
and report-level rankings 307
customizing 205
inserting 204
prioritizing 205
removing 205
resetting 205
setting the order of 205
types of 202
specifying a palette style for chart data 228
SQL
and combined queries 142
and data tracking 325
and database ranking 151
and subqueries 147, 149
standard calculations 300
inserting in tables 265
removing 266
standard drill mode
compared to query drill 287
standard report filters 249
starting breaks on new page 200
starting drill mode 273
starting sections on new page 196
starting tables on new page 186
starting Web Intelligence from BI launch pad 35
structure of query filters 110
subclasses 56
subqueries
and SQL 149
building 147
defined 147
example of 148
parts of 149
uses of 147
subsections
creating 193
creating using table cells 195
subtotals
displaying using breaks 197
Sum standard calculation inserting in tables 265
swapping rows or columns in tables 178
switching between viewing modes 171
switching to Data mode 96
switching to drill mode 274
synchronized queries
compared with combined queries 96
compared with multiple queries 96
synchronizing data providers with different aggregation levels 300
synchronizing dimensions 291
synchronizing drill across charts 281
synchronizing drill across tables 281
table breaks
avoiding page breaks in 200
centering values across 200
compared to sections 197
default sort order in 199, 200
defined 197
displaying subtotals using 197
effect of on changed data 325
effect on conditional formatting 239
inserting 199
organizing data with 197
removing 200
removing duplicate values from 200
repeating footers in 200
repeating headers in 200
repeating values on new page 200
showing break footers 200
showing break headers 200
starting on new page 200
table cells
clearing the contents of 178
formatting text in 180
merging 183
repeating on every page 186
tables (continued)
  showing/hiding with zero measure values 228
  starting on new page 186
  swapping rows or columns in 178
  synchronizing drill across 281
  tables
    charts
      from tables 177
      turn into chart 177
    using as input controls 262
  vertical tables 173
  taking drill snapshots 276
  templates
    applying to tables 177
    creating tables using 176
  testing web services 336
  text
    copying free-standing cells as 188
    finding in reports 168
    formatting in cells 180
    formatting on chart axes 225
    saving documents as (HTML interface) 48
  text
    saving reports as (HTML interface) 48
  Text
    saving documents as (Java interface) 46
  tied rankings 308
  titles
    adding to charts 220
    formatting on charts 220
  toolbars
    Drill toolbar 273, 276, 285
    Report Filter 252
    Report Filter toolbar 285
  tracking data changes 317
  Turn Into
    changing the chart type using 215
    changing the table type using 177
  typing formulas 266

U

understanding effects of merged dimensions 300
union combined queries 141
universe
  creating a new document 36
  universe hierarchies 271
  and the scope of analysis 76, 269
  universes
    and query contexts 75
    changing the query universe 103
universes (continued)
  predefined query filters in 116
  selecting default 63
  unvisited hyperlinks
    setting the color of 363
Use Query Drill document option 51
  users
    sending documents to 39
    uses of combined queries 142
    using charts as input controls 262
    using formulas to track data changes 326
    using tables as input controls 262
V

validating query script 78
values
  formatting boolean 233, 234
  formatting currency 233
  formatting currency 234
  formatting date and time 233, 234
  formatting number 233, 234
  formatting on chart axes 225
  hiding on charts 230
  selecting from a list 119, 250, 256
  showing on charts 230
  showing ranges of on chart axes 226
variable orders
  in BEx queries 84
variables
  adding to reports 265
  changing values of using input controls 259
  creating from formulas 267
  deleting 267
  editing 267
  in BEx queries 84
  varying the data markers on charts 230
vertical records per page
  restricting 169
vertical tables 173
viewing drill hierarchies 271
viewing interface
  selecting 29
viewing modes
  defined 169
  Page mode 169, 171
  Quick Display mode 169, 171
  switching between 171
viewing published web services 335
viewing query script 78
viewing the input controls map 262
visited hyperlinks
  setting the color of 363
VisualizationConfig.xml color palette file 379, 380

W

warning icons 219, 220
  charts
    warning icons 219, 220
  in charts 219, 220
  Warning icons in charts document option 51
Web Intelligence
  launching from the BI launch pad 19
Web Intelligence interface
  setting the locale of 29
  starting from BI launch pad 35
Web interface 27
web services
  defining filters for 333
  identifying duplicate tables
    published in 332
  making data available for filtering in 334
  managing host servers for 333
  publishing charts as 331
  publishing from host server 334
  publishing prompts in 332
  publishing tables as 331
  re-publishing 334
  saving on host server 334
  selecting host servers for 333
  testing 336
  viewing and managing 335
  when to use query drill 288
WHERE clause (SQL)
  and subqueries 147
width
  setting on cells 181
  WIH 00015 401
  WIH 00016 401
  WIJ 10000 381
  WIJ 10001 382
  WIJ 10500 382
  WIJ 11111 382
  WIJ 20000 383
  WIJ 20001 383
  WIJ 20002 384
  WIJ 20003 384
  WIJ 20004 384
  WIJ 20005 384
  WIJ 2010 385
  WIJ 30000 386
  WIJ 30001 386
  WIJ 30003 386
  WIJ 30004 385
wrap text  
effect of with autofit height 181  
effect of with autofit width 181  

X  
X-Axis  
drilling on 282  

Y  
Y axis  
displaying logarithmically 227  
Y-Axis  
drilling on 282  

Z  
zero measure values  
hiding 228  
showing 228  
zero suppression  
in BEx queries 84